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ABSTRACT
Global supply chain is largely dependent on seaports and marine terminals. Ports serve
international cargo traffic for imports and exports. About 90% of the world’s goods are
transported by sea and over 70% as containerized cargo ships. Coastal hurricanes/cyclones and
rainfall flood disasters cause major disruptions for sea shipping traffic, disruptions of port
infrastructure, and adverse impacts on coastal communities each year. Additionally, these
weather related disasters threaten millions of people, damage infrastructure, and cost billions of
dollars in global supply chain disruptions. Sustainable global supply chains, port infrastructure,
and coastal community impact by these extreme weather disasters are the major motivation of
this research. The objectives of this research are: (1) modeling shipping demand and level of
service, (2) developing Landsat-8 satellite imagery based methodology for mapping surface
types and landuse, and (3) assessing the impact of coastal disasters and climate related sea level
rise. The Autoregressive Integrated Moving Average (ARIMA) model equations, the Artificial
Neural Networks (ANN) models, and regression equations were developed using historical
containerized cargo volumes to predict the future volumes for the Port of New Orleans and the
Port of New York and New Jersey. The predictions by these models indicate that the ANN
model achieves the most accurate predicted values, compared to reported volume. However, the
ANN approach requires future values of independent variable inputs to calculate the forecast.
Therefore, applying the ANN model was recommended for short-term prediction for these ports.
The ARIMA model equation was applied for long-term prediction because it does not need other
independent variable inputs. Results of cargo vessel volume analysis for ten selected
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international shipping navigation routes using Automatic Identification System (AIS) data show
that the Europe Atlantic route to the East Coast of the U.S. has the largest cargo vessel volumes.
A spatial map of cargo vessel demand for selected navigation routes was also created. A level of
service (LOS) methodology for cargo vessel service was developed using AIS data for the Port
of Miami to evaluate the operating conditions of a seaport. A mathematical function to estimate
LOS level (A, B, C, D, E, F) was proposed based on delay time and waiting time of cargo vessels
at the port and number of processed cargo vessels per total annual cargo vessels.
A new methodology was developed to classify built and non-built surfaces using
Landsat-8 satellite imagery. Groundtruth samples of the Landsat-8 pansharpened multispectral
satellite imageries from six selected sites were sampled and used to develop the Landsat-8 Builtup Area and Natural Surface (L-BANS) auto-classification methodology. The L-BANS surface
classification results for most sites using GeoMedia Pro geospatial analysis were within ±15% of
the groundtruth. Based on analysis of variance (ANOVA) hypothesis testing results, the
difference between the L-BANS results and the groundtruth was not statistically significant. The
anthropogenic CO2 based global warming hypothesis was evaluated to undertand climate
impacts. Measured global temperature and atmospheric carbon dioxide (CO2) data from 1958 to
2016 were analyzed. The final ARIMA time series seasonal model equation for monthly global
temperature data had a high R value of 0.989 with only 2.25% difference compared to measured
values. The final ARIMA model equation for monthly CO2 data provided reasonably accurate
results for 2016 monthly measured CO2 data with high a R value of 0.999 with only 0.0025%
difference compared to measured values. The results show that there is very poor
crosscorrelation (0.08) between global temperature and CO2. Both IPCC and EPA models predict
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unreasonably high values of CO2 until 2050. This research shows that contrary to the IPCC
claims, global warming is not caused by anthropogenic CO2.
Rainfall flood simulations were conducted for five selected port cities using the one
dimension (1-D) U.S. Army Hydrologic Engineering Center’s River Analysis System (HECRAS). Results of the rainfall flood simulations indicate that these selected port cities are at great
risk to extreme floods, in which more than 37% of the land area of each port city is inundated by
floodwater. This dissertation also presents the Center for Advanced Infrastructure Technology
(CAIT) methodologies to evaluate the land submerged from 2 m sea level rise (SLR) related to
climate impacts by the year 2100 and the impact of 2 m, 4 m, and 9 m tsunami wave peak
heights (WPH) on the selected port cities. The results show that extreme rainfall flood, which
can happen any year, is more disastrous to people and infrastructures compared to 2 m SLR and
2 m tsunami WPH. A resilience management plan was recommended to protect both people and
infrastructure from coastal hazards. In response to SLR and tsunami, the seawall around port
infrastructures should be improved and raised to 2 m height to protect life infrastructure and
communities in the port cities.
This research will benefit port authorities, maritime and waterway cargo shipping
enterprises, and port cities in reducing impacts on communities and enhancing disaster resilience
of port infrastructures, which are imperative for minimizing disruptions in the global supply
chain and sustaining the world economy.
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Autocorrelation Function
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Artificial Neural Network
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Analysis of Variance
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Global Positioning System
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LIDAR
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Level of Service

MA
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MARIS
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MS
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NAFTA
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NOAA
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R
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RMSE
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SD

Standard Deviation

SLR

Sea Level Rise

SCA

Suez Canal Authority

SPSS

Statistical Package for the Social Science
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Shuttle Radar TopoRgraphy Mission

TEU
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TIN

Triangular Irregular Networks

TIRS

Thermal Infrared Sensor

TU
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USACE
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USAID

United States Agency for International Development
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United States Geological Survey
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Wave Peak Height
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I. INTRODUCTION
1.1

Background
Port infrastructure and maritime ship navigation routes are vital for sustainable global

supply chain. Ports serve international cargo traffic for import and export. About 90% of the
world’s goods are transported by sea and over 70% as containerized cargo ships [1]. The
American Association of Port Authorities (AAPA) reported that the U.S. seaports are
accountable for moving more than 99% of the country’s import or export cargo by volume and
65% by value [2]. Coastal hurricanes, cyclones, and rainfall flood disasters cause major
disruptions for sea shipping traffic, disruptions of port infrastructure, and adverse impacts on
coastal communities each year. In addition, these weather related disasters threaten millions of
people, damage infrastructures, and cost billions of dollars in global supply chain disruptions.
According to the U.S. Climate Central, coastal areas are home to more than one billion people
across the globe and up to 310 million of those live in 100-year floodplain areas. Moreover,
U.S. $11 trillion worth of infrastructure assets were also constructed below the 100-year flood
mark [3]. Sustainable global supply chain, port infrastructure, and coastal community impact by
these extreme weather disasters are the major motivation of this research.

1.1.1 Motivation and Goals
This research is motivated by the results of three NCITEC projects. Extreme weather
disasters associated with ports and coastal communities are also major motivation for the
research.
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Primary goals of this research are the enhancement of global freight mobility and
disaster resilience for port infrastructure and maintaining sustainable global supply chains.
These goals are also the goals and achievements of the NCITEC projects.

1.1.2 Needs for Research Issues
The exchange of capital, goods and services through international borders is known as
international trade, and it represents a significant share of the nation's gross domestic product
(GDP) in many countries. Trade between an origin group of countries and a destination group of
countries is defined as a trade route. Nearly 500 liner shipping services offer regularly
scheduled service between ports along a single trade route or a group of trade routes. Liner
ships transport about 65% of the value of seaborne trade or more than U.S. $ 4 trillion worth of
goods annually [4]. Table 1 shows the top five trade routes in the world in 2013 [5]. The trade
route from Asia to North America was ranked as number one with 23,125,000 twenty-foot
equivalent units (TEUs) in 2013. The trade route from Asia to North Europe was ranked as
number two with 13,706,000 TEUs.

Table 1. Top five trade routes (TEUs shipped) 2013
Route

West Bound (TEUs)

East Bound (TEUs)

Total (TEUs)

Asia-North America

7,739,000

15,386,000

23,125,000

Asia-North Europe

9,187,000

4,519,000

13,706,000

Asia-Mediterranean

4,678,000

2,061,000

6,739,000

Asia-Middle East
North Europe-North America

3,700,000
2,636,000

1,314,000
2,074,000

5,014,000
4,710,000
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Table 1 also shows that liner trade has been dominated by countries in Asia. Greater
China (including mainland China, Hong Kong, and Taiwan, China) accounts for 28% of the
value of liner exports and 30% of the global volume of containerized exports [5].
Over 200 countries have ports open to container ships. Containers handled by all ports
world-wide (including empties, transshipments and port handling) were estimated at more than
580 million TEUs in 2011 [5]. As the largest exporter of goods moving on container services,
Shanghai, China ranks as number one in the top fifty global container ports. Singapore still
ranks as number two mainly because it is an important hub where containers from one liner
service are transferred to another liner service for on-carriage to their final destination.
Container ships make about 9,000 port calls, and vehicle vessels about 1,000 port calls, per
week. This means workers at ports worldwide load and unloads more than 10,000 liner ship
stops per week. The average ship makes about two port calls per week [7].
According to the World Shipping Council [8], there are almost 6,000 ships in the globe
operating in liner services with most built since 1980. About 5,000 of those ships are container
ships. Container ships have grown in size from just 1,500 TEUs in 1976 to ships able to carry in
excess of 12,000 TEUs today, with some ships on order capable of carrying 18,000 TEUs.
Today's ships not only are able to carry more goods in one voyage, they are much more fuel
efficient.
Each year, natural disasters cause hundreds of deaths and cost billions of dollars in
disaster aid, disruption of commerce, and destruction of homes and critical Infrastructure [9].
Climate impacts, like a projected sea levels rise (SLR) of .6 m to 2 m and doubling of Category
4 and 5 hurricanes by 2100, will result in more extreme events at many seaports and port cities
[10]. Decision-makers of ports, shipping enterprises, and port cities must anticipate the impacts
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of climate change and proactively prepare for SLR, increased flooding, and more frequent
extreme storm events [11, 12]. In recent decades, an average of 130 ports was hit by a tropical
cyclone each year. Figure 1 shows the map of world ports and tropical cyclone tracks from 1990
to 2008 [13].
It can be seen from Figure 1-2 that most tropical cyclones formed in and affected East
Asian and Western and Eastern North America where many large and busy ports and trade
routes are located. In another study, Bender et al. [14] indicated a doubling of category four and
five hurricanes in the Atlantic basin by 2100. More extreme precipitation events could cause
localized flooding and changes to sedimentation loading that could increase dredging
requirements. SLR, storms, and flooding create interruptions and bottlenecks in the flow of
products through ports.

Figure 1. Map of world ports and tropical cyclone tracks from 1990 to 2008
(Map credit: http://www.pianc.org/downloads/climate%20change/WP128.pdf)
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Nicholls et al. [15] analyzed 136 port cities around the world to measure current and
future exposure to a 1-in-100 year flooding event. Their findings propose that many of these
areas have significant percentages of their GDP in areas that are at high risk today, and climate
change will increase that risk significantly. By 2070, for instance, the combined effect of
climate change, urbanization, increased population, and land subsidence could put 150-million
people and US 35,000 billion U.S. dollars (9% of projected global GDP) of assets at direct risk
[15].
Over 60% of Americans are living within 50 miles of the Atlantic and Pacific Oceans,
the Gulf of Mexico and the five Great Lakes. The population density of these areas is four times
the national average and is expected to grow by 15% in the next two decades [16]. Because of
this growth, Americans today are more vulnerable to hurricanes than ever before [17]. Between
1980 and 2007, the U.S. bore 78 weather-related disasters in which overall damages and costs
reached or exceeded U.S $1 billion per event.
Floods are the most frequent and widespread of all natural disasters [17]. Flooding also
causes extensive damage and service disruption to the transportation and supply chain
infrastructures of the nation. The United States also faces significant tsunami threats to the West
Coast, Hawaii, Alaska, and island territories in the Caribbean and the Pacific [17]. Hurricane
Katrina was one of the strongest storms to impact the New Orleans and Gulfport port cities in
the southeastern United States during the past 100 years [17], with estimated total economic
losses of U.S $125 billion, insured losses of $35 billion, and U.S. $5.5 billion worth of damages
to infrastructure. About 2,400 ships and vessels were destroyed [18]. The 350 miles of levees
built around the city of New Orleans failed and water from Lake Pontchartrain flooded the city
unabated for 36 hours, covering an estimated 80% of the city. The Port of Gulfport shutdowns

5

in Mississippi impacted commerce in 30 states [19]. The port experienced total destruction.
Containers from the terminals washed up throughout the downtown area. Piers and warehouses
were destroyed. Customers relocated, and 5 years later the port works at 80% of its pre-Katrina
volume.

1.2

Research Objectives and Scope
The research objectives are:
1. To model container freight shipping demand for seaports, analyze shipping
volumes on international shipping navigation routes using AIS data, and develop a
LOS methodology for cargo vessel service using AIS data to evaluate the operating
conditions of a seaport.
2. To develop a Landsat-8 satellite imagery based auto-classification methodology for
mapping surface types and landuse using selected sites and port cities.
3. To assess impacts of extreme rainfall flood, tsunami, and climate related SLR on
coastal port cities and enhance the resilience of port infrastructure.
This research scope is limited to:


Port of New Orleans and the Port of New York and New Jersey: container freight
shipping demand prediction models in these seaports.



Strait of Malacca, Red Sea, Suez Canal, Mediterranean Sea, Europe Atlantic, East
Coast Atlantic, Gulf/Caribbean, Panama Canal, Pacific Ocean, West Pacific Alaska:
shipping volume analysis, anthropogenic CO2 emission.
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Miami in Florida, Gulfport in Mississippi, Los Angeleso in California, Karachi and
Gwadar in Pakistan, and Hai Phong in Vietnam: the L-BANS auto-classification of
surface types and landuse, rainfall flood, tsunami, and SLR simulations.

1.3

Research Methodology
The research methodology flow chart in Figure 2 shows milestones of the research

topics and their interaction. Details of each research topic and related research products are
discussed in the following sections.

Figure 2. Research methodology flow chart
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1.4

Overview of NCITEC Projects

1.4.1 Integrated Intermodal Transportation Corridors for Economically Viable and Safe
Global Supply Chain
Details of NCITEC project 2012_32 on the intermodal optimization and waterborne
freight transport are available from the following link:
http://www.olemiss.edu/projects/cait/ncitec /NCITEC_2013-32-UM-Uddin-Summary.pdf
Assessed October 15, 2014.
The global supply chain can be seriously disrupted by extreme weather disasters. This
issue of disruption in the supply chain can seriously harm local economies which depend on
distribution through surface transportation modes. The four transportation modes (shipping port,
aviation, rail, and highway) are owned and operated by different entities in the U.S. Federal and
state funded highway infrastructure, while freight railroads are privately owned. All these modal
networks operate within their own policy frameworks and profit motivations with little or no
real operational integration. Financing for preserving and upgrading intermodal infrastructure
for both freight and rail is being handled very differently. Transport infrastructure funding crisis
is evident on all levels.
The main focus of this research project is to identify major transportation corridors
involving shipping ports (marine and inland river system), highway network, and rail
infrastructure networks and to evaluate the economic viability, safety, disaster resiliency, and
revenue/funding aspects of integrating selected segments of the candidate corridors. The project
objective is accomplished by using airborne and spaceborne remote sensing and geospatial
technologies for mapping and visualization of freight corridors and connecting major city hubs.
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The analysis of freight traffic data of the project shows that total inbound freight from
all foreign origins to U.S. was 604,459 ton-miles in 2011. Waterway accounted 58% of total
inbound freight, 13% of truck, and 13% of rail. Waterway is known as the main transportation
mode of inbound freight from all foreign origins to the U.S. However, trucks are the main
transportation mode for freight shipments within the U.S. Total freight shipments within the
U.S. in 2007 were 18,579 million. Trucks made up 72% of total freight shipments; rail made up
11%, and only 3% was carried out waterways. Another conclusion from the project is that
trucks carry 15 times more freight by dollar values compared to rail and waterborne transport
combined, and almost same truck ton-mile. This indicates that a greater freight share of rail and
waterway will reduce congestion on highways, operating long-haul costs, and emissions.
Figure 3 shows the integrated freight corridor map created during the project [6].

Figure 3. Integrated freight corridor: I-55 and Mississippi River
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This map shows important transportation infrastructures (ports, Interstate Highway 55,
US Highway, and Mississippi River) as well as freight integration corridor that connects New
Orleans to Chicago. By diverting 30% freight trucks from port of Gulfport to the integrated
Mississippi river corridor, the cost is reduced. It is 2.6 times more costly for the base highway
truck freight case. Travel time is reduced by one-third and anthropogenic CO2 emission is also
reduced. Another interesting finding from the project that by diverting 40% truck freight to rail
in the NAFTA Integrated Freight Corridor, the annual benefits of the integration of highway
and rail corridors include: 98.8% (917,610 days) of saving in travel time, 87.2% (U.S $3,000
million) of saving in ton-mile cost, 58.2% (416,769 tons) of saving in anthropogenic CO2
produced.

1.4.2 Intermodal Optimization for Economically Viable Integration of Surface and
Waterborne Freight Transport
Details of NCITEC project 2012_32 on the intermodal optimization and waterborne
freight transport are available from the following link:
http://www.olemiss.edu/projects/cait/ncitec /NCITEC_2013-32-UM-Uddin-Summary.pdf.
Assessed October 15, 2014.
In the U.S. and around the globe, the efficient delivery of goods and services is a key
factor in economically competitive markets and quality of life. From 1960s to1990s, timely
capital investments were made in transportation infrastructure. This efficient freight
transportation network in North America led to a global competitive edge for many decades.
However, these transportation infrastructure systems are aging, not being expanded and
modernized at a rate comparable to those of other global competitors. In addition, economic
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competitiveness is diminishing. These modes operate independently in the U.S. with no
operational integration, except some to rail and road intermodal transport terminals. One freight
mobility area for economically competitive markets that can benefit tremendously from
intermodal integration is the efficient freight transport through seamless connectivity among
surface transport, inland waterways, and marine ports.
The main goals of this project are to: (1) identify major freight transportation corridors
involving shipping ports (marine and inland waterways), highway networks, and rail
infrastructure assets, (2) model transport demand, visualize routing scenarios, and optimize
locations of integrated intermodal terminals, and (3) evaluate the economic competitiveness
considering travel time efficiency, safety, disaster resiliency, emissions, and economic
development opportunities over a 10 - 20 year planning period.
Key results from the project include the following:
1. Development of geospatial maps of the Mississippi River waterway, inland ports and
interconnecting surface transportation network, synthesis of both surface and
waterborne databases and commodity flow, optimization models, benefit/cost results
of proposed modal integration studies, and life cycle economic evaluation and
environmental impact.
2. Development of traffic flow demand and flow models using AIS data.
3. Computer simulations of selected inland port(s) and surface freight corridor(s) with
life cycle cost analysis, which will provide benefits of the intermodal integration
approach for enhancing the economic competitiveness, safety, security and disaster
resilience of freight transport.
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4. The developed models of freight intermodal corridor are able to assess other societal
benefits, which include reduction in highway traffic congestion, cost avoidance of
billions of gallons of fuel wastage on congested highway corridor, decrease in
transportation related emissions of anthropogenic CO2.
5. The intermodal freight corridor case studies are used to develop a “best practice guide”
for consideration by government transportation agencies and supply chain
stakeholders.
6. Training of undergraduate and graduate students in transportation network analysis
and geospatial workforce development are additional benefits.

1.4.3 Disaster Protection of Transport Infrastructure and Mobility Using Flood Risk Modeling
and Geospatial Visualization
Details of NCITEC project 2012_25 on the disaster are available from the following
link: http://www.olemiss.edu/projects/cait/ncitec/NCITE_2012_25_UM_Uddin_Altinakar.pdf
Assessed October 15, 2014.
About 60% of all disasters costing one billion dollars or more in the U.S. were related to
weather; most occurred in southeastern states. Weather-related natural disasters include flooding
events which cause catastrophic damages to road infrastructure including pavements and
bridges. Washing away of bridges and highways disrupt public mobility, freight traffic and
supply chain, emergency management, and even disaster evacuation routes. Each year millions
of dollars are devoted to emergency funds and mitigation of damaged transport infrastructure.
This project addresses the NCITEC theme of efficient, safe, secure, and sustainable national
intermodal transportation network that can be made resilient to disasters. Specific focus is on
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developing technologies to enhance decision support systems for transport infrastructure
protection from extreme weather related natural disasters such as floods.
The main focus of this project is the use of airborne and spaceborne remote sensing and
geospatial technologies for modeling and visualization of terrain and built environment, flood
risk mapping on regional and local levels, and simulation of extreme events for estimating flood
disaster impacts on intermodal transport infrastructure network assets.
Key outcomes from the project include the following:
1. Geospatial decision support system for flood risk assessment and protection of
infrastructure including roads and bridges were developed.
2. Computer simulations and flood mitigation cost analysis were used to show the
importance of this approach to save lives and billions of dollars in flood damages that
can be avoided.
3. Flood related vulnerabilities of traditional urbanization processes and infrastructure
systems were assessed by the developed approach.
4. Training of undergraduate and graduate students and geospatial workforce
development were additional benefits.

1.5

Research Significance
Coastal hurricanes, cyclones, rainfall flood, tsunami, and other related disasters continue

to cause major disruptions for seaport traffic, and global shipping and damage to infrastructure.
In order to help government policy makers, worldwide port agencies, and port cities to achieve
the goals of disaster resilience for maintaining sustainable global supply chain, research to
addresses these issues is needed.
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There is a strong need for a new innovative approach for cargo shipping volume
prediction and development of LOS for evaluating port operational efficiency for serving and
making strategies to improve port infrastructures. Multispectral decision tree criteria and
workflow to auto-classify surface classes using Landsat-8 multispectral imagery are new
innovative approaches for classification of built and non-built surfaces. Implementation of
rainfall flood simulation, tsunami and SLR simulations developed by CAIT using 1-D HECRAS, Landsat-8 pansharpened multispectral satellite imagery, flow hydrographs, and
topographic terrain data are also another innovative approach. Last but not least, the advanced
ARIMA model equations for predicting global temperature (oC) and anthropogenic CO2 is
another innovative approach.
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II. CONTAINER FREIGHT SHIPPING DEMAND PREDICTION MODELS
2.1

Overview of Container Freight Shipping Demand at Selected Port Cities
According to the Maritime Trades Department [1], nearly 90% of the world’s commerce

or goods are transported by sea with over 70% as containerized cargo. The U.S. seaports are
accountable for moving more than 99% of the country’s import or export cargo by volume [2].
Port cities are a vital part of the global economy and are gradually becoming important
concentrations of population and asset value. Thirteen out of the twenty most populated cities in
the world are port cities [15]. New Orleans and New York City are two port cities in the United
States were selected for this study.
The Port of New Orleans, located in New Orleans, Louisiana, ranks as the sixth-largest
port in the United States [20, 21]. The port is 3.4 km long and can accommodate 15 vessels at
one time. It is connected throughout the U.S. and Canada via 14,500 miles of inland waterways
and is the only seaport in the U.S. to be served by six major rail lines. In addition, trucks easily
reach the port through interstates I-10, I-12, I-55 and I-59. This intermodal access allows goods
to be transported to and from the port in a timely, efficient and cost-effective manner [21]. The
port provides direct industry expenditures in Louisiana totaling U.S. $406 million, creating
8,102 jobs and providing U.S. $324 million in personal income. The port’s facilities contain 20
million square feet of cargo handling area, more than 3.1 million square feet of covered storage
area and 1.7 million square feet of cruise and parking facilities. The Port of New Orleans has
the capacity to handle around 240,000 export containers a year. The port had plans to improve
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major infrastructure expected to cost more than U.S. $1 billion [21] to increase the capacity of
the port.
The Port of New York and New Jersey is the port district of the New York-Newark
metropolitan area, surrounding the region within an almost 40 km radius of the Statue of Liberty
National Monument [22]. The port, founded in 1921, is the gateway to one of the most
concentrated and affluent consumer markets in the world. It is the largest port on the East Coast
and the third-largest in the nation. The area’s network of aviation, ground, rail, and seaport
facilities supports more than 550,000 regional jobs, and creates more than U.S. $23 billion in
annual wages and U.S. $80 billion in annual economic activity [23]. In 2014, the port handled
3,342,286 cargo containers, a 5.4 percent increase in total container traffic from 2013. The
record volumes allowed the port to keep its position as the busiest on the East Coast with nearly
30 percent of the total market share. The dollar value of all cargo that moved through the port
exceeded U.S. $ 200 billion [23]. Each day, U.S. $ 557 million of goods move through the port,
and about 8,800 containers that are imported goods from top trading partners such as China,
India, Germany and Italy are unloaded. In many ways, the port is the physical demonstration of
the U.S. trade deficit totaling U.S. $36.44 billion in 2016 [23].
A successful transportation infrastructure and sustainable supply chain depends on a
healthy seaport infrastructure. The right infrastructure requires an accurate forecast of market
demand. Then this demand must be translated into a master plan for execution. It all sounds
simple, but many challenges are found along the way [23]. In order to get sustainable
development goals and meet the demand in the future, the forecasts of freight shipping demand
for both the Port of New Orleans and the Port of New York and New Jersey are required.
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2.2

Review of Methodologies for Estimating TEU Freight Shipping Demand
Forecasting provides predictive information. It can help people and organizations plan

for the future and make decisions [24]. There are several types of forecasting models. Multiple
Linear Regression (MLR), Time series, and Artificial Neural Networks (ANNs) models are
known commonly and used as forecasting models for predicting freight transport and shipping
demand. MLR is a statistical technique that uses several explanatory variables to predict the
outcome of a response variable. The goal of MLR is to model the relationship between the
explanatory and response variables [25].
In the past, researchers always applied the traditional regression methods for predicting
the volumes of containers. However those researchers did not reflect this non-stationary
relationship between the volumes of import containers and the macro-economic variables [26].
Consequently, prediction errors made by those researchers were higher, and the volumes of
containers in those predictions were mostly higher than the actual volumes of containers [26].
Chou et al. [26] proposed a new modified regression equation using data for the period
1989-2001 for predicting the volumes of Taiwan’s import containers. This research was
expected to reduce the non-stationary contribution coefficient produced by the macro-economic
variables and to provide better accuracy prediction. The economic data, including the volumes
of export containers, the volumes of import containers, the population, the industrial production
index, the gross national product, the gross national product per capita, the wholesale price, the
gross domestic product, the agricultural gross domestic product, the industrial gross domestic
product, and the service gross domestic product, was summarized. The correlations between
different economic variables were calculated. The results demonstrated that there was generally
a statistically significant correlation among these different economic variables. Then, the
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modified regression equation was built. The accuracy of the traditional regression equation and
the modified regression equation was compared; the comparison results indicated that the
modified regression equation showed higher prediction accuracy.
Time series is an ordered sequence of values of a variable at equally spaced time
intervals. The factors are not affected for this forecasting, and the predicting depends on past
values [27]. In time series analysis, an Autoregressive Integrated Moving Average (ARIMA)
model, known as the Box-Jenkins model [28], was introduced as a forecasting technique that
projects the future values of a series based entirely on its own inertia. The ARIMA model has
been academically proven to get accurate and trustworthy results for time series estimated and
prediction model in port logistics [29], traffic flow forecasting [30], and tourism passengers
[31]. Stopford [32] suggested the ARIMA model for maritime forecasting because the model
can present real past patterns and deal with both stationary and non-stationary data series.
Therefore, the ARIMA will be used as a good prediction model for this research.
ANNs is an information-processing system based on mathematical models of human
cognition and neural biology [33]. ANNs has been successfully used in civil and other
engineering disciplines. There are only a few ANN research studies regarding supply chain,
commodity flows, and import and export containerized cargo volumes. One of the earlier
studies, Celik [34], served a theoretically related variable set into the ANNs model for fifteen
commodity groups using the 1993 US Commodity Flow Survey. The performances of speciﬁed
ANNs models were compared with a benchmark Box–Cox model with the same variables set.
The results of the ANN model for every commodity group outclassed that of the Box-Cox
model in terms of replicating observed base year data. Due to the lack of other important
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factors, it is difficult to predict the number of import containers or number of export containers
with this model.
In another study, Mostafa [35] conducted an ANNs model to forecast the maritime
traffic flows in the Suez Canal in order to help the Suez Canal Authority (SCA) plan its future
activities given the unusual fluctuations in regional and international politics. Another objective
of that study was to compare the performance of both the neural network and the ARIMA
models using the same data set. Data used for the study was composed of monthly traffic
through the Canal expressed in thousands of tons from the reopening of the Canal in June 1975
through June 1998. Experimental design was conducted; the combination of ten input nodes and
15 hidden nodes yielded a total of 150 neurals. A three-layer feedforward neural network was
used to forecast the Suez Canal traffic. Measures and comparison were performed, and root
mean square error (RMSE) was used to evaluate the predictive performance of neural networks.
The study indicated that no pattern was detected in the residuals for both neural net and
ARIMA, which suggested that the errors were normally distributed with a mean of zero. Results
of the study showed that the RMSE for the neural network model chosen was 0.034 vs RMSE
of 0.048 for the ARIMA series resulting from ‘best’ ARIMA technique. This indicated that
forecasts based on neural networks would lead to lesser amounts of forecast error. However,
this conclusion was still doubted because of the two aspects of limitation of this study. The first
aspect was that only the traffic expressed in tons series was selected for detailed examination, so
cautions may still need to be exercised for generalization of the results to other traffic data. The
second aspect was that only one-step-ahead forecasting strategy was investigated by Mostafa.
Results for multiple-step forecasting could be different from those obtained from this study.
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Additionally, other researchers such as Gosasang el al. [27] and Al-Deek [36]
recommended the ANNs model for maritime forecasting. Thus, the ANNs model will be also
used for this research.

2.3

Implementation of the ARIMA Model of TEU for the Port of New Orleans and the Port of
New York and New Jersey

2.3.1 ARIMA Model Equation Methodology
The ARIMA model equation approach was selected to better understand the data and
also to make an appropriate forecasting of future month data of total loaded containerized cargo
volumes. The ARIMA model equations are usually used in time series analysis. The iterative
model building process includes the following steps [28, 37]:
1.

Identification: The identification of the appropriate model for the time series
requires using a differencing, autocorrelation function (ACF) and partial
autocorrelation function (PACF) of different orders.

2. Estimation: The parameter estimates follow model identification using standard
ARIMA software such as SPSS for statistically significant terms [93]. The
parameters are improved by going back to the identification process.
3. Diagnosis: After identifying a tentative ARIMA model, the model is diagnosed by
analyzing (1) residuals of the model for independence at the first and second lags;
and (2) for statistical adequacy, the residuals must be distributed as white noise with
zero value of ACF. This is an iterative process by going back to the steps of
identification and estimation.
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4. Metadiagnosis: This step verifies that a tentative ARIMA model is statistically
adequate with a high R value, and it provides reasonably accurate results of model
verification using estimate parameters.
5. Model implementation: After a tentative model has been accepted, it may be used
for forecasting and assessing impact of an intervention event.
The ARIMA model equations are usually defined as ARIMA (p,d,q), where p, d, and q
terms are positive integers. The p is the autoregressive process, d is the degree of differencing,
and q is the order of moving-average process. The AR evaluates sequential correlation between
observed data. The differencing process was required to ensure that the data used to develop the
ARIMA model is statistically stationary. The final term of MA was applied to smooth out the
curve or line of the plotted time series data.
In this study, the mean absolute relative error (MARE) and RMSE were used to measure
the accuracy of these model equations. According to Riad et al [38], MARE is a statistical
accuracy measure that is used to filter out the most promising optimal networks or models. If
the value of MARE is small, close to zero, it means that the model’s performance is good.
MARE is calculated as the following equation.
N

 yˆ i  yi
 yi

 
MARE =

i 1

N





x 100

(2.1)

Where yi and ŷi are respectively the observed and predicted value of total loaded
container volume. N is total number of data sets.
As shown by Dý´az-Robles at al. [39], RMSE is generally used as a measure of the
difference between values predicted by the model and measured values. RMSE is an indicator
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of model accuracy or precision. RMSE should be as low, or as close to zero, as possible. RMSE
is calculated as the following equation.
N

y
RMSE =

i 1

 yˆ i 

2

i

N

(2.2)

Where yi and ŷi are respectively the observed and predicted value of total loaded
container volume. N is total number of data sets.

2.3.2 Implementation of the ARIMA Model of TEU for the Port of New Orleans
Monthly total loaded export containerized cargo volumes or observed data for ten years
from 2005 to 2014 was provided by the Port of New Orleans [40]. The distribution of observed
data points (unfilled circle) in Figure 4 shows a steadily increasing trend of total loaded export
container volumes from 2005 to 2014.

Figure 4. Total loaded export container volumes (TEUs) by month for the Port of New Orleans
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Additionally, the observed data do not clearly show cycles of seasonal patterns for total
loaded export container volumes. Therefore, only non-seasonal ARIMA models were used in
this study. The observed data from 2005 to 2013 was used for analyzing and evaluating the
ARIMA model equations, and the observed data in 2014 was used for validating the model
equations.
The non-seasonal ARIMA model equations are usually defined as ARIMA (p,d,q),
where p, d, and q terms are positive integers. The p is the Autoregressive process, d is the
degree of Differencing, and q is the order of Moving-Average process. The AR evaluates
sequential correlation between the observed data and whether the number of total loaded export
container volumes for a single month (Yt) depends on the value from the previous month (Yt-1).
The differencing process was required to ensure that the data used to develop the ARIMA
model is statistically stationary. A stationary time series explains that the properties of the total
loaded export container volume data such as mean, variance and autocorrelation, are all constant
over time [28, 37]. In this particular study, the data was differenced once, by subtracting the Yt
with Yt-1 data until 2014. The differencing process successfully transformed the data to be
stationary as shown in Figure 2-2 (upward triangle). In the final term of MA, q is equal to two
and three was also applied in the transformation process. The MA process was applied to
smooth out the curve or line of the plotted time series data. The two months MA term was
plotted as shown in Figure 2-2 (filled circle). For the two-month MA process, data from
January and February in 2005 was the first averaged value (Yt). The subsequent data (Yt+1) was
obtained by averaging data in February and March in 2005. The two-month MA process
continued until data in December 2014. Additionally, the three-month MA term was also
applied. The plot of the three-month MA term is shown in Figure 5 (cross). The three-month
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MA process is similar to the two-month MA process, but the first averaged value (Yt) was
obtained by averaging data in January, February, and March in 2005, and subsequent data (Yt+1)
was acquired by averaging data in February, March, and April in 2005.

Figure 5. Differencing, Moving Average process to determine ARIMA model equation terms,
the Port of New Orleans
The sequential correlation between monthly data (Yt) and the previous month’s data (Yt-1), and
the Pearson’s correlation between time (month) and transformed data (by Differencing and
Moving Average processes) were evaluated, and the results are shown in Table 2.

Table 2. Correlations of observed data with different AR and MA terms,
the Port of New Orleans
A

B

C

D

E

Sequential
Correlation
(Lag 1)

Month vs.
Total (TEUs)
(Observed)

Month vs.
One Differencing

Month vs.
Two Months
Moving Average

Month vs.
Three Months
Moving Average

0.778

0.772

0.023

0.820

0.836
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The total loaded export container volumes were found to have high sequential
correlation between original and Lag 1 data sets with R of 0.778. The Pearson’s correlation
between months and the total loaded export container volume data also shows high correlation
of R more than 0.7, respectively. This concludes that the total loaded export container volumes
are the reasonable independent variable to be incorporated into the model development process.
The Differencing process shows almost zero value of Pearson’s correlation, which explains that
the data was in a stationary condition. The Moving Average processes show high sequential
correlation between months and the total loaded export container volume data with R of 0.820
for the two months MA process and 0.836 for the three months MA process. For this particular
data set, a high sequential correlation between data indicates that the non-regression ARIMA
time series modeling approach was more desirable as compared to traditional regression
equations.
Further analysis was conducted to evaluate ARIMA (0,1,3) and ARIMA (1,1,3) model
equations. Figure63 shows the observed and predicted total loaded export container volumes
using ARIMA model equations from January 2005 to December 2013. Basically, the average,
standard deviation (SD), and coefficient of variation (COV) of the predicted values are
comparable to the observed data. There is no predicted total loaded export container volumes
calculated in January 2005 due to the differencing term applied in both ARIMA model
equations, which resulted in only 107 data points. The plot also showed the capability of the
ARIMA model equations to predict total loaded export container volumes, exhibited by high R
of more than 0.80. The average, SD, and COV of the predicted data are almost the same as the
observed data. Figure 7 shows that all lags of the Residual ACF and Residual FACF of ARIMA
(0,1,3) and ARIMA (1,1,3) models equations are within the confidence interval limits.
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Figure 6. Verification of the ARIMA model equations, the Port of New Orleans

ARIMA (0,1,3) Model Equation

ARIMA (1,1,3) Model Equation

Figure 7. Residual ACF and Residual FACF, the Port of New Orleans
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Table 3 shows validation using 2014 data for the ARIMA (0,1,3) and ARIMA (1,1,3)
model equations. The average percent differences between the predicted and observed data for
2014 are -4.0% for both ARIMA (0,1,3) and ARIMA (1,1,3) model equations. The mean
absolute relative error (MARE) are 5.28% for ARIMA (0,1,3) model equation and 5.34% for
ARIMA (1,1,3) model equation. The RMSE is 1,263.16 for ARIMA (0,1,3) model equation and
1,276.74 for ARIMA (1,1,3) model equation.

Table 3. Comparision between observed and predicted data from ARIMA (0,1,3) and ARIMA
(1,1,3) model equations, the Port of New Orleans
Month
Jan-14
Feb-14
Mar-14
Apr-14
May-14
Jun-14
Jul-14
Aug-14
Sep-14
Oct-14
Nov-14
Dec-14
Total
Average
SD
COV
Average % Difference
MARE (%)
RMSE (TEUs)

Total Loaded
Export (Observed)
(TEUs)
18,840
17,715
19,688
19,056
20,934
19,394
20,175
20,879
20,655
20,657
21,318
20,827
240,138
20,012
1082.0
5.4%
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ARIMA (0,1,3)
Predictions
(TEUs)
18,462
18,851
19,041
19,232
19,370
19,456
19,488
19,468
19,395
19,269
19,090
18,859
229,981
19,165
316.0
1.6%
-4.0
5.28
1,263.16

ARIMA (1,1,3)
Predictions
(TEUs)
18,425
18,854
19,028
19,241
19,378
19,464
19,493
19,468
19,387
19,251
19,060
18,813
229,862
19,155
329.4
1.7%
-4.0
5.34
1,276.74

Additionally, Table 3 shows that the percent differences between the average observed
and average predicted data for 2014 are -4.2% for ARIMA (0,1,3) model equation and -4.3%
for ARIMA (1,1,3) model equation. This shows that the ARIMA (0,1,3) model equation is a
better predictor compared to ARIMA (1,1,3) model equation. Therefore, it is recommended that
the ARIMA (0,1,3) model equation is used for future month predictions.

Table 4. Percentage difference between average observed and average predicted ARIMA model
equations, the Port of New Orleans
A

B

C

D = 100*(B-A)/A

E = 100*(C-A)/A

Average
Observed

ARIMA (0,1,3)
Average
Predicted

ARIMA (1,1,3)
Average
Predicted

% Difference
Average Observed vs.
Average Predicted
ARIMA (0, 1, 3)

% Difference
Average Observed
vs. Average Predicted
ARIMA (1, 1, 3)

(TEUs)

(TEUs)

(TEUs)

(TEUs)

(TEUs)

20,012

19,165

19,155

-4.2

-4.3

The following Equation 2.3 shows the general ARIMA (0,1,3) model equation.
▼1 . Yt = C + (1 – θ1B – θ2B2 – θ3B3) . at
Yt

(2.3)

= Discrete time series

▼1 = Regular Differencing operator of order one
C

= Constant = 402.395

1 – θ1B – θ2B2 – θ3B3 = Regular Moving Average process of order three
at = random shock term; normally distributed, independent with zero mean, and
variance equal to σa
The summary of ARIMA (0,1,3) model equation parameters is shown in Table 5.
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Table 5. Summary of ARIMA (0,1,3) Model Parameters, the Port of New Orleans
ARIMA Model Parameters

Total
loaded
export
container
volumes
(TUEs) Model

Total loaded
export
container
volumes
(TUEs)
MONTH,
period 12

No
Transformation

Estimate

SE

t

Sig.

Constant

402.395

346.060

1.163

.248

Difference

1
.000

MA
No
Transformation

Numerator

Lag 1

.621

.098

6.316

Lag 2

-.121

.115

-1.056 .294

Lag 3

.156

.098

1.590

Lag 0

-52.834

51.307

.115

-1.030 .306

The following Equation 2.4 shows the general ARIMA (1,1,3) model equation.
▼1 . Yt = C + (1 – ϕ1B) . (1 – θ1B – θ2B2 – θ3B3) . at

(2.4)

Yt = Discrete time series
▼1 = Regular Differencing operator of order one
C = Constant = 417.191
1 – ϕ1B = Regular Autoregressive process of order one
1 – θ1B – θ2B2 – θ3B3 = Regular Moving Average process of order three
at = random shock term; normally distributed, independent with zero mean, and
variance equal to σa
The summary of ARIMA (1,1,3) model equation parameters is shown in Table 6.

Table 6. Summary of ARIMA (1,1,3) Model Parameters, the Port of New Orleans
ARIMA Model Parameters
Estimate
Total
loaded
export
container
volumes
(TUEs) Model

Constant

Total

AR

loaded
export

No

container

Transformation

volumes

Difference

MA

(TUEs)
MONTH,

No

period 12

Transformation

Lag 1

Numerator
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417.191
-.213

SE

t

Sig.

339.527 1.229 .222
.645

-.330

.742

1

Lag 1

.417

.639

.651

.516

Lag 2

.009

.418

.021

.983

Lag 3

.138

.106

1.293 .199

Lag 0

-55.324

50.095

-1.104 .272

The feature month predictions were also conducted based on the best ARIMA (0,1,3)
model equation, and the results are shown in Figure 8. The average, SD, and COV for the
predicted values from 2005 to 2014 are 15,223, 3,680.9, 24.2%, respectively, which is
comparable to the observed data.

Figure 8. ARIMA (0,1,3) model equation for feature months, the Port of New Orleans

The verifications from 2015 to 2020 were also carried out using selected the ARIMA
(0,1,3) model equation. The predicted annual total loaded export container volumes from 2015
to 2020 are shown in Table 7.
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Table 7. Predicted yearly total loaded export container volumes from 2015 to 2020,
the Port of New Orleans
Year
2015
2016
2017
2018
2019
2020
Average

Average Monthly
Total (TEUs)
(TEUs)
19,872
20,580
21,287
21,995
18,119
23,410
20,877

Predicted Annual
Total (TEUs)
(TEUs)
238,460
246,955
255,445
263,937
272,431
280,924
259,692

% Increase from
Annual Total in 2014
(TEUs)
-0.7
2.8
6.4
9.9
13.4
17.0
8.1

Annual total loaded export container volumes in 2014 are 240,136 Tues.

The predicted annual data was compared with the annual 2014 data, and the percentage
differences ranged from -0.7% to 17.0%. Figure 9 shows a plot of the predicted annual total
loaded export container volumes for the Port of New Orleans from 2015 to 2020 using the
ARIMA (0,1,3) model equation. The predicted annual total loaded export container volumes
steadily increase from 2016 to 2020.

Figure 9. Predicted annual total loaded export container volumes (TEUs) for the Port of New
Orleans from 2015 to 2020 using ARIMA (0,1,3) model equation
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2.3.3 Implementation of the ARIMA Model of TEU for the Port of New York and New Jersey
Historical total loaded containerized cargo volumes data (TEUs) was provided by the
Port Authority of New York and New Jersey in February 2015 [2T]. There is also monthly data
from January 2005 to December 2015. The distribution of observed data points (unfilled circle)
in Figure 10 shows a steadily increasing trend of total loaded container volumes from January
2005 to October 2008. However, total loaded container volumes dropped down from November
2008 to January 2011 due to economic recession.

Figure 10. Total loaded container volumes (TEUs) by month for the Port Authority of New York
and New Jersey from January 2005 to December 2015

From February 2011 to December 2015, total loaded container volumes of the port
jumped up and increased steadily as the trend of the period from January 2005 to October 2008.
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The observed data from 2005 to 2014 was used for analyzing and evaluating the ARIMA model
equations, and the observed data in 2015 was used for validating the model equations.
Figure 11 shows the differencing process that successfully transformed the data to be
stationary. The final term of MA, where q is equal to two and three was also used in the
transformation process. The two-month MA term was plotted as shown in Figure 11 (filled
circle). For the two-month MA process, data from January and February in 2005 was the first
averaged value (Yt). The subsequent data (Yt+1) was obtained by averaging data in February and
March in 2005. The two-month MA process continues until data in December 2015.
Furthermore, the three-month MA term was also applied. Figure 11 (cross) shows the plot of the
three-month MA term.

Figure 11. Differencing, Moving Average process to determine ARIMA model equation
terms, the Port of New York and New Jersey
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The sequential correlation between monthly data (Yt) and the previous month’s data (Yt-1), and
the Pearson’s correlation between time (month) and transformed data (by Differencing and
Moving Average processes) were assessed, and the results are shown in Table 8.

Table 8. Correlations of observed data with different AR, I, and MA terms, the Port of New York
and New Jersey
A

B

C

D

E

F

G

Sequential
Correlation
(Lag 1)

Month vs.
Total
(TEUs)
(Observed)

Month vs.
Total
(TEUs)
(Lag 1)

Month vs.
Total (TEUs)
(Lag 2)

Month vs.
One
Differencing

Month vs.
Two Months
Moving
Average

Month vs.
Three Months
Moving
Average

0.935

0.885

0.883

0.881

-0.007

0.898

0.904

The total loaded container volumes were found to have high sequential correlation
between original and Lag 1 data sets with R of 0.935. The Pearson’s correlation between
months and the total loaded container volume data also shows high correlation of R more than
0.8, respectively. This indicates that the total loaded container volumes are the reasonable
independent variable to be incorporated in the model development process. The Differencing
process shows almost zero value of Pearson’s correlation, which explains that the data was in a
stationary condition. The Moving Average processes shows high sequential correlation
between months and the total loaded container volume data with R of 0.898 for the two months
MA process and 0.904 for the three-month MA process. For this particular data set, a high
sequential correlation between data indicates that the non-regression ARIMA time series
modeling approach was more desirable as compared to traditional regression equations.
ARIMA (0,1,3) and ARIMA (1,1,3) model equations were selected for further analysis.
Figure 12 shows the observed and predicted total loaded container volumes using ARIMA
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model equations from January 2005 to December 2014. The average, SD, and COV of the
predicted values are comparable to the observed data. There are no predicted total loaded
container volumes calculated in January 2005 due to the differencing term applied in both
ARIMA model equations, which resulted in only 119 data points. The plot also shows the
capability of the ARIMA model equations to predict total loaded container volumes, exhibited
by high R of more than 0.90. The average, SD, and COV of the predicted data are almost the
same as the observed data. Figure 13 shows that most of lags of the Residual ACF and Residual
FACF of ARIMA (0,1,3) and ARIMA (1,1,3) models equations are within the confidence
interval limits.

Figure 12. Verification of the ARIMA (0,1,3) and ARIMA (1,1,3) model equations, the Port of
New York and New Jersey
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ARIMA (0,1,3) Model Equation

ARIMA (1,1,3) Model Equation

Figure 13. Residual ACF and Residual FACF of ARIMA models equations, the Port of New
York and New Jersey

Table 9 shows validation using 2015 data for the ARIMA (0,1,3) and ARIMA (1,1,3)
model equations. The average percent differences between the predicted and observed data for
2015 are -1.2% for ARIMA (0,1,3) and -3.9% for ARIMA (1,1,3) model equations. The MARE
values are 6.02% for the ARIMA (0,1,3) model equation and 6.82% for the ARIMA (1,1,3)
model equation. The RMSE values are 34,844.47 for the ARIMA (0,1,3) model equation and
42,049.00 for the ARIMA (1,1,3) model equation.
Furthermore, Table 10 shows that the percent differences between the average observed
and average predicted data for 2015 are -1.2% for the ARIMA (0,1,3) model equation and 3.9% for the ARIMA (1,1,3) model equation. This shows that the ARIMA (0,1,3) model
equation is a better predictor compared to the ARIMA (1,1,3) model equation. Therefore, it is
recommended the ARIMA (0,1,3) model equation is used for future month predictions.
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Table 9. Comparision between observed and predicted data from ARIMA (0,1,3) and ARIMA
(1,1,3) model equations, the Port of New York and New Jersey.

Month

Jan-15
Feb-15
Mar-15
Apr-15
May-15
Jun-15
Jul-15
Aug-15
Sep-15
Oct-15
Nov-15
Dec-15
Total
Average
SD
COV
Average %
Difference
MARE (%)
RMSE (TEUs)

Total Loaded
(Observed)

ARIMA (0,1,3)
Predictions

ARIMA (1,1,3)
Predictions

(TEUs)
463,002
445,285
559,264
504,674
558,991
562,573
588,918
574,547
569,956
544,677
500,608
499,225
6,371,720
530,977
46838.1
8.8%

(TEUs)
495,787
511,011
521,520
529,288
534,753
537,913
538,770
537,322
533,570
527,514
519,154
508,490
6,295,092
524,591
13709.4
2.6%

(TEUs)
490,658
499,757
508,083
514,468
518,892
521,338
521,791
520,238
516,669
511,076
503,450
493,786
6,120,206
510,017
10894.4
2.1%

Regression
Equation
Predictions
(TEUs)
496,099
498,053
500,006
501,959
503,913
505,866
507,819
509,772
511,726
513,679
515,632
517,586
6,082,109
506,842
7042.7
1.4%

-1.2

-3.9

-4.5

6.02
34,844.47

6.82
42,049.00

8.14
49,443.03

Table 10. Percentage difference between average observed and average predicted ARIMA model
equations, the Port of New York and New Jersey
A

B

C

D = 100*(B-A)/A

E = 100*(C-A)/A

Average
Monthly
Total Loaded
(Observed)

ARIMA
(0,1,3)
Average
Predicted

ARIMA
(1,1,3)
Average
Predicted

% Difference
Average Observed vs.
Average Predicted
ARIMA (0, 1, 3)

% Difference
Average Observed vs.
Average Predicted
ARIMA (1, 1, 3)

(TEUs)
530,977

(TEUs)
524,591

(TEUs)
510,017

(TEUs)
-1.2

(TEUs)
-3.9
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The following Equation 2.5 shows the general ARIMA (0,1,3) model equation.
▼1 . Yt = C + (1 – θ1B – θ2B2 – θ3B3) . at

(2.5)

Yt = Discrete time series
▼1 = Regular Differencing operator of order one
C = Constant = 16985.306
1 – θ1B – θ2B2 – θ3B3 = Regular Moving Average process of order three
at = random shock term; normally distributed, independent with zero mean, and
variance equal to σa

The summary of ARIMA (0,1,3) model equation parameters is shown in Table 11.

Table 11. Summary of ARIMA (0,1,3) model parameters, Port of New York and New Jersey
ARIMA Model Parameters

Total
loaded
container
volume
(TEUs)Model

Total
loaded
container
volume
(TEUs)

Estimate
16985.30
1

SE
4092.80

t
4.150

Sig.
.000

Lag 1

.504

.094

5.373

.000

Lag 2

-.148

.105

-1.413 .161

Lag 3

.119

.097

1.227

Lag 0

-2304.13

594.83

Constant
Difference
No
Transformation

MONTH,
No
period 12 Transformation

MA

Numerator

.222

-3.874 .000

The following Equation 2.6 shows the general ARIMA (1,1,3) model equation.
▼1 . Yt = C + (1 – ϕ1B) . (1 – θ1B – θ2B2 – θ3B3) . at

(2.6)

Yt = Discrete time series
▼1 = Regular Differencing operator of order one
C = Constant = 15419.112
1 – ϕ1B = Regular Autoregressive process of order one
1 – θ1B – θ2B2 – θ3B3 = Regular Moving Average process of order three
at = random shock term; normally distributed, independent with zero mean, and
variance equal to σa

The summary of ARIMA (1,1,3) model equation parameters is shown in Table 12.
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Table 12. Summary of ARIMA (1,1,3) model parameters, Port of New York and New Jersey
ARIMA Model Parameters
Estimate

SE

t

Sig.

15419.11

3938.13

3.915

.000

Lag 1

.847

.105

8.104

.000

Lag 1

1
1.395

1.321

1.056

.293

Lag 2

-.628

.544

-1.15

.251

Lag 3

.232

.302

.770

.443

Lag 0

-2073.95

602.71

-3.44

.001

Constant
Total
loaded
container
volume
(TEUs)Model

Total
laded
container
volume
(TEUs)

MONTH,
period 12

AR
No
Transformation

Difference
MA

No
Transformation

Numerator

The feature month predictions were also conducted based on the best ARIMA (0,1,3) model
equation, and the results are shown in Figure 14.

Figure 14. ARIMA (0,1,3) model equation verification for feature months, the the Port of New
York and New Jersey

39

The average, SD, and COV for the predicted values from 2005 to 2015 are 392,277,
82,757.0, 21.1%, respectively, which are comparable to the observed data. The verifications
from 2015 to 2020 were also carried out using the selected ARIMA (0,1,3) model equation. The
predicted annual total loaded export container volumes from 2015 to 2020 are shown in Table
13.

Table 13. Predicted yearly total loaded export container volumes from 2016 to 2020, the Port of
New York and New Jersey
Average Monthly
Yearly Total
% Increase from
Year
Total Loaded
Loaded
Yearly Total Loaded
Container Volume Container Volume Container Volume in 2015
(TEUs)
(TEUs)
(TEUs)
2016
549,003
6,588,032
3.4
2017
573,104
6,877,251
7.9
2018
597,206
7,166,468
12.5
2019
621,307
7,455,689
17.0
2020
645,409
7,744,908
21.6
Average
597,206
7,166,470
12.5
Annual total loaded container volumes in 2015 are 6,371,720 TEUs.

The predicted annual data was compared with the annual 2015 data and the percentage
differences ranged from 3.4% to 21.6%. Figure 15 shows a plot of the predicted annual total
loaded container volumes for the Port of New York and New Jersey from 2016 to 2020 using
the ARIMA (0,1,3) model equation. The predicted annual total loaded export container volumes
steadily increase from 2016 to 2020.
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Figure 15. Predicted annual total loaded export container volumes (TEUs) for the the Port of
New York and New Jersey from 2016 to 2020 using ARIMA (0,1,3) model equation

2.4

ANN Modeling and Comparison with ARIMA Results of TEU for Port of New Orleans

2.4.1 ANN Methodology
Artificial neural network is an information-processing system based on mathematical
models of human cognition and neural biology [33]. ANN contains many simple processing
elements called neurons and connection links between the neurons. The function of the
connection links is to transfer signals between the neurons when the ANN processes
information. Input signals of each neuron are evaluated to determine its output signal. The
neuron output signal is then transmitted to all neurons, which are on the receiving side of the
connection links originating in the transmitting neuron. A weight that multiplies the signal
transmitted is associated with each connection link. The advantage of neural networks is being
able to represent some highly complex relationships that are difficult to solve by the traditional
sequential, logic-based modeling and computation techniques [33].
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The ANN model equation was established in four sequential steps.
1. First, the architecture of the ANN was designed based on ANN knowledge,
requirements and characteristics of the problem. Nodes in the input, hidden, and output
layers were determined in this step. The input layer contains variables or independent
variables, and the output layer contains the output or the dependent variable.
Classifying datasets into training, testing, and validation is also an important task in
the first step.
2. Second, the optimum number of hidden nodes and iterations for the ANN architecture
was obtained by training (tr) and testing (ts) the ANN network using the available
data.
3. Third, the best performing network obtained from the second step is validated using
the validation (vl) datasets.
4. In the fourth step, the best performing network obtained in the second step is retrained
on all available data (all) sets. Note that step four may not be needed if the accuracy
measures from the training, testing, and validation datasets are very comparable.
However, it is highly recommended to do step four in order to arrive at the best
performing ANN model.
In the fourth step, the best performing network obtained in the second step is retrained
on all available data (all) sets. Note that step four may not be needed if the accuracy measures
from the training, testing, and validation datasets are very comparable. However, it is highly
recommended to do step four in order to arrive at the best performing ANN model [33, 42].
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2.4.2 ANN Model Development for Containerized Cargo Export Volumes
2.4.2.1 Dependent and Independent Variables
The dependent variable is the monthly total loaded export containers [40]. The
independent variables are also determined based on the analysis of three-group factors. The first
group-factor includes economic indicators such as industrial U.S. Gross Domestic Product
(GDP), the U.S. inflation rate, and unemployment rate [43, 44, 45, 46, 47]. Maritime activities
at the Port of New Orleans are not only responsible for about 160,500 jobs in the port city and
the state but also about 380,000 jobs in the U.S [50]. Therefore, unemployment rate indicators
are selected at three levels (National, State, and Port city). The second group-factor is monthly
total export quantities (TEUs) from the top three trading countries [40]. The statistical analysis
for monthly total exports from 2005 to 2014 show that Argentina, Brazil, and Belgium are
always the top three export trading countries [40]. The third group-factor represents monthly
total exports for the top three commodities (in TEUs). The statistical analysis for monthly total
exports from 2005 to 2014 showed that forest product, synthetic resins NSPF, and synthetic
rubber are always the top three total export commodities [40]. In addition, time elapsed since
January 2005 in months was also considered as an independent variable. The analysis shows
that there are 12 independent variables: time history, U.S. GDP, U.S. inflation rate,
unemployment rate in U.S, unemployment rate in Louisiana, unemployment rate in New
Orleans, export volume to Argentina, export volume to Brazil, export volume to Belgium,
export volume of forest product, export volume of synthetic resins NSPF, and export volume of
synthetic rubber.

2.4.2.2 Data Description for ANN Model
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Similarly to the ARIMA model equation, data sets of monthly total loaded export
containerized cargo volumes provided by the Port of New Orleans were also used for the ANN
method. Additional data required for the model included monthly total export from the top three
trading countries, monthly total export from the top three commodities, U.S. GDP, U.S.
inflation rate, unemployment rate in U.S, unemployment rate in Louisiana, unemployment rate
in New Orleans [43,44,45,46,47], and time history data defined as numerical data.
In order to evaluate how selected input data relates to the output data, a correlation
analysis is conducted. Results indicate that all 12 input variables have good correlations with
the output variable data. Therefore, the ANN model was established based on the selected 12
input variables.

2.4.2.3 Export Containerized Cargo Volume Model
The number of nodes in the input, hidden, and output layers are denoted by IN-HN-ON,
respectively. Following the four sequential modeling steps, the resulting best performing ANN
model contained five hidden nodes. As a result, the export containerized cargo ANN model has
12 inputs, five hidden nodes and one output variable that can be designated as ANN Model 125-1. The datasets used for the model were classified into training data sets, testing data sets, and
validation data sets based on the principle of 50% for training, 25% for testing and 25% for
validation (42,51). The export ANN model was developed and tested and validated using the
four sequential steps mentioned before, and the accuracy results are shown in Table 14.
Statistical accuracy measures for the train all model are SSENall = 0.000869, MAREall = 2.15%,
R2all = 0.9627, with a corresponding Standard Deviation or Error (SDE) = 367.109. In this
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study, ASE, MARE and R2 refer to Averaged Squared Error, Mean Absolute Relative Error in
%, and Coefficients of Determination, respectively.

Table 14. Statistical accuracy measures for containerized cargo ANN export model
Model
Architecture

Export containerized cargo
ANN-based model
12-5-1

ASEtr
Training MAREtr

0.000714
5.68%
0.97223

2

R tr
Testing

ASEts
MAREts

0.002722
7.11%
0.85966

2

R tr
ASEvl

0.002231
7.80%
0.88999

Validation MAREvl
2

R vl
ASEall

0.000869
5.15%
0.9627

All data MAREall
2

R all

2.4.3 Regression Equation for Export Containerized Cargo Volumes
The basic objective of the regression analysis was to identity factors affecting the
monthly total loaded export containerized cargo volumes and to develop a model for estimating
the monthly total loaded export containerized cargo volumes in the form of multiple linear
regressions. The input variables of the ANN model were also used as input variables for the
regression equation because all these input variables have good correlations with or affect the
monthly total loaded export containerized cargo volumes.
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The regression equation for the monthly total loaded export containerized cargo volumes
has been developed using the Data Analysis Toolkit in Excel. The datasets used for the ANN
model were used to obtain the desired linear regression prediction model. The inputs and output
of the regression model are shown as follows:
Inputs:
1. X1’ = Time history
2. X2’ = U.S. Gross Domestic Product (GDP) in billion dollars
3. X3’ = U.S. Inflation rate (%)
4. X4’ = U.S. Unemployment rate (%)
5. X5’ = Unemployment rate in Louisiana (%)
6. X6’ = Unemployment rate in New Orleans (%)
7. X7’ = Export volume to Argentina (TEUs)
8. X8’ = Export volume to Belgium (TEUs)
9. X9’ = Export volume to Brazil (TEUs)
10. X10’ = Export volume of forest product (TEUs)
11. X11’ = Export volume of synthetic resins NSPF (TEUs)
12. X12’ = Export volume of synthetic rubber (TEUS)
And
13. Output (Yexport): Total Loaded Export (TEUs)
The linear regression prediction equation was established using coefficients obtained
from regression analysis in Excel, and it is listed in Equation 2.7:
Yexport = 52222.83 + 219.04X1’– 3.06X2’ + 153.03 X3’ – 1099.27 X4’ + 82.63 X5’ +
127.58X6’ + 1.22X7’ + 1.31X8’ + 0.61X9’ + 1.83X10’-0.36X11’+ 0.95X12’

(2.7)

The statistical accuracy measures of the obtained regression model include R2 = 0.9113
with a corresponding SDE = 1254.56.
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Figures 16a and 16b illustrate the graphical comparison of the prediction accuracy
measures for the export containerized cargo values via ANN model and regression equation,
respectively.

(a)

(b)
Figure 16. Graphical prediction accuracy for export containerized cargo: (a) ANN model, (b)
Regression equation

The above figures show that the prediction accuracy of the export ANN model is higher
than that obtained from the regression equation. Accordingly, the R2 value for the ANN model
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is 0.9627, which is about 6% higher than the R2 value of 0.9113 obtained from the regression
equation. Moreover, the SDE value obtained via the ANN model is 367.109, which is almost
70% lower than the SDE value obtained using the regression equation.

2.4.4 Excel Application of Containerized Cargo Demand
The desired excel-based prediction application for the monthly total loaded export
containerized cargo volumes was developed using the connection weights and threshold values
of the export ANN models. By providing the needed 12 input variables for export in the Excel
interface shown in Figure 17, the total loaded export containerized cargo volumes can be
calculated or predicted automatically by ANN model and regression equation. The application
range for input variables is shown in the middle of the interface. Any value of input variable
that is outside of the application range may cause the models to yield unreliable predictions.

Figure 17. The desired excel-based prediction application using ANN model for the total loaded
export containerized cargo volumes
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2.4.5 Relationships Between Economic Indicators and Total Monthly Loaded Export
Containerized Cargo Volumes
The sensitivity analysis method was conducted in order to understand the relationship
between economic indicators and the monthly total loaded export container quantities. The first
step was to obtain the mean of the economic indicator from the available 120 data sets. The
second step was to vary the value of the economic indicator around its mean value. The last step
was to monitor the impact of the change in the economic indicator value on the monthly total
loaded export container values. Some economic indicators were used for the ANN model and
the regression model equation. However, only two indicators (U.S. Inflation Rate and
unemployment rate in New Orleans) were selected for the sensitivity analysis.
The U.S. inflation rate varied from -2.1% to 5.6% while keeping other input parameters
unchanged. Figure 18 shows the relationships between the varying U.S. inflation rate and the
monthly total loaded export containerized cargo volumes.

Figure 18. Relationship showing the influence of U.S. Inflation Rate on monthly total loaded
export containerized cargo
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The monthly total loaded export containerized cargo decreases steadily as the U.S.
inflation rate increases. Inflation rate affects exports primarily through its influence on interest
and exchange rates. A higher inflation rate in the U.S compared to other countries typically
leads to higher interest rates and tends to reduce the value of the U.S dollar. Therefore, a higher
inflation rate in the U.S means that U.S. goods increase in price quicker than other countries.
Accordingly, U.S. goods become less competitive. Demand for U.S. exports will fall, or
monthly total loaded export containerized cargo at the Port of New Orleans will decrease.
A similar approach was used to analyze the relationship between the unemployment rate
in New Orleans and the monthly total loaded export containerized cargo values. The resulting
relationships (Figure 19) show that as the unemployment rate in New Orleans increases,
monthly total loaded export containerized cargo volumes decrease steadily.

Figure 19. Relationship showing the influence of the unemployment rate in New Orleans on
monthly total loaded export containerized cargo
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These noted behaviors can be explained via population and job analysis in New Orleans.
According to the United States Census Bureau [49], the population in New Orleans was 384,320
in 2014. Maritime activity within the Port of New Orleans is responsible for about 160,500 jobs
[52]. In addition, about 380,000 jobs in the U.S. are dependent on the cargo that is handled by
the port [52]. Therefore, there is a relationship between the unemployment rate in New Orleans
and the monthly total loaded export containerized cargo volumes. When total loaded export
containerized cargo decreases, employees at the port will lose their jobs, so unemployment rate
in New Orleans will increase.

2.4.6 Comparison of ANN Model, Regression Equation, and ARIMA Model Equation
In order to evaluate the accuracy of the selected forecasting methods, the data of 12
months in 2014 were used for validation for the selected models and equations. Table 15 shows
a comparison of results of 2014 data verification using the ARIMA model equation, the ANN
model, and the regression equation for the Port of New Orleans.
The average percent differences between the average observed and average predicted
data for 2014 are -4.0% for the ARIMA (0,1,3) model equations, -0.2% for the ANN-base
model, and 1.7% for the regression equation. MARE and RMSE values of the ANN model
equation are smaller than those of ARIMA model equations and the regression equation. This
indicates that the ANN model is better or more accurate than the regression equation and the
ARIMA (0,1,3) model equation.
Although both the ANN model and regression equation give better results in the model
database than the ARIMA (0,1,3) model equation, they are only recommended to apply to the
port for short-term prediction when predicted values of input independent variables are
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available. The Port of New Orleans exports more than 30 commodities to more than 100
countries in the world. If predicted values of only the top three commodities and the top three
trading countries are known together with predicted economic indicators, the ANN model can
be applied to predict total loaded export containerized cargo volumes with highly accurate
predicted results.

Table 15. Comparison of results of 2014 data validation using ARIMA model equations, ANN
model equation, and regression equation model

Month

Jan-14
Feb-14
Mar-14
Apr-14
May-14
Jun-14
Jul-14
Aug-14
Sep-14
Oct-14
Nov-14
Dec-14
Total
Average
SD
COV
Average
% Difference
MARE (%)
RMSE (TEUs)

Total Loaded
Export
Containerized
Cargo Volumes
(Observed Data)
(TEUs)
18,840
17,715
19,688
19,056
20,934
19,394
20,175
20,879
20,655
20,657
21,318
20,827
240,138
20,012
1082.0
5.4%

ARIMA
(0,1,3) Model
Equation
Predictions

ANN Model
Predictions

Regression
Model
Equation
Predictions

(TEUs)
18,462
18,851
19,041
19,232
19,370
19,456
19,488
19,468
19,395
19,269
19,090
18,859
229,981
19,165
316.0
1.6%

(TEUs)
19,342
18,243
19,868
18,412
20,135
20,181
20,810
20,449
20,704
20,636
20,475
20,274
239,532
19,961
861.2
4.3%

(TEUs)
19,570
18,287
21,689
19,266
21,437
20,790
20,521
20,932
21,122
20,448
20,580
19,333
243,974
20,331
1011.9
5.0%

-4.0

-0.2

1.7

5.28

2.50

3.65

1,263.16

566.04

925.24
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Monthly export volume data by trading countries and by commodities provided by the
port indicate that the top three trading countries and the top three commodities did not change
during the period from 2005 to 2014. The monthly data of economic indicators such as GDP,
inflation rate, and unemployment rate show that there is a minor change of the data within a
year. However, for long-term, the top three trading countries and the top three commodities, as
well as data of economic indicators may have major changes, so the ANN model can be applied
to predict total loaded export containerized cargo volumes at the port in short-term.
The ARIMA (0,1,3) model equation, with only -4.0% of the average percent differences
between the predicted and observed data, 5.28% of the MARE, and 1,263.16 of the RMSE from
the validation of the model equation, is recommended to be used for future predictions,
especially long-term prediction, for the port. According to the 2020 Master Plan of the Port of
New Orleans [52], the grand total for both short and long-term projects is approximately U.S.
$1 billion for infrastructure improvements. The trends of the container trade in the port in the
2020 Master Plan were analyzed based on the forecast information of the North American
container trade. No forecast models of the container trade volumes for the port were found or
used as references in this report, so the ANN model or ARIMA (0,1,3) model equation
introduced in this study may be a good reference for the planners of the port for prioritizing
funds for port infrastructure projects in the future.

2.5

Future Container Shipping Demand and Concluding Remarks
The three methods including the ARIMA model equation, the ANN model, and the

regression equation were used to predict monthly total loaded export containerized cargo
volumes for the Port of New Orleans. The comparison of these methods’ results indicates that
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the ANN model achieves the most accurate predicted values. Although the ANN model and
regression equation provide better results in the model database than the ARIMA model
equation, the two approaches require predicted values of input independent variables to conduct
the forecast. Therefore, they should be applied only when the required predicted values of input
independent variables are available. The ANN model, known as the most accurate model, can
be applied for short-term prediction for the port.
The ARIMA (0,1,3) model equation is recommended to use for future prediction,
especially long-term prediction, of the total loaded export containerized cargo volumes at the
port. The predicted annual data generated from the ARIMA (0,1,3) model equation show that
the annual total loaded export containerized cargo volumes steadily increase from 2016 to 2020.
The predicted annual data in 2020 is 280,924 TEUs, which is a 17% increase from annual data
in 2014. The Port of New Orleans plans to invest one billion U.S. dollars for infrastructure
improvements in the future. The predicted total loaded export containerized cargo volumes
generated from the ANN model or ARIMA (0,1,3) model equation in this study may be good
reference for the planners of the port for prioritizing funds for port infrastructures.
The Excel-based application, which is developed using the connection weights and
threshold values of the export ANN models, is simple and easy to use for predicting total loaded
export containerized cargo volumes. The sensitivity analysis conducted in this study was able to
quantify the impact of the U.S. inflation rate as well as the unemployment rate in New Orleans
on the total export activities at the Port of New Orleans.
ARIMA (0,1,3), ARIMA (1,1,3) model equations, and regression equations were applied
to predict monthly total loaded containerized cargo volumes (TEUs) for the Port Authority of
New York and New Jersey. The comparison of these model equations’ results shows that the
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ARIMA (0,1,3) model equation attains the most accurate predicted values. So, the ARIMA
(0,1,3) model equation is recommended to use for future predictions for the Port Authority of
New York and New Jersey. The predicted annual total loaded container volumes for the Port of
New York and New Jersey steadily increase from 2016 with 3.4% to 2020 with 21.6% in
comparison with the annual 2015 data.
Future cargo ship demand predictions for any port can be used to evaluate the impacts of
shipping demand on performance level of service of a port, as discussed in Chapter III.
Similarly, future shipping demand estimation can be used to evaluate impacts on built-up areas
(Chapter IV) and supply chain during and after natural coastal disasters (Chapter V, VII).
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III. GLOBAL CARGO SHIP DEMAND RELATED CO2 EMISSIONS AND PORT LEVEL OF
SERVICE
3.1

Shipping Volumes using AIS Data for Navigation Routes

3.1.1 Selection of Navigation Routes
According to World Shipping Council [8], there are almost 6,000 ships on the globe
operating liner services with most ships built since 1980. About 5,000 of those ships are
container ships. Container ships have grown in size from just 1,500 TEUs in 1976 to ships able
to carry in excess of 12,000 TEUs today, with some ships on order capable of carrying 18,000
TEUs [8].
World Shipping Council [5] shows that the trade route from Asia to the Mediterranean
with 6,739,000 TEUs in 2013, was ranked as one of the top three in the world. The Panama
Canal and Suez Canal are the two most important canals in international commerce. The
Panama Canal is nearly 80 kilometers long between the Atlantic and Pacific Oceans. About 13
to 14 thousand vessels from all parts of the world transit through the Panama Canal every year.
The Panama Canal serves 144 maritime routes, connecting 160 countries and reaching about
1,700 ports in the world [53]. The Suez Canal is an artificial sea level waterway located in
Egypt connecting the Mediterranean Sea and the Red Sea. More than 17 thousand vessels pass
through the Suez Canal every year [54]. In this study, navigation routes in the Mediterranean
Sea, Suez Canal, Red Sea, Strait of Malacca, and Panama Canal were selected for studying
average vessel volumes per day, calculating anthropogenic CO2 emissions, and creating a
spatial map of these navigation routes.
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Inorder to estimate cargo shipping volume demand for each navigation route, online AIS
(https://www.marinetraffic.com) based on spatial map of worldwiwe cargo ships was used. AIS
data was used primarily for improving marine safety and maritime domain awareness [55]. “The
AIS technology uses the VHF radio spectrum to broadcast and receive (ship-to-ship, shiptoshore, and shore-to-ship) real-time information concerning vessel identity, dimensions,
position, speed, and headings, among other fields” [55].
Figure 20 shows a map of AIS data on the live world map on September 28, 2015. Each
AIS cell has a number of cargo vessels in that cell. The size of AIS cells can be varied to reflect
the volume of vessel traffic.

Figure 20. Map of AIS data in selected navigation routes

In can be seen from Figure 20 that those selected navigation routes have high volume of
vessel traffic in comparison to other regions. These selected navigation routes play very
important roles for shipping flows from Asia to Europe.
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3.1.2 Shipping Navigation Data Collection based on AIS Data Analysis
In order to study average vessel volumes per day at the selected navigation routes, the
number of cargo vessels in each of the selected navigation routes at a typical time were counted
based on the maps of AIS data. Figure 21 shows cargo vessels in the Mediterranean Sea, Suez
Canal, and Red Sea at 12:00 PM on September 29, 2015. From the AIS web map, 20 vessels in
the Suez Canal, 88 vessels in Red Sea, and 782 vessels in Mediterranean Sea were counted. The
counted number of cargo vessels in Mediterranean Sea is much greater in comparison to the
counted number of cargo vessels in the Suez Canal and Red Sea because this navigation route is
located in a large sea which is bordered by Southern Europe to the north, by North Africa to the
south, and by the Levant to the east. Figure 22 shows 311 cargo vessels counted at 9:00 AM on
September 8, 2016 in the Strait of Malacca.

Figure 21. Cargo vessels in Mediterranean Sea, Suez Canal, and Red
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Figure 22. Cargo vessels in Strait of Malacca

Table 16 shows a summary of counted cargo vessels in the five selected navigation
routes at difference times on September 28 - 29, 2015, and September 8 - 9, 2016. The counted
cargo vessels in the Red Sea, Suez Canal, and Panama Canal are much smaller than those of
other selected navigation routes. The Red Sea is a small and narrow sea; both the Suez Canal
and Panama Canal are also narrow. Although these navigation routes have very high demand,
only a limited number of cargo vessels pass through these navigation routes per day. The cargo
vessel data in the missing cells for each navigation route, shown in grey in Table16, were
interpolated and presented in section 3.2.
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Table 16. Original cargo vessel count data with missing data cells
Hour

12:00 AM
1:00 AM
2:00 AM
3:00 AM
4:00 AM
5:00 AM
6:00 AM
7:00 AM
8:00 AM
9:00 AM
10:00 AM
11:00 AM
12:00 PM
1:00 PM
2:00 PM
3:00 PM
4:00 PM
5:00 PM
6:00 PM
7:00 PM
8:00 PM
9:00 PM
10:00 PM
11:00 PM

3.2

Strait of
Malacca
(SM)
9/8/2016
283
282
291
285

Red Sea
(RS)

Suez Canal
(SC)

Mediterranean
Sea (MS)

Panama Canal
(PC)

9/29/2015
79
76

9/29/2015
39
39

9/28/2015
872
852

9/8/2016
48
47
47
48

71
74

22
22

775
759

283
289
311

52
52
54

88
67
279
278
281
278
296
283
278
307
281
302

20
33

90
86

52
48

782
800

832
828

53
53
48
50
50
49
48
52
46
44

Visualization of Worldwide Shipping Navigation Flow
Table 17 shows typical daily original and missing data interpolations for the Strait of

Malacca. Column one shows original cargo vessel counts on September 8 - 9, 2016. Cargo
vessels were counted almost every hour. Column two shows the cargo vessel counts for missing
cells that were interpolated using interpolation method. Column three shows hourly cargo vessel
counts from column one and column two. The percentage of maximum cargo vessel count was
calculated in column four. The average hourly cargo vessel counts per day were 288 cargo
vessels.
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Table 17. Typical daily original and missing data interpolations for the Strait of Malacca (SM)
1
Hour

Original Cargo
Vessel Counts

2
Interpolated Vessel
Counts for Missing
Cells

12:00 AM
283
1:00 AM
282
2:00 AM
291
3:00 AM
285
285
4:00 AM
284
5:00 AM
283
6:00 AM
283
7:00 AM
283
283
8:00 AM
289
9:00 AM
311
311
10:00 AM
305
11:00 AM
299
12:00 PM
293
1:00 PM
287
2:00 PM
279
279
3:00 PM
278
4:00 PM
281
5:00 PM
278
6:00 PM
296
7:00 PM
283
8:00 PM
278
9:00 PM
307
10:00 PM
281
11:00 PM
302
302
Average Hourly Cargo Vessel Counts per Day
Standard Deviation (SD)
Coefficient of Variation (COV)
Number of data point (n)

3
Hourly Cargo
Vessel Counts
283
282
291
285
284
283
283
283
289
311
305
299
293
287
279
278
281
278
296
283
278
307
281
302
288
10
3.4%
24

4 = 3/311*100
Percent (Normalized to
Maximum Cargo Vessel
Count)
91.0%
90.7%
93.6%
91.6%
91.3%
91.0%
91.0%
91.0%
92.9%
100.0%
98.1%
96.1%
94.2%
92.3%
89.7%
89.4%
90.4%
89.4%
95.2%
91.0%
89.4%
98.7%
90.4%
97.1%

Figure 23 shows the Strait of Malacca 24 hour cargo vessel counts, which were counted
from 12:00 AM on September 8, 2016, until 11:00 PM on September 9, 2016. The Strait of
Malacca shipping route has slightly higher traffic from 7:00 AM to early afternoon at 2:00 PM.
The numbers of cargo vessels counted for each hour on this route range from 278 to 311 cargo
vessels. The peak value is 311 cargo vessels counted at 9:00 AM. The percentage of maximum
cargo vessel count for most of the time is more than 90%, which showed that this navigation
route is very busy for the whole day.
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Figure 23. Cargo vessel counts in Strait of Malacca (SM)

Table 18 shows typical daily original and missing data interpolations for the Red Sea.
The column one shows original cargo vessel counts starting at 12:00 AM on September 28,
2015. The cargo vessels were counted at eight different times at early morning, noon, and
evening. Column two shows the cargo vessel counts for missing cells that were extrapolated and
interpolated using extrapolation and interpolation methods. Column three shows hourly cargo
vessel counts in the Red Sea. The percentage of maximum cargo vessel count is also calculated
and shown in column four.
Figure 24 shows the Red Sea 24 hour cargo vessel counts which were counted from
12:00 AM on September 28, 2015, until 11:00 PM on September 29, 2015. The numbers of
cargo vessels on this route range from 66 to 90 vessels for each count. The average hourly cargo
vessel count per day was 78 cargo vessels. The percentage of maximum cargo vessel count from
8:00 AM to 12:30 PM and from 3:00 PM to 7:00 PM is more than 90%, which indicated that
this navigation route is mainly busy in the morning and late afternoon. The busiest time was at
5:00 PM with 90 cargo vessels counted. The percent of maximum cargo vessel counts are less
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than 80% after 9:00 PM. That means the navigation route on the Red Sea is not very busy at
nigh time.

Table 18. Typical daily original and missing data interpolations for the for the Red Sea (RS)
1

2

3

4 = 3/90*100

Hour

Original Cargo
Vessel Counts

Extrapolated/Interpola
ted Vessel Counts for
Missing Cells

Hourly Cargo
Vessel Count

Percent (Normalized
to Maximum Cargo
Vessel Count)

12:00 AM

79

79

87.8%

76
75
74
73
71
74
76
78
80
82
84
88
67
73
79
85
90
86
82
78
74
70
66
78
6
8.2%
24

84.4%
83.3%
82.2%
81.1%
78.9%
82.2%
84.4%
86.7%
88.9%
91.1%
93.3%
97.8%
74.4%
81.1%
87.8%
94.4%
100.0%
95.6%
91.1%
86.7%
82.2%
77.8%
73.3%

1:00 AM
76
2:00 AM
75
3:00 AM
74
4:00 AM
73
5:00 AM
71
6:00 AM
74
7:00 AM
76
8:00 AM
78
9:00 AM
80
10:00 AM
82
11:00 AM
84
12:00 PM
88
1:00 PM
67
2:00 PM
73
3:00 PM
79
4:00 PM
85
5:00 PM
90
6:00 PM
86
7:00 PM
82
8:00 PM
78
9:00 PM
74
10:00 PM
70
11:00 PM
66
Average Hourly Cargo Vessel Counts per Day
Standard Deviation (SD)
Coefficient of variation (COV)
Number of data point (n)
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Figure 24. Cargo vessel counts in the Red Sea (RS)

Table 19 shows typical daily original and missing data interpolations for the Suez Canal.
Column one shows original cargo vessel counts on September 28 - 29, 2015. Column two
shows the extrapolated and interpolated cargo vessel counts for missing cells. Column three
shows hourly cargo vessel counts. The average hourly cargo vessel counts per day was 33 cargo
vessels. The percentage of maximum cargo vessel count is shown in column four.
Figure 25 shows the Suez Canal 24 hour cargo vessel counts, which were counted from
12:00 AM on September 28, 2015 until 11:00 PM on September 29, 2015. The Suez Canal
shipping route had slightly higher traffic from 2:00 PM to 8:00 PM. The numbers of cargo
vessels for each count on this route ranged from 20 to 52 cargo vessels. The average hourly
cargo vessel count per day was 33 cargo vessels, which are smaller than the cargo vessel counts
in the Red Sea navigation routes. The Suez Canal is known as the first artificial waterway
connecting the Mediterranean Sea and the Red Sea, and it has been an economically important
shortcut between Europe and Asia. Most vessels in the Red Sea move to the Mediterranean Sea
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via the Suez Canal, so these vessels from the Red Sea have to wait in the Suez Port, Egypt, for
several hours before passing through the canal. The percentage of maximum cargo vessel count
from 2:00 PM to 8:00 PM was more than 80%, which shows that this route is typically busy in
the afternoon and evening of a day.

Table 19. Typical daily original and missing data interpolations for the for the Suez Canal (SC)

Hour

1

2

3

Original Cargo
Vessel Counts

Extrapolated/Interpolated
Vessel Counts for
Missing Cells

Hourly Cargo
Vessel Count

12:00 AM
39
1:00 AM
39
39
2:00 AM
35
3:00 AM
31
4:00 AM
27
5:00 AM
22
22
6:00 AM
22
22
7:00 AM
22
8:00 AM
22
9:00 AM
22
10:00 AM
22
11:00 AM
22
12:00 PM
20
20
1:00 PM
33
33
2:00 PM
38
3:00 PM
43
4:00 PM
48
5:00 PM
52
52
6:00 PM
48
48
7:00 PM
44
8:00 PM
40
9:00 PM
36
10:00 PM
32
11:00 PM
28
Average Hourly Cargo Vessel Counts per Day
Standard Deviation (SD)
Coefficient of variation (COV)
Number of data point (n)

65

39
39
35
31
27
22
22
22
22
22
22
22
20
33
38
43
48
52
48
44
40
36
32
28
33
10
30.3%
24

4 = 3/52*100
Percent
(Normalized to
Maximum Cargo
Vessel Count)
75.0%
75.0%
67.3%
59.6%
51.9%
42.3%
42.3%
42.3%
42.3%
42.3%
42.3%
42.3%
38.5%
63.5%
73.1%
82.7%
92.3%
100.0%
92.3%
84.6%
76.9%
69.2%
61.5%
53.8%

Figure 25. Cargo vessel counts in the Suez Canal (SC)

Table 20 shows typical daily original and missing data interpolations for the
Mediterranean Sea. The original cargo vessel counts are shown in column one. The extrapolated
and interpolated cargo vessel counts for missing cells are shown in column two. Column three
shows hourly cargo vessel counts in the Mediterranean Sea. The percentage of maximum cargo
vessel count is calculated in column four.
Figure 26 shows the Mediterranean Sea 24 hour cargo vessel counts, which were
counted from 12:00 AM on September 28, 2015, until 11:00 PM on September 29, 2015. The
numbers of cargo vessels for each count on this navigation route ranged from 759 to 872 cargo
vessels. The average hourly cargo vessel count per day was 805 cargo vessels, which is much
higher compared with other selected navigation routes. The percentage of maximum cargo
vessel count was mostly more than 90%, which shows that this route is busy for the whole day.
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In addition, this navigation route is very wide because it is located on the larger sea. The cargo
vessels do not have to wait when passing through this navigation route.

Table 20. Typical daily original and missing data interpolations for the for the Mediterranean Sea
(MS)

Hour

1

2

Original Cargo
Vessel Counts

Extrapolated/Interpolated
Vessel Counts for
Missing Cells

12:00 AM
872
1:00 AM
852
852
2:00 AM
833
3:00 AM
814
4:00 AM
795
5:00 AM
775
775
6:00 AM
759
759
7:00 AM
763
8:00 AM
767
9:00 AM
771
10:00 AM
775
11:00 AM
779
12:00 PM
782
782
1:00 PM
800
800
2:00 PM
808
3:00 PM
816
4:00 PM
824
5:00 PM
832
832
6:00 PM
828
828
7:00 PM
824
8:00 PM
820
9:00 PM
816
10:00 PM
812
11:00 PM
808
Average Hourly Cargo Vessel Counts per Day
Standard Deviation (SD)
Coefficient of variation (COV)
Number of data point (n)
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3

4 = 3/872*100

Hourly
Cargo
Vessel
Count
872
852
833
814
795
775
759
763
767
771
775
779
782
800
808
816
824
832
828
824
820
816
812
808
805
29
3.6%
24

Percent
(Normalized to
Maximum Cargo
Vessel Count)
100.0%
97.7%
95.5%
93.3%
91.1%
88.9%
87.0%
87.5%
88.0%
88.4%
88.9%
89.3%
89.7%
91.7%
92.7%
93.6%
94.5%
95.4%
95.0%
94.5%
94.0%
93.6%
93.1%
92.7%

Figure 26. Cargo vessel counts in the Mediterranean Sea (MS)

Table 21 shows typical daily original and missing data interpolations for the Panama
Canal. Column one and column two show original cargo vessel counts and interpolated cargo
vessel counts for missing cells on September 8 - 9, 2016. Column three shows hourly cargo
vessel counts. The percentage of maximum cargo vessel count is shown in column four.
Figure 27 shows the Panama Canal 24 hour cargo vessel counts, which were counted
from 12:00 AM on September 8, 2016 until 11:00 PM on September 9, 2016. The numbers of
cargo vessels on this route ranged from 44 to 54 cargo vessels for each count. The average
hourly cargo vessel count per day was 50 cargo vessels. The Panama Canal is located in Central
America and extends from Limon Bay to the Gulf of Panama to connect the Atlantic and Pacific
Oceans. It is the busiest canal in the world. It can be seen from Figure 27 that the percentage of
maximum cargo vessel count was mostly more than 90%, which indicated that this route is very
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busy for the whole day. Due to the busyness and congestion on the Panama Canal, all cargo
vessels have to wait for a few hours before passing through this canal.

Table 21. Typical daily original and missing data interpolations for Panama Canal (PC)
1

2

3

4 = 3/54*100

Hour

Original
Cargo
Vessel
Counts

Interpolated
Vessel Counts
for Missing Cells

Hourly
Cargo
Vessel
Counts

Percent
(Normalized to
Maximum Cargo
Vessel Count)

12:00 AM

48

48

88.9%

1:00 AM
2:00 AM
3:00 AM
4:00 AM
5:00 AM
6:00 AM
7:00 AM
8:00 AM
9:00 AM
10:00 AM
11:00 AM
12:00 PM
1:00 PM
2:00 PM
3:00 PM
4:00 PM
5:00 PM
6:00 PM
7:00 PM
8:00 PM
9:00 PM
10:00 PM
11:00 PM

47
47
48

47
47
48
49
50
51
52
52
54
54
54
54
54
53
53
48
50
50
49
48
52
46
44

87.0%
87.0%
88.9%
90.7%
92.6%
94.4%
96.3%
96.3%
100.0%
100.0%
100.0%
100.0%
100.0%
98.1%
98.1%
88.9%
92.6%
92.6%
90.7%
88.9%
96.3%
85.2%
81.5%

48
49
50
51

52
52
54
54
54
54
54

53
53
48
50
50
49
48
52
46
44
Average Hourly Cargo
Vessel Counts per Day
Standard Deviation (SD)
Coefficient of Variation (COV)
Number of data point (n)

50
3
5.8%
24

69

Figure 27. Cargo vessel counts in Panama Canal (PC)

Richardson [56] counted cargo vessels in five other navigation routes for his research.
These navigation routes include Europe Atlantic, East Coast Atlantic, Gulf/Caribbean, Pacific
Ocean, and West Pacific Alaska. The average hourly cargo vessel counts per day from the five
navigation routes were also used for this study for further analysis.
Table 22 shows a summary of cargo vessel counts in ten navigation routes. The code
column indicated collectors. QN is Quang Nguyen and RR is Robert Richardson, who counted
cargo vessels in the selected navigation routes. The average hourly cargo vessel counts per day
for each navigation route are shown in column five.
Figure 28 shows a graph of average hourly cargo vessel counts per day for navigation
routes. The average hourly cargo vessel count per day in the Europe Atlantic was 5,865 cargo
vessels, which is much higher than those of other navigation routes. The Europe Atlantic is
known as the busiest ocean navigation route, and the greatest. About 50 of the World's leading
ports serve this route. Major ports of Western Europe, such as London, Liverpool, Hamburg,
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Amsterdam, are connected to the major ports of the Eastern United States via the navigation
route in the Europe Atlantic.

Table 22. Summary of daily cargo vessel counts in selected navigation routes
Code

Navigation Routes

Route
Length

Date
Collected

Average Hourly
Cargo Vessel
Counts per Day

(km)

(mm/dd/yyyy)

(vessels)

QN

Strait of Malacca (SM)

790

09/08/2016

288

QN

Red Sea (RS)

1,900

09/28/2015

78

QN

Suez Canal (SC)

190

09/28/2015

33

QN

Mediterranean Sea (MS)

3,500

09/28/2015

805

RR

Europe Atlantic (E)

4,000

09/07/2015

5,865

RR

East Coast Atlantic (EA)

5,093

09/07/2015

224

RR

Gulf/Caribbean (G)

1,968

09/07/2015

456

QN

Panama Canal (PC)

78

09/08/2016

50

RR

Pacific Ocean (P)

4,788

09/07/2015

199

RR

West Pacific Alaska (W)

3,149

09/07/2015

96

Figure 28. Average hourly cargo vessel counts in selected navigation routes
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Figure 29 shows 24 hour cargo vessel counts in the selected navigation routes. The
cargo vessel counts of the Europe Atlantic are much higher than other navigation routes. The
cargo vessel counts for most navigation routes are shown as straight lines. That means the
volume of vessels on the navigation routes does not much change between daytime and night
time. In addition, most navigation routes are located on large oceans; so there are no congestion
issues on these routes. The cargo vessel counts on both the Suez Canal and the Panama Canal
are shown on two lines at the bottom of the graph (Figure 29). The cargo vessel counts on the
two canals are smaller compared with other navigation routes because these canals are narrow
navigation routes, so cargo vessels have to wait several hours before passing through the canals
from the both sites.

Figure 29. Hourly cargo vessel counts in selected navigation routes
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Figure 30 shows a spatial map of cargo vessel demand for selected navigation routes. Cargo
vessel counts for each navigation routes are displayed with different colors and thickness.
The thick routes are for the navigation routes that have high vessel volumes. The selected
navigation routes in this study play important roles in international trading routes, which connect
Asia to North and West Europe, Asia to North America, and Europe to the Eastern United States.

Figure 30. Spatial map of typical hourly cargo vessel demand for selected shipping routes

3.3

Anthropogenic CO2 Emission for Selected Shipping Routes

3.3.1 Important Input Parameters
 According to the CMA CGM Corporate Foundation [57], TEU (Twenty-Foot
Equivalent Unit) is a standard container size that can be loaded and sealed onto
vessels. The dimensions of a TEU are 20 ft (length) × 8 ft (width) × 8.6 ft (height).
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Maximum weight of TEU is 30,480 kg or 30.48 metric tons, an average empty
container is 2,230 kg, and maximum payload is 28,250 kg. For this research, 30
metric tons is used as the maximum weight of TEU.
 Remias et al. [58] indicated that the cost of each metric ton of anthropogenic CO 2 is
22 U.S. dollars.
 As shown by the World Shipping Council [59], a container vessel gives off 10 grams
of anthropogenic CO 2 to carry one metric ton of cargo one kilometer.
 According to the Marine Engines & Systems [60], the 8,000 TEUs vessels have a
speed of 25 knots (46 km/h).
 Suez Canal Authority [61] shows that average speed of vessels in the Suez Canal is
14 km/h.
 As shown by Panama Canal Authority [62], speed of vessels in the Panama Canal is
5 knots (9 km/h).
 Maritime and Port Authority of Singapore [63] indicated that speed of vessels in the
Strait of Malacca is not more than 12 knots (22 km/h).
 Average size of vessel via the Suez Canal is 8,000 TEUs [64]. Figure 3-12 shows the
evolution of container vessel size from 1968 to 2015. In 1968, container vessel size
was 1,530 TEUs; container vessel size grew 19,000 TEUs in 2015. In other words,
container-carrying capacity has increased by approximately 1,200% since 1968.
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Figure 31. Fifty year of container vessel growth

3.3.2 Calculation of Amount and Cost of Anthropogenic CO2 Emission for Container Cargo
Vessels for Selected Navigation Routes
3.3.2.1 Amount of Average Anthropogenic CO2 Emissions for a Navigation Route
Calculations of average anthropogenic CO2 emissions from cargo vessels for a
navigation route are shown in Equation 3.1, 3.2, and 3.3 as follows:
Average anthropogenic CO2 emissions per day per cargo vessel (metric tons/day/vessel) =
((Average load of cargo vessel (TEU) x Maximum weight of TEU (metric tons) x
Anthropogenic CO2 emissions rate per one ton of one kilometer (grams) x Average distance
traveled per day (km)) /1,000,000

(3.1)

75

Average anthropogenic CO2 emissions for a navigation route per day (metric tons/day) =
Average anthropogenic CO2 emissions per day per cargo vessel (metric tons/day/vessel) x
Average hourly cargo vessel counts per day (vessels)

(3.2)

Average anthropogenic CO2 emission for a navigation route per year (metric tons/year) =
Average anthropogenic CO2 emissions for a navigation route per day (metric tons/day) x 300
(days)

(3.3)

Example for the Mediterranean Sea
 Average load of a cargo vessel = 8,000 TEUs.
 Maximum weight of TEU = 30 metric tons.
 Anthropogenic CO2 emissions rate per one metric ton of one kilometer = 10 grams.
 Average distance traveled per day = 24 hours x 46 km/h = 1,104 km/day.
Average anthropogenic CO2 emissions per day per cargo vessel (Equation 3.1) = [8,000 TEUs x
30 metric tons x 10 grams x 1,104 km/day]/1000,000 = 2,650 metric tons of CO2/day/vessel
Average anthropogenic CO2 emissions for the Mediterranean Sea navigation route per day
(Equation 3.2) = 2,650 metric tons of CO2/day/vessel x 805 vessels = 2,132,928 metric tons of
CO2/day.
Average anthropogenic CO2 emissions for the Mediterranean Sea navigation route per year
(Equation 3.3) = 2,132,928 metric tons/day x 300 days = 639,878,400 metric tons/year.

3.3.2.2 Cost of Average Anthropogenic CO2 Emissions for a Navigation Route per Day
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Cost of average anthropogenic CO2 emissions for a navigation route per day (U.S. dollars/ day)
= Average anthropogenic CO2 emissions for a navigation route per day (metric tons/day) x
Cost of each metric ton of anthropogenic CO2 (U.S. dollars)

(3.4)

Example for the Mediterranean Sea
Cost of average anthropogenic CO2 emissions on the Mediterranean Sea navigation route per
day (U.S. dollars/ day) = 2,132,928 x 22 U.S. dollars = 46,924,416 U.S. dollars/ day
Table 23 shows calculations of amounts of average anthropogenic CO2 emission per day
on selected navigation routes. Detailed calculations of amount and cost of average
anthropogenic CO2 emissions on these selected navigation routes are shown in Table 24.
As shown in both Table 23 and Table 24, on the Europe Atlantic navigation route, with
4,000 km length, 5,865 cargo vessels pass through per day, emitting the largest amount of
anthropogenic CO2 emissions with about 23 million metric tons per day.
The East Coast Atlantic navigation route is the longest route with 5,093 km. However,
the 224 cargo vessels per day on this route only emit 593,510 metric tons of anthropogenic CO2
per day.
On the Panama Canal, only 25,920 metric tons of anthropogenic CO2 are emitted per day
because only 50 cargo vessels pass 78 km through this canal. The Suez Canal navigation route,
with only 33 cargo vessels per day, also has less anthropogenic CO2 emissions per day in
comparison to other selected navigation routes.
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Table 23. Summary of daily cargo vessel counts and anthropogenic CO2 emissions on selected
navigation routes, 2015

Code

Navigation
Routes

Route
Length

Average
Hour
Vessels
Counts
per Day

Typical
Vessel
Speed

Average
Distance
Traveled
24 Hours

Average
Anthropogenic
CO2 Emissions
per Day per
Cargo Vessel

Average
Anthropogenic
CO2 Emissions
per Day

(km)

(vessels)

(km/h)

(km)

(metric
tons/day)

(metric
tons/day)

QN

Strait of
Malacca (SM)

790

288

22

528

1,267

364,954

QN

Red Sea (RS)

1,900

78

46

1,104

2,650

206,669

QN

Suez Canal
(SC)

190

33

14

336

806

26,611

QN

Mediterranean
Sea (MS)

3,500

805

46

1,104

2,650

2,132,928

RR

Europe Atlantic
(E)

4,000

5,865

46

1,104

3,974

23,309,856

RR

East Coast
Atlantic (EA)

5,093

224

46

1,104

2,650

593,510

RR

Gulf/Caribbean
(G)

1,968

456

46

1,104

2,650

1,208,218

QN

Panama Canal
(PC)

78

50

9

216

518

25,920

RR

Pacific Ocean
(P)

4,788

199

46

1,104

2,650

527,270

RR

West Pacific
Alaska (W)

3,149

96

46

1,104

2,650

254,362

25,456

8,094

Total

28,650,298

78
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Table 24. Amount and cost of anthropogenic CO2 emission for container cargo vessels on selected navigation routes

3.4

Development of Port Level of Service (LOS) for Cargo Vessel Service
LOS is a qualitative measurement that describes traffic conditions using various

quantitative terms such as speed, travel time, and traffic interruptions [65]. The LOS was
developed for highway traffic with six classifications, which designated by the letters A through
F. LOS A represents the best operating conditions, while LOS F represents heavily congested
flow with traffic demand exceeding highway capacity [65]. However, there is no LOS for
marine traffic, especially in port areas with high vessel volumes and congestion issues. In U.S.
sea ports, many cargo vessels wait a day or several days at the anchorage offshore of the port
due to congestion issues as well as limitations of marine and port infrastructures. In this study, a
LOS was developed and proposed for cargo vessels at ports. In addition, a mathematical
function based on LOS was also proposed to predict delay time of cargo vessels at ports. The
developed LOS for cargo vessels at ports is expected to evaluate the operating conditions of the
ports.

3.4.1 Port Selection and Data Collection
The Port of Miami was selected for studying and developing the LOS for cargo vessels
because of the following reasons:
 The Port of Miami is the largest container port in the state of Florida and in the list of
top 25 container ports in the United States. The port is recognized as a global
gateway, contributes U.S. $ 28 billion annually to the local economy, and supports
more than 207,000 jobs [66].
 The port is located in an area with low elevation; so it has high risk of rainfall flood,
tsunami, and SLR. The developed LOS and results of the rainfall flood, tsunami, and
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SLR simulations are expected to provide comprehensive issues of the port that may
help the port make a resilience plan to protect infrastructure and people from
disasters and improve infrastructures to meet the demand of cargo vessel volumes.
 Data used for development of LOS is available
This required AIS data from the Port of Miami for this study was provided by the U.S.
Army Engineer Research and Development Center [67]. The data set in 2014 includes vessel
types, waiting time of cargo vessels at the anchorage offshore, travel time of cargo vessels from
anchorage offshore to the terminals of the port, dwell time of cargo vessels at the docks of the
port, and travel time of cargo vessels from the terminals to the offshore.
Figure 32 shows a pie chart by vessel types at the Port of Miami in 2014. There were 15
vessel types. Most vessels were cargo vessels with 44.29% of total vessels in the port in 2014.
That makes the port among the busiest container ports in the United States, handling more than
1 million TEUs each year [68].

Figure 32. Pie chart by vessel types at the Port of Miami, Florida, 2014
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Figure 33 shows a map of cargo vessels at the anchorage and docks of the Port of
Miami. The port has three cargo terminals; however many cargo vessels had to wait at the
anchorage offshore

Figure 33. Cargo vessels at the anchorage and docks of the Port of Miami, Florida, 2014

The red points with high density in the box at anchorage represent the cargo vessels that
were waiting to move to the docks of the port in 2014.
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3.4.2 Delay Time Calculation using Statistical methods
Delay time of cargo vessels was used as criteria for developing a LOS for cargo vessels
at ports. Delay time was calculated based on waiting time of cargo vessels at the anchorage
offshore, travel time of cargo vessels from offshore to terminals, and dwell time of cargo
vessels at the docks.
The waiting time data of cargo vessels at the anchorage offshore of the Port of Miami
were analyzed using the AIS data. The mean, standard deviation (SD), coefficient of variation
(COV), minimum (Min), and maximum (Max) of waiting times of cargo vessels at the
anchorage were calculated and are shown in Figure 34.

Figure 34. Waiting time of cargo vessels at the anchorage of the Port of Miami

The frequency plot in Figure 34 indicates that the waiting time data of cargo vessels at
the anchorage was not normally distributed; the waiting time of many cargo vessels is not close
to the mean. Therefore, the mean of the waiting time of cargo vessels at the anchorage was not
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used to represent the waiting time of the cargo vessels at the anchorage. The waiting time of the
cargo vessels at the anchorage offshore ranges from 0.58 hours to 190 hours, and they were
classified into 8 ranges with 25-hour intervals.
Most cargo vessels at the anchorage (72.9%) had to wait less than or equal to 25 hours.
Other cargo vessels (27.1%) were classified in other ranges of waiting time. The eight ranges of
waiting time of the cargo vessels at the anchorage were used for calculating delay time of cargo
vessels at the Port of Miami.
Figure 35 shows a frequency plot and statistical descriptive summary of travel time of
cargo vessels from offshore to terminals at the Port of Miami. The mean of travel time of cargo
vessels from offshore to terminals was 0.47 hours. The frequency plot of the travel time data
shows that the data of travel time of cargo vessels from offshore to terminals was normally
distributed. The travel time of most cargo vessels is close to the mean (0.47 hours).

Figure 35. Travel time of cargo vessels from offshore to terminals at the Port of Miami
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Figure 33 shows the navigation route with light blue from offshore to terminals at the
Port of Miami. This navigation route is narrow and about 8 km long. The cargo vessels on the
navigation route moved without stop from offshore to terminals of the port. That explains why
travel time of cargo vessels from offshore to terminals is close to 0.47 hours. The mean values
of 0.47 hours were used as the travel time of cargo vessels from offshore to terminals of the
port.
Figure 36 shows a frequency plot and statistical descriptive summary of dwell time of
cargo vessels at the docks of the Port of Miami. Dwell time is the continuous length of time a
vessel spends within the dock area. Dwell time indicates the capability of the port to efficiently
handle cargo flows at the terminals [69]. The mean of dwell time of cargo vessels at the docks
of the port was 16.66 hours. The frequency plot of the dwell time of cargo vessels at the docks
shows that the data of dwell time of cargo vessels at the docks was normally distributed.
Therefore, the mean of dwell time of cargo vessels at the docks was used to represent dwell
time of cargo vessels at the docks.

Figure 36. Dwell time of cargo vessels at the docks of the Port of Miami
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A frequency plot and statistical descriptive summary of return time of the cargo vessels
from terminals of the port to offshore are shown in Figure 37. The mean of travel time of cargo
vessels from terminals to offshore was 0.46 hours, which is very close to the mean of travel
time of cargo vessels from offshore to terminals. The cargo vessels returned to offshore on the
same navigation route they came but in the opposite direction. The data of travel time of cargo
vessels from terminals to offshore was also normally distributed.

Figure 37. Travel time of cargo vessels from terminals to offshore the Port of Miami

Figure 38 shows a frequency plot and statistical descriptive summary of draft (ft) of
cargo vessels at the Port of Miami.
Draft is the vertical distance between a cargo vessel's waterline and the lowest point of
its keel. The mean of draft (ft) of cargo vessels at the port was 24.7 ft. The data of draft (ft) of
cargo vessels at the port was also normally distributed.
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Figure 38. Draft (ft) of cargo vessels at the Port of Miami

Based on the above statistical analysis for data of waiting time of cargo vessels at the
anchorage offshore, travel time of cargo vessels from offshore to terminals, and dwell time of
cargo vessels at the docks, the equation of the delay time was created as shown in equation 3.6.
Delay time = Waiting time at the anchorage + Average travel time of cargo vessels from
offshore to terminals + Average dwell time of cargo vessels at the docks

(3.6)

where,
Average travel time of cargo vessels from offshore to terminals = 0.47 hours
Average dwell time of cargo vessels at the docks = 16.6 hours
Table 25 shows calculated delay time of cargo vessels at the Port of Miami. Column A
shows waiting time of cargo vessels at the anchorage offshore; column B shows calculated
delay time using equation 3.6. Column D shows number of processed cargo vessels in each
waiting period and delay time as shown in Column B. Delay time of 210 vessels is equal to or
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less than 42.13 hours. Column E shows the ration between number of processed cargo vessels
and total annual cargo vessels.

Table 25. Delay time of cargo vessels for the year 2014 at the Port of Miami, Florida.
(based on AIS data in 2014)
A

B=A+
0.47+16.66

C=
B/(Largest Value in B)

Waiting
Time

Delay
Time

Delay Time/
Maximum Delay Time

Processed

(hours)
0.00
25.00
50.00
75.00
100.00
125.00
150.00
175.00
200.00

(hours)
0
42.13
67.13
92.13
117.13
142.13
167.13
192.13
217.13

0.194
0.309
0.424
0.539
0.655
0.770
0.885
1.000

210
45
19
5
5
1
1
2

D
Number of
Cargo
Vessels
(vessels)

E=
D/( Total Cargo Vessels)
Number of Processed
Cargo Vessels/Total
Annual Cargo Vessels

0.729
0.156
0.066
0.017
0.017
0.003
0.003
0.007

Annual total cargo vessels = 288 cargo vessels

3.4.3 Development of Port LOS for Cargo Vessel Service
The LOS was developed based on delay time of cargo vessels and the ratio between
number of processed cargo vessels and total annual cargo vessels at the Port of Miami. The plot
in Figure 39 shows that 72.9% of total cargo vessels have less than or equal to 42.3 hours of
delay time; and 15.6% of total cargo vessels have less than or equal to 67.13 hours of delay
time. Only a small percent of total cargo vessels have a delay time of greater than 100 hours.
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Figure 39. Plot of processed cargo vessels and their delay time at the Port of Miami, Florida

Table 26 shows the proposed LOS criteria for processing cargo vessels at a port. LOS A,
which is equal to or less than 24 hours (1 day) of delay time and greater than 0.6 of number of
vessels per total vessels, represents the unconstrained flow with excellence rating.
LOS B, which is equal to or less than 48 hours (2 days) of delay time, shows smooth
flow conditions with very good rating. LOS C, which is 72 hours (3 days) of delay time,
represents the saturated flow with good rating.
LOS D, LOS E, and LOS F are described as constrained flow, undesirable flow, and
over capacity conditions, respectively. The delay time of these LOS is greater than 96 hours, or
4 days.
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Table 26. Proposed LOS criteria for processing cargo vessels at a port

Port
LOS

Delay Time
Criteria
hours

days

A

24

1

B

48

C

Number of Processed
Cargo Vessels/Total
Annual Cargo Vessels

Port Level of Service (LOS)
Based on Delay Time and Cargo
Vessel Volume Criteria
Rating

Description

> 0.60

Excellent

Unconstrained flow

2

0.60

Very good

Moderately
Constrained flow

72

3

0.30

Good

Constrained flow

D

96

4

0.15

Fair

Congested flow

E

144

6

0.10

Poor

Saturated flow

F

192

8

≤ 0.05

Very poor

Over capacity flow

Figure 40 shows a plot of the proposed LOS for a port. The horizontal axis is the ratio
between number of processed cargo vessels per total annual cargo vessels or represents
operating conditions of cargo vessels.

Figure 40. Proposed level of service plot for cargo vessel volume and delay time at a port
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The vertical axis is delay time in hours and days of the cargo vessels at a port. LOS A is
described as the best operating condition. Based on delay time criteria and ratio between
number of processed cargo vessels and annual total cargo vessels in Table 26, a mathematical
function of delay time was developed and shown in Figure 41, as well as Equation 3.7.
y = 29.327 x-0.63

(3.7)

where,
y

= Delay time (hours)

x

= Number of processed cargo vessels/total annual cargo vessels

Equation 3.7 is used to calculate delay time of cargo vessels in a port and determine
LOS of a port. The calculated delay time and LOS are helpful for port managers and planners
for evaluating operational efficiency of ports for handling cargo vessels and improving port
infrastructures.

Figure 41. Mathematical function for estimating LOS of cargo vessels at ports
For Miami, LOS based on Equation 3.7 is D with 82.5 hours delay time.
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Calculate LOS for the Port of New Orleans, 2014:
Assuming 4,000 TEUs per cargo vessel, the total number of cargo vessels of the Port of
New Orleans is equal to 83 vessels in 2014 [40]. The LOS for the Port of New Orleans is
calculated as follows:
1. For typical waiting process of cargo vessels, about 15 cargo vessels are processed in
the Port of New Orleans.
2. Number of processed cargo vessels/total annual cargo vessels or x = 15/83 = 0.1807
3. Delay time or y = 29.327x-0.63 = 29.327 x 0.1807-0.63 = 86.17 hours delay times
4. Based on Figure 3-21, the LOS for the Port of New Orleans is D.
Calculate LOS for the Port of New York and New Jersey, 2015:
Assuming 4,000 TEUs per cargo vessels, the total number of cargo vessels of the Port of
New York and New Jersey is equal to 1,592 vessels in 2015 [41]. The LOS for the Port of New
York and New Jersey is calculated as follows:
1. For typical waiting process of cargo vessels, about 150 cargo vessels are processed in
the Port of New York and New Jersey.
2. Number of processed cargo vessels/total annual cargo vessels or x = 150/1,592 = 0.09
3. Delay time or y = 29.327x-0.63 = 29.327 x 0.09-0.63 = 133.69 hours delay times
4. Based on Figure 3-21, the LOS for the Port of New York and New Jersey is E.
Calculate LOS for the Port of Miami for Future Ship Demand, 2025:
Assuming total annual TEUs in 2015 [68] = 1,007,782 TEUs.
In 2025, total annual TEUs (44% increase from 2015) = 1,007,782 TEUs x 1.44 = 1,451,206
TEUs.
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Assuming an average of 3,500 TEUs for a cargo vessel, total future estimated cargo vessel in
2025 = 415 vessels.
The LOS for the Port of Miami in 2025 is calculated as follows:
1. Processed cargo vessels in 2015 = 45 vessels. Assumed 10% reduction in processing
cargo ships, so processed cargo vessels in 2025 = 40.5 vessels.
2. Number of processed cargo vessels/total annual cargo vessels or x = 40.5/415 = 0.098.
3. Delay time y = 29.327x-0.63 = 29.327 x 0.098-0.63 = 126 hours delay times.
4. Based on Figure 3-21, the LOS for the Port of Miami in 2025 = E.
This example clearly shows the importance of a reliable cargo ship demand model (Chapter II) in
order to evaluate ship processing performance at the port by estimating future LOS.

3.5

Summary of Key Results
The cargo vessels along ten important navigation routes for international trading were

counted based on AIS spatial maps. The analysis results of the average hourly cargo vessel
counts per day indicate that these navigation routes have high demand and are busy. The Suez
Canal and the Panama Canal especially have a very high demand of cargo vessel traffic;
however only 33 cargo vessels in the Suez Canal and 50 cargo vessels in the Panama Canal can
pass through these canals per day.
The port LOS based on the mathematical function of delay time was developed using
cargo vessel AIS data by the Port of Miami. The LOS as well as calculated delay times are
useful references for port managers and planners for evaluating port operational efficiency for
serving cargo vessels and improving port infrastructures.
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Although cargo vessels, mostly operated by diesel engine emit less anthropogenic CO2
and other harmful pollutants than transportation by rail, truck, and air craft [6, 56], larger
amounts of anthropogenic CO2 are emitted on the selected navigation routes due to heavy
shipping volumes. More efficient routes for cargo vessels, cleaner and renewable fuels, and new
larger cargo vessels will produce less anthropogenic CO2. These should be future goals for
reducing emissions of CO2, NO2, and other particulate matter pollution.
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IV. IMAGERY-BASED SURFACE TYPES AND LANDUSE CLASSIFICATION
4.1

Overview of Applicable Remote Sensing and Geospatial Analysis Technologies

4.1.1 Applicable Remote Sensing
Remote sensing is defined as the science and art of obtaining information about an
object, area or phenomenon through the analysis of data acquired by a device that is not in
contact with the object, area, or phenomenon under investigation [70]. Aerial imagery is now
collected by aircraft with film or digital cameras, and by satellites with multispectral sensors.
These sensors collect data simultaneously from several regions of the electromagnetic spectrum
[71]. Spaceborne satellite imagery data became commercially available in 1972 when the U.S.
government launched the first Landsat satellite [72]. Several major satellite systems are
described as follows.


Landsat: Landsat represents the world’s longest continuously acquired collection of
space-based moderate-resolution land remote sensing data. Four decades of imagery
delivers a single resource for those who work in agriculture, geology, forestry,
regional planning, education, mapping, and global change research [73]. The latest of
the Landsat series is the Landsat-8, launched by National Aeronautics and Space
Administration (NASA) on February 11, 2013. Landsat-8 carries two instruments:
The Operational Land Imager (OLI) sensor and the Thermal Infrared Sensor (TIRS).
The OLI sensor includes OLI multispectral bands 1 to 7 and 9 with horizontal
resolutions of 30-meters, and OLI panchromatic band 8 with horizontal resolutions
of 15-meters. The TIRS provides two thermal bands 10 and 11 collected at 100
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meters but resampled to 30 meters to match OLI multispectral bands. It has a typical
ground foot print of 170 km x 185 km (106 mi x 115 mi) and a 16 day revisit time
[74].


IKONOS: Launched by the Space Imaging Inc. on September 24, 1999, IKONOS is
the world's first commercial satellite. It collects multispectral imagery with 4-meter
horizontal resolution and panchromatic images with 1-meter horizontal resolution.
The ground foot print is 11.3 km x 11.3 km at nadir and 13.8 km x 13.8 km at 26°
off-nadir. Its revisit time is approximately 3 days at 40° latitude. Data are collected
over 2048 gray levels [75].



QuickBird: This is a high-resolution commercial earth observation satellite, owned
and launched by Digital Globe on October 18, 2001. It collects multispectral imagery
with 2.44 m horizontal resolution and a panchromatic band at 0.61 m horizontal
resolution. It has a typical ground foot print of 16.8 km x 16.8 km and revisit time
may vary from 2 to 12 days depending on target location as the orbit decays [76].



Moderate Resolution Imaging Spectroradiometer (MODIS): The MODIS instrument
is working on both the terra and aqua spacecraft. It has a viewing swath width of
2,330 km and views the entire surface of the earth every one to two days. Its sensors
measure 36 spectral bands between 0.405 and 14.385 µm, and it acquires data at
three spatial resolutions: 250 m, 500 m, and 1,000 m. Many data products derived
from MODIS observations describe features of the land, oceans and the atmosphere
that can be used for studies of processes and trends on local to global scales [77].
Data from satellite imagery has been one of the primary sources for landuse/landcover

information used for transportation, environment, land management, urban planning and
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modeling applications. Classification is the process of sorting pixels into a finite number of
singular classes, or categories of data based on their data file values. If a pixel satisfies a certain
set of criteria, then the pixel is assigned to the class that corresponds to those criteria [78].
Supervised and unsupervised classifications are known as two basic schemes commonly used
for allocating pixels to different categories.

4.1.2 Geospatial Analysis Technologies
Geospatial technologies are systems that obtain and handle location-specific data about
earth. Remote sensing, the global positioning system (GPS), and geographic information
systems (GIS) are important geospatial technologies. Remote sensing and the GPS are used for
collecting information about earth's surface; GIS is a mapping tool for organizing and analyzing
information [79].
These geospatial technologies have been developing in some form since the first maps
were drawn in ancient times. The technologies of photographic interpretation and map making
were enhanced during the World War II and during the Cold War it took on new dimensions
with the advent of satellites and computers. These technologies have evolved into a network of
national security, scientific, and commercially operated satellites complemented by powerful
desktop and internet GIS since the last decade. Geospatial technology such as GIS has many
useful applications for port city planners, port managers, and environmental sciences [79].

4.2

Review of BANS and Supervised Satellite Imagery-Based Surface Classifications

4.2.1 Unsupervised Classification Methodology for Surface Classification
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Unsupervised classification is a classification pattern in which no training data is
required. Unsupervised training is a computer-automated process. It allows specifying some
parameters that the computer uses to determine statistical patterns that are inherent in the data.
These patterns do not necessarily match to directly meaningful characteristics of the scene, such
as contiguous, easily recognized areas of a particular land use. They are basically clusters of
pixels with similar spectral characteristics. In some cases, it may be more important to identify
groups of pixels with similar spectral characteristics than it is to sort pixels into recognizable
categories. Unsupervised classification is suitable only if the classes can be appropriately
interpreted [78].
Unsupervised classification is also usually performed using the ISODATA algorithm in
the ERDAS IMAGINE software. The ISODATA clustering method uses the minimum spectral
distance formula to form clusters. It begins with either arbitrary cluster means or means of an
existing signature set, and each time the clustering repeats, the means of these clusters are
shifted. The new cluster means are used for the next iteration. The ISODATA utility repeats the
clustering of the image until either a maximum number of iterations have been performed, or a
maximum percentage of unchanged pixel assignments has been reached between two iterations.
Performing an unsupervised classification is simpler than a supervised classification, because
the signatures are automatically generated by the ISODATA algorithm.


Perform an unsupervised classification using the ISODATA algorithm: From the
Unsupervised Classification dialog, input data is required to select; output cluster
layer and output signature set are required to define. Both initial cluster options and
processing options are also to set in this operation.
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Evaluate classification: After a classification is performed, classification overlay,
thresholding, recodes classes, and accuracy assessments are available methods for
evaluating and testing the accuracy of the classification.
Some researchers, such as Villa et al. [80] have pointed out some advantages of the

unsupervised classification methodology. No prior knowledge of the image area is required, so
human error is minimized; unique spectral classes are produced, and performance is fast and
easy. Those researchers also indicated some disadvantages of the methodologies: spectral
classes do not represent features on the ground, the method does not consider spatial
relationships in the data, it can be very time consuming to interpret spectral classes, and spectral
properties vary over time, across images.

4.2.2 Supervised Classification Methodology for Surface Classification
Supervised classification is subjective because it depends on the knowledge and
experiences of users who select calibration samples. This is the primary of the supervised
classification method. In this process, pixels that represent recognizable patterns can be
identified with help from other sources. Knowledge of the data, the classes desired, and the
algorithm to be used is required before training samples are selected [81]. Through recognizing
patterns in the imagery, the computer system can be trained to recognize pixels with similar
characteristics. By setting priorities to these classes, the classification of pixels is supervised as
they are assigned to a class value. If the classification is accurate, then each resulting class
corresponds to a pattern that is originally identified by users [81].
Supervised classification is usually performed using the supervised classification tool in
the ERDAS IMAGINE software. The performance includes three operations as follows.
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Define signatures: Signatures (.sig extension) can be created, managed, evaluated
and edited by the ERDAS IMAGINE Signature Editor. Signatures are collected
from the image and Feature Space image to be classified using the area of interest
(AOI) tools and Feature Space tool.



Evaluate signatures: Once signatures are created, they can be evaluated, deleted,
renamed, and merged with signatures from other files. Merging signatures are
required to perform complex classifications with signatures that are derived from
more than one training method.



Process a supervised classification: The decision rules for the supervised
classification process are multilevel. If the signature is nonparametric, feature space
and parallelepiped are two offered decision rules. For parametric signatures, the
decision rules include maximum likelihood, mahalanobis distance, and minimum
distance.
Supervised classification methodology is known as one of the most popular supervised

classification methods used with remote sensing image data. Rawat, J.S and Kumar.M [81] have
applied supervised classification methodology for land use/cover classification in the
Hawalbagh block-one of the eleven development blocks of District Almora of the Uttarakhand
state, India.
Landsat Thematic Mapper at a resolution of 30 m of 1990 and 2010 were used for this
research. The results showed that during the last two decades, vegetation and built-up land have
been increased by 3.51% (9.39 km2) and 3.55% (9.48 km2) while agriculture, barren land and
water body have decreased by 1.52% (4.06 km2), 5.46% (14.59 km2) and 0.08% (0.22 km2),
respectively.
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Churches et al. [82] evaluated forest cover estimates for Haiti using supervised
classification of 2010-2011 Landsat Thematic Mapper (TM) imagery data. Result of this
research indicated that approximately 32.3% of Haiti’s total land area was tree covered in 20102011. This classification result was compared to other sources of land-cover data produced for
similar years, with an emphasis on the statistics presented by the FAO. The result was greater
than the reported FAO value of 4%.
Some other researchers applied supervised classification methodology for their research
and made comparisons with other methodologies such as Beligu and Dragut [83] and Alajlan et
al. [84]. Those researchers indicated some advantages of the supervised classification
methodology such as generation of information classes, self-assessment using training sites, and
reusable training sites. However, the methodology also has some disadvantages. For example,
information classes may not match spectral classes; signature homogeneity of information
classes varies, signature uniformity of a class may vary, and training sites may not encompass
unique spectral classes.

4.2.3 Application of Multispectral Reflectance Decision Criteria for Surface Classification
Traditional surface classification methods, such as supervised classification and
unsupervised classification methods, usually gave low accuracy (36-44%) for classifying the
tree and other surface classes. Moreover, those methods gave unsatisfactory delineation of the
geometric shapes of features such as road alignments [74].
Hence, a new (Built-up Area and Natural Surfaces) BANS classification methodology
using 1-m IKONOS pansharpened multispectral imagery was developed by Wodajo [85] in
2009 as a part of Center for Advanced Infrastructure Technology (CAIT) project.
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Wodajo calculated autocorrelation coefficients of the spectral reflectance values for all
image bands of the groundtruth samples. Groundtruth samples of different surface classes were
collected from pre-Katrina 1-m IKONOS pansharpened multispectral imagery of a 5 km x 10
km Gulfport area. The imagery was acquired on January 18, 2003, and has four spectral bands,
namely: Near-Infrared (NIR), Red (R), Green (G), and Blue (B). The decision criteria for each
surface class were established by considering image bands with autocorrelation of 0.8 or higher,
excluding tree and water, and uniqueness of the reflectance values of the surface classes in the
nominated image bands.
GeoMedia Pro geospatial analysis software [86] was used to implement the
classifications according to the established decision criteria and classification workflow.
Preliminary classification results of five Gulfport sample areas using only the spectral
reflectance decision criteria (without polygon maps) indicated an overall accuracy of less than
49%.
In order to get more accuracy and improvement, BANS geospatial surface classification
methodology was developed based on pixel-by-pixel spectral reflectance values of multispectral
image bands and manually drawn polygon maps. Asphalt, building/concrete, grass, tree, soil,
and water are surface classes created from this method. The pre-Katrina 1-m IKONOS
multispectral imagery of a 5 km x 10 km Gulfport area was also used for development of
BANS.
The following factors were considered to develop the BANS surface classification
methodology based on the preliminary classification results:
1.

Combine building and concrete surface classes into a single building/concrete surface
class to resolve the misclassification between the two surface classes. Note that it was
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difficult to distinguish between buildings and concrete surface classes in the preliminary
classification because there were buildings with concrete or other light-colored roof
materials.
2.

Draw polygon maps around built-up areas and natural surfaces to improve the
confounding between some of the surface classes.

3.

Revise the range of spectral reflectance values of the decision criteria for the surface
classes based on the preliminary classification results.

4.

Develop a classification workflow that improves the percentage of correctly classified
pixels. This was accomplished by selecting the order of the classification steps such that
surface classes with relatively unique range of reflectance values in their decision criteria
were given precedence.
The final BANS criteria and classification workflow (Table 27) were developed after

performing several trial classifications [85].

Table 27. Decision criteria and workflow for BANS surface classification methodology
Steps

Decision Criteria

Polygon map

1

Water: 0<NIR<50

Yes (If needed)

Surface class
legend
Bluecolor

2

Soil: Red >731

Yes (If needed)

Yellow

3

Vector map of built-up area pixels

Yes

Light Magenta

4

Asphalt: 235 < Green < 427

No

Grey

5

(Apply to step-3
Building/Concrete:
Step 3Pixels)
- Step 4 pixels

No

Light Magenta

6

Get Tree and Grass pixels

No

Green

7

pixels
- steps 1,2,3
pixels
Tree:Total
Red <
200 (Apply
to step
6 pixels)

No

Dark Green

8

Grass: Step 6 - Step 7 pixels

No

Light Green
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The polygons used for these two surface classes are optional due to the fact that they
have relatively unique reflectance values in their selected criteria bands. Thus, in most cases,
they can be classified without the use of polygons. Nevertheless, there is some exclusion where
polygons need to be used to avoid misclassification.
The maximum residual error with respect to the groundtruth was reduced to within ±7%
for the five Gulfport samples. This result was also more precise compared to traditional
supervised classification methods, which usually give up to 50% overall classification error.
The BANS methodology was also validated for other sample areas from the pre-Katrina
IKONOS imagery of Gulfport, and the classification errors were within a satisfactory margin of
± 5% difference from groundtruth. Statistical significance test results of paired samples t-test,
Cohen's d, nonparametric tests, and the analysis of variance (ANOVA) using four Gulfport
samples with different sizes indicated no significant difference between the groundtruth and
BANS results.

4.2.4 Implementation of the BANS Classification Methodology for Thammsat University
Campus, Thailand
The BANS surface classification methodology was developed by Wodajo [85] using
only the coastal and flat rolling terrain of Gulfport and Oxford in Mississippi. It may need
calibration with groundtruthing of other areas.
The Asian Institute of Technology (AIT) and the Thammasat University (TU) campus,
located in Bangkok, suffered heavy flood damage [87]. A mega flood disaster occurred in
Thailand in 2011. Due to this mega flood disaster, the TU campus was inundated with flood
water for several weeks from October to November, 2011. Research motivated by mega flood
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water at the TU campus as well as implementation of BANS surface classification methodology
outside of Mississippi was conducted. A subset of the TU campus imagery was created using
imagery analysis software [88].
One of the main objectives of this research was to apply the BANS surface classification
and supervised classification methodologies to classify built-up, open surface areas using highresolution pre-flood 1-m IKONOS pansharpened multispectral imagery at the TU campus area.
Geospatial planimetrics were created on pre-flood 1-m IKONOS pansharpened multispectral
imagery of the TU campus using GeoMedia Pro software [86]. Then, the results of both
methodologies were compared with results of detailed planimetrics of all campus features in
order to evaluate the accuracy of each method. The planimetrics results are shown in Figure 42.

Figure 42. Planimetrics of extracted features for the pre-flood surfaces of TU campus
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The built-up area was calculated as 37.77%, which includes asphalt (18.14%) and
building/concrete (19.63%). The natural surface is 62.23%, which includes 31.30% grass,
26.03% trees, 0.21% soil, and 4.68% water. It can be concluded that most pre-flood surface
areas of the TU campus were natural surfaces.
Decision criteria and workflow for BANS surface classification methodology was
applied for classifying pre-flood surface areas of the TU campus.
The summary of BANS classification results is shown in Figure 43; they gave a built-up
area estimate of 37.05%, which includes asphalt (16.51%) and building/concrete (20.54%). The
remaining 62.95% of the area was covered with natural surface: 35.55% grass, 22.21% trees,
0.51% soil, and 4.69% water.

Figure 43. BANS classification for the pre-flood surfaces on TU campus
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The supervised classification methodology using ERDAS IMAGINE software [88] was
applied for classifying pre-flood surface areas of TU campus. The experts more closely control
this method by pattern recognition skills. By identifying patterns of the imagery, the computer
needs to be trained to identify pixels with similar characteristics. A prior knowledge of the data
helps the system determine the statistical criteria (signatures) for data classification.
From the pre-flood 1-m IKONOS pansharpened multispectral imagery of the TU
campus, five to eight training samples are collected for each training set. The classes include
building/concrete, asphalt, grass, tree, and water.
Figure 44 shows the results of supervised classification for the pre-flood surface of the
TU campus. The built-up area was calculated as 52.44%, which includes asphalt (35.84%) and
building/concrete (16.60%). The natural surface is 47.56%, which includes 15.19% grass,
25.28% trees, 3.04% soil, and 4.05% water. Built-up area was indicated as larger than natural
surface area.

Figure 44. Supervised classification for the pre-flood surfaces on the TU campus
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Differences between planimetrics and BANS surface classification methodologies are
shown in Table 13.
It is clearly seen in Table 28 that there is a small difference of planimetrics and BANS
classification results for all surface classes; range of the difference is from -4.25% to 3.83%.
The maximum difference in percent between the groundtruth and the BANS results is -4.25%
(Grass). However, the differences of most surface classes are less than 1%. The differences of
total built-up area are only 0.72%.

Table 28. Difference between planimetrics and pre-flood BANS classification
Planimetrics
(groundtruth)
m2
%
1
1A
575,726.6
19.63

m2
2
602,355.8

%
2A
20.54

%
(1A-2A)
-0.91

Asphalt

532,117.6

18.14

484,332.5

16.51

1.63

Water

137,280.7

4.68

137,591.9

4.69

-0.01

Soil

6,297.8

0.21

14,813.3

0.51

-0.29

Tree

763,631.8

26.03

651,419.1

22.21

3.83

Grass

918,195.5

31.30

1,042,737.5

35.55

-4.25

SUM

2,933,250.0

100.00

2,933,250.0

100.00

0.00

Total Built-up Area
(Building/Concrete,
Asphalt)

1,107,844.2

37.77

1,086,688.3

37.05

0.72

Total Natural Surface
(Soil, Trees, Grass,
Water)

1,825,405.8

62.95

-0.72

100.00

0.00

Surface Class

Building/Concrete

SUM

(1.1 km2)

Difference

(1.1 km2)
62.23

(1.8 km2)
2,933,250.0

Pre-Flood BANS

1,846,561.7
(1.8 km2)

100.00

2

2,933,250.0
2

(2.9 km )

(2.9 km )

Differences between planimetrics and supervised classification methodologies are
shown in Table 29. Table 29 shows that the range of the difference between planimetrics results
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and supervised classification results for all surface classes was from -17.70% to 16.11%. Some
surface classes have big differences, such as asphalt (-17.70%), grass (16.11%),
building/concrete (3.03%), and soil (-2.82%). The difference of total built-up area is -14.67%.

Table 29. Difference between planimetrics and supervised classification
Surface Class

Planimetrics
(groundtruth)

Supervised
(By Quang Nguyen)

Difference

m2

%

m2

%

%

Building/Concrete

1
575,726.6

1A
19.63

2
486,883.9

2A
16.60

(1A-2A)
3.03

Asphalt
Water
Soil
Tree
Grass

532,117.6
137,280.7
6,297.8
763,631.8
918,195.5

18.14
4.68
0.21
26.03
31.30

1,051,313.1
118,761.8
89,077.0
741,660.6
445,553.6

35.84
4.05
3.04
25.28
15.19

-17.70
0.63
-2.82
0.75
16.11

SUM

2,933,250.0

100.00

2,933,250.0

100.00

0.00

Total Built-up Area
( Building/Concrete,
Asphalt)

1,107,844.2

37.77

1,538,197.0

52.44

-14.67

Total Natural Surface
(Soil, Trees, Grass,
Water)

1,825,405.8

47.56

14.67

100.00

0.00

SUM

(1.1 km2)

(1.5 km2)
62.23

(1.8 km2)
2,933,250.0

1,395,053.0
(1.4 km2)

100.00

(2.9 km2)

2,933,250.0
(2.9 km2)

In summary, there was a small difference between planimetrics and BANS for all
surface classes (ranging from -4.25% to 3.83%). However, there was a significant difference
between planimetrics and supervised classification for surface classes (ranging from -17.70% to
16.11 %.). In addition, Wodajo [85] indicated that the difference between the BANS results and
the groundtruth was statistically not significant (less than ±7%). Therefore, this case study
indicates that the results of the BANS surface classification methodology are more accurate
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than those of tranditional supervised classification methodology. Furthermore, also helps to
confirm that the BANS surface classification methodology can be applied any areas worldwide,
beyond Mississippi and Thailand.

4.3

Development of the Landsat-8 Satellite Imagery Built-up Area and Natural Surface (LBANS) Auto-Classification

4.3.1 Selection of Groundtruth Samples from Landsat-8 Satellite Imageries in Selected Sites
The study sites, selected for developing the L-BANS auto-classification method, include
(1) Sardis in Mississippi (MS), (2) Gulfport in MS, (3) Los Angeles in California (CA), (4)
Miami in Florida (FL), (5) Oxford in MS, and (6) Gwadar in Pakistan. In this section,
groundtruth samples of seven surface classes were collected and their pixel attributes of spectral
reflectance values were analyzed to establish decision criteria for auto-classification using
Landsat-8 satellite imagery.
Table 30 shows selected Landsat-8 satellite imageries in selected sites. These selected
Landsat-8 satellite imageries were downloaded from the website of the USGS [89]. All these
imageries were acquired in day time and have less than 1% of cloud cover; so both
infrastructure and natural features in the study areas are shown clearly on these imageries. The
detailed step-by-step procedure for downloading as well as analyzing Landsat-8 satellite
imageries is presented in Appendix A. A high resolution of 15 meters Landsat-8 pansharpened
multispectral satellite imagery for each study site was created by merging high resolution
panchromatic and lower resolution multispectral imagery using the ERDAS IMAGINE software
[88].
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Figure 30 shows the Landsat-8 pansharpened multispectral satellite imagery of Miami,
Florida. The red line shown on the imagery is the boundary of Miami city. Roads, port docks,
buildings, ocean water, and other features in Miami can be seen and identified on the imagery.
The Landsat-8 pansharpened multispectral satellite imageries of other selected sites are shown
in section C1 in Appendix C.

Table 30. Selected Landsat-8 satellite imageries in selected sites
Sardis,
MS

Gulfport,
MS

Los Angeles,
CA

Miami,
FL

Oxford,
MS

Gwadar,
Pakistan

Date
Acquired
Time
Acquired

August 25,
2015

May 23,
2015

September 8,
2015

October 17,
2014

November 22,
2015

September,
14, 2015

Day time

Day time

Day time

Day time

Day time

Day time

Cloud
cover

Less than
1%

Less than
1%

Less than
1%

Less than
1%

Less than
1%

Less than
1%

Site

This imagery was acquired on October 17, 2014 (day time)
Figure 45. Landsat-8 Imagery, Miami, FL
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Each Landsat-8 satellite imagery has 11 bands, as shown in Table 31. Each band has its
own wavelength and resolution. Horizontal resolutions of most bands range from 15 m to 30 m.
Band 10 (thermal infrared 1) and band 11 (thermal infrared 2) are acquired at 100 m resolution.
Table 31. Bands, wavelength, resolution, and functions of Landsat-8
Recommended by
USGS [54]

Useful for
surface
classification

Wavelength

Resolution

(micrometers)

(meters)

Band 1 - Coastal aerosol

0.43 - 0.45

30

Aerosol

Band 2 - Blue

0.45 - 0.51

30

Bathymetric

Soil, building

Band 3 - Green

0.53 - 0.59

30

Vegetation

Tree

Band 4 - Red

0.64 - 0.67

30

Vegetation slopes

Tree

Band 5 - Near Infrared (NIR)

0.85 - 0.88

30

Biomass

Water, building

Band 6 - SWIR 1

1.57 - 1.65

30

Moisture

Water

Band 7 - SWIR 2

2.11 - 2.29

30

Moisture

Water

Band 8 - Panchromatic

0.50 - 0.68

15

Image

Planimetric

Band 9 - Cirrus

1.36 - 1.38

30

Cloud

Band 10 - Thermal Infrared 1

10.60 - 11.19

100 * (30)

Soil moisture

Soil

Band 11 - Thermal Infrared 2

11.50 - 12.51

100 * (30)

Soil moisture

Soil

Bands

* TIRS bands are acquired at 100 meter resolution, but are resampled to 30 meters in data product

Table 31 also shows the recommendations from USGS and benefit of each band used for
surface classification. The function used for each band is described as the following:
Band 1: Aerosol studies
Band 2: Bathymetric mapping, distinguishing soil from vegetation and deciduous from
coniferous vegetation
Band 3: Emphasizes peak vegetation, which is useful for assessing plant vigor
Band 4: Discriminates vegetation slopes
Band 5: Emphasizes biomass content and shorelines
Band 6: Discriminates moisture content of soil and vegetation; penetrates thin clouds
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Band 7: Improved moisture content of soil and vegetation and thin cloud penetration
Band 8: 15 meter resolution, sharper image definition
Band 9: Improved detection of cirrus cloud contamination
Band 10: 100 meter resolution, thermal mapping and estimated soil moisture
Band 11: 100 meter resolution, improved thermal mapping and estimated soil moisture
At least four representative groundtruth samples were collected from the Landsat-8
pansharpened multispectral satellite imagery for each of the seven surface classes using the
ERDAS IMAGINE 2013 software [88]. The samples for each surface class were selected based
on the following recommended features:


Asphalt samples were taken from road pavements, parking areas, and runway of an
airport.



Building samples were taken to represent buildings, including terminal building of an
airport.



Concrete samples were taken from port docks and parking areas.



Grass samples were taken from grass areas on a golf course, near an airport, or roads.



Soil samples were taken from bare grounds within the study areas, including a beach
area by the ocean.



Tree samples were taken from densely wooded areas in different parts of the study
area.



Water samples were taken from shallow and deep areas of the ocean and also from
an inland water body.
Table 32 shows groundtruth samples for each surface class in each site. Each surface

class has at least four groundtruth samples.
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Table 32. Selections of groundtruth samples from selected sites
Surface
class

Sardis,
MS

Gulfport,
MS

Asphalt

A1
30mx1,455m
(runway of
Panola
County
Airport)

Building

B1
90mx255m
(terminal
building of
Panola
County
Airport)

Miami,
FL

Oxford,
MS

A2
45mx1,440m
(US-49
pavement)

A3
45mx1,080m
(I-95
pavement)

A4
1,665mx30m
(runway of
UniversityOxford
Airport)

B2
540mx90m
(near 28th
street)
B3
225mx60m
(terminal
building of
GulfportBiloxi
Airport)

B3
240mx120m
(center)

B4
210mx75m
(Jackson
Avenue
Center)

5

C4
360mx60m
(parking
near Taylor
Rd)

4

G5
540mx120m
(near
UniversityOxford
Airport)

5

S4
345mx120m
(near Old
Sardis Rd)

C1
150mx165m
(Port of
Gulfport)

Concrete

Los Angeles,
CA

C2
810mx165m
(Port of Los
Angeles)

C3
675mx180m
(Port of
Miami)

Grass

G1
810mx510m
(near Sardis
Lake Baptist
Church)
G2
450mx525m
(near Hwy
35)

G3
105mx390m
(near Airport)

G4
375mx210m
(Melreese
Golf course)

Soil

S1
180mx150m
(near Old
Panola Rd)

S2
234mx45m
(near beach)

S3
45mx2,595m
(near beach)

Tree

T1
330mx1,485m
(near River
Rd)
T2
285mx585m
(near Terza
Rd)

T3
570mx795m
(near US-49)
T4
900mx315m
(near John
Hill Blvd)

W1
1,485mx975m
(Sardis Lake
reservoir)

W2
1,200mx630m
(near beach)
W3
870mx165m
(near Biloxi
Bay)

Water

Gwadar,
Pakistan

4

S5
1,830mx585m
(north)

T5
390mx930m
(near
Anchorage
Rd)
T6
810mx375m
(near Old
Taylor Rd)

W4
1,230mx570m
(open sea)

n: Number of samples
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W5
1,635mx810m
(near Port of
Miami)
W6
1,275mx510m
(open sea)

n

5

6

W7
1,725mx840m
(open sea)

7

Tree has six groundtruth samples, and water has seven groundtruth samples.
Groundtruth samples of asphalt, building, concrete, grass, and tree were collected from the
Landsat-8 pansharpened multispectral satellite imageries in U.S. sites. In Gwadar, Pakistan,
only groundtruth samples of soil and water were collected because Gwadar has a semi-arid
climate, and most of the terrain area is dominated by soil. South of Gwadar is the Arabian Sea.
The size (number of pixels) for each sample was selected in such a way that pixels from
other adjacent surface classes must not be included. The spectral reflectance values of every
pixel in each sample were extracted and exported as American standard code for information
interchange (ASCII) files using ERDAS IMAGINE 2013 [88]. The procedure to extract the
spectral reflectance values from the Landsat-8 satellite imagery and to export as a data file using
the ERDAS IMAGINE software is described in detail in section A8 in Appendix A. The
following are the main steps of the procedure:
1.

Make a subset imagery file (.img) of the selected sample area using Create Subset Image
function of the ERDAS IMAGINE software.

2.

Export the subset imagery file (.img) to ASCII file (.asc) using Pixels to ASCII functions.
Table 33 shows an example of spectral reflectance values for each band of the

groundtruth sample W1 for water in Miami. The ASCII file (.asc) file of the groundtruth
sample W1 for water is opened in the Excel program. The X and Y columns show the
coordinates of pixel points. The columns B1 to B11, contain spectral reflectance values of band
1 to band 11 as described in Table 31. The ranges of spectral reflectance values for each band
are difference.
Frequency plots of the spectral reflectance values in each band were made for all
groundtruth samples of the surface classes. These plots provide a good understanding of the
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distribution of the spectral reflectance values, which is useful for selecting a band and ranges of
spectral reflectance values to represent the surface classes.

Table 33. Spectral reflectance values for each band of the groundtruth sample W5

Figures 46 shows the imagery and frequency plots of the groundtruth sample W5 for
water in Miami. The mean, standard deviation, and coefficient of variation (COV), minimum,
and maximum of the reflectance values were also calculated.
The imageries and frequency plots of 35 other groundtruth samples from the selected
sites (Table 46) are presented in section C2 in Appendix C. The groundtruth samples of water
have the lowest standard deviation compared to groundtruth samples of the other surface
classes. This indicates that spectral reflectance values of groundtruth samples of water have less
variation, which is reasonable when selecting a range of spectral reflectance values to represent
water.
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(a) Landsat -8 imagery of groundtruth sample-W5 for water in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(g) Frequency plot for SWIR 1 band

(f) Frequency plot for near infrared band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure 46. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W1 in Miami, FL
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A surface class, which has small variation, has the lower possibility of confounding or
overlap of the spectral reflectance values with other surface classes.
No overlap of the spectral reflectance values shows an ideal condition in which all
surface classes can be represented by a unique range of spectral reflectance values.
The distribution of the spectral reflectance values could be affected by several factors.
For example, in the groundtruth samples of asphalt shown in Figure B15 and Figure B16, the
presence of white highway patterns and other non-asphalt materials such as dirt can skew the
distribution of the spectral reflectance values. In addition, the color of asphalt samples taken
from road pavement has a similar color to concrete. In the groundtruth samples of buildings
shown in Figure B6 through Figure B10, the buildings in these samples may have other features
such as air-conditioning equipment, antennas, etc. on rooftops that can affect the distribution of
the spectral reflectance values. For groundtruth samples of grass and trees, the distribution of
their spectral reflectance values may be affected by the different shades of color of the leaves
and other intermittent materials that cover the ground when a larger grass or tree sample area is
selected.

4.3.2 Autocorrelation Analysis of Pixel Reflectance Values for Each Band
In order to determine a band and range of spectral reflectance values that can be used to
establish unique decision criteria for identifying each surface class, the spectral reflectance
values of the groundtruth pixels in each surface class and each band were analyzed. The
analysis includes the two following steps:
1. Selecting bands which have high autocorrelation of spectral reflectance values of each
surface class.
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2. Selecting unique ranges of spectral reflectance values in the selected bands for
identifying a surface class without confounding with other surface classes.
The autocorrelation analysis was used in this study to make the selection of the band for
the surface classes. For a finite series (Yt) of n observations, the autocorrelation (AC) value is
estimated using Equation 4.1 [85, 28].
n k


AC(k) =

t 1
n

 (Y
t 1

where,

(Yt Y )
t

[

 Y)

2

n
]
nk

(4.1)

k

= number of lags

Yt

= a space series of pixel reflectance values where t is pixel sequence number

Yt+k = the kth lag of Yt
Y

= mean of reflectance values

n

= the number of pixels in the series

Autocorrelation can be analyzed in both time and spatial domains. For this study, it is
only analyzed in the spatial domain. Consequently, the Yt series in this study is an equal space
series of the spectral reflectance values of the groundtruth sample pixel of each surface class in
each of the bands. The Yt+k series was formed by lagging the Yt series forward by one. The first
autocorrelation (R) or AC(1) is a measure of correlation between Yt and Yt+1 for the groundtruth
sample pixels of the selected surface class.
The spectral reflectance values of all groundtruth samples of each surface class were
combined for autocorrelation and statistical analysis. Table 34 shows the number of groundtruth
sample pixels, mean (m), standard deviation (SD), coefficient of variation (COV), minimum,
maximum, and autocorrelation (R) of reflectance values in each band for each of the seven
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surface classes. These values were calculated using autocorrelation and statistical functions in
Excel [90].
The autocorrelation (R) values were used as indicators of the correlation between the
pixel reflectance values of groundtruth samples of a surface class. The band with the high
autocorrelation is recommended to use for establishing a unique decision criterion for a given
surface class.
Another important indicator used for establishing decision criterion for surface
classification is the upper limit (m+2SD) and lower limit (m-2SD) of the range of spectral
reflectance values. The m ± 2SD spectral reflectance range indicates a 95% probability that the
spectral reflectance value of a given surface class pixel for the selected band falls within the
selected range. So the m ± 2SD spectral reflectance range must be used for considering the
unique range of spectral reflectance values of each band for a given surface class.

Table 34. Statistical summary and autocorrelation of spectral reflectance values for tree
groundtruth samples
(a) Asphalt
Number of Samples (n)
Pixels

1
Coastal
Aerosol
4

2

3

4

5

6

7

9

10

11

Blue

Green

Red

NIR

4

4

4

4

4

4

4

4

4

920

920

920

920

920

920

920

920

920

920

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2

Mean

11,109

Standard Deviation (SD)

1,666.9 1,811.8 2,159.3 2,481.8 3,420.9 2,270.8 1,890.6

10,650 10,526 10,534 15,472 14,590 11,658 5,047 26,762 24,262

Coefficient of Variation (COV)

15.0%

17.0%

20.5%

23.6%

22.1%

15.6%

16.2%

0.3%

Min

8,565

8,005

7,307

7,104

8,643

9,726

8,132

5,016 20,332 19,173

Max

13,746

14,021 14,929 15,955 25,957 20,755 15,955 5,072 29,848 26,215

Autocorrelation (R)

0.960

0.947

0.941

0.921

0.744

0.708

0.811

14.5 3,553.1 2,796.5

0.936

13.3%

0.996

Number of asphalt pixels: Sardis (194), Gulfport (288), Miami (216), Oxford (222)

120

11.5%

0.996

(b) Building
Number of Samples (n)
Pixels

1
2
Coastal
Blue
Aerosol
5
5
577

577

3

4

5

6

7

9

10

11

Green

Red

NIR

5

5

5

5

5

5

5

5

577

577

577

577

577

577

577

577

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2

Mean

13,698 13,663 13,883 14,240 17,958 17,768 15,040 5,044 28,281 25,329

Standard Deviation (SD)

2,547.2 2,883.3 3,227.7 3,592.5 5,582.4 5,226.2 4,598.9 12.6 3,063.9 2,268.5

Coefficient of Variation (COV) 18.6% 21.1% 23.2% 25.2% 31.1% 29.4%

30.6% 0.2% 10.8%

Min

9,265

4,431 5,019 20,403 19,229

Max

20,765 22,961 26,333 29,653 48,779 48,644 41,003 5,070 31,157 27,076

Autocorrelation (R)

0.951

8,957
0.942

7,684
0.918

7,067
0.904

5,666
0.744

5,288
0.827

0.860 0.920 0.990

9.0%

0.990

Number of building pixels: Sardis (102), Gulfport (277), Miami (128), and Oxford (70)
2

3

4

5

Blue

Green

Red

NIR

Number of Samples (n)

1
Coastal
Aerosol
4

4

4

4

4

4

4

4

4

4

Pixels

1,340

1,340

1,340

1,340

1,340

1,340

1,340

1,340

1,340

1,340

Mean

11,782

11,400 11,082 11,343 12,524 12,762 11,448 5,038 28,431 25,424

Standard Deviation (SD)

1,094.4 1,177.7 1,366.5 1,524.5 2,210.5 2,119.6 1,742.1

(c) Concrete

Coefficient of Variation (COV)

9.3%

6

7

9

10

11

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2

15.4 2,271.6 1,734.4

10.3%

12.3%

13.4%

17.7%

16.6%

15.2%

0.3%

8.0%

6.8%

7,404

7,247

5,187

7,206

7,096

4,989 20,269 19,132

Min

8,492

7,895

Max

14,930

14,853 16,284 17,368 27,184 22,190 17,351 5,150 31,621 27,000

Autocorrelation (R)

0.957

0.943

0.919

0.908

0.800

0.860

0.889

0.775

0.989

0.992

10

11

Number of concrete pixels: Gulfport (110), LA (594), Miami (540), Oxford (96)

2

3

4

5

Blue

Green

Red

NIR

Number of Samples (n)

1
Coastal
Aerosol
5

5

5

5

5

5

5

5

5

5

Pixels

3,706

3,706

3,706

3,706

3,706

3,706

3,706

3,706

3,706

3,706

Mean

9,597

8,765

8,362

7,817

17,816 13,925

9,866

5,043 27,197 24,933

Standard Deviation (SD)

473.5

437.0

543.7

649.3

7,024.1 1,335.2 1,465.8

(d) Grass

6

7

9

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2

8.5

2,036.0 1,682.9

Coefficient of Variation (COV)

4.9%

5.0%

6.5%

8.3%

39.4%

9.6%

14.9%

0.2%

Min

8,391

7,794

7,223

6,291

10,199

8,962

6,500

5,024 20,265 19,110

Max

11,721

11,093 11,675 11,535 30,820 21,600 14,559 5,068 29,476 26,016

Autocorrelation (R)

0.977

0.960

0.950

0.948

0.993

0.929

0.973

0.986

7.5%

0.998

Number of grass pixels: Sardis (2,886), Gulfport (182), Miami (350), Oxford (288)
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6.7%

0.998

2

3

4

5

Blue

Green

Red

NIR

Number of Samples (n)

1
Coastal
Aerosol
5

5

5

5

5

5

5

5

5

5

Pixels

5,815

5,815

5,815

5,815

5,815

5,815

5,815

5,815

5,815

5,815

Mean

11,737

11,797

12,572

13,723

15,836

19,021

17,382 5,033 27,238

25,200

Standard Deviation (SD)

2,035.2 2,365.6 2,782.6 3,196.9 4,733.1 3,890.7 2,999.1

Coefficient of Variation (COV)

17.3%

20.1%

22.1%

23.3%

29.9%

20.5%

17.3%

0.1%

Min

8,354

7,733

7,172

7,412

9,409

9,871

8,043

5,019 20,048

18,963

Max

20,978

22,474

25,088

28,685

37,527

38,311

34,047 5,075 29,531

26,061

Autocorrelation (R)

0.990

0.989

0.985

0.983

0.974

0.967

0.958

0.993

(e) Soil

6

7

9

10

11

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2

7.2

0.971

1,318.9 1,109.4
4.8%

4.4%

0.992

Number of soil pixels: Sardis (120), Gulfport (234), Miami (519), Oxford (184), Gwadar (4,758)
2

3

4

5

Blue

Green

Red

NIR

Number of Samples (n)

1
Coastal
Aerosol
6

6

6

6

6

6

6

6

6

6

Pixels

9,155

9,155

9,155

9,155

9,155

9,155

9,155

9,155

9,155

9,155

Mean

9,375

8,442

7,748

6,826

15,508

9,888

7,059

5,050 24,896

22,876

Standard Deviation (SD)

852.7

698.2

744.8

404.0

4,188.1 1,206.9

455.1

11.1

3,325.4 2,707.2

Coefficient of Variation (COV)

9.1%

8.3%

9.6%

5.9%

27.0%

12.2%

6.4%

0.2%

13.4%

11.8%

Min

8,193

7,458

6,568

6,058

7,596

6,748

5,729

5,020 20,013

18,922

Max

10,716

9,727

9,194

8,204

25,210

13,025

8,877

5,069 27,999

25,250

Autocorrelation (R)

0.999

0.999

0.997

0.976

0.992

0.961

0.917

0.973

1.000

1.000

9

10

(f) Tree

6

7

9

10

11

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2

Number of tree pixels: Sardis (2,919), Gulfport (3,274), Oxford (2,962)
2

3

4

5

Blue

Green

Red

NIR

Number of Samples (n)

1
Coastal
Aerosol
7

7

7

7

7

7

Pixels

28,765

28,765

28,765

28,765

28,765

28,765

28,765 28,765 28,765

28,765

Mean

9,778

8,945

7,750

6,717

6,240

5,752

5,537

24,905

Standard Deviation (SD)

671.3

611.7

701.8

824.1

905.1

711.4

518.4

9.1

658.2

614.3

Coefficient of Variation (COV)

6.9%

6.8%

9.1%

12.3%

14.5%

12.4%

9.4%

0.2%

2.4%

2.5%

(g) Water

6

7

11

SWIR 1 SWIR 2 Cirrus TIRS 1 TIRS 2
7

7

7

5,033 27,117

7

Min

9,071

8,340

7,015

5,956

4,898

4,771

4,857

5,013 26,042

23,625

Max

11,774

10,896

9,906

9,511

9,556

9,030

7,978

5,088 27,914

25,563

Autocorrelation (R)

0.999

0.999

0.998

0.998

0.996

0.996

0.995

0.972

1.000

1.000

Number of water pixels: Sardis (6,435), Gulfport (3,998), Los Angeles (3,116), Miami (8,776),
Gwadar (6,440).

Table 35 shows a statistical summary of spectral reflectance values of groundtruth
samples for all surface classes in each band, which includes the mean (m), standard deviation
(SD), and m ± 2SD of spectral reflectance values in each surface class for each band.
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Table 35. Statistical summary of spectral reflectance values of groundtruth samples for all
surface classes in each band
Not Used
(a) Band 1: Coastal
Aerosol
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

Asphalt

Grass

Building

Soil

Concrete

Tree

Water

1,666.9
14,443
11,109
7,775
0.960

473.5
10,544
9,597
8,650
0.977

2,547.2
18,793
13,698
8,604
0.951

2,035.2
15,807
11,737
7,666
0.990

1,094.4
13,971
11,782
9,594
0.957

852.7
11,080
9,375
7,669
0.999

671.3
11,120
9,778
8,435
0.999

Tree
698.2
9,839
8,442
7,046
0.999

Water
611.7
10,168
8,945
7,721
0.999

Not Used
(b) Band 2: Blue
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)
(c) Band 3: Green
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)
(d) Band 4: Red
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)
(e) Band 5: NIR
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

Asphalt
1,811.8
14,273
10,650
7,026
0.947

Grass
437.0
9,640
8,765
7,891
0.960

Asphalt
2,159.3
14,845
10,526
6,208
0.941
Asphalt
2,481.8
15,498
10,534
5,571
0.921
Asphalt
3,420.9
22,313
15,472
8,630
0.744

Grass
543.7
9,450
8,362
7,275
0.950

Building
2,883.3
19,429
13,663
7,896
0.942
Building
3,227.7
20,339
13,883
7,428
0.918

Soil
2,365.6
16,528
11,797
7,066
0.989
Soil
2,782.6
18,137
12,572
7,006
0.985

Concrete
1,177.7
13,755
11,400
9,044
0.943
Concrete
1,366.5
13,815
11,082
8,349
0.919

Tree
744.8
9,238
7,748
6,258
0.997

Water
701.8
9,153
7,750
6,346
0.998

Grass
649.3
9,116
7,817
6,518
0.948

Building
3,592.5
21,425
14,240
7,056
0.904

Soil
3,196.9
20,117
13,723
7,330
0.983

Concrete
1,524.5
14,392
11,343
8,294
0.908

Tree
404.0
7,634
6,826
6,018
0.976

Water
824.1
8,365
6,717
5,069
0.998

Grass
7,024.1
31,865
17,816
3,768
0.993

Building
5,582.4
29,122
17,958
6,793
0.744

Soil
4,733.1
25,302
15,836
6,370
0.974

Concrete
2,210.5
16,945
12,524
8,103
0.800

Tree
4,188.1
23,884
15,508
7,131
0.992

Water
905.1
8,050
6,240
4,430
0.996
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(f) Band 6: SWIR 1
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

(g) Band 7: SWIR 2
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

(h) Band 9: Cirrus
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

(i) Band 10: TIRS 1
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

Asphalt
2,270.8
19,131
14,590
10,048

Grass
1,335.2
16,595
13,925
11,255

Building
5,226.2
28,221
17,768
7,316

Soil
3,890.7
26,802
19,021
11,239

Concrete
2,119.6
17,002
12,762
8,523

Tree
1,206.9
12,302
9,888
7,474

Water
711.4
7,175
5,752
4,330

0.708

0.929

0.827

0.967

0.860

0.961

0.996

Asphalt
1,890.6
15,439
11,658
7,877

Grass
1,465.8
12,798
9,866
6,935

Building
4,598.9
24,238
15,040
5,842

Soil
2,999.1
23,380
17,382
11,383

Concrete
1,742.1
14,932
11,448
7,963

Tree
455.1
7,969
7,059
6,148

Water
518.4
6,574
5,537
4,500

0.811

0.973

0.860

0.958

0.889

0.917

0.995

Asphalt
14.5
5,076
5,047
5,018
0.936

Not Used
Grass
8.5
5,060
5,043
5,026
0.986

Building
12.6
5,069
5,044
5,018
0.920

Soil
7.2
5,047
5,033
5,018
0.971

Asphalt
3,553.1
33,868
26,762
19,656
0.996

Not Used
Grass
Building
2,036.0
3,063.9
31,269
34,408
27,197
28,281
23,125
22,153
0.998
0.990

Soil
1,318.9
29,876
27,238
24,601
0.992

Concrete
15.4
5,068
5,038
5,007
0.775

Concrete
2,271.6
32,974
28,431
23,887
0.989

Tree
11.1
5,072
5,050
5,028
0.973

Water
9.1
5,051
5,033
5,015
0.972

Tree
3,325.4
31,547
24,896
18,245
1.000

Water
658.2
28,434
27,117
25,801
1.000

Not Used
(j) Band 11: TIRS 2
Standard Deviation (SD)
m + 2SD
Mean (m)
m - 2SD
Autocorrelation (R)

Asphalt
2,796.5
29,856
24,262
18,669
0.996

Grass
1,682.9
28,299
24,933
21,568
0.998

Building
2,268.5
29,866
25,329
20,792
0.990

Soil
1,109.4
27,419
25,200
22,982
0.993

Concrete
1,734.4
28,893
25,424
21,956
0.992

Tree
2,707.2
28,290
22,876
17,461
1.000

Water
614.3
26,133
24,905
23,676
1.000

The bands for the decision criteria of each surface class were selected based on high
autocorrelation (R) values for the spectral bands (Table 34) and unique ranges of the spectral
reflectance values (Table 35). As shown in Table 30, band 1 (Coastal aerosol) is used for
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aerosol studies; and band 9 (Cirrus) is used for cirrus cloud contamination studies. So band 1 as
well as band 2 are not used for surface classification. Due to high resolution (100 meter), both
band 10 (Thermal Infrared 1) and band 11 (Thermal Infrared 2) are also not used for
establishing the decision criteria of each surface class. All bands from 2 to 7 were considered
for each surface class as follows:
1.

Asphalt: With high autocorrelation value (higher than 0.900), blue, green, or red bands
could be selected for the decision criteria of the asphalt surface class. However, Table 35
shows that these are confounding of reflectance values within the m ± 2s range in both
blue and green bands for asphalt. The red band with less confounding of reflectance
values within the m ± 2SD range was selected for the decision criteria for the asphalt
surface class.

2.

Building: The blue, green, or red bands with the high autocorrelation value (higher than
0.900) were suitable for establishing the decision criteria of the building surface class.
Table 35 shows confounding of reflectance values within the m ± 2SD range in blue and
red bands. So both blue and red bands were not selected. Only the green band with less
confounding of reflectance values within the m ± 2SD range was selected for establishing
the decision criteria of the building surface class.

3.

Concrete: The autocorrelation value of all bands from 2 to 7 is high (Table 34). As shown
in Table 35, the green, red, and SWIR 2 bands have a problem with confounding of
reflectance values within the m ± 2SD range between concrete and other surface class.
Therefore, the three bands were not selected. The blue band, which has the highest
autocorrelation of 0.934 and less confounding of reflectance values within the m ± 2SD
range, was selected for concrete. In addition, the NIR and SWIR 1 bands have less
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confounding of reflectance values within the m ± 2SD range between concrete and other
surface class; and their autocorrelation value is also high, so both the NIR and SWIR 1
bands were also recommended for the decision criteria of the concrete surface class.
4.

Grass: Table 34 indicates that the SWIR 2 band has the highest autocorrelation of 0.973
(Table 34). Moreover, Figure 4-9 also shows no confounding of reflectance values within
the m ± 2SD range in the SWIR 2 band between grass and other surface class. Therefore,
the SWIR 2 band was selected for the decision criteria of the grass surface class.

5.

Soil: Similar to the concrete surface class, the autocorrelation value of all bands from 2 to
7 for the soil surface class is also high (Table 34). However, only the SWIR 1 band has
the least confounding of reflectance values within the m ± 2SD range in the SWIR 1 band
between soil and other surface class. So the SWIR 1 band was selected for the decision
criteria of the soil surface class.

6.

Tree: Table 34 indicates that the autocorrelation value of all bands from 2 to 7 for the tree
surface class is high (higher than 0.917). However, most of these bands have problems
with confounding of reflectance values within the m ± 2s range between tree and other
surface class. Only the SWIR 1 band does not has a problems with confounding of
reflectance values. The reflectance values for the tree within the m ± 2s range do not
overlap with any of the other surface classes. Therefore, the SWIR 1 band was selected
for the decision criteria of the tree surface class.

7.

Water: As shown in Table 34, the autocorrelation value of all bands from 2 to 7 for water
surface class is very high (higher than 0.995). However, only the NIR band (R=0.996)
was selected for classification of water due to its uniqueness for identifying the water
surface class without confounding (overlap) with any of the other surface classes.
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4.3.3 Decision Criteria and Preliminary Surface Classification
4.3.3.1 Decision Criteria for Surface Classification
A preliminary decision criterion was established for surface classification based on the
criteria of high autocorrelation and uniqueness of band and its range of reflectance values.
Table 36 shows selected bands for each surface class. Basically, only one band is selected for
one surface class. However, Blue or SWIR 1 or NIR bands can be selected for concrete surface
class.

Table 36. Preliminary decision criteria for surface classification
Surface class
Band
Mean (m)
Standard
Deviation (SD)
Upper limit
(m + 2SD)
Lower limit
(m - 2SD)
Probability
Coefficient of
Variation
(COV)
Autocorrelation
(R)

Asphalt

Building

Concrete

Grass

Soil

Tree

Water

Red

Green

Blue

SWIR 1

NIR

SWIR 2

SWIR 1

SWIR 1

NIR

10,534

13,883

11,400

12,762

12,524

9,866

19,021

9,888

6,240

2,481.8

3,227.7

1,177.7

2,119.6

2,210.5

1,465.8

3,890.7

1,206.9

905.1

15,498

20,339

13,755

17,002

16,945

12,798

26,802

12,302

8,050

5,571

7,428

9,044

8,523

8,103

6,935

11,239

7,474

4,430

95%

95%

95%

95%

95%

95%

95%

95%

95%

23.6%

23.2%

10.3%

16.6%

17.7%

14.9%

20.5%

12.2%

14.5%

0.921

0.918

0.943

0.860

0.800

0.973

0.967

0.961

0.996

The statistical summary of the reflectance values for the groundtruth samples for each
surface class, including mean (m), standard deviation (SD), coefficient of variation (COV),
autocorrelation (R), and the upper limit (m + 2SD) and lower limit (m - 2SD) of the range of
reflectance values, is also presented in Table 10. The m ± 2SD range indicates a 95%
probability that the reflectance value of a given surface class pixel for the selected band falls
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within the selected range. All surface classes had autocorrelation values higher than 0.8 in their
selected bands.

4.3.3.2 Extracting Planimetries using Landsat-8 Satellite Imageries in Selected Sites
The planimetric map or vector map for each study site was extracted in GeoMedia Pro
using Landsat-8 pansharpened multispectral satellite imageries described in section 4.3.1.
Vector maps show detailed geometric and attribute information of infrastructures and other
features such as roads, buildings, parking areas, tree, grass, and water.
The basic procedures [85] for extraction of the vector maps are described as follows:
1.

Opening the Landsat-8 pansharpened multispectral satellite imagery in GeoMedia Pro.

2.

Defining entries, properties and style for the vector map legend, which includes several
classes of roads, buildings and other infrastructure, and natural surfaces.

3.

Drawing the vector map of each surface class using the Landsat-8 pansharpened
multispectral satellite imagery as a background. While drawing the vector map, Google
Earth was required to identify the correct surface type and geometry of the features.

4.

Removing the background imagery from the map window and save the remaining vector
map as a separate file. Note that this georeferenced vector map file can be exported as
AutoCAD format (.dx or .dwg) or shapefile format (.shp) that can be used in AutoCAD
and ArcGIS software.

5.

Calculating the areas of each vector map features using GeoMedia Pro's analysis.
Figure 47 shows a planimetric map of Miami, Florida, which was extracted using

Landsat-8 pansharpened multispectral satellite imageries described in Figure 45. The
planimetric features were only extracted within the boundary of Miami.
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Figure 47. Planimetric map of Miami, Florida

A surface type map was created by combining features in the planimetric map for each
study site. The surface type map includes seven surface classes (asphalt, building, concrete,
grass, soil, tree, and water). In each surface class, the planimetric features were combined using
Union function of GeoMedia Pro software. Figure 48 shows a surface type map of Miami,
Florida. This map was created using extracted planimetric features as shown in Figure 47.
In this research, the vector map extraction and surface type map are used to obtain
groundtruth information of built-up area and natural surfaces for validation of imagery based
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surface classification results. The area of each surface class was calculated and used as
groundtruth for accuracy assessment of classification results.

Figure 48. Surface type map of Miami, Florida

The planimetric and surface type maps of other study sites such as Gulfport, Los
Angeles, Sardis, Oxford, and Gwadar are shown in section C3 in Appendix C.

4.3.3.3 Preliminary Surface Classification
As presented in section 4.1.3, the ERDAS IMAGINE 2013 software [88] was used to
export pixel coordinates and spectral reflectance values of the Landsat-8 pansharpened
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multispectral satellite imagery in each site as an ASCII text file (.asc). The ASCII text file was
then converted to an ACCESS database (.mdb) file and imported in GeoMedia Pro. The
GeoMedia Pro 2013 geospatial analysis software [86] was used to perform the task of assigning
the pixels of the imagery to different surface classes according to the preliminary decision
criteria.
The "functional attributes” analysis of the GeoMedia Pro 2013 software [86] was used to
write logical expressions that compare the spectral reflectance values of each pixel with the
decision criteria and assign the pixels to the appropriate surface class [85]. Equation 4.2 shows
the basic syntax of the logical expression and Equation 4.3 shows an example for classification
of water surface class.
IF (Logical test, Value if True, Value if False)

(4.2)

IF(4,430 ≤ Input.NIR Band ≤ 8,050, 'Water', 'Non_Water')

(4.3)

The expression in Equation 4.2 yields one value if the decision criteria evaluate TRUE
and another value if it evaluates to FALSE. Therefore, in Equation 4.3 for water, if the
reflectance value of a pixel in the NIR band is equal to or larger than 4,430; and the pixel in the
NIR band is also less than or equal to 8,050, it is classified as 'Water', otherwise it is classified
as 'Non_Water'.


Preliminary Surface Classification W1 (PSC W1):
Based on the preliminary decision criteria for classifying each surface class

(Table 36), a multispectral decision tree criteria and workflow to auto-classify surface types for
landuse, and built infrastructure, and open natural terrain using Landsat-8 pansharpened
multispectral satellite imagery was developed and shown in Table 37 as follow.

131

Table 37. PSC W1 multispectral decision tree criteria and workflow to
auto-classify surface classes
Preliminary Surface Classification W1; Created on 10/7/2016
Surface
class legend
color

Spectral
Range

Yes
(if needed)

Blue

± 2SD

No

Dark Green

± 2SD

No

Light Green

± 2SD

Yes
(if needed)

Orange

± 2SD

No

Magenta

± 2SD

Asphalt (NA)
NA ≤ (NI - NC - NB)
5,571 ≤ Red Band ≤ 15,498

Yes
(if needed)

Gray

± 2SD

Soil (NS)
NS ≤ N – NN – NC – NB– NA

No

Yellow

Check unclassified (NU) pixels
NU = N – NN – NC - NB - NA -NS
Total pixels remaining

No

White

Steps

Multispectral decision tree criteria for
surface discrimination

Polygon
map

0

Define geospatial boundary of area of
interest (AOI)
Total pixels = N

Yes

1

Water (NW)
NW < N
4,430 ≤ NIR Band ≤ 8,050

2

Tree (NT)
NT < (N - NW)
7,474 ≤ SWIR 1 Band ≤ 12,302

3
4
5
6

7

8

9
10

Grass (NG)
6,935 ≤ SWIR 2 Band ≤ 12,798
Natural terrain (NN) without soil
NN = (NW + NT + NG) < N
Built Infrastructure (NI) with Soil
NI ≤ (N - NN)
Concrete (NC)
NC < NI
9,044 ≤ Blue Band ≤ 13,755
Building (NB)
NB < NI - NC
7,428 ≤ Green Band ≤ 20,339

The decision tree criteria is based on high autocorrelation R values for the spectral bands
and unique ranges of the spectral reflectance values. Also, try to use all bands from 2 to 7.
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As shown in Table 37, there are ten steps used for classifying seven surface classes. The
selected band used for each surface class is shown in Table 36.
The blue band was used for concrete in the PSC W1. It should be noted that after each
classification step, a spatial query was made to exclude all classified pixels from the subsequent
classification step. Therefore, once a pixel was classified as a given surface class, it was
excluded from classification of the remaining surface classes. For example, all pixels classified
as 'Water' in step 1 were excluded from classification of tree in step 2. The water, tree, and grass
surface classes, which have higher autocorrelation values and do not overlap of reflectance
values within the m ± 2SD range, were selected for three first steps. The decision criteria and
workflow of the PSC W1 were used to classify the six selected study sites.
Table 38 shows results of the PSC W1 and comparison between the PSC W1 and the
groundtruth for Miami, Florida. The first and second columns show the area in m2 and % for
each surface class calculated from extracted planimetrics. The fourth and fifth column show the
area in m2 and % for each surface class calculated from the PSC W1. The sixth column shows
the difference in percent between the groundtruth and the PSC W1 for each surface class.
Miami is a metropolitan area and bordered by Atlantic Ocean to the east. Water areas
cover more than 20% of the study area. Figure 49 shows a histogram plot of the comparison
between the groundtruth and the PSC W1for all surfaces in Miami, Florida. There was a 40.49
difference in percent area for building between the PSC W1 result and the groundtruth, which
indicates the most significant misclassification among the surface classes. This was mainly
because the decision criteria for building could not identify the small urban features such as
houses and small building blocks that are mixed with trees and grass in urban areas.
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Table 38. Comparison of PSC W1 with groundtruth for Miami, Florida
Surface Class

A Asphalt
B Building
C Concrete
BC
Building/Concrete
G Grass

Planimetrics
Percent
(Groundtruth)
Area
Area
m2
%
A1
A2
8,525,524
6.96
52,773,228
43.10
11,157,386
9.11

PSC W1
Area

Percent
Area

m2
B1
1,062,225
2,642,400
8,192,025

%
B2
0.87
2.16
6.69

Difference
Groundtruth
& PSC W1
%
A2-B2
6.10
40.94
2.42

Class

A
B
C

63,930,613

52.21

10,834,425

8.85

43.36

BC

9,122,647

7.45

33,325,650

27.22

-19.77

G

Soil

2,251,749

1.84

291,825

0.24

1.60

S

T Tree

10,926,615

8.92

48,129,750

39.31

-30.38

T

W Water

27,684,028

22.61

28,797,300

23.52

-0.91

W

0

0.00

0

0.00

0.00

U

SUM

122,441,175

100.00

122,441,175

100.00

0.00

Total Built
Infrastructure
(Building,Concrete,
Asphalt)
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)

72,456,137

59.18

11,896,650

9.72

49.46

90.28

-49.46

100.00

0.00

S

U Unclassified

SUM

(72.46 km2)
49,985,038

(11.88 km2)
40.82

(49.98 km2)
122,441,175
2

(122.44 km )

110,544,525
(110.54 km2)

100.00

122,441,175
2

(122.44 km )
MARE = 1.2942%
RMSE = 25,502,194.16 m2

Concrete surface class includes:





Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
The grass with a difference of -19.77% and tree with a difference of -30.38% also have

significant misclassification because many houses and buildings were misclassified by the grass
and tree. The water was well identified with only -0.91% difference from the groundtruth. The
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MARE and the RMSE were also calculated to measure the accuracy of the method. Table 38
shows that the MARE and RMSE values of the PSC W and the groundtruth. The MARE value
is 1.2942%; while the RMSE value is 25,502,194.16 m2.

Figure 49. Plot of comparison of the PSC W1 with the planimetrics for Miami, Florida

Results of the PSC W1 and comparison between the PSC W1 and groundtruth for other
study sites, such as Sardis in MS, Gulfport in MS, Los Angeles in California, Oxford in
Mississippi, and Gwadar in Pakistan, are shown in Table 38.
Table 39 shows a summary of the comparison between the groundtruth and the PSC W1
for six selected study sites. The MARE and the RMSE were also presented in Table 38 for each
site. Figure 50 shows histogram plots of the comparison between the groundtruth and the PSC
W1 for all surfaces in six selected sites.
As shown in Figure 50, both asphalt and water were well identified for all six sites with
less than 10% difference from the groundtruth. The percent difference was less than 15% for the
building and the tree in all sites, with the exception of Miami and Los Angeles. In Miami, the
difference from the groundtruth was 40.94% for the building, and -30.43% for the tree. In Los
Angeles, the difference from the groundtruth was 14.03% for building and -22.44% for tree.
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This was mainly because in urban areas such as Miami and Los Angeles, many small buildings
and houses were mixed with the trees, and grass, so the decision criteria for building could not
identify these urban features.
The concrete was also well identified for all sites with less than 10% difference from the
groundtruth, with the exception of Gwadar in Pakistan. Because most of the land areas in
Gwadar are covered by soil, many soil areas were misclassified as concrete. Similar to concrete,
the soil was also well identified for all sites, with the exception of Gwadar in Pakistan. As
explained for the concrete, many soil areas were misclassified as concrete.

Table 39. Comparison between the groundtruth and the PSC W1 for Selected Sites
Site

Surface Class

Sardis, MS

Gulfport, MS

Los Angeles, CA

Miami, FL

Oxford, MS

Gwadar, Pakistan

Difference
Planimetrics &
PSC W1

Difference
Planimetrics &
PSC W1

Difference
Planimetrics &
PSC W1

Difference
Planimetrics &
PSC W1

Difference
Planimetrics &
PSC W1

(%)
A2-B2
0.93
0.90
-1.24

(%)
A2-B2
2.80
14.08
-2.44

(%)
A2-B2
2.04
14.03
9.12

(%)
A2-B2
6.10
40.94
2.42

(%)
A2-B2
-2.19
2.55
1.66

(%)
A2-B2
0.03
-1.22
-33.96

-0.35

11.63

23.15

43.36

4.21

-35.18

-3.70
0.21
2.66
0.25
0.00
0.00

-0.92
1.51
-14.27
-0.76
0.00
0.00

-13.06
1.09
-22.44
9.22
0.00
0.00

-19.77
1.60
-30.38
-0.91
0.00
0.00

17.37
0.09
-19.12
-0.36
0.00
0.00

-1.31
36.99
-0.62
0.09
0.00
0.00

0.59

14.44

25.19

49.46

2.02

-35.15

-0.59

-14.44

-25.19

-49.46

-2.02

35.15

Difference
Legend
Planimetrics &
Color
PSC W1

A Asphalt
B Building
C Concrete
BC Building/
Concrete
G Grass
S Soil
T Tree
W Water
U Unclassified
SUM
Total Built Infrastructure
(Building,Concrete,
Asphalt)
Total Natural Terrain
(Water, Soil, Trees,
Grass)
SUM

0.00

0.00

0.00

0.00

0.00

0.00

MARE =
0.9213%
RMSE =

MARE =
0.5294%
RMSE =

MARE =
2.8675%
RMSE =

MARE =
1.2942%
RMSE =

MARE =
1.0132%
RMSE =

MARE =
5.8734%
RMSE =

1,723,310.08 m2

8,286,490.84 m2

22,522,393.43 m2

25,502,194.16 m2

791,199.58 m2

228,042,885.05 m2

A2: Percent area of planimetrics (groundtruth) ;

B2: Percent area of PSC W1
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(a)

(b)

(c)
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(d)

(e)

(f)
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(g)
Figure 50. Histogram plots for each surface at selected sites using the PSC W1

In summary, the results of the PSC W1 indicated that some surface classes such as
building, concrete, grass, and soil have significant misclassification. Therefore, further revision
of the decision criteria and classification methodology was required to improve the results.


Preliminary Surface Classification WT (PSC WT):
The PSC W1 results were poor, so the PSC W1 needs additional improvement. After

revising the PSC W1, the PSC WT was developed. Table 40 shows a multispectral decision tree
criteria and workflow of the PSC WT to auto-classify surface types for landuse, built
infrastructure, and open natural terrain using Landsat-8 pansharpened multispectral satellite
imagery.
The PSC WT also has ten steps used for classifying seven surface classes (Table 40).
The selected band used for each surface class is the same the selected band used in the PSC W1,
with the exception of concrete. For the PSC WT, SWIR 1 band was selected for the concrete
surface class. The three first steps were for classifying the water, tree, and grass surface classes
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because these surface classes have higher autocorrelation values than other surface classes, and
they also do not overlap of reflectance values within the m ± 2SD range. The decision criteria
and workflow of the PSC WT were applied for all six selected sites. Table 41 shows results of
the PSC WT and comparison between the PSC WT and the groundtruth for Miami, Florida.
As shown in Table 41, the MARE of the PSC WT and the groundtruth is 1.3768% and
RMSE of these two methods is 23,647,766.80 m2. Figure 51 shows histogram plot of the
comparison between the groundtruth and the PSC WT for all surfaces in Miami, Florida. The
building has 34.26% difference from the groundtruth. The difference of the building has slightly
improved in compared with difference of the building in the PSC W1. The difference from the
groundtruth for other surface classes does not much change, or there are no improvements for
other surface classes in Miami.
Results of the PSC WT and comparison between the PSC WT and groundtruth for other
study sites are shown in Table 41.
Table 42 shows a summary of the comparison between the groundtruth and the PSC WT
for six selected study sites. The MARE and the RMSE were shown in Table 42 for each site.
Figure 52 shows a histogram plots of the comparison between the results of the groundtruth and
the results of the PSC WT for all surfaces in six selected sites.
Similar to the PSC W1, the asphalt and water were also well identified for all six sites
with less than 10% difference from the groundtruth. For the building, with the exception of
Gwadar in Pakistan where soil areas were misclassified as concrete, the difference from the
groundtruth of the building in other sites is smaller than that of the building in these sites in the
PSC W1.
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Table 40. Preliminary surface classification WT multispectral decision tree criteria and workflow
to auto-classify surface classes
Preliminary Surface Classification WT; Created on 10/25/2016
Steps

Multispectral decision tree criteria for
surface discrimination

Polygon
map

Surface class
legend color

Spectral
Range

0

Define geospatial boundary of area of
interest (AOI)
Total pixels = N

Yes

1

Water (NW)
NW < N
4,430 ≤ NIR Band ≤ 8,050

Yes
(if needed)

Blue

± 2SD

2

Tree (NT)
NT < (N - NW)
7,474 ≤ SWIR 1 Band ≤ 12,302

No

Dark Green

± 2SD

3

Grass (NG)
6,935 ≤ SWIR 2 Band ≤ 12,798

No

Light Green

± 2SD

4

Natural terrain (NN) without soil
NN = (NW + NT + NG) < N

5

Built Infrastructure (NI) with Soil
NI ≤ (N - NN)
No

Magenta

± 2SD

Yes
(if needed)

Gray

± 2SD

Concrete (NC)
NC < NI
8,523 ≤ SWIR 1 ≤ 17,002

Yes
(if needed)

Orange

± 2SD

Soil (NS)
NS ≤ N – NN – NC – NB– NA

No

Yellow

Check unclassified (NU) pixels
NU = N – NN – NC - NB - NA -NS
Total pixels remaining

No

White

6

7

8

9

10

Building (NB)
NB < NI - NC
7,428 ≤ Green Band ≤ 20,339
Asphalt (NA)
NA ≤ (NI - NC - NB)
5,571 ≤ Red Band ≤ 15,498

The decision tree criteria is based on high autocorrelation R values for the spectral bands
and unique ranges of the spectral reflectance values. Also, try to use all bands from 2 to 7.
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Table 41. Comparison of PSC WT with groundtruth for Miami, Florida
Surface Class

Planimetrics
(Groundtruth)
Area

Percent
Area

m2

%

PSC WT
Area

Percent
Area

Difference
Planimetrics
&
PSC WT

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

8,525,524

6.96

1,069,875

0.87

6.09

A

B Building

52,773,228

43.10

10,826,775

8.84

34.26

B

C Concrete

11,157,386

9.11

0

0.00

9.11

C

BC
Building/Concrete

63,930,613

52.21

10,826,775

8.84

43.37

BC

G

Grass

9,122,647

7.45

33,325,650

27.22

-19.77

G

S

Soil

2,251,749

1.84

291,825

0.24

1.60

S

T

Tree

10,926,615

8.92

48,129,750

39.31

-30.38

T

27,684,028

22.61

28,797,300

23.52

-0.91

W

0

0.00

0

0.00

0.00

U

122,441,175

100.00

122,441,175

100.00

0.00

72,456,137

59.18

11,896,650

9.72

49.46

90.28

-49.46

100.00

0.00

W Water
U Unclassified
SUM
Total Built
Infrastructure
(Building,
Concrete, Asphalt)
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)

(72.46 km2)
49,985,038

(11.88 km2)
40.82

(49.98 km2)
122,441,175

110,544,525
(110.54 km2)

100.00

122,441,175

SUM
(122.44 km2)

(122.44 km2)
MARE = 1.3768%
RMSE = 23,647,766.80 m2

Concrete surface class includes:





Class

Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
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Figure 51. Plot of comparison of PSC WT with the planimetrics for Miami, Florida

Table 42. Comparison between the groundtruth and the PSC WT for Selected Sites
Site

Surface Class

Sardis, MS

Gulfport, MS

Los Angeles, CA

Miami, FL

Difference
Planimetrics &
PSC WT

Difference
Planimetrics &
PSC WT

Difference
Planimetrics &
PSC WT

(%)
A2-B2
0.93
-0.74
0.39

(%)
A2-B2
2.80
6.41
5.22

(%)
A2-B2
2.04
7.49
15.67

(%)
A2-B2
6.09
34.26
9.11

Difference
Planimetrics
&
PSC WT
(%)
A2-B2
-2.19
1.97
2.23

-0.35

11.64

23.16

43.37

4.21

-35.21

-3.70
0.21
2.66
0.25
0.00
0.00

-0.92
1.52
-14.27
-0.76
0.00
0.00

-13.06
1.09
-22.44
9.22
0.00
0.00

-19.77
1.60
-30.38
-0.91
0.00
0.00

17.37
0.09
-19.12
-0.36
0.00
0.00

-1.31
35.54
-0.62
0.04
0.00
0.00

0.59

14.43

25.19

49.46

2.02

-33.65

-0.59

-14.43

-25.19

-49.46

-2.02

33.65

Difference
Legend
Planimetrics &
Color
PSC WT

A Asphalt
B Building
C Concrete
BC Building/
Concrete
G Grass
S Soil
T Tree
W Water
U Unclassified
SUM
Total Built Infrastructure
(Building,Concrete,
Asphalt)
Total Natural Terrain
(Water, Soil, Trees,
Grass)
SUM

Oxford, MS

Gwadar, Pakistan
Difference
Planimetrics &
PSC WT
(%)
A2-B2
0.03
-34.56
0.88

0.00

-14.43

0.00

0.00

0.00

0.00

MARE =
0.5865%

MARE =
0.5342%

MARE =
2.8668%

MARE =
1.3768%

MARE =
1.0193%

MARE =
3.9895%

RMSE =

RMSE =

RMSE =

RMSE =

RMSE =

RMSE =
1,662,798.05 m2

6,813,927.62 m2 22,753,219.52 m2 23,647,766.80 m2

A2: Percent area of planimetrics; B2: Percent area of PSC WT
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790,991.92 m2 224,992,408.44 m2

There was a difference of only 0.88% for concrete in Gwadar, which is much
improvement in compared with the difference of the concrete in Gwadar in the PSC W1. For the
grass, soil, and tree, the difference from the groundtruth does not have much improvement in
comparison to the PSC W1.
In comparison to the PSC W1 results, the results of PSC WT have some improvements,
which show smaller percent difference from the groundtruth for most sites. However, the
building and soil still have high misclassification. For instance, in Gwadar in Pakistan, there
was a difference of -34.56% for concrete, and 35.54% for soil from the groundtruth. Therefore,
further revision of the decision criteria and classification methodology was required to improve
the results.

(a)

(b)
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(c)

(d)

(e)
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(f)

(g)
Figure 52. Histogram plots for each surface at selected sites using the PSC WT

4.3.4 L-BANS Auto-Classification Methodology
The results of preliminary surface classification in section 4.3.3.3, including the PSC
W1 and the PSC WT, were still poor. Therefore, the L-BANS auto-classification methodology
was developed based on pixel-by-pixel spectral reflectance values of the selected bands, as
discussed and shown in Table 36.
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Table 43 shows a multispectral decision tree criteria and workflow of the L-BANS autoclassification methodology to auto-classify surface types for landuse, built infrastructure, and
open natural terrain using Landsat-8 pansharpened multispectral satellite imagery. The three
first steps were always for classifying the water, tree, and grass surface classes because these
surface classes have higher autocorrelation values than other surface classes, and they also have
no confounding of reflectance values within the m ± 2SD range.
In both the PSC W1 and the PSC WT, the soil surface class was classified in step 9, after
all other surface classes were already classified in the previous steps. The remaining pixels are
only for the soil surface class. Therefore, the soil surface class in the PSC W1 and the PSC WT
did not require a band and criteria. Because of this reason, in an area dominated by the soil,
such as Gwadar in Pakistan, there is significant misclassification for the soil. In order to
improve the classification accuracy of the soil without confounding with other surface classes in
the L-BANS auto-classification methodology, the soil surface class was classified in step 4 after
classifying the water, tree, and grass surface classes. The SWIR 1 band was selected for the soil
surface class. The building surface class in the PSC W1 and the PSC WT was misclassified as
other surface classes, so in the L-BANS auto-classification methodology, the building surface
class was classified after classifying soil surface class. The green band was also selected for the
building surface class. After classifying building surface class, the concrete and asphalt were
classified as shown in step 8 and step 9. Unlike the PSC W1 and the PSC WT, the NIR band
was selected for concrete surface class in the L-BANS auto-classification methodology.
The decision criteria and workflow of the L-BANS auto-classification methodology
were implemented for all six selected sites.
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Table 43. L-BANS multispectral decision tree criteria and workflow to
auto-classify surface classes
L-BANS auto-classification, Created on 11/11/2016
Steps

L-BANS Multispectral decision tree
criteria for surface discrimination

Polygon
map

Surface class
legend color

Spectral
Range

0

Define geospatial boundary of area of
interest (AOI)
Total pixels = N

Yes

1

Water (NW)
NW < N
4,430 ≤ NIR Band ≤ 8,050

Yes
(if needed)

Blue

± 2SD

2

Tree (NT)
NT < (N - NW)
7,474 ≤ SWIR 1 Band ≤ 12,302

No

Dark Green

± 2SD

3

Grass (NG)
NG < (N - NW - NT)
6,935 ≤ SWIR 2 Band ≤ 12,798

No

Light Green

± 2SD

4

Soil (NS)
NS < (N - NW - NT-NG)
11,239 ≤ SWIR 1 Band ≤ 26,802

No

Yellow

± 2SD

5

Natural terrain (NN)
NN = (NW + NT + NG + Ns) < N

6

Built Infrastructure (NI)
NI ≤ (N - NN)
No

Magenta

± 2SD

Yes
(if needed)

Orange

± 2SD

7

8

Building (NB)
NB < NI
7,428 ≤ Green Band ≤ 20,339
Concrete (NC)
NC < (NI - NB)
8,103 ≤ NIR Band ≤ 16,945

9

Asphalt (NA)
NA ≤ (NI – NB – NC)

No

Gray

10

Check unclassified (NU) pixels
NU = N – NN – NB – NC – NA
Total pixels remaining

No

White

The decision tree criteria is based on high autocorrelation R values for the spectral bands
and unique ranges of the spectral reflectance values. Also, try to use all bands from 2 to 7.
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Table 44 shows results of the L-BANS auto-classification methodology and comparison
between the L-BANS auto-classification methodology and the groundtruth for Miami, Florida.
Table 44. Comparison of L-BANS with groundtruth for Miami, Florida
Planimetrics
(Groundtruth)
Area

Percent
Area

L-BANS
Area

Percent
Area

Difference
Planimetrics &
L-BANS

m2
A1

%
A2

m2
B1

%
B2

%
A2-B2

A Asphalt

8,525,524

6.96

832,050

0.68

6.28

A

B Building

52,773,228

43.10

1,920,825

1.57

41.53

B

C Concrete

11,157,386

9.11

500,175

0.41

8.70

C

BC
Building/Concrete

63,930,613

52.21

2,421,000

1.98

50.24

BC

G

Grass

9,122,647

7.45

33,325,650

27.22

-19.77

G

S

Soil

2,251,749

1.84

8,935,425

7.30

-5.46

S

T

Tree

10,926,615

8.92

48,129,750

39.31

-30.38

T

27,684,028

22.61

28,797,300

23.52

-0.91

W

0

0.00

0

0.00

0.00

U

SUM

122,441,175

100.00

122,441,175

100.00

0.00

Total Built
Infrastructure
(Building/Concrete
, Asphalt)

72,456,137

59.18

3,253,050

2.66

56.52

97.34

-56.52

100.00

0.00

Surface Class

W Water
U Unclassified

Total Natural
Terrain
(Water, Soil, Trees,
and Grass)
SUM

(72.46 km2)
49,985,038

(3.25 km2)
40.82

(49.98 km2)
122,441,175
(122.44 km2)

Class

119,188,125
(119.19 km2)

100.00

122,441,175
(122.44 km2)
MARE = 1.6982 %

RMSE = 26,116,502.82 m2

Concrete surface class includes:





Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
Table 44 shows that the MARE of the L-BANS auto-classification methodology and the

groundtruth is 1.6982 %, and RMSE of the L-BANS auto-classification methodology and the
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groundtruth is 26,116,502.82 m2. Figure 53 shows a histogram plot of the comparison between
the results of the groundtruth and the results of the L-BANS auto-classification methodology for
all surfaces in Miami, Florida.

Figure 53. Plot of comparison of L-BANS with the planimetrics for Miami, Florida

Figure 54 shows a spatial map of the L-BANS classification results in Miami. The map
was created using CAIT’s legend feature style [91] to represent the surface classes.
In Miami, the difference between the L-BANS classification results and the groundtruth
for building and tree surface classes do not much change in comparison with results of the PSC
W1 and the PSC WT. There are many houses and small buildings that mixed with trees and
grass in urban areas in Miami. In addition, the horizontal resolution of the Landsat-8
pansharpened multispectral satellite imagery, used for this analysis, is 15 m. That means the
decision criteria for building surface class in both the preliminary surface classification and the
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L-BANS classification could not identify a building or a house with an area is less than 225 m2
or one edge of the building is less than 15 m long. Therefore, the small buildings and houses in
Miami were misclassified as trees or grass.

Figure 54. Spatial map of Miami, Florida using L-BANS classification

Results of the L-BANS classification and comparison between the L-BANS
classification and groundtruth for other study sites, including Sardis, Gulfport, Los Angeles,
Oxford, and Gwadar, are shown from Table C1 to Table C5 in section C4 in Appendix C.
Spatial maps of the L-BANS classification results in these sites are shown from Figure C52 to
Figure C56 in Appendix C.
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Table 45 shows a summary of the comparison between the groundtruth and the L-BANS
classification for six selected sites.

Table 45. Comparison between the groundtruth and the L-BANS for Selected Sites
Site

Sardis, MS

Surface Class

Los Angeles, CA

Miami, FL

Oxford, MS

Gwadar, Pakistan

Difference
Planimetrics &
LBANS

Difference
Planimetrics &
LBANS

Difference
Planimetrics &
LBANS

Difference
Planimetrics &
LBANS

Difference
Planimetrics &
LBANS

(%)
A2-B2
0.97
0.85
0.34

(%)
A2-B2
3.04
13.84
4.85

(%)
A2-B2
1.83
15.08
15.66

(%)
A2-B2
6.28
41.53
8.70

(%)
A2-B2
0.63
2.66
-0.59

(%)
A2-B2
-1.67
1.20
0.87

1.19

18.68

30.74

50.24

2.07

-35.18

-3.70
-1.37
2.66
0.25
0.00
0.00

-0.92
-5.77
-14.27
-0.76
0.00
0.00

-13.06
-6.28
-22.44
9.22
0.00
0.00

-19.77
-5.46
-30.38
-0.91
0.00
0.00

17.37
-0.59
-19.12
-0.36
0.00
0.00

-1.31
1.51
-0.62
0.01
0.00
0.00

2.16

21.72

32.57

56.52

2.71

0.40

-2.16

-21.72

-32.57

-56.52

-2.71

-0.40

Difference
Legend
Planimetrics &
Color
LBANS

A Asphalt
B Building
C Concrete
BC Building/
Concrete
G Grass
S Soil
T Tree
W Water
U Unclassified
SUM
Total Built Infrastructure
(Building,Concrete,
Asphalt)
Total Natural Terrain
(Water, Soil, Trees, Grass)
SUM

Gulfport, MS

0.00

0.00

0.00

0.00

0.00

0.00

MARE =
1.3369 %

MARE =
0.9687 %

MARE =
3.4822 %

MARE =
1.6982 %

MARE =
1.3953 %

MARE =
5.5604 %

RMSE =
26,116,502.82 m2

RMSE =

RMSE =

787,786.73 m2

13,881,059.34 m2

RMSE =

RMSE =

RMSE =

1,749,737.55 m2

8,702,022.93 m2

24,877,739.49 m2

A2: Percent area of Groundtruth;
B2: Percent area of L-BANS

The MARE and the RMSE, calculated from the results of the groundtruth and the LBANS classification, were shown in Table 42 for each site. Figure 55 shows histogram plots of
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the comparison between the results of the groundtruth and the results of the L-BANS
classification for all surfaces in the six selected sites.
The histogram plots in Figure 54 show that the asphalt and water were well identified
for all sites with less than 10% difference from the groundtruth, especially water. The difference
from the groundtruth for water in Sardis, Gulfport, Los Angeles, Miami, and Oxford is less than
1%.

(a)

(b)
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(c)

(d)

(e)
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(f)

(g)
Figure 55. Histogram plots for each surface at selected sites using L-BANS

Results from the L-BANS classification for tree and grass surface class do not change
compared with the results of preliminary surface classification because both the tree and grass
surface classes used the same selected bands and also have the same order of classification.
By changing the selected band and order of classification for soil in the workflow in
Table 43, the results from the L-BANS classification for soil in Gwadar much improve in
comparison to results from the preliminary surface classification. The difference of the soil
decreases greatly with only 1.51% from the L-BANS classification.

155

For the building, with the exception of Miami that was already discussed, the difference
from the groundtruth of the building in Gwadar much improves in comparison to results from
the preliminary surface classification. The results from the PSC WT show that the difference
from the groundtruth for the building in Gwadar is -34.56%. The difference is much smaller,
with only 1.20% when the buildings in Gwadar were classified by L-BANS auto-classification
methodology. The difference from the groundtruth for the building using L-BANS autoclassification methodology in other sites such as Sardis, and Oxford is also small (less than 3%).
The concrete surface class was well identified in most selected sites. The difference
from the groundtruth for concrete is only 0.34% in Sardis, 4.85% in Gulfport, -0.59% in
Oxford, and 0.87% in Gwadar.
In conclusion, the L-BANS auto-classification methodology provides more accurate
results in comparison with the preliminary surface classification, including the PSC W1 and the
PSC WT. The L-BANS auto-classification methodology for classification of surface classes
using Landsat-8 pansharpened multispectral satellite imagery was recommended to use in other
sites such as Hai Phong in Vietnam.

4.3.5 Univariate Analysis of Variance (ANOVA) Analysis for Methodology Results of
Planimetric Groundtruth and L-BANS
The objective of this ANOVA is to observe if the means of surface class area in square
meter have statistical significant difference by using planimetric groundtruth and L-BANS
methods. This is an univariate analysis because only one response variable is analyzed.

4.3.5.1 Sample Design for Computation Simulations
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Table 46. Factorial for sample design by planimetric groundtruth method (Factor 1)
Sardis,
MS

Gulfport,
MS

Los Angeles,
CA

Miami,
FL

Oxford,
MS

Gwadar,
Pakistan

Total

Asphalt

Y1,1

Y1,2

Y1,3

Y1,4

Y1,5

Y1,6

6

Building

Y2,1

Y2,2

Y2,3

Y2,4

Y2,5

Y2,6

6

Concrete

Y3,1

Y3,2

Y3,3

Y3,4

Y3,5

Y3,6

6

Grass

Y4,1

Y4,2

Y4,3

Y4,4

Y4,5

Y4,6

6

Soil

Y5,1

Y5,2

Y5,3

Y5,4

Y5,5

Y5,6

6

Tree

Y6,1

Y6,2

Y6,3

Y6,4

Y6,5

Y6,6

6

Water

Y7,1

Y7,2

Y7,3

Y7,4

Y7,5

Y7,6

6

7

7

7

7

7

7

42

Factor 2
Factor 3

Total Samples

Table 47. Factorial for sample design by L-BANS method (Factor 1)
Factor 2
Factor 3

Sardis,
MS

Gulfport,
MS

Los Angeles,
CA

Miami,
FL

Oxford,
MS

Gwadar,
Pakistan

Total

Asphalt

Y’1,1

Y’1,2

Y’1,3

Y’1,4

Y’1,5

Y’1,6

6

Building
Concrete

Y’2,1
Y’3,1

Y’2,2
Y’3,2

Y’2,3
Y’3,3

Y’2,4
Y’3,4

Y’2,5
Y’3,5

Y’2,6
Y’3,6

6
6

Grass

Y’4,1

Y’4,2

Y’4,3

Y’4,4

Y’4,5

Y’4,6

6

Soil
Tree
Water

Y’5,1
Y’6,1
Y’7,1

Y’5,2
Y’6,2
Y’7,2

Y’5,3
Y’6,3
Y’7,3

Y’5,4
Y’6,4
Y’7,4

Y’5,5
Y’6,5
Y’7,5

Y’5,6
Y’6,6
Y’7,6

6
6
6

7

7

7

7

7

7

42

Total Samples

Table 46 and Table 47 show sampling designs based on the two methods, six
locations/seasons, and seven surface classes. There are 84 grand total samples.

4.3.5.2 Statistical Descriptive Summary
A two-way ANOVA analysis was conducted to analyze whether there is any sufficient
evidence of a significant difference in the means of the surface class area by the method (Factor
1), location/season (Factor 2), and surface class (Factor 3). A statistical descriptive summary,
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including number of methods, locations/seasons, and surface classes, mean, and standard
deviation of the surface class area, is shown in Table 48, Table 49 and Table 50.
Methods are at two levels. The dependent or response univariate variable, Y is surface
class area.

Table 48. Statistical data summary by methods
Factor 1
Method and

Level

Planimetric groundtruth
L-BANS

1
2

Factor 2
Locations/Seasons,
Factor 3
Surface Classes
(n)
1, 2, 3, …, 42
1, 2, 3, …, 42

Surface Class Area, Factor 1
Y = Mean
(m2)
40,843,190
40,843,190

Standard
Deviation
(m2)
129,046,867
127,471,170

Locations/seasons are at six levels.

Table 49. Statistical data summary by locations/seasons
Factor 2
Location/Season and

Sardis, MS
Gulfport, MS
Los Angeles, CA
Miami, FL
Oxford, MS
Gwadar, Pakistan

Level

1
2
3
4
5
6

Factor 1
Methods,
Factor 3
Surface Classes
(n)
1, 2, 3,…, 14
1, 2, 3,…, 14
1, 2, 3,…, 14
1, 2, 3,…, 14
1, 2, 3,…, 14
1, 2, 3,…, 14

Surface classes are at seven levels.
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Surface Class Area, Factor 2
Y = Mean
(m2)
13,267,736
15,294,825
26,335,575
17,491,597
1,145,443
171,523,962

Standard
Deviation
(m2)
22,171,471
14,348,137
35,958,967
17,571,221
2,215,863
281,139,992

Table 50. Statistical data summary by surface classes
Factor 3
Surface Class and

Asphalt
Building
Concrete
Grass
Soil
Tree
Water

Level

1
2
3
4
5
6
7

Surface Class Area, Factor 3

Factor 1 Method,
Factor 2
Location/Season

Y = Mean

(n)
1, 2, 3,…, 12
1, 2, 3,…, 12
1, 2, 3,…, 12
1, 2, 3,…, 12
1, 2, 3,…, 12
1, 2, 3,…, 12
1, 2, 3,…, 12

(m2)
3,340,155
10,173,158
4,837,293
16,644,463
76,265,054
27,008,312
147,633,893

Standard
Deviation
(m2)
5,998,952
16,275,446
8,642,425
13,223,307
169,076,715
23,140,843
272,634,669

4.3.5.3 Univariate ANOVA Model
Equation 4.5 shows the two-way ANOVA model used in the analysis that considers
method (Factor 1), location/season (Factor 2), and surface class (Factor 3).
yijk = µm + αi + βj + γk + eijk

(4.2)

where,
y
i
j
k
µm
αi
βj
γk
eijk

= square meter of surface class area (dependent variable)
= level of Factor 1 method (i = 1 Planimetric groundtruth, i = 2 L-BANS)
= level of Factor 2 location/season (j = 1 Sardis, MS, j = 2 Gulfport, MS, j = 3 Los
Angeles, CA, j = 4 Miami, FL, j = 5 Oxford, MS, and j = 6 Gwadar, Pakistan)
= level of Factor 3 surface class (k = 1 Asphalt, k = 2 Building, k = 3 Concrete,
k = 4 Grass, k = 5 Soil, k = 6 Tree, k = 7 Water)
= grand mean (for all sites in the whole world)
= effect of method factor (i = 1, 2)
= effect of location/season factor (j = 1, 2, 3, 4, 5, 6)
= effect of surface class factor (k = 1, 2, 3, 4, 5, 6, 7)
= error, randomly normal distribution and mean equal to zero

4.3.5.4 Hypothesis Testing for Two-Way ANOVA
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 Hypothesis Testing for Methods (Factor 1)
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of surface class area from planimetric
groundtruth method and the mean of surface class area from L-BANS
method are equal.
H0: µ1 = µ2
Alternative Hypothesis, H1: In the population, the mean of surface class area from planimetric
groundtruth method and the mean of surface class area from L-BANS
method are different.
H1: µ1 ≠ µ2
where,
µ1
µ2

= mean of surface class area from planimetric groundtruth method
= mean of surface class area from L-BANS method

Step 2: Select level of statistical significance, α
An α of 0.05 for probability of type one error was selected as the level of significance
for the ANOVA for surface class area because within any simulation, a α/2 (0.025) is for each
one side of the probability associated with rejecting a null hypothesis when it is true. The F
distribution sketch with α/2 = 0.025 is shown in Figure 56.
Figure 56 shows the α/2 equal to 0.025, which is shown at each end of the F distribution.
The α/2 (0.025) is two standard deviations away from the mean. This shows that within the
curve, 95% of all possibilities are contained within two standard deviations from the population
mean.
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Figure 56. The F distribution showing type I error

Step 3: Define criterion and decision rule for rejecting H 0, F value at α/2
The ANOVA uses the Ftest criteria and decision rule for hypothesis testing. This is done
by comparing the independent ratio level variables, through what is known as an Ftest. By
comparison of Fcritical and Ftest, the null hypothesis can be rejected or accepted. Fcritical is found
through a distribution of F table for given α value, while the Ftest is calculated through a
statistics program such as SPSS software [93]. Fcritical is defined in equation 4.6.
Fcritical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025
where,
dfb = degree of freedom between methods = K - 1
dfw = degree of freedom within the samples = N - K
K = Number of methods = 2
N = Number of total samples = 84
dfb
dfw

=2-1=1
= 84 - 2 = 82
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(4.3)

Fcritical is determined using Table C.5 [92]. The Table C.5 is only available for α = 0.01 and α =
0.05, so Fcritical for α/2 = 0.025 was interpolated as the following:
1. F value for α = 0.05 and F value for α = 0.01 were obtained using Table C.5.
F0.05, 1, 82 = 4.00
F0.01, 1, 82 = 7.08
2. Fcritical for α/2 = 0.025 was interpolated from F0.05, 1, 82 and F0.01, 1, 82.
Fcritical = F0.025, 1, 82

=

F0.05, 1, 82 + 2.5* ((F0.01, 1, 82 - F0.05, 1, 82)/4)

Fcritical = F0.025, 1, 82 = 4.00 + 2.5* ((7.08 – 4.00/4) = 4.00 + 1.93
Fcritical = F0.025, 1, 82 = 5.93 for α/2 (0.025)
Decision rule: Reject H0 if the Ftest exceeds the Fcritical (or Ftest > Fcritical).
In SPSS results, calculated α/2 ≤ selected α/2.

Step 4: Compute the Test Statistic, Ftest
The test statistic or Ftest for method was calculated using SPSS software [93]. Table 51
shows SPSS output for the two-way ANOVA. Detailed input and output results are shown in
section C5 in Appendix C.

Table 51. Two-way ANOVA test results from SPSS
Type III Sum of
Squares

df

Mean
Square

F

Sig. (p)

Corrected Model

4.965E+17a

12

4.137E+16

3.446

.001

Significant

Intercept

1.401E+17

1

1.401E+17

11.670

.001

Significant

Method

.298

1

.298

.000

1.000

Not significant

4.856
2.845

.001
.015

Significant
Significant

Source

Location/Season
2.915E+17
5
5.830E+16
Surface class
2.050E+17
6
3.416E+16
Error
8.525E+17
71 1.201E+16
Total
1.489E+18
84
Corrected Total
1.349E+18
83
a. R Squared = 0.368 (Adjusted R Squared = 0.261)
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Result

Step 5: Interpret the results for methods (SPSS results show Ftest and probability α
value)
Table 51 shows that Ftest of method is 0, and p value is 1.000.
According to decision rule, Ftest (0) < Fcritical (5.93), or p (1.000) > α/2 (0.025). Therefore, the null
hypothesis test (H0) failed to reject.
Therefore, in the population, there is no statistical significant difference by method considering
the means of surface class area.
 Hypothesis Testing for Locations/Seasons (Factor 2)
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of surface class area at each location/season
is equal.
H0: µ1 = µ2 = µ3= µ4 = µ5= µ6
Alternative Hypothesis, H1: In the population, the mean of surface class area at each
location/season is different.
H1: µ1 ≠ µ2 ≠ µ3 ≠ µ4 ≠ µ5 ≠ µ6
where,
µ1
µ2
µ3
µ4
µ5
µ6

= mean of surface class area in Sardis, MS
= mean of surface class area in Gulfport, MS
= mean of surface class area in Los Angeles, CA
= mean of surface class area in Miami, FL
= mean of surface class area in Oxford, MS
= mean of surface class area in Gwadar, Pakistan

Step 2: Select level of statistical significance, α
The α of 0.05 was already selected to test the statistical significance between
methods. For this reason, α remains the same.
Step 3: Define criterion and decision rules for rejecting H 0, F value at α/2
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F critical is defined in equation 4.7.
Fcritical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025

(4.4)

where,
dfb = degree of freedom between locations/seasons = K - 1
dfw = degree of freedom within the samples = N - K
K = Number of locations/seasons = 6
N = Number of total samples = 84
dfb
dfw

=6-1=5
= 84 - 6 = 78

Fcritical is determined using Table C.5 [92]. The Table C.5 is only available for α = 0.01 and α =
0.05, so Fcritical for α/2 = 0.025 was interpolated as the following:
1. F value for α = 0.05 and F value for α = 0.01 were obtained using Table C.5.
F0.05, 5, 78 = 2.37
F0.01, 5, 78 = 3.34
2. Fcritical for α/2 = 0.025 was interpolated from F0.05, 5, 78 and F0.01, 5, 78.
Fcritical = F0.025, 5, 78

=

F0.05, 5, 78 + 2.5* ((F0.01, 5, 78 - F0.05, 5, 78)/4)

Fcritical = F0.025, 5, 78 = 2.37 + 2.5* ((3.34 – 2.37)/4) = 2.37 + 0.61
Fcritical = F0.025, 5, 78 = 2.98 for α/2 (0.025)
Decision rule: Reject H0 if the Ftest exceeds the Fcritical (or Ftest > Fcritical).
In SPSS results, calculated α/2 ≤ selected α/2.
Step 4: Compute the Test Statistic, Ftest
The test statistic or Ftest for location/season was calculated using SPSS software [93]. The
SPSS output for the two-way ANOVA is shown in Table 51.
Step 5: Interpret the results for locations/seasons (SPSS results show Ftest and probability α
value)
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Table 51 shows that Ftest of location/season is 4.856, and p value is 0.001.
According to decision rule, Ftest (4.856) > Fcritical (2.98), or p (0.001) < α/2 (0.025). Therefore,
the null hypothesis test (H0) is rejected.
Therefore, in the population, there is statistical significant difference by location/season
considering the means of surface areas.
 Hypothesis Testing for Surface Classes (Factor 3)
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of area of each surface class is equal.
H0: µ1 = µ2 = µ3= µ4 = µ5= µ6= µ7
Alternative Hypothesis, H1: In the population, the mean of area of each surface class is
different.
H1: µ1 ≠ µ2 ≠ µ3≠ µ4 ≠ µ5 ≠ µ6 ≠ µ7
where,
µ1
µ2
µ3
µ4
µ5
µ6
µ7

= mean of area of asphalt surface
= mean of area of building surface
= mean of area of concrete surface
= mean of area of grass surface
= mean of area of soil surface
= mean of area of tree surface
= mean of area of water surface

Step 2: Select level of statistical significance, α
The α of 0.05 was already selected to test the statistical significance between
methods and among locations/seasons. For this reason, α remains the same.
Step 3: Define criterion and decision rules for rejecting H 0, F value at α/2
F critical is defined in equation 4.8.
Fcritical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025
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(4.5)

where,
dfb = degree of freedom between surface classes = K - 1
dfw = degree of freedom within the samples = N - K
K = Number of surface classes = 7
N = Number of total samples = 84
dfb
dfw

=7-1=6
= 84 - 7 = 77

Fcritical is determined using Table C.5 [92]. The Table C.5 is only available for α = 0.01 and α =
0.05, so Fcritical for α/2 = 0.025 was interpolated as the following:
1. F value for α = 0.05 and F value for α = 0.01 were obtained using Table C.5.
F0.05, 6, 77 = 2.25
F0.01, 6, 77 = 3.12
2. Fcritical for α/2 = 0.025 was interpolated from F0.05, 6, 77 and F0.01, 6, 77.
Fcritical = F0.025, 6, 77

=

F0.05, 6, 77 + 2.5* ((F0.01, 6, 77 - F0.05, 6, 77)/4)

Fcritical = F0.025, 6, 77 = 2.25 + 2.5* ((3.12 – 2.25)/4) = 2.25 + 0.54
Fcritical = F0.025, 6, 77 = 2.79 for α/2 (0.025)
Decision rule: Reject H0 if the Ftest exceeds the Fcritical (or Ftest > Fcritical).
In SPSS results, calculated α/2 ≤ selected α/2.
Step 4: Compute the Test Statistic, Ftest
The test statistic or Ftest for surface class was calculated using SPSS software [93]. The
SPSS output for the two-way ANOVA is shown in Table 51.
Step 5: Interpret the results for surface class (SPSS results show Ftest and probability α
value)
Table 51 shows that Ftest of surface class is 2.845, and p value is 0.015.
According to decision rule, Ftest (2.845) > Fcritical (2.79), or p (0.015) < α/2 (0.025).
Therefore, the null hypothesis test (H0) is rejected.
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Therefore, in the population, there is the statistical significant difference by surface class
considering the means of surface areas.
Figure 37 shows an SPSS plot of the mean of the surface areas from two methods and six
locations/seasons. On the plot, the line of planmetric groundtruth method parallels and almost
overlaps on the line of L-BANS method. This indicates that the difference of the mean of surface
class area from the planimetric groundtruth method and the mean of surface class area from LBANS method is not statistically significant.
Figure 58 shows an SPSS plot of the mean of the surface areas from two methods and
seven surface classes. On the plot, the line of planimetric groundtruth method parallels and
almost overlaps on the line of L-BANS method. This indicates that the difference of the means
of surface class area from planimetric groundtruth method and the means of surface class area
from L-BANS method is not statistically significant by method.

Figure 57. SPSS plot of the mean of the surface areas from two methods in six locations/seasons
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Figure 58. SPSS plot of the mean of the surface areas from two methods in
seven surface classes

In addition, these lines on Figure 58 go up and down depending on surface classes, which
mean there is statistical significant difference in the means of surface areas by surface class.
Figure 59 shows an SPSS plot of the mean of the surface areas from seven surface class
and six locations/seasons. On the plot, the lines of surface classes parallel each other’s. But
these lines do not overlap.
For example, the line of water surface class is much higher than that of other surface
classes. This indicates that there is statistical significant difference in the means of surface areas
by location/season; and the means of surface areas by surface class also have statistically
significant difference.
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Figure 59. SPSS plot of the mean of the surface areas from seven surface classes
in locations/seasons

4.3.6 Comparison of the L-BANS Results with Supervised Surface Classification Results for
Miami, Florida
The Landsat-8 pansharpened multispectral satellite imagery of Miami, Florida, which
covered 122 km2, was selected for classifying surface classes in Miami using the three
traditional supervised classification methods in the ERDAS IMAGINE software [88]. The
traditional supervised classification methods include minimum distance, mahalanobis distance,
and maximum likelihood. The minimum distance method uses a decision rule to calculate the
spectral distance between the measurement vector for the candidate pixel and the mean vector
for each signature. The mahalanobis distance method is similar to minimum distance method,
except that the covariance matrix is used, and the histograms of the bands are assumed as
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normal distributions. The maximum likelihood method evaluates both the variance and
covariance of the category spectral response patterns when classifying imagery pixels [85]. The
traditional supervised classification methods use spectral signatures of surface classes to train
the classification algorithm and assign the imagery pixels to one of the surface classes [85]. The
spectral reflectance signature files of seven surface classes, including asphalt, building,
concrete, grass, soil, tree, and water, were collected from the Landsat-8 pansharpened
multispectral satellite imagery of Miami. Then the spectral reflectance signature files were used
by the three traditional supervised classification methods for classifying surface areas in Miami.
The results of the three methods were compared with the L-BANS classification results.
L- BANS is a geospatial auto-classification methodology based on pixel-by-pixel spectral
reflectance values of pansharpened multispectral imagery. Figure 60 and Table 52 show of
results the three traditional supervised classification methods and the comparison to the LBANS classification results.
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Results of the minimum distance, mahalanobis distance, and maximum likelihood
methods and comparison between the methods and groundtruth for Miami are shown in details
from Table C8 to Table C10 in section C6 in Appendix C. The spatial maps of the three
methods are also shown from Figure C59 to Figure C61 in Appendix C.
Table 52 shows the difference in percent between each classification method result and
the groundtruth. The asphalt of the L-BANS classification method has 6.3% difference from the
groundtruth, which is smaller than the difference from the groundtruth of the mahalanobis
distance and maximum likelihood methods. However, the minimum distance method has the
smallest difference from the groundtruth for asphalt with only -0.3%. The difference from the
groundtruth for the buildings of the L-BANS classification method is the smallest in
comparison to the three traditional methods. This indicates L-BANS classification method gives
better results for buildings than the traditional methods. The difference from the groundtruth for
the concrete of the L-BANS classification method is smaller than that of the minimum distance
method. For the grass and soil surface class, L-BANS classification method gives smaller
difference from the groundtruth compared with the mahalanobis distance and maximum
likelihood methods. For water, the L-BANS classification method was evaluated as the best
method for classifying water, with only -0.9% difference from the groundtruth. The MARE,
RMSE, and NASSDA were also calculated to evaluate the accuracy of each method (Figure 418).
In summary, the L -BANS classification method gives more accurate results for surface
classification compared with the mahalanobis distance and maximum likelihood methods. In
comparison to the minimum distance method, the L -BANS classification method give more
accurate results for classifying building, concrete, and water surface classes.
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4.4

Implementation of the L-BANS Auto-Classification for Hai Phong City, Vietnam
The L-BANS auto-classification methodology was implemented for classification of the

Landsat-8 pansharpened multispectral satellite imagery of Hai Phong, Vietnam, covering an
area of 261 km2. The L-BANS classification results of the city are shown in Table 53. A spatial
map of Hai Phong created by the L-BANS classification methodology is shown in Figure 61.
Table 53. The L-BANS classification results of Hai Phong, Vietnam
Surface Class

A Asphalt
B Building
C Concrete
BC Building/Concrete
G Grass
S Soil
T Tree
W Water
U Unclassified
SUM
Total Built Infrastructure
(Building, Concrete, Asphalt)
Total Natural Terrain
(Water, Soil, Trees, and Grass)
SUM

L-BANS Area

Percent Area

m2

%

B1

B2

8,786,250
40,756,275
6,594,750
47,351,025
47,453,850
95,625
90,814,275
66,915,900
0
261,416,925
56,137,275

3.36
15.59
2.52
18.11
18.15
0.04
34.74
25.60
0.00
100.00
21.47

(56.14 km2)
205,279,650

78.53

2

(205.28 km )
261,416,925
(261.42 km2)

100.00

As shown in Table 53, total built infrastructure is 21.47% of the study area. The built
infrastructure includes asphalt, buildings, and concrete. Some important infrastructures of the
city, such as port docks, and airport runways, also belong to the built infrastructure group. The
remaining 78.53% of the area was covered with natural terrain surfaces with 18.15% grass,
0.04% soil, 34.74% trees, and 25.60% water.
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Figure 61. Spatial map of Hai Phong, Vietnam, using L-BANS classification

4.5

Application of the L-BANS Auto-Classification of Surface Types and Landuse
One of the most advanced benefits of the L-BANS classification methodology is the

ability to automatically classify the surface classes using free Landsat-8 satellite imageries. The
L-BANS classification method took approximately 2.5 hours total on average for each selected
site in the United States. The planimetrics method for each of these sites took on average 100
hours longer to perform than did the L-BANS classification method.
The L-BANS classification methodology can be applied for auto-classification for areas
where planimetrics are not available. The planimetrics method is expensive because it takes
much time to implement for each site and requires manual drawing for each feature. Therefore,
planimetric data are not available for many sites. For this case, the L-BANS classification
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methodology brings large benefits for these sites because it only takes few hours to run and uses
free Landsat-8 satellite imagery data.
In the port areas, the L-BANS classification methodology can be used for autoclassification for landuse areas that is helpful for making a plan for a port or designing a new
facility area for the port. In addition, the classified landuse areas can be used to assess the
damage of port infrastructures caused by natural disasters.
Another application of the L-BANS classification methodology is to evaluate the
economic loss and damage cost due to flood disaster caused by extreme rainfall or tsunami. The
Landsat-8 satellite imageries cover the entire Earth, and their scenes are updated every 16 days;
so in any flood areas, pre-and post-flood Landsat-8 satellite imageries can be acquired. The preand post-disaster surface class areas are then created by using the L-BANS classification
methodology. By comparing the difference in km2 between pre- and post-disaster surface areas
for each surface class and calculating inundated/submerged areas, a damage cost of the flood
area can be calculated using the damage cost equation developed by Wodajo [85].
The L-BANS classification methodology can also apply for estimating heat-island
effects. Based on the surface classification results from the L-BANS classification analysis of
the Landsat-8 satellite imageries of the study site, the surface temperature of the area can be
estimated for the purpose of evaluating the adverse impact of built-up areas on air quality as
well as greenhouse gasses emission.
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V. FLOODPLAIN SIMULATION STUDIES TO ENHANCE DISASTER RESILIENCE
5.1

Overview of Methodologies for Flood Impact Assessment Studies

5.1.1 Sources of Digital Elevation Model Data
5.1.1.1 Traditional Ground Based Total Station Topographic Survey
Ground Based Total Station Topographic Surveys with kinematic GPS or total station
survey instruments are always required to establish geodetic controls and horizontal and vertical
coordinates of chosen points on locations of NAVAID equipment. Conventional field methods
are also used to provide ground truth data by manually measuring positions and heights of a
limited number of potential obstructions. The GPS coordinate data are also collected on selected
ground control points for the purpose of aerotriangulation used for georeferencing and
orthorectification in the photogrammetry process [95].

5.1.1.2 Traditional Photogrammetry Survey
Photogrammetry for obstruction analysis required aerial photography to be taken at low
altitudes. Field surveys have to be done to identify and position man-made and natural objects
not readily visible in photography, such as transmission lines, tall and thin towers, antennas, and
trees without canopies. It should be acknowledged that the photogrammetric method requires
‘seeding’ elevations of known ground features and substantial experience for reliable and
accurate office data processing to extract three-dimensional (3-D) stereoscopic data for discrete
locations to identify potential obstructions [94]. Traditional photogrammetric methods are
suitable for an open area, but do not have the accuracy for wooded and vegetative areas [95].
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5.1.1.3 Airborne LIDAR Survey
LIDAR stands for LIght Detection And Ranging. The electromagnetic spectrum is
defined in terms of wavelength, with light ranging from about 1mm for the far infrared to about
10 nm for the extreme ultraviolet. The remote sensing LIDAR pulse measurements in nearinfrared band use laser pulses from a low-altitude aircraft to transmit and receive
electromagnetic radiations. Because the time of return and the light speed are known, the
vertical distances from aircraft to the ground can be calculated [95].
This method uses high-accuracy GPS receivers with aircraft avionics. Several ground
GPS control points are used for accuracy checks [94].
After the flight mission, the collected 3-D vector cloud point data can be easily uploaded
to computer workstations for post-processing and interpretation. Next, the horizontal
coordinates named as the North American Datum of 1983 (NAD 83), and vertical elevation
known as the North American Vertical Datum of 1988 (NAVD 88) are calculated for each 3-D
point. The digital data processing workflow is completely computerized without handling any
manual data [94].
Airborne LIDAR survey, often named Airborne Laser Terrain Mapping (ALTM)
technology, is known as a cost-effective and useful method for creating a high resolution digital
terrain model (DEM), contours for transportation, and environmental applications for
significantly reduced cost with significant time saved [95].
The LIDAR can survey day and night, at altitudes between 300 to 900 m (1,000 to 3,
000 ft) above ground, over any terrain, and through most vegetation and canopy. The flexibility
of day and night missions depends on usual constraints of flying aircrafts at relatively low
altitudes due to applicable aviation rules [95].
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The LIDAR DEM can be used to increase the remote sensing aerial or satellite imagery
data for the plans and designs of transportation and other infrastructure projects, which includes:
highway and railway corridors, airports, intermodal facilities, land use planning, ecological and
environmental assessment, and forest canopy monitoring [96].
Airborne LIDAR data for both canopy and bare ground can generate accurate DEM,
contours for engineering design and flood plain modeling, and planimetrics for GIS mapping of
infrastructure and forestry canopy. Commercial terrestrial LIDAR technology is most suitable
for mapping hard-to reach remote areas, and interior mapping of critical infrastructures:
historical landmarks, archeological sites, and forest canopy areas [96].
Uddin [96] has documented the spatial accuracy and cost-effectiveness of airborne
LIDAR surveys. The time and cost reduction of using airborne LIDAR and spatial coverage
with ±13 cm elevation accuracy, along with traditional methods were established in a 9 km
highway alignment project in Mississippi. Additionally, Uddin [96] also indicated that 33% cost
reduction and 35% time reduction was achieved by combining LIDAR with traditional methods.
Traditionally, aerial photography and stereophoto analysis have been used for
identifying obstructions in relation to specific obstruction identification surfaces. However,
weather conditions affect the collection of such data. LIDA data provides the benefit of
operation at day and night as well as in some inclement weather conditions [96].

5.1.1.4 Shuttle Radar Topography Mission
The Shuttle Radar Topography Mission (SRTM) is a cooperative project between the
National Geospatial-Intelligence Agency (NGA) and the National Aeronautics and Space
Administration (NASA). Production of digital topographic data for 80% of the Earth's land
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surface (all land areas between 60° north and 56° south latitude), with data points located every
1-arc second (approximately 30 meters) on a latitude/longitude grid, is the main objective of
this project [97].
Radar interferometry is a technique used for SRTM. In radar interferometry, the
antennas separated by a fixed distance were used to collect radar data sets. At the same time two
radar data sets were collected. One data set was collected by the main antenna onboard the
space shuttle, and the other data set was collected by the outboard antenna located at the end of
the 60 meter (200 foot) mast [97].

Figure 62. Radar signals being transmitted and received on the SRTM mission

For SRTM, a beam of radar waves was transmitted. When the radar waves met the
surface of the Earth, rays were scattered in different directions. These scattered waves collected
by the two SRTM antennas are shown in Figure 62. Accurate elevation of the Earth's surface
can be calculated using the information about the distance between the two antennas and the
differences in the reflected radar wave signals.
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SRTM data can be used by military, civil, and scientific user communities. The data is
also needed for any project that requires accurate knowledge of the shape and height of the land
such as flood control, soil conservation, reforestation, volcano monitoring, and earthquake
research [97].

5.1.1.5 Accuracy of DEM
DEM data are basically created from large LIDAR point collections. DEM is usually
expressed by the grid cell size and the accuracy of the elevation. DEM data may have
differences in cell size resolution, which is created using the resampling technique. According
to USGS [98], cubic convolution and bilinear interpolation are the preferred methods of
resampling digital elevation data. These two methods are known as the best for preserving DEM
accuracy and terrain characteristics. Figure 63 shows DEM data with cell size (a) 30m x 30 m,
(b) 10m x 10 m, (b) 50m x 50 m, (d) (b) 2.5m x 2.5 m.

30 m

30 m

10 m
5m
10

5m

(a)

(b)

2.5
2.5

(c)

Figure 63. DEM data with difference cell size resolution

5.1.1.6 NED Elevation Data Accuracy

180

(d)

The National Elevation Dataset (NED) is the key elevation data product produced by the
U.S. Geological Survey (USGS). The NED provides elevation data coverage of the continental
United States (CONUS), Alaska, Hawaii and the island territories, Mexico, and Canada in a
seamless format with a consistent projection, resolution, elevation unit, and horizontal and
vertical datums. The horizontal datum for NED is the North American Datum of 1983 (NAD
83), and the vertical datum is the North American Vertical Datum of 1988 (NAVD 88) [99,
100].
The accuracy of the NED differs spatially because of the variable quality of the source
data. The April 2013 release version of the dataset was tested by comparing it with an
independent reference source in order to detailed information to users on the vertical accuracy
of the NED [101]. The overall absolute vertical accuracy for each area is the root mean square
error (RMSE), a widely used error metric for documenting elevation data accuracy. Accuracy is
expressed in terms of the National Map Accuracy Standards (NMAS), which use a 90 percent
confidence level, and in terms of the National Standard for Spatial Data Accuracy (NSSDA).
According to Open-File Report 2014-1008 [101], the RMSE for the NED covering
CONUS is 1.55 m [100, 101] and the NSSDA of 3.04 m [101]. Because the NED results from
source DEMS that were produced with some different methods. It may be essential for users to
know what levels of accuracy can be expected for the areas based on DEMs produced with
various methods. The RMSE for the LIDAR method is 0.87 m, and the RMSE for the
Photogrammetric mass points and break lines method is 1.15 m [101].
Relative accuracy is also an important parameter of vertical accuracy, and it is a measure
of just random errors. The relative vertical accuracy of a dataset is especially important for
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derivative products that use the local differences among adjacent elevation values. For CONUS,
the relative vertical accuracy is 0.81 m [100, 101].

5.1.1.7 Comparison of DEM Accuracy of Traditional Ground Based and Remote Sensing
Method and Airborne LIDAR Data Accuracy
The elevation data from the traditional ground based total station topographic survey is
the best and most accurate topographic survey method with an accuracy of better than 3 mm
[103]. The elevation accuracy or RMSE, of the traditional photogrammetry survey method is
1.36 m [103]. The LIDAR survey provides low-altitude, high speed laser scanning up, and
accuracy of the LIDAR survey is about 0.15 m for flat terrain and 0.23 - 0.38 m for sloped
terrain [103]. In the Raleigh Bypass study with 62% of the site having steep slopes, the RMSE
of all LIDAR centerline elevation data is 0.28 m [103].
In this study, the 2 ft DEM contour data were used for rainfall flood, sea level rise, and
tsunami simulations at Gulfport, Mississippi and Miami, Florida. The 2 ft DEM contour data
used for Gulfport, Mississippi was collected from the Mississippi Automated Resource
Information System (MARIS) [104]. The 2 ft DEM contour data used for Miami, Florida were
collected from the Florida Geographic Data Library (FGDL) [105]. Both 2 ft DEM contour
data was generated from LIDAR data. The RMSE of the 2 ft DEM data is 0.3 ft (9 cm) [104,
105].

5.1.1.8 SRTM Elevation Data Accuracy
Further research comparing SRTM data with the NED was conducted [99]. Results
indicated that both SRTM data with the NED errors are strongly correlated with slope. Figure
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5-3 shows that 31.5% is the largest difference between the NED and SRTM for 45 degree
aspect, and 4.8% is the smallest difference between the NED and SRTM for rat/not-flat [101,
102].
Ranges of RMSE and the NSSDA of absolute vertical accuracy of SRTM data were
calculated by the following Equations.
 Lower range of Accuracy: RMSESRTM (L) = 1.55 (1+0.048) = 1.62 m

(5.1)

 Upper range of Accuracy: RMSESRTM (U) = 1.55 (1+0.315) = 2.04 m

(5.2)

 Lower range of NSSDA: NSSDASRTM (L) = 3.04 (1+0.048) = 3.19 m

(5.3)

 Upper range of NSSDA: NSSDASRTM (U) = 3.04 (1+0.315) = 4.00 m

(5.4)

Figure 64. Differences in NED and SRTM elevation for corresponding points

The range of RMSE of SRTM data is from 1.62 m to 2.04 m, and the range of NSSDA
of SRTM data is from 3.19 m to 4.00 m. Ranges of the relative vertical accuracy of SRTM data
were calculated by the following Equations.
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 Lower range of the vertical accuracy of SRTM data = 0.81(1+0.048) = 0.85 m (5.5)
 Upper range of the vertical accuracy of SRTM data = 0.81(1+0.315) = 1.07 m

(5.6)

Range of the relative vertical accuracy of SRTM data is from 0.85 m to 1.07 m.

5.1.2 Methodologies for Flood Impact Assessment Studies
Port cities are a vital component of the global economy and are increasingly becoming
important concentrations of population and asset value. Thirteen out of the twenty most
populated cities in the world in 2005 were port cities. In addition, their economic importance in
terms of international trade has grown significantly, particularly in developing countries, in line
with globalization and the rapid development of newly industrialized countries [15]. By
increasing the population in port cities, the threat of flooding is possible to increase [106].
According to the World Bank [107], flood damages for the world's largest coastal cities could
cost 1 trillion U.S. dollars annually by 2050 if cities do not take steps to adapt. Floodplain
modeling is an important step for the hydrological research and vital for engineers and planners.
Early manual methods to model floodplain need considerable time and effort [15].
Genovese et al. [109] conducted damage assessment from storm surge to coastal and
port cities. The Miami metropolitan area was selected as a case study for this research. Miami is
known as a low-lying city with most of the population living below an elevation of 10 m and is
located in a region where tropical cyclones hit frequently. The impact of different storm surges
predicted by the computerized model SLOSH (Sea, Lake, and Overland Surge from Hurricanes)
and investigated flood risks with current sea level, considering different hurricane parameters
(storm category and direction, wind speed, and tide level), were considered. SLOSH is a
computerized model developed by the American National Weather Service (NWS) to estimate
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storm surge heights and winds resulting from historical hypothetical or predicted hurricanes.
SLOSH is used to define potential flooding from storm surge, for a given location, and from a
threatening hurricane. For each impact, a damage function was applied and the considered
storms surges potentially leading to asset loss were determined. The results indicated that, in
absence of protections, losses will be very high for large storm surges reaching up to tens of
billions of U.S. dollars. In the second part of the analysis, the goal is to determine how the
economic impact changes when protections are built up, considering different dams’ heights.
The results showed that raising flood defenses would be beneficial, since the consequences of a
storm surge could be enormous.
Another methodology for estimating flood impact among natural hazards is the HAZUSMA flood model [110]. HAZUS-MA flood model was developed by the U.S. Army Corps of
Engineers [110] to address both property and contents damage from flooding. The model,
managed and distributed by the Federal Emergency Management Administration, is capable of
interpreting flood characteristics such as flood extent, depth, and duration. However, HAZUSMA flood model does not state the whole story on damages. It covers property losses while it
does not capture other costs such as infrastructure damage (bridges, highways, electricity
network facilities) and agricultural losses. Fortunately, there are well developed methods of
measuring these losses. Flood maps can also provide the basis for determining infrastructure
repair costs and whether and to what extent transportation networks (air, rail, and highway) will
be out of service because of flood waters. In 2013, California’s Department of Water
Resources, for example, used the model to estimate potential flood damage in all 58 counties.

5.2

Review of 1-D and 2-D Flood Modeling and Simulation Methodologies
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5.2.1 CCHE2D-FLOOD Flood Modeling and Simulation Methodology
The results of a flood simulation project for disaster risk mapping, conducted at the
University of Mississippi [113], are used in this research as a preliminary study. The 2012-25
flood simulation project was implemented by the Center for Advanced Infrastructure
Technology (CAIT) and the National Center for Computational Hydroscience and Engineering
(NCCHE). In this project, a two-dimensional (2-D) flood modeling software CCHE2D-FLOOD
[114] was simulated over large area in Sardis, Mississippi. The CCHE2D-FLOOD software is a
component of the Decision Support System for Water Infrastructural Security (DSS-WISE)
software package developed by NCCHE [114]. It combines a state-of-the-art two dimensional
numerical model with a digital elevation model of the study area. Major steps for flood
simulation [115] using CCHE2D-FLOOD software include:
1.

Create planimetrics and coordinates of river centerline, cross sections, highways, rail
lines and other built infrastructure assets based on satellite imagery.

2.

Set up a geospatial domain for flood simulation software CCHE2D-FLOOD and
resampling the DEM based on a specified computational cell size.

3.

Run extreme flood simulations for high-resolution bare ground DEM.

4.

Analyze flood simulation outputs for floodwater vectors.

5.

Use floodwater simulation results for assessment of the flood impacts on infrastructure
features in the study area.
The extreme flood simulation results for the pilot Sardis site, considering 10 m square

computation cells of the bare ground, showed that a total area 58 km2 inundated. Maximum
floodwater inundation depth reaches 7.53 m at the highway bridge on US-51.
5.2.2 1-D HEC-RAS Flood Modeling and Simulation Methodology
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To determine flood areas in a river watershed, the U.S. Army Hydrologic Engineering
Center’s River Analysis System (HEC-RAS) hydraulic model is commonly used [116]. The
HEC-RAS is a 1-D unsteady flow analysis program capable of simulating a full network of
open channels [117]. The geographic information systems (GIS) and DEM are available and
widely used for the purpose of floodplain delineation [117]. The GIS has visualization
capabilities and data management tools that allow linkage of the hydraulic data to spatial
locations. The HEC-RAS software and GIS-based tools such as the HEC-GeoRAS software
[116] can be used to attain this linkage [117] and are used in this study.
For an unsteady flow simulation of the HEC-RAS, the principle of conservation of mass
(continuity) and the principle of conservation of momentum are the physical laws which govern
the flow of water in a river. These laws are expressed mathematically in the form of the
continuity (Equation 5.7) and momentum (Equation 5.8) equations [118].
(5.7)

where,
x
t
Q
A
S
q1

= Distance along the channel
= Time
= Flow
= Cross sectional area
= Storage from non-conveying portions of cross section
= Lateral inflow per unit distance
(5.8)

where,
x
t
V
z
g
Q

= Distance along the channel
= Time
= Velocity
= Water surface elevation
= Gravitational acceleration
= Flow
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A
Sf

= Cross sectional area
= Friction slope

The upstream and downstream boundary conditions for each river are required for an
unsteady flow simulation. An upstream boundary condition is applied as a flow discharge
hydrograph of discharge versus time at the upstream start of the river. The downstream
boundary condition is required at the downstream end of the river. Normal depth from
Manning’s equation is a common type of downstream boundary condition. A friction slope is
required to enter when the normal depth is selected [118].
An extreme rainfall 1-D HEC-RAS flood simulation methodology is comprised of the
following main steps:
1.

Load DEM in triangular irregular networks (TIN) format as well as Landsat-8
pansharpened multispectral imagery into a project of ArcGIS software.

2.

Create RAS layers, which include river centerlines, banks, flow path centerlines, and
cross sections using HEC-GeoRAS software.

3.

Attribute RAS layers to define the direction of flow, input name for rivers.

4.

Export RAS Data, which contains the created RAS layers using HEC-GeoRAS
software.

5.

Import the RAS Data into HEC-RAS software.

6.

Complete the flow discharge hydrograph data and boundary conditions for the rivers in
the study area.

7.

Run the extreme rainfall 1-D flood simulation using HEC-RAS software.

8.

Visualize floodplain area as the result from the simulation and overlaying the flood
polygons above the Landsat-8 pansharpened multispectral imagery.
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9.

Assess the impacts of the extreme rainfall floodplain on inundated landuse, population,
and infrastructures the study area.
The detailed step-by-step procedure for implementing an extreme rainfall 1-D HEC-

RAS flood simulation is shown in Appendix D. Figure 65 shows the main interface of the HECRAS 4.1 software. Project, plan, geometry, and unsteady flow are required components that
need to be created before running the extreme rainfall 1-D HEC-RAS flood simulation. Figure
66 shows the graphical user interface of HEC-GeoRAS software. The HEC-GeoRAS works as
an extension in ArcGIS software.

Figure 65. Interface of HEC-RAS software

Figure 66. Graphical user interface of HEC-GeoRAS as an extension in ArcGIS

189

5.3

1-D HEC-RAS Flood Simulation Comparison for Sardis Site with 2-D Simulation
The extreme rainfall 1-D HEC-RAS flood simulation was implemented at Sardis,

Mississippi (MS). The output results of the extreme rainfall 1-D HEC-RAS flood simulation are
compared with the output results of the CCHE2D-FLOOD flood simulation. The both 1-D and
2-D flood simulations used the same input data including a high resolution imagery, DEM data
for 10 m cell size, and discharge hydrograph associated with a full spillway discharge from
Sardis Dam on the Tallahatchie River developed in 2-D flood simulation study.
Figure 67 shows planimetrics of the river centerline of Tallahatchie River and other
infrastructure features in Panola County, MS, which were created from 2 ft (61 cm) highresolution aerial imagery using GeoMedia Pro/ArcGIS geospatial software.

Figure 67. Infrastructure features at Sardis created from high-resolution aerial imagery
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Figure 68 shows the DEM of the study area. The DEM data was acquired through the
cooperation of Mississippi Department of Transportation (MDOT) and Mississippi Automated
Resource Information System (MARIS). The DEM, based on the topographic data collected by
an airborne laser survey, has an absolute accuracy of elevation 1.55 m, whereas the relative
accuracy of elevation is 0.81 m [119].

Figure 68. The DEM of Sardis, MS

The domain size of these flood simulations is 20,580 m from west to east by 17,260 m
from north to south, corresponding to 2,058 columns and 1,726 rows of 10 m by 10 m size cells
(Figure 68). This corresponds to a total of 3,552,108 computational cells.
Figure 69 shows cross sections created based on high-resolution aerial imagery and TIN
map. These cross sections were used as an important required geometry layer for both 1-D and
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2-D flood simulations. These cross sections cover most of the study area where floodwater can
reach.

Figure 69. The cross sections using for the flood simulation, Sardis, MS

Figure 70. Simulation discharge hydrograph for 48 hours at Sardis, MS
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The discharge hydrograph used in these flood simulations is shown in Figure 70. The
discharge hydrograph was associated with a full spillway discharge [120]. The peak discharge is
16,450 m3/s at 1.97 hours. The following table (Table 54) shows an input comparison between
1-D HEC-RAS and CCHE2D-FLOOD flood simulations.

Table 54. Input comparison between 1-D HEC-RAS and CCHE2D-FLOOD
Input Type
Geometry

DEM

Input
River Centerline (km)
Cross Section (km)
DEM
Computation Cell Size
Computation Domain

Flow Data
Others

Peak Discharge (m3/s)
Discharge Scenario
Manning’s n (m-1/3s)
Domain Area (km2)
Simulation Time (hour)

1-D HEC-RAS

CCHE2D-FLOOD

30.48
3 to 19
high-resolution ground DEM
varies
20,580 m west-east by
17,260 m north-south
16,450
full spillway discharge
0.035
355.21
24*

30.48
3 to 19
high-resolution ground DEM
10 m x 10 m
20,580 m west-east by
17,260 m north-south
16,450
full spillway discharge
0.035
355.21
48

* Maximum HEC-RAS simulation time allowed

Table 55. Output comparison between 1-D HEC-RAS and CCHE2D-FLOOD
A
Output

Maximum
Channel
Depths

B
Infrastructure
Assessed

I-55
Railroad
US 51

E

F

1-D HEC-RAS

CCHE2D-FLOOD

RS

Value

CS

Value

RS0
RS14
RS15
RS18

9.71 m
7.74 m
7.94 m
7.73 m

X0
X14
X15
X18

9.32 m
7.94 m
8.04 m
7.53 m

RS24

6.05 m

X24

5.81 m

2

4.22
-2.52
-1.24
2.66
4.13
2

Floodplain

57.80 km

58.17 km

Computation
Time

5.58 seconds

100 seconds

RS0 or X0 is the cross section at the upstream start of the river
RS24 or X24 is the cross section at the downstream end of the river
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G=100*((E-F)/F)
% Difference
Between E and F

-0.64

The comparison of output results between 1-D HEC-RAS and CCHE2D-FLOOD flood
simulations are shown in Table 55. The maximum percent differences between calculated
maximum flood channel depths of these two simulations are within ± 5% at important
infrastructures in the study area such I-55, railroad, and US-51. The percent difference between
floodplain areas created from these two simulations is only -0.64%. The computational time of
the simulation in 1-D HEC-RAS is only 5.58 seconds. It is much smaller in comparison with the
computational time of CCHE2D-FLOOD, which required 100 seconds. The floodplain area or
inundated area was generated from the 1-D HEC-RAS simulation (Figure 71), and from
CCHE2D-FLOOD simulation (Figure 72).

Land Area: 355.21 km2
Inundated Area: 57.80 km2 (16.27% of Land Area)

Peak Discharge: 16,450 m3/s

Figure 71. Spatial map of 1-D HEC-RAS floodplain simulation overlay on HighResolution Aerial Imagery, Sardis, MS
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Land Area: 355.21 km2
Inundated Area: 58.17 km2 (16.38% of Land Area)

Peak Discharge: 16,450 m3/s

Figure 72. Spatial map of CCHE2D-FLOOD floodplain simulation overlay on HighResolution Aerial Imagery, Sardis, MS

The inundated area is about 58 km2. The spatial boundaries of the inundated areas from
both simulations are within 1% of inundated area.
Most of important infrastructure features (Figure 71, Figure 72) in the study area such as
I-55, US-51, rail, airport runway were inundated by the extreme rainfall flood.
The comparison of the extreme rainfall 1-D HEC-RAS and CCHE2D-FLOOD flood
simulations at Sardis, MS indicates that flood depths as well as floodplain areas generated from
these simulations are almost similar (within ± 5% percent differences for flood depth and
within ± 0.7% for floodplain area) when both simulations used the same input data. Therefore,
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the extreme rainfall 1-D HEC-RAS flood simulation will be selected for implementing flood
simulations at selected port cities.
5.4

1-D HEC-RAS Flood Simulation Results for Selected Port Cities

5.4.1 Selected Port Cities and Summary Key Inputs
Rainfall floods can occur almost everywhere in the world at any time. However, the
magnitude of a flood depends on rainfall, climate, weather conditions, and the terrain of the area
where the flood happened. At the coastal or port cities, rainfall floods can cause more damages
in comparison with other areas [107]. They not only affect infrastructures and population in
urban areas of the ports, but also make disruptions to operations of these port structures. The
following port cities were selected for simulating extreme rainfall floods:
1.

Miami, Florida, which has the Port of Miami

2.

Gulfport, Mississippi, which has the Port of Gulfport

3.

Los Angeles, California, which has the Port of Los Angeles and the Port of Long Beach

4.

Karachi, Pakistan, which has the Port of Karachi

5.

Hai Phong, Vietnam, which has the Port of Hai Phong
Summary of key inputs for the rainfall flood simulations of these selected port cities are

shown in Table 56 as below.
Table 56. Key inputs for the 1-D HEC-RAS rainfall flood simulations at selected port cities
Miami,
Florida

Gulfport,
Mississippi

Los Angeles,
California

Karachi,
Pakistan

Hai Phong,
Vietnam

722 km2

80 km2

2,006 km2

723 km2

211 km2

5

4

4

3

2

25 days and
24 hours
time interval

11 days and
24 hours
time interval

19 days and
24 hours
time interval

7 days and
6 hours
time interval

13 days and
6 hours
time interval

Peak Discharge

481.4 m3/s

566.3 m3/s

838.2 m3/s

26,000 m3/s

37,800 m3/s

DEM

2 ft DEM

2 ft DEM

2.4 m DEM

SRTM DEM

SRTM DEM

Satellite Imagery

Landsat-8
Imagery

Landsat-8
Imagery

Landsat-8
Imagery

Landsat-8
Imagery

Landsat-8
Imagery

Input
Simulation Area
Number of Rivers
Discharge
hydrograph
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5.4.2 1-D HEC-RAS Flood Simulation Results for Miami, Florida
Miami, located in Southeast Florida (FL), is a port city in Miami-Dade County between
the Florida Everglades and the Atlantic Ocean [121]. The city is the second-most populous
metropolis in the southeastern United States with about 2.2 million people [122] and ranked
seventh in the United States in terms of finance, commerce, culture, entertainment. Port of
Miami is among the busiest container ports in the United States, handling more than 1,007,782
TEUs each year [68]. Miami has a tropical monsoon climate, which get more rainfall during the
wet season usually begins during the month of May and continues through November [121].
Discharge hydrograph data is derived from rainfall-runoff measurements typically in a
stream or river. It is the most important input for an extreme rainfall flood simulation. The
discharge hydrograph data for Miami was provided by the USGS [123]. This data came from
the most extreme rainfall flood in Miami from October to November in 1947. Figure 73 shows
the discharge hydrograph plot used for the extreme rainfall flood simulation. Discharge data for
this discharge hydrograph were measured every 24 hours from October 10 to November 4,
1947. The peak discharge of 481.4 m3/s was measured on October 12, 1947.

Figure 73. Developed simulation discharge hydrograph, Miami, FL
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An extreme rainfall flood at Miami and the surrounding area was simulated using 1-D
HEC-RAS, 2ft DEM data, and Landsat-8 satellite imagery. The 2ft DEM data, generated from
LIDAR data, was downloaded from the Florida Geographic Data Library (FGDL) [105]. The
absolute vertical accuracy of the 2 ft DEM is 0.3 ft (9 cm) [104, 105]. Figure 5-13 shows cross
sections created based on Landsat-8 imagery and 2ft DEM map. These cross sections were
designed along rivers and canals in the study area. The discharge hydrograph data in Miami was
inputted at the upstream start of each river such as A, B, C, and D (Figure 74).

Figure 74. Spatial map of cross sections and rainfall hydrograph for floodplain simulation,
Miami and surrounding areas, FL
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Results of the extreme rainfall flood in Miami and surrounding area are shown in Figure
75 and Figure 76.

Figure 75. Spatial map of floodplain simulation overlay on DEM elevation map,
Miami and surrounding areas, FL

Figure 75 shows a spatial map of the floodplain simulation overlay on the DEM
elevation map. The inundated area is 409.64 km2 or 56.76% of land area. The elevation of the
study area is less than 51 m. The areas east of the city, located on higher elevation, are less
affected by the rainfall flood. However, most of area west and northwest, on lower elevation,
was inundated by floodwater. The runways of Miami International Airport are completely
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under floodwater. The Port of Miami is not affected by rainfall flood because it is located on a
small island surrounding the ocean; rainfall in the port area flows directly to ocean without
flooding.

Figure 76. Spatial map of floodplain simulation overlay on Landsat-8 Imagery,
Miami and surrounding areas, FL

Figure 76 shows a spatial map of the floodplain simulation overlay on Landsat-8
Imagery and the population at risk by the extreme rainfall flood. The population at risk in
Miami-Dade Metro Area is 1.42 million. The density of population at risk is 1,967 per km2.
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The total population at risk in the four cities in the study area including Pembroke Pines, Opalocka, Miami Beach, and Miami is 373,030.
5.4.3 1-D HEC-RAS Flood Simulation Results for Gulfport, Mississippi
Gulfport is the second largest city in Mississippi. Major infrastructures of the city
include Port of Gulfport, the Gulfport–Biloxi International Airport, I-10 [124]. The Port of
Gulfport is the third major container seaport on the United States shores on the Gulf of Mexico
and also the country's second busiest importer of green fruit.
The port is model for ocean freight carriers serving Mexico, the Caribbean, and Central
and South America. The port handles around two million tons of cargo a year, shipping in
excess of 200,000 TEUs. [125]. Gulfport has a humid subtropical climate and strongly
moderated by the Gulf of Mexico. The port city is subject to extreme weather, most remarkably
tropical storm activity through the Gulf of Mexico. In 2005, Hurricane Katrina's winds and
storm surge killed 1,833 people and caused 108 billion of U.S. dollars damage in the
Mississippi Gulf Coast and surrounding areas [126].
The 1-D HEC-RAS flood simulation was implemented in Gulfport in order to assess the
impacts of an extreme rainfall flood on major infrastructures as well as population of the port
city. The discharge hydrograph data used in this simulation was acquired from the USGS [127].
Discharge hydrograph data at several gaging stations in Mississippi were reviewed; the
discharge hydrograph measured at Yocona River, Mississippi was selected for this simulation
because its discharge is the highest among these stations. Figure 77 shows the discharge
hydrograph plot for 11 days from March 16 to March 26, 1955. The peak discharge of 566.3
m3/s was measured on March 22, 1955.
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The Landsat-8 imagery and the 2 ft DEM contour data were also used in the flood
simulation in Gulfport. The 2 ft DEM contour data were collected from the Mississippi
Automated Resource Information System (MARIS) [104], which has the absolute vertical
accuracy of 0.3 ft (9 cm) [104, 105].

Figure 77. Developed simulation discharge hydrograph, MS

Figure 78 shows cross sections created based on Landsat-8 imagery and 2ft DEM map.
These cross sections were designed along rivers in the study area.
The discharge hydrograph data in Gulfport was inputted at A, B, C, which are points at
the upstream start of each river.
The output results from the extreme rainfall flood at Gulfport are shown in Figure 79
and Figure 80.

202

Figure 78. Spatial map of cross sections and rainfall hydrograph for floodplain simulation,
Gulfport and surrounding areas, MS

Figure 79 shows a spatial map of the floodplain simulation overlay on DEM elevation
map at the study area. Inundated area is 31.84 km2 or 39.66% of land area. The elevations in the
study area are less than 20 m. Most of watershed areas of Bayou Bernard River, Brickyard
Bayou River, and Turkey Creek are inundated by floodwater.
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Figure 79. Spatial map of floodplain simulation overlay on DEM elevation map,
Gulfport and surrounding areas, MS

Figure 80 shows a spatial map of the floodplain simulation overlay on Landsat-8
imagery. Some parts of the runways of the Gulfport-Biloxi International Airport were
inundated. The Port of Gulfport was affected by rainfall flood in the north of the port, where the
port connects to the roads and urban infrastructures. About 13 thousand people are at risk by
the extreme rainfall flood, and the density of population at risk is 162 per km2.
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Figure 80. Spatial map of floodplain simulation overlay on Landsat-8 Imagery,
Gulfport and surrounding areas, MS

5.4.4 1-D HEC-RAS Flood Simulation Results for Los Angeles, California
Los Angeles, California (CA), commonly referred to as L.A., is the second largest city
in the United States in terms of population (after New York City) and one of the largest in terms
of area [128]. The population in the study area is about 12.8 million [129]. The Los Angeles
International Airport, the Port of Los Angeles, and the Port of Long Beach are main
infrastructure features in Los Angeles. The Los Angeles International Airport is located on the
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west side of the city, and known as the largest and busiest airport in the state of California. Both
the Port of Los Angeles and the Port of Long are located in the south of the city. These ports are
ranked as the world's busiest seaports. The Port of Los Angeles is the largest container port in
the United States, handling 8.8 million TEUs in 2016 [130]. The climate of Los Angeles is
warm and temperate. The rain in the city falls mostly in the winter during November through
March but sometimes has heavy rainfall during winter storms. The recent rainfall flood in the
city and surrounding areas in January 2017 costed tens of millions of U.S. dollars in damage
from the flooding [131].
Discharge hydrograph data, DEM, and Landsat-8 imagery were used as input for the 1D HEC-RAS flood simulation for Los Angeles. The discharge hydrograph as shown in Figure
81 was developed using USGS rainfall and river gage data [132]. The discharge hydrograph
data came from the most extreme rainfall flood in Los Angeles from January 5 to January 23 in
1995 [132, 133]. The peak discharge of 838.2 m3/s was measured on January 11, 2005. The
DEM data was downloaded from the USGS [134]. The absolute vertical accuracy is 2.44 m, and
relative vertical accuracy is 1.64 m [134].

Figure 81. Developed simulation discharge hydrograph, Los Angeles, CA
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Figure 82. Spatial map of cross sections and rainfall hydrograph for floodplain simulation,
Los Angeles and surrounding areas, CA

These cross sections were designed along the four rivers in the study area (Figure 82).
The discharge hydrograph data in Los Angeles was inputted at the upstream start of the each
river.
The outputs of the extreme rainfall 1-D flood simulation are shown in Figure 83 and
Figure 84. The inundated area with blue color covers large areas in the south and center of the
city, where are watershed areas of Los Angeles River and San Gabriel River. The west coastal
areas have less affected by rainfall flood due to high elevation. A total 747.06 km2 or 37.23%
of land area in the study area is inundated. Both the Port of Los Angeles and the Port of Long
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are affected by the rainfall flood. Some parts of the runways of the Los Angeles International
Airport are inundated.

Figure 83. Spatial map of floodplain simulation overlay on DEM elevation map,
Los Angeles and surrounding areas, CA

Figure 84 shows the floodplain overlay on NLCD 2011 Landuse/Landcover map. The
NLCD 2011 Landuse/Landcover map, downloaded from the Multi-Resolution Land
Characteristics (MRLC) consortium [135], has five different types of landuse/landcover. The
developed areas with red color represent built-up and infrastructure features. Inundated areas,
mostly within developed areas, indicate that developed areas have more affected by rainfall
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flood in comparison with other landuse/landcover types. Total population at risk in the study
area is 4,776,176. The density of population at risk is 2,381 per km2

Figure 84. Spatial map of floodplain simulation overlay on NLCD 2011 Landuse/Landcover
map, Los Angeles and surrounding areas, CA

Terrain of Los Angeles is different than other selected port cities. The city is located on
a hilly coastal plain with the Pacific Ocean as its southern and western boundaries. Figure 85
showed contours and floodplain map of the city. These contour lines, created from the DEM
data, show clearly elevation in meter of the study area. Most of areas along the western coast of
the city are not inundated by floodwater because these areas located on hills with elevation from
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40 m to 240 m. The area north and east of the city, where the foothills of the Santa Monica
Mountains and the San Gabriel Mountains are located, also not inundated. Inundated areas
occur in the center and the south of the study area where elevation less than 40 m.

Figure 85. Spatial map of contours and floodplain simulation,
Los Angeles and surrounding areas, CA

Los Angeles is the most challenging area among selected port cities for simulating a
rainfall flood due to widely diverse terrain areas. Depth of inundated areas could be much
difference among difference terrain areas in Los Angeles. Therefore, the port city was selected
for depth inundated analysis. There are six depth cross sections designed in the study area
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(Figure 86). The three depth cross sections including X1 - X1, X2 - X2, and X3 - X3 have
direction from west to east, and the three other depth cross sections including Y1 - Y1, Y2 - Y2,
and Y3 - Y3 have direction from north to south.

Figure 86. Spatial map of depth cross sections and floodplain simulation overlay on DEM
elevation map, Los Angeles and surrounding areas, CA

The Interpolate line function (Figure 87) in ArcGIS 3D Analyst [136] was used to
interpolate a series of elevation points on each depth cross section, then the elevation points of
each depth cross section were plotted to make a line of terrain height above mean sea level
(Figure 88, Figure 89).
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Figure 87. Interpolate line function in 3D Analyst, ArcGIS

Depth data on the depth cross sections, achieved from the output of the 1-D HEC-RAS
flood simulation for Los Angeles, were also plotted. The blue areas above terrain height above
mean sea level in Figure 5-27 and Figure 5-28 represent depth inundated on the depth cross
sections. Average and maximum depth inundated values on each depth cross section were
calculated. The largest value of the maximum depth inundated among these cross sections is
31.71 m as shown at M6 on the depth Y3-Y3 cross section (Figure 86). The M6 is located in the
river centerline and also in the narrow valley between the foothills of the Santa Monica
Mountains and the San Gabriel Mountains, where large volumes of floodwater flow through the
valley from the northeast part of the study area. Average depth inundated value of the Y3 - Y3
cross section is also larger than that of other depth cross sections because the Y3 - Y3 cross
section passes through the deep narrow valley and passes through large inundated areas in the
south east of the study area.
The center of the study area, where the X2 - X2 depth cross section passes through, has
large inundated area; however the average depth inundated is only 0.77 m. The center area is
located on a large valley surrounding by hills and mountains, and also is the watershed areas of
Los Angeles River and San Gabriel River, therefore floodwater spread out in the larger area in
the center but the inundated areas are not deeply.
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(a)

(b)

(c)
Figure 88. Depth inundated analysis in X1-X1, X2-X2, X3-X3 cross sections
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(a)

(b)

(c)
Figure 89. Depth inundated analysis in Y1-Y1, Y2-Y2, Y3-Y3 cross sections
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5.4.5 1-D HEC-RAS Flood Simulation Results for Karachi, Pakistan
Karachi, located on the coast of the Arabian Sea, is the capital of the province of Sindh,
and the largest city in Pakistan. It is also the financial and commercial capital of the country
[137]. The population of Karachi is about 15 million [138, 139]. The Port of Karachi is the
largest port in Pakistan. The port handles about 26 million tons of cargo and 650 thousand
TEUs per year [143]. The city has a semi-arid climate and more rainfall from June to
September. Flood disasters happened more frequency in recent years. For instance, the extreme
rainfall flood in Karachi in 2009 killed 26 people and injured 150 people; another flood in
August 2016 killed 10 people and left 45% of Karachi without power [144].
Due to missing actual discharge hydrograph data in Karachi, the discharge hydrograph
data, measured from the rainfall flood happed from August 5 to August 11, 2006 at the Lower
Tapi River including Surat city in Gujarat, India, was used for the 1-D HEC-RAS flood
simulation in Karachi. This rainfall flood is known as the most extreme flood in the last 34
years in Gujarat State. The flood caused a direct damage of 4,200 million U.S. dollars, 150
deaths, and 80% of Surat city remained submerged for more than two days [145, 146]. Gujarat
State, India is bordered by Sindh Province, Pakistan to the west. Both Gujarat and Sindh have a
semi-arid climate. Karachi, the capital of Sindh Province, was the selected port city in Pakistan
for implementing a rainfall flood simulation. Although Karachi has the same climate conditions
and is close to Gujarat in India, the used discharge hydrograph is not an actual discharge
hydrograph in Karachi. From the measured discharge hydrograph data in Gujarat, three
scenarios of the discharge hydrograph were developed as shown in Figure 90.
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Figure 90. Developed simulation discharge hydrograph, Karachi, Pakistan

The first scenario used the full discharge data, which is real measured data from the
extreme flood in Gujarat in 2006. The peak discharge of the first scenario is 26,000 m3/s. The
second scenario used 50% of the full discharge data; the discharge hydrograph plot of the
second scenario is shown as violet color in Figure 90. The peak discharge of the second
scenario is 13,000 m3/s. The third scenario used 25% of the full discharge data. The discharge
hydrograph plot is shown in red. The peak discharge of the third scenario is 6,500 m3/s.
The Shuttle Radar Topography Mission (SRTM) DEM and Landsat-8 imagery were also
used for the simulation in Karachi. The SRTM DEM data was downloaded from the National
Aeronautics and Space Administration (NASA) website [147]. The SRTM DEM samples are
spaced every 30 m. The absolute vertical accuracy is 1.62 m, and relative vertical accuracy is
0.85 m [148].
Figure 91 shows cross sections created based on Landsat-8 imagery and SRTM DEM
map. These cross sections were designed along the three rivers in the study area. The discharge
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hydrograph data in Miami was inputted at A, B, C, which are points at the upstream start of
these rivers.

Figure 91. Spatial map of cross sections and rainfall hydrograph for floodplain simulation,
Karachi and surrounding areas, Pakistan

The 1-D HEC-RAS flood simulation was implemented for all 3 scenarios of the
discharge hydrograph in Karachi. The result of the extreme rainfall 1-D flood simulation using
the first scenario or full discharge data is shown in Figure 92. Inundated area is 556.12 km2 or is
76.87% of land area. Total population at risk in the study area is 11,530,500. The density of
population at risk is 15,937 per km2.
The result of the extreme rainfall 1-D flood simulation using the second scenario or 50%
of full discharge data is shown in Figure 93. A total 534.00 km2 or 73.81% of land area in the
study area is inundated. The total population at risk in the study area is 11,071,500. The density
of population at risk is 15,303 per km2.
217

Figure 92. Spatial map of full discharged floodplain simulation overlay on
Landsat-8 Imagery, Karachi and surrounding areas, Pakistan

Figure 93. Spatial map of 50% of full discharged floodplain simulation
overlay on Landsat-8 Imagery, Karachi and surrounding areas, Pakistan
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The result of the extreme rainfall 1-D flood simulation using the third scenario or 25%
of full discharge data is shown in Figure 94 and Figure 95. Inundated area is 416.26 km2 or is
57.53% of land area. Figure 94 shows that the extreme rainfall flood occurs the south of the city
where is low elevation, and watershed areas of Budnai Nala River, Lyari River, Marlir River.
Figure 95 shows the 25% of full discharged floodplain simulation overlay on Landsat-8
Imagery. The total population at risk in the study area is 8,629,500. The density of population at
risk is 11,928 per km2. Important infrastructure features of the city such as the Port of Karachi,
Jinnah International Airport, PAF Base Faisal, and PAF Base Masroor are inundated by
floodwater for all three scenarios of the discharge hydrograph.

Figure 94. Spatial map of 25% of full discharged floodplain simulation overlay on DEM
elevation map, Karachi and surrounding areas, Pakistan

Due to missing actual flow discharge hydrograph in Karachi, a model of the rainfall
floodplain simulation was created based on the 3 scenarios of the discharge hydrograph in
Karachi and their inundated areas. Figure 96 shows a nonlinear relationship between inundated
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land and percent of full discharge discharge hydrograph. The plot was created using results of
the rainfall floodplain simulation at 3 points (25%, 50%, and 100% of full discharge
hydrograph).

Figure 95. Spatial map of 25% of full discharged floodplain simulation
overlay on Landsat-8 Imagery, Karachi and surrounding areas, Pakistan

Figure 96. Rainfall floodplain simulation model for Karachi, Pakistan
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Equation 5.9, representing nonlinear functions of these points, was used to calculate
inundated land at 10% and 5% of full flow discharge hydrograph.
y = -0.0569x2 + 8.9768x + 227.4

(5.9)

Table 57 shows summary of results from the 3 scenarios of the discharge hydrograph as
well as the calculated inundated land at 10% and 5% of full flow discharge hydrograph from the
Equation 5.9. From the equation, if a rainfall is 10% of full flow discharge hydrograph, 311.48
km2 of land (43.05% of land area) could be inundated, and if a rainfall is 5% of full flow
discharge hydrograph, 270.86 km2 of land (37.43% of land area) could be inundated.

Table 57. Summary of results from the three scenarios of the discharge hydrograph and
inundated land for Karachi, Pakistan
Percent of
Full Flow Discharge
hydrograph
(%)
25
50
100
10
5

Inundated Land

Percent of Land
Area Inundated

(km2)
416.26
534.00
556.12
311.48
270.86

(%)
57.53
73.81
76.87
43.05
37.43

Note

From Equation 5.9
From Equation 5.9

Figure 97 shows a spatial map of roads and floodplain areas generated from the
simulation using 25% of full discharge hydrograph overlay on Landsat-8 imagery in Karachi.
This spatial map was created using GeoMedia Professional 2013 software. Road network data
was acquired from the U.S. Agency for International Development (USAID) transportation
project for Pakistan, 2007-2010 [139, 140]. The methodologies used for road network
planimetrics and daily traffic volume were developed and implemented by CAIT researchers,
the University of Mississippi [141, 142]. Most of the roads in the south of Karachi and main
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roads connected to the Jinnah International Airport, the Port of Karachi, and the PAF Base
Faisal are inundated by floodwater. Total lengths of the inundated roads are 62,609.46 km. In
particular, 155.8 km of railroad, 35 km of Highway/Motorway, 750.3 km of major roads, and
1,632.2 km of minor roads are inundated.

Figure 97. Spatial map of roads and floodplain simulation overlay on Landsat-8 imagery,
Karachi and surrounding areas, Pakistan

5.4.6 1-D HEC-RAS Flood Simulation Results for Hai Phong, Vietnam
The port city of Hai Phong is located on the northern coast of Vietnam. It is the third
largest city of Vietnam. Total population in the study area is about 0.7 million. Most of the
population in the port city lives in three districts in the center. These center districts include Ngo
Quyen, Le Chan, and Hai An [149]. The port city is bordered by the Gulf of Tonkin to the east
and has 125 km along the coastline.
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The Hai Phong port is the second largest sea port in Vietnam. The port has three main
terminals, handling more than 26 million tons of cargo in 2016 [150]. The study area is affected
by two monsoon regimes, which usually have heavy rainfall and floods from April to
September [150]. There are two main rivers in the city. The Cam River, in the north of the city,
is one branch of the Red river, with over 1,000 km beginning from the mountains of the Yunnan
province in China. Lach Tray River, in the south of the city, is one branch of the Thai Binh
River. Geospatial mapping of these features were carried out in this study.
The 1-D HEC-RAS, SRTM DEM data, and Landsat-8 satellite imagery were used to
simulate an extreme rainfall flood to evaluate the impacts on the port city. The discharge
hydrograph data for Hai Phong was provided by the Vietnam Institute of Meteorology,
Hydrology and Climate Change (IMHEN) [151]. This data came from the most extreme rainfall
flood in the Northern Vietnam, including Hai Phong, in August 1971. Figure 98 shows the
discharge hydrograph plot used for the extreme rainfall flood simulation. Discharge data for this
discharge hydrograph were measured every 6 hours from August 10 to August 22, 1971. The
peak discharge of 37,800 m3/s was measured at 1 pm on August 16, 1971.

Figure 98. Developed simulation discharge hydrograph, Hai Phong, Vietnam
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Figure 99 shows cross sections created based on Landsat-8 imagery and SRTM DEM
map in the study area. The discharge hydrograph data in Hai Phong was inputted at the points at
the upstream start of the three rivers in the city.

Figure 99. Spatial map of cross sections and rainfall hydrograph for floodplain simulation,
Hai Phong and surrounding areas, Vietnam

Figure 100 shows the floodplain overlay on DEM elevation map for the port city and
surrounding area. The inundated area in blue covers most of the land area of the port city. A
total 177.84 km2, or 84.31 % of land area is inundated by floodwater. All terminals of the Hai
Phong port and runways of Cat Bi international airport are completely under floodwater. Most
of the roads and other important infrastructures of the port city are also inundated by
floodwater. Figure 101 shows the floodplain overlay on Landsat-8 imagery for the port city and
surrounding area. The total population at risk by the extreme rainfall flood in the study area is
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624,757 people, which is 87.33% of total population in the study area. The density of
population at risk is 2,962 per km2.

Figure 100. Spatial map of floodplain simulation overlay on DEM elevation map,
Hai Phong and surrounding areas, Vietnam

Figure 101. Spatial map of floodplain simulation overlay on Landsat-8 imagery,
Hai Phong and surrounding areas, Vietnam
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5.5

Summary and Conclusions
The comparison between results of the rainfall flood simulation using the 1-D HEC-

RAS program and the results of the CCHE2D-FLOOD flood simulation in Sardis, MS, shows
that flood depths and floodplain areas generated from these both simulations are almost similar
(less than ± 5% percent differences for flood depth and less than ± 0.7% for floodplain area)
when both simulations used the same input data.
The computational time of the rainfall flood simulation using 1-D HEC-RAS is only
5.58 seconds. It is much smaller in comparison with the computational time of CCHE2DFLOOD, which required 100 seconds.
Table 58 shows a summary of inputs and output results of the rainfall flood simulations
in selected port cities. DEM data, hydrograph and peak discharge data are main inputs for the
simulation. Output results include inundated area, and population at risk information.

Table 58. Summary of the 1-D HEC-RAS rainfall flood simulations in selected port cities
Miami,

Gulfport,

Los Angeles,

Florida

Mississippi

California

Karachi,
Pakistan

Hai Phong,
Vietnam

Land Area

722 km2

80 km2

2,006 km2

723 km2

211 km2

Inundated Area

409 km2

32 km2

747 km2

556 km2

178 km2

Percent of Land
Inundated

56.8%

39.7%

37.2%

76.9%

84.31%

1.42 million

13,029

4.78 million

11.53 million

624,757

1,967

162

2,381

15,937

2,962

Peak Discharge

481.4 m3/s

566.3 m3/s

838.2 m3/s

26,000 m3/s

37,800 m3/s

DEM

2 ft DEM

2 ft DEM

2.4 m DEM

SRTM DEM

SRTM
DEM

Flat

Flat

Hills

Hills in north

Flat

0 - 50 m

0 - 19 m

0 - 255 m

0 -196 m

0 - 118 m

Input

Population at Risk
Population at
Risk/km2

Terrain
Elevation Range
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Percent of land inundated by the rainfall flood in Miami, Gulfport, Los Angeles,
Karachi, and Hai Phong is 56.8%, 39.7%, 37.2%, 76.9%, and 84.31%, respectively.
Population at risk by the rainfall flood in Miami, Gulfport, Los Angeles, Karachi, and
Hai Phong is 1.42 million people, 13,029 people, 4.78 million people, 11.53 million people, and
624,757 people, respectively.
The percent of inundated land is higher for high peak discharge of these port cities.
Karachi and Hai Phong, located in semi-arid and tropical climate areas, have heavier rainfall.
Therefore, both Karachi and Hai Phong have more damage of infrastructures and more
population at risk from rainfall floods in comparison with other port cities in the United States.
The percent of inundated land is also dependant on a terrain or DEM elevation of the
port cities. Miami and Hai Phong are located on low elevation areas; the inundated area of the
two cities is larger than 56% of the land area. However, Los Angeles is located on higher
elevation areas, the inundated area of the Los Angeles is 37.2% of the land area.
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VI. IMPACTS OF COASTAL NATURAL DISASTERS ON PORT CITIES
6.1

Overview of Historical Weather Related Natural Disasters
According to the United Nations [153], weather-related natural disasters appear to

becoming more frequent due largely to a sustained rise in the numbers of floods and storms.
Between 1995 and 2015, there were 6,457 weather-related natural disasters, which killed
606,000 people and affected more than 4 billion people in the world. Asia has more frequent
events and greater numbers of people killed and affected than any other continent. This is due
mainly to Asia’s large and varied landmass that includes multiple river basins, flood plains, and
high population densities in disaster-prone regions. Weather-related natural disasters have
become increasingly frequent since the late 1990s. Since 2005, an average annual total up to
335 disasters happened per year. These disasters are 14% higher than in the previous decade and
more than twice the level recorded in 1980-1989 [153].
The United States has sustained 203 weather and climate disasters since 1980. The
cumulative costs for these 203 events exceed U.S. $1.1 trillion. In 2016, there were 15 weather
and climate disaster events across the country with losses exceeding U.S. $1 billion each. These
events in 2016 resulted in the deaths of 138 people and had significant economic effect on the
areas impacted [154]. Figure 102 shows floods caused by 2005 Hurricane Katrina covering 80%
of New Orleans, Louisiana, in 36 hours. According to FEMA, Hurricane Katrina was one of the
deadliest hurricanes ever to hit the United States; the total damage for Katrina is estimated at
U.S. $ 108 billion, and the hurricane killed 1,833 people [155].
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Figure 102. Flooded by 2005 Hurricane Katrina covering 80% of New Orleans
(Photo Credit: usnews.com)

Coastal areas and port cities are threatened by SLR and tsunamis. SLR is one of the
most visible effects of climate change, and it is increasing more rapidly than in previous
decades. SLR is speculated mainly by thermal expansion of seawater due to global temperature
rise and melting ice mass [156]. About 23 percent of the world's population and 40 percent of
the population in the United States lives in relatively high-population-density coastal areas,
where sea level plays a role in submersion, shoreline erosion, and hazards from storms
[157,158]. Without adaptation, from 0.3 to 9.3% of global gross domestic product (GDP) is
expected to be lost annually in 2100 by SLR [158].
Tsunamis are large and long waves with small steepness that transform dramatically
through spatial and temporal spreading from the ocean. Tsunamis are caused by impulsive
geophysical events of the seafloor such as earthquakes, submarine landslides, meteorological
events, and less commonly, by volcanic eruptions [159]. Waves of tsunami have much longer
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periods of 10 minutes to one hour, wavelengths of 100 - 500 km, and travel at speeds of 800 1,000 km per hour. Based on historical data shown by NOAA [160], about 59% of the world's
tsunamis have occurred in the Pacific Ocean, 25% in the Mediterranean Sea, 12% in the
Atlantic Ocean, and 4% in the Indian Ocean. Between 1900 and 2009, 94 tsunamis that
affected human populations were recorded. A total of 250,000 people were killed and close to
50,000 injured [161]. The Indian Ocean tsunami in 2004, caused by a magnitude Mw 9.1
earthquake (depth 30 km) that occurred off the coast of northern Sumatra, Indonesia, was one of
the worst natural disasters in history. Enormous waves from the Indian Ocean tsunami hit
countries in South Asia and East Africa with little to no warning, killing 230,000 people. The
estimated material losses are U.S. $10 billion and insured losses are U.S. $2 billion [162].
On March 11, 2011, a magnitude Mw 9.0 earthquake (depth 30 km) that occurred off the
coast of Japan’s Tohoku region generated a tsunami that was observed all over the Pacific
region and caused tremendous devastation locally. Figure 103 shows the flow of the tsunami
into the city of Miyako from the Heigawa estuary in Iwate Prefecture on March 11, 2011; and
Figure 104 shows waves of the tsunami hitting residences in Natori, Japan, on March 11, 2011.
According to the National Police Agency of Japan report in February 2015 [163], the
2011 tsunami in Japan caused 15,890 deaths, 2,590 missing and presumed deaths, and 6,152
injuries in 12 Japanese prefectures [163]. Figure 105 shows homes collapsed by the 2011
tsunami in Akahama, Iwate Prefecture, Japan. Figure 105 shows a boat on top of a two-story
building left by the 2011 tsunami at Otsuchi, Japan.
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Figure 103. Tsunami in the city of Miyako, Iwate Prefecture, Japan, on March 11, 2011
(Photo Credit: dailymail.co.uk)

Figure 104. Waves of tsunami hitting residences in Natori, Japan, on March 11, 2011
(Photo Credit: fellowshipoftheminds.com)
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Figure 105. Homes collapsed by 2011 tsunami in Akahama, Iwate Prefecture, Japan
(Photo Credit: dailymail.co.uk)

Figure 106. A boat on top of a two-story building left by the 2011 tsunami at Otsuchi town,
Japan
(Photo Credit: dailymail.co.uk)
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The 2011 tsunami also killed one person in Papua, Indonesia, and one person in Klamath
River, California. The earthquake and tsunami in 2011 caused U.S. $220 billion damages in
Japan and resulted in a nuclear disaster with an International Atomic Energy Agency (IAEA)
rating of 7 at the Fukushima I (Daiichi) Nuclear Power station. The tsunami also cost U.S. $30
million damages in Hawaii; U.S. $55 million damages to marine facilities in California; and
U.S. $6 million in losses to the fishing industry in Tongoy, Chile, over 16,000 km from the
source [163].

6.2

Assessing Impacts of Flood Disasters on Selected Port Cities
Port cities are important concentrations for population including 13 out of the 20 most

populated cities in the world. These port cities are a vital component of national and global
economies. At the same time, these cities are facing with flood disasters that damage their
infrastructure assets as well as population. Hanson et al. [15] conducted a research showing a
first evaluation of the exposure of 136 of the world’s large port cities, including selected port
cities in this research, to coastal flooding due to SLR, flood, and storm surge today and in the
year 2070. The analysis proposes that about 40 million people in the large port cities are
currently exposed to a 1 in 100 year coastal flood event. For assets, the total value exposed in
2005 across all cities considered is estimated to be U.S. $ 3,000 billion; corresponding to around
5% of global GDP. Miami is ranked as number one in the top 20 world’s large port cities in
terms of assets exposed to coastal flooding in the year 2070. The value assets exposed in Miami
in 2005 were U.S. $ 416.29 billion, and will be U.S. $ 3,513.04 billion in 2070. Miami is also in
the top 20 cities ranked in terms of population exposed to coastal flooding in the year 2070 [15].
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6.3

Tsunami and Climate Related Sea Level Rise Simulations for Selected Port Cities

6.3.1 Impacts of Sea Level Rise for Selected Port Cities
6.3.1.1 CAIT Methodology to Evaluate the Impact of SLR Due to Climate Impacts
As speculated by IPCC [165], rising sea level threatens infrastructure assets as well as
the populations of many port cities and coastal areas in the world. As studied by the NOAA
[166], the global mean sea level will rise but no more than 2 m by 2100. Scenarios developed by
NOAA are based on four estimates of global SLR by 2100 that reflect different degrees of
ocean warming and ice sheet loss (Figure 107). The highest scenario of global sea level rise (2
m) is derived from a combination of calculated ocean warming from the fourth assessment
report of the IPCC about global SLR projections and a calculation of the maximum possible
glacier and ice sheet loss by the end of the century.

Figure 107. Global mean sea level rise scenarios
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The CAIT researchers at the University of Mississippi have developed a methodology to
evaluate the impact of 2 m SLR due to climate impacts. The following steps of the CAIT
methodology are performed using 3-D analyst tools of ArcGIS software
(http://www.esri.com/software/arcgis/extensions/3danalyst):
1.

Create DEM map from DEM data to visualize the terrain surface.

2.

Reclassify DEM elevation to make a spatial map of selected elevation ranges.

3.

Create shapefiles for 2 m SLR submerged land spatial maps.

4.

Overlay the 2 m SLR submerged land polygons above the Landsat-8 pansharpened
multispectral imagery.

5.

Assess the impact of the 2 m SLR submerged land on key infrastructure assets, as well as
the population at risk in the port city.
The detailed step-by-step procedure for implementing a 2 m SLR simulation is shown in

Appendix E.
The five port cities selected for SLR simulation include (1) Miami, Florida, (2) Gulfport,
Mississippi, (3) Los Angeles, California, (4) Karachi, Pakistan, and (5) Hai Phong, Vietnam.

6.3.1.2 SLR Simulation Results for Miami, Florida
Miami, the second-most populous metropolis in the southeastern United States with
about 2.5 million people, is the top city in the United States and in the top 20 port cities in the
world that ranked in terms of value assets as well as population exposed to coastal flooding due
to SLR [15]. The CAIT methodology of 2 m SLR was implemented to evaluate the impact of 2
m SLR on Miami. The 2 m SLR simulations used 2ft DEM data, Landsat-8 satellite imagery,
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and population data, which are the same input data used for the rainfall flood simulations for the
port city.
Results of the 2 m SLR simulation consist of submerged land polygons. These
submerged land polygons were overlayed on the DEM elevation map (Figure 108). The
submerged land area is 411.96 km2, or 57.08% of land area. The elevation of the study area is
less than 70 m. The areas east of the study area with high elevation are less affected by the 2 m
SLR. However, most of the area west and northwest of the study area and islands located at
lower elevation (less than 2 m) are submerged by 2 m SLR.

Figure 108. Spatial map of SLR simulation overlay on DEM elevation map,
Miami and surrounding areas, FL
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Figure 109 shows a spatial map of the 2 m SLR simulation overlay on Landsat-8
imagery and the population at risk by 2 m SLR. Some parts of the Port of Miami and the
runways of Miami International Airport are affected by 2 m SLR. The population at risk in
Miami-Dade Metro area is 1.43 million. The density of population at risk is 1,977 per km2. The
total population at risk in the four cities in the study area, including Pembroke Pines, Opa-locka,
Miami Beach, and Miami, is 357,132.

Figure 109. Spatial map of SLR simulation overlay on Landsat-8 Imagery,
Miami and surrounding areas, FL
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6.3.1.3 SLR Simulation Results for Gulfport, Mississippi
The CAIT methodology of 2 m SLR was implemented in Gulfport, MS, to evaluate the
impact of 2 m SLR on the main infrastructure features as well as population of the port city. The
2 ft DEM data, Landsat-8 satellite imagery, and population data, used for the rainfall flood
simulation for the port city, were also used for the 2m SLR simulation for Gulfport. Figure 110
shows a spatial map of 2 m SLR overlaid on the DEM elevation map of the port city.

Figure 110. Spatial map of SLR simulation overlay on DEM elevation map,
Gulfport and surrounding areas, MS
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The elevation in Gulfport areas is not high (less than 20 m); however the elevation of
most land areas in the port city is higher than 2 m. So, only 1.68 km2 or 2.09% of land area is
submerged by 2 m SLR. The submerged land areas are along coastline and the Port of Gulfport.
Figure 111 shows a spatial map of the 2 m SLR simulation overlay on Landsat-8 imagery and
the population at risk by 2 m SLR in Gulfport and surrounding areas.

Figure 111. Spatial map of SLR simulation overlay on Landsat-8 Imagery,
Gulfport and surrounding areas, MS
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The population at risk in the study area is 687 million. The density of population at risk
is 9 per km2. The runways of the Gulfport-Biloxi International Airport are not submerged by 2
m SLR. Some parts of E Beach Blvd road near the coastline are submerged. The Port of
Gulfport is also affected by 2 m SLR.

6.3.1.4 SLR Simulation Results for Los Angeles, California
Los Angeles, CA, is the second largest city in the United States with 12.8 million
population [129]. The city is located on a hilly coastal plain with elevation less than 250 m. The
areas south of the city, located on low elevation, could be affected by 2 m SLR. In order to
evaluate the impact of 2 m SLR on infrastructures and population of the city, the CAIT
methodology of 2 m SLR was implemented. The DEM data, Landsat-8 satellite imagery, and
population data, used for the rainfall flood simulation for Los Angeles, were also used for the
2 m SLR simulation.
Figure 112 shows a spatial map of 2 m SLR overlaid on the DEM elevation map of the
port city. Most of land area in the city is not affected by 2 m SLR because the city is located on
high elevation areas. Some submerged land areas occur in the south and west coastal areas
where elevation is less than 2 m. Both the Port of Los Angeles and the Port of Long Beach are
affected by 2 m SLR. However, the Los Angeles International Airport in the west coastal area is
not submerged by 2 m SLR. Figure 113 shows a spatial map of the 2 m SLR simulation overlay
on metropolitan boundary area map and the population at risk by 2 m SLR in Los Angeles and
surrounding areas. The submerged land area is 33.76 km2, or 1.68% of land area. The
population at risk in the study area is 215,857; and the density of population at risk is 108 per
km2. Both maps in Figure 112 and Figure 113 were created by Stafford [164].
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Figure 112. Spatial map of SLR simulation overlay on DEM elevation map,
Los Angeles and surrounding areas, CA

Figure 113. Spatial map of SLR simulation overlay on boundary map,
Los Angeles and surrounding areas, CA
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In Los Angeles, the future 2 m SLR has less effect to people in comparison with Miami,
FL. However some important infrastructure features such as the Port of Los Angeles and the
Port of Long Beach are affected by 2 m SLR.

6.3.1.5 SLR Simulation Results for Karachi, Pakistan
Karachi, the largest city in Pakistan with a population around 15 million, was selected
for analyzing the impacts of 2 m SLR. The SRTM DEM data, Landsat-8 satellite imagery, and
population data, used for the rainfall flood simulation for Karachi, were also used for the 2 m
SLR simulation.
Results of the CAIT methodology of 2 m SLR applied for Karachi are shown in Figure
114 and Figure 115. Figure 114 shows a spatial map of SLR simulation overlay on DEM
elevation map in Karachi and surrounding areas.

Figure 114. Spatial map of SLR simulation overlay on DEM elevation map,
Karachi and surrounding areas, Pakistan
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The center and north of the city with high elevation ranging from 10 to 200 m are not
affected by feature 2 m SLR. The areas in the south of the city, which are along the coastline,
are submerged by 2 m SLR. The submerged land area is 27.54 km2, or 3.88% of land area.
Figure 115 shows a spatial map of the 2 m SLR simulation overlay on Landsat-8 imagery and
the population at risk by 2 m SLR in Karachi and surrounding areas. The Jinnah International
Airport, PAF Base Faisal, and PAF Base Masroor, are not affected by 2 m SLR. However, the
Port of Karachi is affected by 2 m SLR. The population at risk in the study area is 2 million, and
the density of population at risk is 2,765 per km2.

Figure 115. Spatial map of SLR simulation overlay on Landsat-8 Imagery,
Karachi and surrounding areas, Pakistan
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6.3.1.6 SLR Simulation Results for Hai Phong, Vietnam
The SRTM DEM data, Landsat-8 satellite imagery, and population data, used for the
rainfall flood simulation for Hai Phong, were also used for the 2 m SLR simulation. Results of 2
m SLR simulation in Hai Phong and surrounding areas consist of submerged land polygons.
These submerged land polygons were overlaid on both a DEM elevation map as well as the
Landsat-8 pansharpened multispectral imagery. Figure 116 shows a spatial map of 2 m SLR
simulation overlay on DEM elevation map. The center of the city, where elevation ranges from
4 to 12 m, is less affected by future 2 m SLR. The submerged land by seawater is 35.27 km2, or
16.72 % of land area.

Figure 116. Spatial map of SLR simulation overlay on DEM elevation map,
Hai Phong and surrounding areas, Vietnam
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Figure 117 shows a spatial map of the 2 m SLR simulation overlay on Landsat-8
imagery and the population at risk by 2 m SLR in Hai Phong and surrounding areas. Some parts
of the port property as well as some sections of the runways of Cat Bi International Airport are
submerged by 2 m SLR. The population at risk in the study area is 27,673; and the density of
population at risk is 131 per km2.

Figure 117. Spatial map of SLR simulation overlay on Landsat-8 Imagery,
Hai Phong and surrounding areas, Vietnam

6.3.2 Impacts of Tsunami Simulations for Selected Port Cities
6.3.2.1 CAIT Methodology to Evaluate the Impact of Tsunami Simulation
The development of CAIT tsunami simulation methodology was motivated from the 9 m
tsunami wave peak height (WPH) that hit the Kesennuma Bay in Japan on March 11, 2011.
Figure 118 shows a plot of the tsunami wave height time series derived from the combined two
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videos [159, 167]. These videos were recorded from the rooftop of the Japanese Coast Guard
(JCG) and Miyagi Prefecture (MP) buildings in Kesennuma Bay. The maximum tsunami height
in the bay reaches 9 m at 15:33. The tsunami height increased very rapidly from 0 to 9 m within
10 minutes. The velocity of the tsunami flow was also recorded. The plot of the tsunami wave
flow velocity is shown in lower part of Figure 118. The maximum tsunami wave flow velocity
of 11 m/s was measured less than 10 minutes after the maximum tsunami wave height.

Figure 118. Measured tsunami wave height and interpreted line from March 2011
tsunami in the Kesennuma Bay, Japan

In order to get a series of continuous data to develope the CAIT methodology of tsunami
simulation, a tsunami wave height line was interpreted and traced in blue, shown in Figure 118.
The tsunami wave height was measured from 15:20 to 16:05 on March 11, 2011. At 16:05, the
tsunami wave height is 0.7 m. So adjusted tsunami wave height data decreased from 0.7 m to 0
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m, when the tsunami returned to the shore, was estimated using extrapolation method. Table 59
shows the summary of interpreted, adjusted tsunami wave height data.

Table 59. Interpreted, adjusted tsunami wave height data from measured
tsunami height at the Kesennuma Bay, Japan
1

2

No

Time

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54

3
4
5
6
7
Intepreted
Normalized to
2m
Tsunami
Tsunami
Adjusted
Peak Value of Tsunami
Wave
Wave
Data
Tsunami Wave Peak Wave
Height Data
Height Data
Height
Height

(hh:mm)

(m)

15:26
15:27
15:28
15:29
15:30
15:31
15:32
15:33
15:34
15:35
15:36
15:37
15:38
15:39
15:40
15:41
15:42
15:43
15:44
15:45
15:46
15:47
15:48
15:49
15:50
15:51
15:52
15:53
15:54
15:55
15:56
15:57
15:58
15:59
16:00
16:01
16:02
16:03
16:04
16:05
16:06
16:07
16:08
16:09
16:10
16:11
16:12
16:13
16:14
16:15
16:16
16:17
16:18
16:19

0.00
1.40
2.65
4.00
5.35
6.75
8.10
9.25
8.55
7.50
6.25
5.25
4.40
3.80
3.25
2.95
2.65
2.40
2.20
2.00
1.90
1.75
1.65
1.55
1.45
1.40
1.35
1.30
1.25
1.20
1.15
1.10
1.05
1.00
0.95
0.90
0.85
0.80
0.75
0.70

T1

(m)

(m)

0.65
0.60
0.55
0.50
0.45
0.40
0.35
0.30
0.25
0.20
0.15
0.10
0.05
0.00

0.00
1.40
2.65
4.00
5.35
6.75
8.10
9.25
8.55
7.50
6.25
5.25
4.40
3.80
3.25
2.95
2.65
2.40
2.20
2.00
1.90
1.75
1.65
1.55
1.45
1.40
1.35
1.30
1.25
1.20
1.15
1.10
1.05
1.00
0.95
0.90
0.85
0.80
0.75
0.70
0.65
0.60
0.55
0.50
0.45
0.40
0.35
0.30
0.25
0.20
0.15
0.10
0.05
0.00

0.00
0.15
0.29
0.43
0.58
0.73
0.88
1.00
0.92
0.81
0.68
0.57
0.48
0.41
0.35
0.32
0.29
0.26
0.24
0.22
0.21
0.19
0.18
0.17
0.16
0.15
0.15
0.14
0.14
0.13
0.12
0.12
0.11
0.11
0.10
0.10
0.09
0.09
0.08
0.08
0.07
0.06
0.06
0.05
0.05
0.04
0.04
0.03
0.03
0.02
0.02
0.01
0.01
0.00

247

8
4m
Tsunami
Peak Wave
Height

9
9m
Tsunami
Peak Wave
Height

(m)

(m)

(m)

0.00
0.30
0.57
0.86
1.16
1.46
1.75
2.00
1.85
1.62
1.35
1.14
0.95
0.82
0.70
0.64
0.57
0.52
0.48
0.43
0.41
0.38
0.36
0.34
0.31
0.30
0.29
0.28
0.27
0.26
0.25
0.24
0.23
0.22
0.21
0.19
0.18
0.17
0.16
0.15
0.14
0.13
0.12
0.11
0.10
0.09
0.08
0.06
0.05
0.04
0.03
0.02
0.01
0.00

0.00
0.61
1.15
1.73
2.31
2.92
3.50
4.00
3.70
3.24
2.70
2.27
1.90
1.64
1.41
1.28
1.15
1.04
0.95
0.86
0.82
0.76
0.71
0.67
0.63
0.61
0.58
0.56
0.54
0.52
0.50
0.48
0.45
0.43
0.41
0.39
0.37
0.35
0.32
0.30
0.28
0.26
0.24
0.22
0.19
0.17
0.15
0.13
0.11
0.09
0.06
0.04
0.02
0.00

0.00
1.36
2.58
3.89
5.21
6.57
7.88
9.00
8.32
7.30
6.08
5.11
4.28
3.70
3.16
2.87
2.58
2.34
2.14
1.95
1.85
1.70
1.61
1.51
1.41
1.36
1.31
1.26
1.22
1.17
1.12
1.07
1.02
0.97
0.92
0.88
0.83
0.78
0.73
0.68
0.63
0.58
0.54
0.49
0.44
0.39
0.34
0.29
0.24
0.19
0.15
0.10
0.05
0.00

10
Note

A
B
C
D
E
F
G

H

I

J

K

The CAIT methodology proposes three scenarios of the tsunami simulation, including 2
m, 4 m, and 9 m tsunami WPH. The tsunami wave height data for the three scenarios are shown
in column 7, 8, and 9 in Table 59.
Figure 119 shows a plot created from interpreted, adjusted tsunami wave height data in
Table 59. The curve and arrival time of the tsunami wave height, shown in Figure 119, indicate
that the tsunami hit land areas in a short period (less than one hour) but the wave heights of 9 m
can be generated.

Figure 119. Interpreted, adjusted tsunami wave height data and arrival time
from 2011 tsunami in the Kesennuma Bay, Japan
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For evaluating the impact of tsunami simulation on land areas in port cities and coastal
areas, the cumulative arrival time of the tsunami, when its wave height started at 0 m, reached
9 m, and ended at 0 m, was considered and used. Figure 120 shows a plot that normalized to
peak value of tsunami wave height. The vertical axis shows the ratio between the tsunami wave
height and the peak value of the tsunami wave height. The ratio equals 1.0 when the tsunami
reaches the peak of wave height. The horizontal axis shows the cumulative arrival time of the
tsunami from 0 to 53 minutes. The plot in Figure 120 was used as the base reference for
developing 2 m, 4 m, and 9 m tsunami WPH simulations.

Figure 120. Normalized to peak value of tsunami wave height from 2011
tsunami in the Kesennuma Bay, Japan
249

Figure 121 shows a plot of the tsunami wave flow velocity. This plot was created using
measured velocity data presented in Figure 118. The velocity of the tsunami wave flow is low
(less than 5 m/s) at the first 10 minutes; it reaches 11 m/s after 16 minutes. Then, the velocity of
the tsunami wave flow goes down gradually and meets 0 after 53 minutes.

Figure 121. Velocity of tsunami wave flow and cumulative arrive time

Table 60 shows the summary table of wave height, cumulative time, and cumulative
distances of 2 m, 4 m, and 9 m tsunami WPH simulations. A distance that the tsunami travels to
land areas at each time interval equals velocity multiplied by the time interval. The tsunami
wave height of each simulation reaches the peak value at 7 minutes of cumulative arrival time
and 1,800 m of cumulative distance from shorelines. The tsunami wave height returns to 0 m
after 53 minutes of cumulative arrival time; and maximum cumulative distance that a tsunami
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can travel to the land areas is 29.8 km from the shorelines. Curves of 2 m, 4 m, and 9 m tsunami
WPH are shown in Figure 122, Figure 123, and Figure 124.

Table 60. Wave height, cumulative arrival time, and cumulative distances of tsunami
WPH simulations
Tsunami Wave Hight
Step

Time
2 m Peak 4 m Peak 9 m Peak

(hh:mm)
1
15:26
2
15:29
3
15:31
4
15:33
5
15:36
6
15:39
7
15:42
8
15:50
9
16:00
10 16:10
11 16:19
12

(m)
0.00
0.86
1.46
2.00
1.35
0.82
0.57
0.31
0.21
0.10
0.00

(m)
0.00
1.73
2.92
4.00
2.70
1.64
1.15
0.63
0.41
0.19
0.00

(m)
0.00
3.89
6.57
9.00
6.08
3.70
2.58
1.41
0.92
0.44
0.00

Time Cumulative
Distance At Cumulative
Velocity
Interval Arrival Time
Each Interval Distance
(minute)
0
3
2
2
3
3
3
8
10
10
9

(minute)
0
3
5
7
10
13
16
24
34
44
53
95

(m/s)
3.00
4.00
4.30
4.70
4.90
4.00
11.00
9.20
7.10
5.00

(m)
0
720
516
564
882
720
1,980
4,416
4,260
3,000

(m)
0
720
1,236
1,800
2,682
3,402
5,382
9,798
14,058
17,058
29.8 km
Return of water to the shore

Figure 122. Plot of 2 m tsunami WPH and cumulative arrive time
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Figure 123. Plot of 4 m tsunami WPH and cumulative arrive time

Figure 124. Plot of 9 m tsunami WPH and cumulative arrive time
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The main steps of the CAIT methodology to evaluate the impact of a tsunami simulation
are presented as follow. These steps are performed using 3-D analyst tools of ArcGIS software
(http://www.esri.com/software/arcgis/extensions/3danalyst).
1.

Load DEM map as well as Landsat-8 pansharpened multispectral imagery into a project
of ArcGIS software.

2.

Create a shoreline and define a simulation area from the created shoreline.

3.

Generate a shapefile of depth submerged by the tsunami wave peak height.

4.

Visualize submerged land polygons as the result from the tsunami simulation and overlay
the submerged land polygons above Landsat-8 pansharpened multispectral imagery.

5.

Evaluate the impact of a tsunami simulation on population and infrastructures in the study
area.
The detailed step-by-step procedure for implementing a tsunami simulation is shown in

Appendix F.
The five port cities selected for tsunami simulation include (1) Miami, Florida, (2)
Gulfport, Mississippi, (3) Los Angeles, California, (4) Karachi, Pakistan, and (5) Hai Phong,
Vietnam. Both Miami and Hai Phong port cities are more affected by rainfall flood and 2 m
SLR than other selected port cities in terms of inundated/submerged land and population at risk.
So, all three scenarios of the tsunami simulation, including 2 m, 4 m, and 9 m tsunami WPH,
are implemented in these two port cities. For other selected port cities such as Gulfport, Los
Angeles, and Karachi, only 2 m tsunami WPH is implemented.
6.3.2.2 Tsunami Simulation Results for Miami, Florida
Miami is known as the most vulnerable areas to weather related natural disaster in the
United States due to its low elevation and being surrounded by ocean. The results from rainfall
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flood and SLR simulations presented in chapter V and the early part of this chapter show that
56.76 % of Miami land area is undated by an extreme rainfall flood; and 57.08% can be
submerged by potential 2 m SLR. About 1.4 million people are at risk in both these simulations.
In order to have a comprehensive vulnerability assessment of a natural disaster on the port city,
three scenarios of the tsunami simulations were implemented using 3-D analyst tools of ArcGIS
software.

Figure 125. Spatial map of 2 m tsunami WPH simulation overlay on Landsat-8 imagery,
Miami and Surrounding Areas, FL
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The created shoreline, shown by the dashed red line in Figure 125, is more than 35 km
length. The maximum distance from the shoreline to the edge west of the study area is 29.3 km,
which is less than maximum cumulative distance (29.8 km) that a tsunami can travel onto land
areas. Therefore, the entire land area in the study was considered for tsunami simulations. The
tsunami simulations used 2ft DEM data, Landsat-8 satellite imagery, and population data, which
are the same input data used for the rainfall flood and SLR simulations for the port city.
Results of the 2 m tsunami WPH simulation are shown in Figure 125. The submerged
land is 411.96 km2, or 57.08% of land area. The submerged land was classified into 2 ranges of
depth. The first range is a 0 m to 1 m depth, and the second range is a 1 m to 2 m depth. Most of
the submerged land, or 47.10% of land area, is equal to or under 1 m depth. Some parts of the
Port of Miami as well as the runways of Miami International Airport are submerged by 2 m
tsunami. The population at risk in Miami-Dade Metro Area is 1.43 million. The density of
population at risk is 1,977 per km2. The total population at risk in the four cities in the study
area, including Pembroke Pines, Opa-locka, Miami Beach, and Miami, is 375,132.
Figure 126 shows the results of the 4 m tsunami WPH simulation. The submerged land
is 643.39 km2, or 89.15% of land area. Some small areas with high elevation close to the coast
southeast of the city are not affected. The submerged land was classified into 4 ranges of depth
(Figure 126). Most of the submerged land, or about 47% of land area, is at 2 m to 3 m depth.
The population at risk in the Miami-Dade Metro Area increases to 2.2 million. The density of
population at risk is 3,048 per km2. The total population at risk in the four cities in the study
area is 585,899. The dock areas of the port are submerged. The runways of Miami International

255

Airport are completely under seawater. Most of roads in the city are also affected by the 4 m
tsunami WPH.

Figure 126. Spatial map of 4 m tsunami WPH simulation overlay on Landsat-8 imagery,
Miami and Surrounding Areas, FL

Results of the 9 m tsunami WPH simulation are shown in Figure 127. This is the worst
scenario among the three scenarios of the tsunami simulations. Almost all the land area
(97.41%) in the study area is submerged. The submerged land was also classified into 4 ranges
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of depth (Figure 127). About 63% of land area is submerged at a 7 m to 9 m depth. The
population at risk in Miami-Dade Metro Area increases to 2.4 million. The density of
population at risk is 3,325 per km2. The total population at risk in the four cities in the study
area is 640,184. The port property as well as runways of the airport are completely under
seawater.

Figure 127. Spatial map of 9 m tsunami WPH simulation overlay on Landsat-8 imagery,
Miami and Surrounding Areas, FL
6.3.2.3 Tsunami Simulation Results for Gulfport, Mississippi
The 2 m tsunami WPH simulation was implemented in Gulfport in order to assess the
impacts of the tsunami on major infrastructures and population of the port city. The entire land
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area in the study area was used for the tsunami simulation because the maximum distance from
the shoreline to the edge north of the study area is 14.1 km, which is less than maximum
cumulative distance (29.8 km) that a tsunami can travel onto the land areas. The DEM data,
Landsat-8 satellite imagery, and population data, used for both rainfall flood and 2 m SLR
simulations for the port city, were also used for the 2 m tsunami WPH simulation.
The results of the 2 m tsunami WPH simulation are shown in Figure 128. The
submerged land is 1.68 km2 or 2.09% of land area.

Figure 128. Spatial map of 2 m tsunami WPH simulation overlay on Landsat-8 imagery,
Gulfport and Surrounding Areas, MS
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The submerged land was classified into 2 ranges of depth. The first range, a 0 m to 1 m
depth, covers 1.60% of the land area. The second range, a 1 m to 2 m depth, covers 0.49% of
the land area. The runways of the Gulfport-Biloxi International Airport are not submerged by 2
m tsunami WPH. However, some parts of the port property are submerged as well as some
sections of E Beach Blvd road. The population at risk in the study area is 687. The density of
population at risk is 9 per km2.
Gulfport is located on a flat area with mean of land DEM elevation around 6 m, so that
the effects by 2 m SLR or 2 m tsunami WPH in the port city are not as significant as other port
cites. Less than 2.1% of land area of the city is affected by 2 m SLR or 2 m tsunami WPH. Total
population at risk by 2 m SLR or by 2 m tsunami WPH is less than 1,000. However, Gulfport is
significantly affected by the extreme rainfall flood, by which 39.66% of land area is undated
and more than 600 thousand people are at risk.

6.3.2.4 Tsunami Simulation Results for Los Angeles, California
Los Angeles is less affected by an extreme rainfall flood and 2 m SLR in comparison
with other selected port cities. As shown by NOAA [160], about 59% of the world's tsunamis
have occurred in the Pacific Ocean. So, the risk of a tsunami in Los Angeles and other cities in
west coast of the U.S. is very real.
To assess the impacts of the tsunami on major infrastructures, and population of the port
city, the 2 m tsunami WPH simulation was implemented. The maximum distance from the
shoreline to the edge north of the study area is more than 45 km, which exceeds the maximum
cumulative distance (29.8 km) that a tsunami can travel into land areas. A buffer polygon
shapefile that only covers area within 29.8 km from the shoreline was created using ArcGIS.
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The 2 m tsunami WPH was simulated within the buffer polygon. The cumulative time of the
simulations in the study area is 53 minutes (Table 60). The DEM data, Landsat-8 satellite
imagery, and population data, used for both rainfall flood and 2 m SLR simulations for Los
Angeles, were also used for the 2 m tsunami WPH simulations.
Figure 129 shows results of the 2 m tsunami WPH simulation overlay on a contour
DEM map of Los Angeles and surrounding areas.

Figure 129. Spatial map of 2 m tsunami WPH simulation overlay on contour DEM map,
Los Angeles and surrounding areas, CA

Most of the areas along the western coast of the city are not submerged by 2 m tsunami
WPH because these areas are located on hills with elevation from 40 m to 240 m. The center of
the city, located on a flat area with elevation ranging from 30 m to 40 m, is also not affected by
2 m tsunami WPH. Submerged areas occur in the coastal areas south of the port city where
elevation is less than 2 m. The Port of Los Angeles and the Port of Long Beach are affected by
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2 m tsunami WPH. The Los Angeles International Airport in the west coastal area is not
submerged by 2 m tsunami WPH. The submerged land area in the study area is 26.14 km2, or
1.3% of land area. The population at risk in the study area is 167,136; and the density of
population at risk is 83 per km2.

6.3.2.5 Tsunami Simulation Results for Karachi, Pakistan
The 2 m tsunami WPH simulation was implemented in Karachi in order to evaluate the
impacts of the tsunami on major infrastructures and population of the port city.
The entire land area in the study area was used for the tsunami simulation because the
maximum distance from the shoreline to the edge north of study area is 29.5 km, which is less
than maximum cumulative distance (29.8 km) that a tsunami can travel into land areas. The
SRTM DEM data, Landsat-8 satellite imagery, and population data, used for both rainfall flood
and 2 m SLR simulations, were also used for the 2 m tsunami WPH simulation. The results of
the 2 m tsunami WPH simulation are shown in Figure 130.

Figure 130. Spatial map of 2 m tsunami WPH simulation overlay on Landsat-8 imagery,
Karachi and surrounding areas, Pakistan
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The submerged land area is 26.43 km2, or 3.67% of land area. The affected areas by the
2 m tsunami WPH are located along shoreline south of the city, with high population density.
The Jinnah International Airport, PAF Base Faisal, and PAF Base Masroor, located on high
elevation and far away from the shoreline, are not affected by the 2 m tsunami WPH. However
some parts of the Port of Karachi are submerged by the 2 m tsunami WPH. About 2 million of
the population of the city is at risk by 2 m tsunami WPH; and the density of population at risk is
2,765 per km2.

6.3.2.6 Tsunami Simulation Results for Hai Phong, Vietnam
Hai Phong, located in a tropical area, is most effected by a rainfall flood in comparison
with other selected port cities. The results from the extreme rainfall flood simulation for Hai
Phong in chapter V show that 84.31 % of land area is inundated by floodwater. The city is also
located in lowland areas; about 17 % of land area could be submerged by future 2 m SLR. In
order to have a comprehensive vulnerability assessment of natural disaster on the port city, three
scenarios of the tsunami simulations including 2 m, 4 m, and 9 m tsunami WPH were
implemented.
The maximum distance from the shoreline to the edge west of the study area is 17.1 km,
which is less than maximum cumulative distance (29.8 km) that a tsunami can travel into the
land areas. Consequently, the entire land area in the study was used for the three scenarios of
the tsunami simulations. The cumulative time of the simulations in the study area is 44 minutes
(Table 60). The SRTM DEM data, Landsat-8 satellite imagery, and population data, used for
both rainfall flood and 2 m SLR simulations for Hai Phong, were also used for the three
scenarios of the tsunami simulations.

262

Results of the 2 m tsunami WPH simulation are shown in Figure 131. The submerged
land is 35.27 km2, or 16.72% of land area. The submerged land was classified into 2 ranges of
depth. The first range, from 0 m to 1 m depth, covers 14.97% of land area. The second range,
from 1 m to 2 m depth, covers 1.75% of land area. Both the Port of Hai Phong and the runways
of Cat Bi International Airport are affected by the 2 m tsunami WPH. The population at risk in
the study area is 69,183; and the density of population at risk is 328 per km2.

Figure 131. Spatial map of 2 m tsunami WPH simulation overlay on Landsat-8 imagery,
Hai Phong and surrounding areas, Vietnam

Figure 132 shows the results of the 4 m tsunami WPH simulation for Hai Phong. The
submerged land is 107.09 km2, or 50.77% of land area. Most of the submerged land (33.65% of
of land area) is equal to or less than a 1 m depth. The dock areas of the port and the runways of
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the airport are affected by the 4 m tsunami WPH. Many roads in the east and the south of the
city are submerged. The population at risk by the 4 m tsunami WPH in the study area is
230,091; and the density of population at risk is 1,091 per km2.

Figure 132. Spatial map of 4 m tsunami WPH simulation overlay on Landsat-8 imagery,
Hai Phong and surrounding areas, Vietnam

Results of the 9 m tsunami WPH simulation for Hai Phong are shown in Figure 133.
Most of land area (83.50%) in the study area is submerged. The submerged land was classified
into 4 ranges of depth (Figure 133). Most of the submerged land is under a 5 m depth. The port
property and runways of the airport are almost completely under seawater. The population at
risk by the 9 m tsunami WPH in the study area is 583,588; and the density of population at risk
is 2,767 per km2.
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Figure 133. Spatial map of 9 m tsunami WPH simulation overlay on Landsat-8 imagery,
Hai Phong and surrounding areas, Vietnam

6.3.3 ANOVA Analysis for Compute Simulation Results of Flood/Tsunami/SLR
The objective of this ANOVA is to observe if the means of inundated/submerged land in
percent have statistical significant difference by using rainfall flood, tsunami, and SLR
simulation methods. This is an univariate analysis because only one response variable is
analyzed.
6.3.3.1 Sample Design for Computation Simulations
Table 61. Factorial for sample design
Factor 2 Miami,
FL
Factor 1
Rainfall flood
Tsunami
Sea Level Rise

Y1,1
Y2,1
Y3,1

Gulfport,
MS
Y1,2
Y2,2
Y3,2

Total Samples

3

3

Los Angeles, Karachi,
CA
Pakistan
Y1,3
Y1,4
Y2,3
Y2,4
Y3,3
Y3,4
3
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3

Hai Phong,
Vietnam
Y1,5
Y2,5
Y3,5
3

Total
5
5
5
15

Table 61 shows a sampling design based on the inundated/submerged simulation
methods and five study sites. There are 15 grand total numbers of simulation samples.
6.3.3.2 Statistical Descriptive Summary
A two-way ANOVA analysis was conducted to analyze whether there is any sufficient
evidence of a significant difference in the means of inundated/submerged land by the simulation
method (Factor 1) and by the study site (Factor 2). A statistical descriptive summary, including
number of simulation methods and study sites, mean, and standard deviation of
inundated/submerged land, is shown in Table 62 and Table 63.
Simulation methods are at three levels. The dependent or response univariate variable, Y
is inundated/submerged land area.

Table 62. Statistical data summary by simulation methods
Factor 1
Simulation Method and

Level

Factor 2
Study Sites

1
2
3

(n)
1, 2, 3, 4, 5
1, 2, 3, 4, 5
1, 2, 3, 4, 5

Rainfall flood
Tsunami
Sea level rise

Inundated/Submerged Land Area,
Factor 1
Y = Mean
Standard Deviation
(%)
(%)
58.97
21.29
16.17
23.72
16.28
26.63

Study sites are at five levels.
Table 63. Statistical data summary by study sites
Factor 2
Study Site

and

Miami, FL
Gulfport, MS
Los Angeles, CA

Karachi, Pakistan
Hai Phong, Vietnam

Level
1
2
3
4
5

Factor 1
Simulation
Methods
(n)
1, 2, 3
1, 2, 3
1, 2, 3
1, 2, 3
1, 2, 3
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Inundated/Submerged Land Area,
Factor 2
Y = Mean
Standard Deviation
(%)
(%)
56.97
0.18
14.61
21.69
13.40
20.63
28.12
42.22
39.25
39.02

6.3.3.3 Univariate ANOVA Model
Equation 6.1 shows the two-way ANOVA model used in the analysis that considers
simulation methods (Factor 1) and study sites (Factor 2).
yij = µm + αi + βj + eij

(6.1)

where,
y
i
j
µm
αi
βj
eij

= percent of inundated/submerged land (dependent variable)
= level of Factor 1 simulation method (i = 1 rainfall flood, i = 2 tsunami, i = 3 SLR)
= level of Factor 2 study site (j = 1 Miami, FL, j = 2 Gulfport, MS, j = 3 Los
Angeles, CA, j = 4 Karachi, Pakistan, j = 5 Hai Phong, Vietnam)
= grand mean (for all cities in the whole world)
= effect of simulation method factor (i =1, 2, 3)
= effect of study site factor (j =1, 2, 3, 4, 5)
= error, randomly normal distribution and mean equal to zero

6.3.3.4 Hypothesis Testing for Two-Way ANOVA
 Hypothesis Testing for Simulation Methods (Factor 1)
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of the percent of inundated land from rainfall
flood simulation, the mean of the percent of submerged land from a 2 m
tsunami simulation, and mean of the percent of submerged land from a 2 m
SLR simulation are equal.
H0: µ1 = µ2 = µ3
Alternative Hypothesis, H1: In the population, the mean of the percent of inundated land from
rainfall flood simulation, the mean of the percent of submerged land from
a 2 m tsunami simulation, and mean of the percent of submerged land from a
2 m SLR simulation are different.
H1: µ1 ≠ µ2 ≠ µ3
where,
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µ1
µ2
µ3

= mean of the percent of inundated land from rainfall flood simulation
= mean of the percent of submerged land from a 2 m tsunami simulation
= mean of the percent of submerged land from a 2 m SLR simulation

Step 2: Select level of statistical significance, α
An α of 0.05 for probability of type one error was selected as the level of
significance for the ANOVA for inundated/submerged land. The reason is because within
any simulation, α/2 (0.025) is for each one side of the probability associated with
rejecting a null hypothesis when it is true. The F distribution sketch with α/2 = 0.025 is
shown in Figure 134

Figure 134. The F distribution showing type I error

Figure 6-33 shows the α/2 equal to 0.025 which is shown at each end of the F
distribution. The α/2 (0.025) is two standard deviations away from the mean. This shows that
within the curve, 95% of all possibilities are contained within two standard deviations from the
population mean.
Step 3: Define criterion and decision rule for rejecting H0, F value at α/2
The ANOVA uses the Ftest criteria and decision rule for hypothesis testing. This is done
by comparing the independent ratio level variables, through what is known as an F test. By
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comparison of Fcritical and Ftest, the null hypothesis can be rejected or accepted. Fcritical is found
through a distribution of F table for given α value, while the Ftest is calculated through a
statistics program such as SPSS software [93]. Fcritical is defined in equation 6.2.
Fcritical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025

(6.2)

where,
dfb = degree of freedom between method simulations = K - 1
dfw = degree of freedom within the samples = N - K
K = Number of simulation methods = 3
N = Number of total samples = 15
dfb

=3-1=2

dfw

= 15 - 3 = 12

Fcritical is determined using Table C.5 [92]. The Table C.5 is only available for α = 0.01 and α =
0.05, so Fcritical for α/2 = 0.025 was interpolated as follows:
3. F value for α = 0.05 and F value for α = 0.01 were obtained using Table C.5.
F0.05, 2, 12 = 3.89
F0.01, 2, 12 = 6.93
4. Fcritical for α/2 = 0.025 was interpolated from F0.05, 2, 12 and F0.01, 2, 12.
Fcritical = F0.025, 2, 12

=

F0.05, 2, 12 + 2.5* ((F0.01, 2, 12 - F0.05, 2, 12)/4)

Fcritical = F0.025, 2, 12 = 3.89 + 2.5* ((6.93 – 3.89)/4) = 3.89 + 1.90
Fcritical = F0.025, 2, 12 = 5.79 for α/2 (0.025)
Decision rule: Reject H0 if the Ftest exceeds the Fcritical (or Ftest > Fcritical).
In SPSS results, calculated α/2 ≤ selected α/2
Step 4: Compute the Test Statistic, Ftest
The test statistic or Ftest for simulation method was calculated using SPSS software [93].
Table 64 shows SPSS output for the two-way ANOVA.
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Table 64. Two-way ANOVA test results from SPSS
Type III Sum of
Squares

df

Mean
Square

Ftest

Sig. (p)

Corrected Model

10,072.570a

6

1,678.762

5.804

0.013

Significant

Intercept

13,928.142

1

13,928.142

48.156

0.000

Significant

Simulation Method

6,089.343

2

3,044.671

10.527

0.006

Significant

Study_Site

3,983.228

4

995.807

3.443

0.064

Not significant

Error

2,313.833

8

289.229

Total

26,314.545

15

Corrected Total

12,386.404

14

Source

Result

a. R Squared = .813 (Adjusted R Squared = .673)

Step 5: Interpret the results for simulation methods (SPSS results show Ftest and probability α
value)
Table 64 shows that Ftest of simulation methods is 10.527 and significance of probability (p)
value is 0.006.
According to decision rule, Ftest (10.527) > Fcritical (5.79) or p (0.006) < α/2 (0.025). Therefore,
the null hypothesis test (H0) is rejected.
Therefore, in the population, there is statistically significant by simulation methods. In
other words, the difference of the mean of the percent of inundated land from rainfall flood
simulation, the mean of the percent of submerged land from tsunami simulation, and the mean
of the percent of submerged land from SLR simulation is statistically significant.
 Hypothesis Testing for Study Sites (Factor 2)
Step 1: State the hypothesis
Null Hypothesis: In the population, the mean of the percent of inundated/submerged land at
each study site is equal.
H0: µ1 = µ2 = µ3= µ4 = µ5
Alternative Hypothesis: In the population, the mean of the percent of inundated/submerged
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land at each study site is different.
H1: µ1 ≠ µ2 ≠ µ3 ≠ µ4 ≠ µ5
where,
µ1
µ2
µ3
µ4
µ5

= mean of the percent of inundated/submerged land in Miami, FL
= mean of the percent of inundated/submerged land in Gulfport, MS
= mean of the percent of inundated/submerged land in Los Angeles, CA
= mean of the percent of inundated/submerged land in Karachi, Pakistan
= mean of the percent of inundated/submerged land in Hai Phong, Vietnam

Step 2: Select level of statistical significance, α
The α of 0.05 was already selected to test the statistical significance between
simulation methods. It is for this reason α remains the same.
Step 3: Define criterion and decision rules for rejecting H 0, F value at α/2.
F critical is defined in equation 6.3
Fcritical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025

(6.3)

where,
dfb = degree of freedom between study sites = K - 1
dfw = degree of freedom within the samples = N - K
K = Number of study sites = 5
N = Number of total samples = 15
dfb
dfw

=5-1=4
= 15 - 5 = 10

Fcritical is determined using Table C.5 [92]. The Table C.5 is only available for α = 0.01 and α =
0.05, so Fcritical for α/2 = 0.025 was interpolated as follow:
3. F value for α = 0.05 and F value for α = 0.01 were obtained using Table C.5.
F0.05, 4, 10 = 3.48
F0.01, 4, 10 = 5.99
4. Fcritical for α/2 = 0.025 was interpolated from F0.05, 4, 10 and F0.01, 4, 10.
Fcritical = F0.025, 4, 10

=

F0.05, 4, 10 + 2.5* ((F0.01, 4, 10 - F0.05, 4, 10)/4)

Fcritical = F0.025, 4, 10 = 3.48 + 2.5* ((5.99 – 3.48)/4) = 3.48 + 1.57
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Fcritical = F0.025, 4, 10 = 5.05 for α/2 (0.025)
Decision rule: Reject H0 if the Ftest exceeds the Fcritical (or Ftest > Fcritical).
In SPSS results, calculated α/2 ≤ selected α/2
Step 4: Compute the Test Statistic, Ftest
The test statistic or Ftest for the study site was calculated using SPSS software [93]. The
SPSS output for the two-way ANOVA is shown in Table 64.
Step 5: Interpret the results for study site (SPSS results show Ftest and probability α
value)
Table 64 shows that Ftest of study site is 3.443 and p value is 0.064.
According to decision rule, Ftest (3.443) < Fcritical (5.05) or p (0.064) > α/2 (0.025).
Therefore, the null hypothesis test (H0) failed to reject.
Therefore, in the population, there is no the statistically significant difference by study
site considering the mean of the percent of inundated/submerged land.
Figure 135 shows a SPSS plot of the mean of the percent of inundated/submerged land
from three simulations in five different study sites.

Figure 135. SPSS plot of the mean of the percent of inundated/submerged land from three
simulations in five study sites
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On the plot, the line of rainfall flood simulation is much higher than that of tsunami or
SLR simulation. This indicates that the difference of the mean of the percent of inundated land
from rainfall flood simulation and the mean of the percent of submerged land from tsunami or
SLR simulation is statistically significant. In addition, the lines of the three simulations are
parallel. That means there is no the statistically significant difference by study site considering
the mean of the percent of inundated/submerged land.

6.4

Rating Disaster Resilience of Port Infrastructure for Sustainable Global Supply Chain
Global supply chains bring increased risks of disruption from events such as natural

disasters. For example, in November 2012, Hurricane Sandy closed ports and airports in the
north eastern United States and prompted the worst fuel shortages since the 1970s. The impact
of Thailand’s floods persisted into early 2012, affecting the automotive and high-tech industries.
More than 1,000 factories were hit, with subsequent insurance claims reaching U.S.$ 20 billion.
On a global level, cyber risk to supply chains has become a priority issue. Therefore, by
understanding and planning for such risks, disaster resilience should be assessed.
As recommended by Uddin [168], a natural disaster resilience plan is essential to
protect infrastructure assets and associated multimodal transportation networks. For example,
this will reduce damages and disruptions in the event of a hurricane or cyclone lands at or near a
port city. Infrastructure resilience management requires a simplified scale of Infrastructure
Disaster Resilience Rating (IDRR), which has been proposed by Uddin [168] as 100 (best) to
zero (failed). This IDRR scale can improve timely and efficient emergency management.
Additionally, the ratings can be used to prioritize different infrastructure system groups [169]
for appropriate hardening actions based on the type of disaster and associated risks.
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Results

Attributes

Table 65. Comparison of results for rainfall flood, tsunami, and sea level rise simulations
in selected port cities
Port City
Unit
Attributes and Results

Los
Angeles,
CA

Gulfport,
MS

Miami,
FL

Gwadar,
Pakistan

Karachi,
Pakistan

Hai
Phong,
Vietnam

Study Site Size

km x km

55 x 45

9 x 12

30 x 35

37 x 33

45 x 25

20 x 13

km2

2,006.42

80.29

721.71

742.62

723.49

210.93

m
(m)

54.3
(54.1)

6.8
(2.7)

1.7
(1.5)

16.9
(24.4)

20.8
(19.3)

3.6
(3.6)

m
(m)

45.7
(70.1 )

6.7
(1.9 )

0.8
(1.1 )

18.6
(34.7)

6.7
(8.2 )

2.5
(2.4 )

m
(m)

56.2
(49.6)

7.0
(3.5)

1.9
(1.5)

15.3
(5.8 )

25.4
(19.7)

4.5
(4.1)

m3/s

838.2

566.3

481.4

6,500

37,800

hours

24

24

24

6

6

km2
(%)
(million)

747.06
(37.23)
(4.78)

31.84
(39.66)
(0.013)

409.64
(56.76)
(1.42)

416.26
(57.53)
(8.63)

177.84
(84.31)
(0.62)

km2
(%)
(million)

26.14
(1.30)
(0.18)

1.68
(2.09)
(0.0007)

411.96
(57.08)
(1.43)

4.47
(0.95)
(0.18)

26.43
(3.65)
(2.00)

35.27
(16.72)
(0.07)

km2
(%)
(million)

33.76
(1.68)
(0.22)

1.68
(2.09)
(0.0007)

411.96
(57.08)
(1.43)

4.47
(0.95)
(0.18)

27.75
(3.84)
(2.00)

35.27
(16.72)
(0.07)

Land Area
Overall Average Land
DEM Elevation
(Standard Deviation)
First 5 km Average
Land DEM Elevation
(Standard Deviation)
Beyond 5 km Average
Land DEM Elevation
(Standard Deviation)
Peak Discharge of
Hydrograph
Hydrograph Duration
Rainfall Flood
inundated land
(% of land area)
(Population at risk)
2 m Tsunami
submerged land
(% of land area)
(Population at risk)
2 m SLR
submerged land
(% of land area)
(Population at risk)

SLR: Sea Level Rise
 From ANOVA analysis results, Factor 1 (simulation methods) is statistically significant. Therefore, we
can not combine the results of three simulation methods for further applications.
 From ANOVA analysis results, Factor 2 (study sites) is not statistically significant.
 This implies that we can use attributes of each study site and each simulation method to predict the
response variable (inundated/submerged land area in percent).
 Therefore, regression equations can be developed for rainfall flood, 2 m tsunami, and 2 m SLR using
data from study sites to predict the inundated/submerged land area in percent of total land area.
 Gwadar and Karachi, Pakistan, can be used as case studies for using equations.

6.5

Key Findings
The results of the 2 m SLR simulation showed that the submerged land (representing in

percent of land area) in Miami, Gulfport, Los Angeles, Karachi, and Hai Phong is 57.08%,
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2.09%, 1.68%, 3.84%, and 16.72%, respectively. Population at risk by 2 m SLR in Miami,
Gulfport, Los Angeles, Karachi, and Hai Phong is 1.43 million people, 687 people, 215,857
people, 2 million people, and 69,183 people, respectively.
The results of the 2 m tsunami WPH indicated that the submerged land (representing in
percent of land area) in Miami, Gulfport, Los Angeles, Karachi, and Hai Phong is 57.08%,
2.09%, 1.30%, 3.65%, and 16.72%, respectively. The population at risk by a 2 m tsunami WPH
in Miami, Gulfport, Los Angeles, Karachi, and Hai Phong is 1.43 million people, 687 people,
167,136 people, 2 million people, and 69,183 people, respectively.
The CAIT methodology for 4 m and 9 m tsunami WPH simulations were implemented
for Miami, and Hai Phong. Results of these simulations indicate that the submerged land
increases significantly from 2 m to 9 m tsunami WPH (5.0 times in Hai Phong and 1.7 times in
Miami). The population at risk due to a 9 m tsunami WPH is 583 thousand in Hai Phong and
2.4 million in Miami.
The comparison among the rainfall flood, 2 m SLR, and 2 m tsunami WPH simulations
shows that rainfall flood inundation is more disastrous to people and infrastructures compared
to future 2 m SLR related to climate impacts or 2 m tsunami WPH.
The two-way ANOVA hypothesis testing was conducted to analyze whether the means
of inundated/submerged land (in percent) have statistical significant difference by using rainfall
flood, tsunami, and SLR. The results of the two-way ANOVA hypothesis testing indicate that in
the population, there is statistically significance by using rainfall flood, tsunami, and SLR
simulation methods.
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VII. EVALUATION OF GLOBAL WARMING AND CLIMATE IMPACT MODELS
7.1

Climate Impacts on Flood Disaster Resilience of Coastal Cities
Accoring to NASA [170], there is strong proof that global sea level is now rising at an

increased rate and will continue to rise during this century. In another study, Webster et al.
[171] indicated that the number of Category 4 and 5 hurricanes worldwide has approximately
doubled over the past 35 years. Category 4 hurricanes have sustained winds from 131 to 155
miles per hour; Category 5 systems, such as Hurricane Katrina at its peak over the Gulf of
Mexico, feature winds of 156 mph or more. In the 1970s, there was an average of about 10
Category 4 and 5 hurricanes per year globally. Since 1990, the number of Category 4 and 5
hurricanes has almost doubled, averaging 18 per year globally. Additionally, Rahmstorf [172]
reported that current forecasts range from 0.2 m to 2 m of SLR by 2100 and project an overall
shift toward meteorological instability, including changes in storm frequency and intensity.
As shown by Becker [10], seaports are located in areas vulnerable to climate change
impacts. Climate impacts, like a projected SLR of 0.2 m to 2 m and doubling of Category 4 and
5 hurricanes by 2100, will result in more extreme weather disasters at those seaports.
Climate change not only impacts maritime navigation but also inland navigation.
Climate change effects due to rainfall and sea level rise have and will continue to impact inland
navigation primarily in terms of water depth and velocity, resulting in changes in sedimentation
and the presence and absence of ice [173].
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7.2

Review of Global Warming and Climate Impact Models
According to the IPCC [174], anthropogenic CO2 is 77% of the total emitted greenhouse

gases; the remaining are 14% Methane, 8% Nitrous oxide (NOx), and 1% Fluorinated gases (Fgases). Anthropogenic CO2 emissions therefore are the most significant cause of global
warming, as shown in Figure 136.

Figure 136. Global greenhouse gas emission by gas and source

Global greenhouse gas emissions can also be broken down by the economic activities
that lead to their production. As shown by Figure 136(b), energy is the highest proportion, 26%
of the total emitted greenhouse gases, 19% industry, 17% forestry, 14% agriculture, and 13%
transportation [174].
Figure 137 shows a graph of the rise of carbon dioxide presented by NASA [170]. This
graph was made based on the comparison of atmospheric samples contained in ice cores and
more recent direct measurements. The graph shows that levels of anthropogenic CO2 in the
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atmosphere are higher than they have been at any time in the past 450,000 years. During ice
ages, anthropogenic CO2 levels were around 200 parts per million (ppm), and during the
warmer interglacial periods, they hovered around 280 ppm. In 2013, anthropogenic CO2 levels
surpassed 400 ppm for the first time in recorded history. This recent relentless rise in
anthropogenic CO2 shows a remarkably constant relationship with fossil-fuel burning and can
be well accounted for based on the simple premise that about 60 percent of fossil-fuel emissions
stay in the air [170]. The emissions of anthropogenic CO2 have been dramatically increased
within the last 50 years and are still increasing by almost 3% each year [175].

Source: NASA
Figure 137. Graph of the rise of carbon dioxide

Figure 138 shows the IPCC model for prediction of CO2 at the Mauna Loa Observatory,
Hawaii, United States [176]. There are six scenarios of the IPCC model. The predicted CO2
emission from these six scenarios ranges from 500 ppm to 650 ppm by 2050.
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Figure 138. IPCC model of predicted CO2 under six scenarios

Another model for prediction of CO2 provided by the EPA [177] is shown in Figure 139.
This model gave four scenarios. The lowest CO2 emission scenario assumes that emissions
reach a peak between 2010 and 2020, declining thereafter. The predicted CO2 emission by 2050
ranges from 450 ppm to 650 ppm.

Figure 139. EPA model of predicted CO2 under four scenarios
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The IPCC believes that the anthropogenic CO2 emissions are the most significant cause
of global warming. The IPCC model for prediction of global temperature [178] using global
temperature anomaly data is shown in Figure 140. The IPCC model provides four scenarios of
predicted global temperature. The predicted global temperature anomaly by 2050 ranges from
1.8 oC to 3.5 oC. In other words, the global temperature will increase from 1.8 oC to 3.5 oC by
2050 compared with the global temperature in 2000.

Figure 140. IPCC model for prediction of global temperature

The EPA also developed a model for prediction of global temperature change using
global temperature anomaly data [177]. Figure 141 shows four scenarios of predicted global
temperature from the EPA model. The predicted global temperature anomaly by 2050 ranges
from 1.0 oC to 4.1 oC. In other words, the global temperature will increase from 1.0 oC to 4.1 oC
by 2050 compared with the global temperature in 2005.
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Figure 141. EPA model for prediction of global temperature

Global temperature anomaly data were used for both the IPCC and EPA models for
prediction of global temperature. Results of both models indicate that global temperature
change will increase significantly by 2050. However, for acceptable scientific analysis, actual
historic measured global temperatures must be used for global temperature models. Therefore,
in this study, an advanced ARIMA model approach for prediction of global temperature was
used to model the actual historic measured monthly global temperature data.

7.3

ARIMA Modeling and Prediction for CO2

7.3.1 Data Source of Atmospheric CO2
Data of historic monthly average atmospheric CO2 (ppm) from March 1958 to
December 2016 at Mauna Loa Observatory, Hawaii, United States, were acquired from the
NOAA [179]. Figure 142 shows a plot of the historic monthly average atmospheric CO2 data.
There are 706 data points or 706 months in this data. The mean of monthly average atmospheric
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CO2 of the data is 352.04 ppm. The standard deviation (SD) and coefficient of variation (COV)
of the data are 26.20 ppm and 7.4%. The correlation coefficient (R) is 0.989. The high R
indicates that there is significant linear correlation between monthly average atmospheric CO2
from month to month during the period from 1958 to 2016.

Figure 142. Historic monthly average atmospheric CO2 from 1958 to 2016

7.3.2 ARIMA Modeling and Prediction for CO2
Table 66 shows results of correlation analysis between months and other associated
components such as monthly average atmospheric CO2, lag 1 monthly average atmospheric
CO2, one differencing, and moving average atmospheric CO2.
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Table 66. Correlation of average atmospheric CO2 by month with
Different AR, I, and MA terms
A

B

C

D

E

Month vs.
Monthly
Average CO2

Month vs. Lag 1
Monthly Average
CO2 Sequential
Correlation

Month vs.
One
Differencing
Correlation

Month vs.
Two Months
Moving Average
Correlation

Month vs.
Three Months
Moving
Average
Correlation

0.989

0.989

0.032

0.990

0.990

 The Pearson’s correlation between month and the monthly average atmospheric CO 2
shows high correlation of 0.989.
 Month and Lag 1 monthly average atmospheric CO 2 sequential correlation is 0.989,
which is also high. This implies that the monthly average atmospheric CO 2 cannot be
used as an independent variable in the model development process.
 Month and one differencing correlation is 0.032, which explained that the data was in
a stationary condition.
 Month and 2 months moving average atmospheric CO 2 correlation is 0.990. This
correlation is high. Therefore, the 2 months moving average atmospheric CO2 was
used as a moving average term for the ARIMA model equations.
 Month and 3 months moving average atmospheric CO2 correlation is 0.990. This
correlation is also as high as the correlation between month and 2 months moving
average atmospheric CO2.
From the correlation analysis shown in Table 66, ARIMA (0,1,2) and ARIMA (1,1,2)
model equations were recommended to use for further analysis.
The measured data of monthly average atmospheric CO2 from 1958 to 2015 at Mauna
Loa Observatory, Hawaii, were used for analyzing and evaluating these ARIMA model
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equations, and the measured data of monthly average atmospheric CO2 in 2016 was used for
validating the ARIMA model equations.
Both ARIMA (0,1,2) and ARIMA (1,1,2) model equations were implemented using
SPSS software [93] for measured data of monthly average atmospheric CO2 from 1958 to 2015.
Figure 143 shows a plot of the measured and predicted monthly average atmospheric
CO2 from the ARIMA (0,1,2) and ARIMA (1,1,2) model equations from 1950 to 2015. The
statistical descriptive summary of both measured and predicted data is also presented on the
plot.

Figure 143. Verification of the ARIMA (0,1,2) and ARIMA (1,1,2) model equations

The R value is 0.999 for both the ARIMA (0,1,2) and ARIMA (1,1,2) model equations.
The high R value indicates that there is strong correlation between measured monthly average
atmospheric CO2 and predicted monthly average atmospheric CO2 from these ARIMA model
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equations. The MARE and RMSE values of the ARIMA (0,1,2) model equation are 0.18% and
0.80, which are smaller than those of ARIMA (1,1,2) model equation.
In addition, the measured data of monthly average atmospheric CO2 in 2016 was used
for validating these ARIMA model equations. The comparison between the measured and
predicted monthly average atmospheric CO2 in 2016 from these ARIMA model equations is
shown in Table 67.

Table 67. Comparison between measured and predicted data in 2016
from ARIMA (0,1,2), ARIMA (1,1,2) model equations
Cumulative
Month
695
696
697
698
699
700
701
702
703
704
705
706

Month

Jan-16
Feb-16
Mar-16
Apr-16
May-16
Jun-16
Jul-16
Aug-16
Sep-16
Oct-16
Nov-16
Dec-16
Total
Average
SD
COV
Average
% Difference
MARE (%)
RMSE (ppm)

Monthly Average
CO2
(Measured)
(ppm)
402.52
404.04
404.83
407.42
407.70
406.81
404.39
402.25
401.03
401.57
403.53
404.48
4,850.57
404.21
2.2
0.5%

ARIMA
(0,1,2)
Predictions
(ppm)
403.01
403.58
403.85
404.07
404.26
404.41
404.52
404.59
404.62
404.62
404.57
404.49
4,850.59
404.22
0.5
0.1%

ARIMA
(1,1,2)
Predictions
(ppm)
403.00
403.59
403.93
404.17
404.35
404.50
404.62
404.73
404.81
404.87
404.92
404.94
4,852.43
404.37
0.6
0.1%

0.0025

0.0396

0.44
2.22

0.46
2.27

The average % difference of the ARIMA (0,1,2) model equation is 0.025% (Table 67),
which is smaller than that of the ARIMA (1,1,2) model equation. The MARE and RMSE of the
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ARIMA (0,1,2) model equation using data in 2016 are also lower than those of the ARIMA
(1,1,2) model equations. Figure 144 shows a plot of the verification of the ARIMA (0,1,2)
model equation in 2016. The blue dashed line of the predicted data from the verification of the
ARIMA (0,1,2) model equation is close and fit with the red line of measured data, which
indicates the ARIMA (0,1,2) model equation gave accurate prediction for CO2. Therefore, the
ARIMA (0,1,2) model equation was used for predicting monthly average CO2 until 2050.

Figure 144. Plot of verification of ARIMA (0,1,2) models equation in 2016 for CO2

The following Equation 7.1 shows a general ARIMA (0,1,2) model equation for CO2.
▼1 * Yt = C + (1− θ 1B − θ 2B2 ) . at
Yt = Discrete time series
▼1 = Regular Differencing operator of order one
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(7.1)

C = Constant = 10.757
1− θ 1B − θ 2B2 = Regular Moving Average process of order two
at = random shock term; normally distributed, independent with zero average, and
variance equal to σa
The summary of ARIMA (0,1,2) model equation parameters is shown in Table 68.

Table 68. Summary of ARIMA (0,1,2) Model Parameters
ARIMA Model Parameters

Average
Average Carbon
Dioxide (CO2)-

Carbon
Dioxide (CO2)

No

Estimate

SE

t

Sig.

Constant

.382

.096

3.986

.000

Difference

1

Transformation

Lag 1

-.864

.033

-24.845

.000

Lag 2

-.488

.033

-14.588

.000

Lag 0

-.039

.010

-3.910

.000

MA

Model
MONTH,

No

period 12

Transformation

Numerator

The ARIMA (0,1,2) model equation was used for predicting monthly average CO2 until
2050. Figure 145 shows a plot of measured and predicted monthly average CO2 from 1958 to
2016, and predicted monthly average CO2 from 2017 to 2050.
The statistical descriptive summary of the mesured and predicting monthly average
CO2 in both periods is shown in Figure 145.
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Figure 145. Measured and ARIMA (0,1,2) predicted monthly average carbon dioxide
from 1955 to 2050
Table 69 shows annual monthly average CO2 predictions from 2017 to 2050. The annual
average CO2 prediction for a year was averaged from monthly average CO2 predictions in that
year. The predicted annual average CO2 data was compared with the measured annual average
CO2 data in 2016. The comparison results shown in colume four on Table 69 indicate that the
annual average CO2 will increase significantly from 404.21 ppm in 2016 to 456.94 ppm in 2050
(or 13.0% increase from 2016). Figure 146 shows predicted annual average CO2 from the
ARIMA (0,1,2) model equations from 1950 to 2050. The average values of predicted annual
average CO2 from 2017 to 2050 is 431.36 ppm.
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Table 69. Annual monthly average CO2 predictions from 2017 to 2050
Cumulative
Year

Year

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

2017
2018
2019
2020
2021
2022
2023
2024
2025
2026
2027
2028
2029
2030
2031
2032
2033
2034
2035
2036
2037
2038
2039
2040
2041
2042
2043
2044
2045
2046
2047
2048
2049
2050

Annual Average
CO2
(ppm)
405.79
407.34
408.89
410.44
411.99
413.54
415.09
416.64
418.19
419.74
421.29
422.84
424.39
425.94
427.49
429.04
430.59
432.14
433.69
435.24
436.79
438.34
439.89
441.44
442.99
444.54
446.09
447.64
449.19
450.74
452.29
453.84
455.39
456.94

% Increase from
annual average CO2 in 2016
(ppm)
0.4
0.8
1.2
1.5
1.9
2.3
2.7
3.1
3.5
3.8
4.2
4.6
5.0
5.4
5.8
6.1
6.5
6.9
7.3
7.7
8.1
8.4
8.8
9.2
9.6
10.0
10.4
10.7
11.1
11.5
11.9
12.3
12.7
13.0

Annual average measured CO2 in 2016: 404.21 ppm
Annual average predicted CO2 from the ARIMA (0,1,2) model equation in 2016: 404.22 ppm
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Figure 146. ARIMA (0,1,2) predicted annual average carbon dioxide
from 1950 to 2050

Table 70 shows the comaparison of the predicted atmospheric CO2 from the IPCC
model [176], the EPA model [177], and the ARIMA (0,1,2) model equation. The ARIMA
(0,1,2) model equation achieves accurate predicted values. The ARIMA model was validated
using monthly average atmospheric CO2 in 2016, and the average percent difference between
the predicted value and measured data is only 0.025%. The predicted values of the IPCC model
and EPA model are -3.52% and 16.28%, respectively, different from the measured data in 2016.
The predicted CO2 values of all three models increase significantly for 2050 as
compared to measured CO2 in 2016 with 404.21 ppm. But IPCC and EPA models predict
unreasonably high values of CO2. The IPCC’s claims of high correlation of CO2 with
temperature anomaly is not acceptable scientific.
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Table 70. Comparison of predicted CO2 from IPCC, EPA, and ARIMA model equations
Model

2016
(% difference from
measured data)
2050

7.4

IPCC model
Prediction

EPA Model
Prediction

ARIMA (0,1,2)
Model Equation
Prediction

Measured
atmospheric
CO2 in 2016

(ppm)

(ppm)

(ppm)

(ppm)

390.00
(-3.52%)

470.00
(16.28%)

404.22
(0.0025% )

404.21

450 - 650

420 - 640

456.94

ARIMA Modeling and Prediction for Monthly Average Temperature

7.4.1 Data Source of Monthly Average Temperature
Figure 147 shows a map of average temperature in July 2014. This map was created
using data from approximately 7,280 climate stations around the world, provided by the NOAA
[180]. The map of average temperature for any month since 1950 can be viewed.

Figure 147. Monthly average temperature (oC) in July 2014
Data
(Map credit: http://halftone.co/projects/temperatures/)
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Figure 148 shows data of combined land and ocean historic monthly average
temperature (oC) from 1950 to 2016, which was acquired from the NOAA [180]. The plot of the
historic monthly average temperature (oC) data was created by Davis [181]. There are 804
months in this data. The mean of monthly average temperature (oC) of the data is 12.97 oC. The
standard deviation and coefficient of variation of the data are 6.11 oC and 17%. These values
show that data is widely spread above and below the mean. It can be seen from Figure 148 that
most data points are located within the range from 5 oC to 20 oC. The correlation coefficient (R)
is only 0.0781. The very low R indicates that there is very poor correlation between average
temperatures (oC) from month to month during the period from 1950 to 2016.

Figure148 . Historic monthly average temperature (oC) from 1950 to 2016

7.4.2

Crosscorrelation Analysis between Monthly Average Temperature and CO2
The United States Environmental Protection Agency (EPA) [177] indicates that global

warming is caused by the increase of emissions of greenhouse gases. According to IPCC [175],
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atmospheric carbon dioxide (CO2) emissions, accounting for 77% of the totally emitted
greenhouse gases, are the most significant cause of global warming. However, in order to
evaluate the correlation between temperature and CO2, an scientific analysis using actual history
measured temperature and the CO2 data was conducted as follow.
The monthly average anthropogenic CO2 data was provided by NOAA [179]. This is
time series data measured at Mauna Loa Observatory, Hawaii, United States from March 1958
to December 2016. The combined land and ocean historic monthly average temperature (oC)
was also acquired from the NOAA [180] from January 1950 to December 2016. For
crosscorrelation analysis, both monthly average temperature and anthropogenic CO2 data must
use the same range of time. Therefore, only monthly average temperature (oC) data from March
1958 to December 2016 was used for the cross correlation analysis.
Crosscorrelation was conducted using the CORREL function of Microsoft Excel 2010.
The result of this analysis shows that crosscorrelation between monthly average temperature
(oC) and monthly average anthropogenic CO2 is 0.08, which indicates that there is no significant
correlation between monthly average temperature (oC) and monthly average anthropogenic CO2
in the atmosphere observed from 1958 to 2016. This conclusion is clearly explained in Figure
149.
The data points of monthly average anthropogenic CO2 have increased steadily from
312.66 ppm in March 1958 to 404.48 ppm in December 2016, while data points of monthly
average temperature (oC) have not changed much since 1958.
The results from above crosscorrelation analysis show a different conclusion from the
EPA and IPPC, who believe global temperature has increased and global warming is caused by
the increase of the anthropogenic carbon dioxide (CO2) emissions. Both EPA and IPPC did not
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use actual measured temperature (oC) for their analysis. They used temperature anomaly data,
which is a subject reference year with no sound basis. Results from temperature anomaly
analysis are difference from results from actual measured temperature analysis. In order to
assess the correlation between temperature and the anthropogenic CO2, and make prediction of
temperature in future, the actual measured temperature must be used.

Figure 749. Monthly average temperature (oC) and anthropogenic CO2 in from 1958 to 2016

7.4.3 Analysis of Frequency Distribution of Monthly Average Temperature (°C)
The monthly average temperature (oC) data from 1950 to 2016 was used for this
analysis. Figure 150 shows frequency distribution of monthly average temperature (°C).
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Figure 150. The frequency distribution of monthly average temperature (°C)

The monthly average temperature (°C) were classified into five intervals of temperature:
less than 5°C, 5°C to 10°C, 10°C to 15°C, 15°C to 20°C, and larger than 20°C.
The frequency distribution plot shows the measured monthly average temperature (°C)
data that resembles a normal distribution.

7.4.4 One-Way ANOVA Analysis for Monthly Average Temperature (oC)
7.4.4.1 Sample Design for Monthly Average Temperature (oC)
Figure 151 shows a plot of annual average temperature (oC) from 1950 to 2016 [180,
181]. The data points of the annual average temperature (oC) have different slopes at three
different periods. The data points in the first period from 1950 to 1970 are likely to be higher
than the data points in the second period from 1971 to 1990. The data points in the third period
from 1991 to 2016 jump higher than the data points in the first and second periods.
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Figure 151. Historic annual average temperature from 1950 to 2016

Table 71. Level of factor (temperature periods)
Factor

Period 1
(1950 - 1970)

Period 2
(1971 - 1990)

Period 3
(1991 - 2016)

252

240

312

Total Samples

Total
804

Table 71 shows a sampling design based on the three temperature periods. There are 804
grand total temperature samples.
The objective of this one-way ANOVA is to observe if the means of monthly average
temperature (°C) have statistical significant difference at different periods of time. This is an
univariate analysis because only one response variable is analyzed.
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7.4.4.2 Statistical Descriptive Summary and Frequency Distribution Plot
A one-way ANOVA analysis was conducted to analyze whether there is any sufficient
evidence of a significant difference in the means of monthly average temperature (°C) at the
different temperature periods (Factor). A statistical descriptive summary, including number of
measured temperature, mean, and standard deviation of monthly average temperature (°C) is
shown in Table 72.
Temperature periods are at three levels. The dependent or response univariate variable,
Y is monthly average temperature (°C).

Table 72. Statistical data summary of monthly average temperature (°C)
Factor
Temperature Periods and
Period 1 (1950 - 1970)
Period 2 (1971 - 1990)
Period 3 (1991 - 2016)

Level
1
2
3

Number of
Measured
Temperature

Y = Mean

Standard Deviation

(n)
252
240
312

(°C)
12.60
12.46
13.67

(°C)
6.12
6.02
6.13

Monthly Average Temperature

7.4.4.3 Univariate One-Way ANOVA Model
Equation 7.2 shows the one-way ANOVA model that considers a single Factor of
temperature periods.
yi = µm + αi + ei
where,
y
i
µm
αi
ei

= monthly average temperature in °C (dependent variable)
= level of temperature periods factor (i = 1 Period 1 (1950 -1970), i = 2
Period 2 (1971 – 1990), i = 3 Period 3 (1991 - 2016))
= grand mean (for all temperature periods)
= effect of temperature periods factor (i =1, 2, 3)
= error, randomly normal distribution and mean equal to zero
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(7.2)

7.4.4.4 Hypothesis Testing for One-Way ANOVA
 Hypothesis Testing for Temperature Periods (Factor)
Step 1: State the hypothesis
Null Hypothesis, H0: In the population, the mean of the monthly average temperature (°C)
from 1950 to 1970, the mean of the monthly average temperature (°C) from
1971 to 1990, and the mean of the monthly average temperature (°C) from
1991 to 2016 are equal.
H0: µ1 = µ2 = µ3
where,
µ1
µ2
µ3

= mean of the monthly average temperature (°C) from 1950 to 1970
= mean of the monthly average temperature (°C) from 1971 to 1990
= mean of the monthly average temperature (°C) from 1991 to 2016

Alternative Hypothesis, H1: In the population, the mean of the monthly average temperature
(°C) from 1950 to 1970, the mean of the monthly average temperature (°C)
from 1971 to 1990, and the mean of the monthly average temperature (°C)
from 1991 to 2016 are different.
H1: µ1 ≠ µ2 ≠ µ3
Step 2: Select level of statistical significance, α
An α of 0.05 for probability of type one error was selected as the level of
significance for the one-way ANOVA for monthly average temperature (°C) because
within any temperature periods, α/2 (0.025) is for each side of the probability associated
with rejecting a null hypothesis when it is true. The F distribution sketch with α/2 = 0.025
is shown in Figure 152.
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Figure 152. The F distribution showing type I error
Figure 152 shows the α/2 equal to 0.025, which is shown at each end of the F
distribution. The α/2 (0.025) is two standard deviations away from the mean. This shows that
within the curve, 95% of all possibilities are contained within two standard deviations from the
population mean.
Step 3: Define criterion and decision rule for rejecting H 0, F value at α/2
The one-way ANOVA uses the Ftest criteria and decision rule for hypothesis
testing. This is done by comparing the independent ratio level variables through what is
known as an F test. By comparison of F critical and Ftest, the null hypothesis can be rejected
or accepted. Fcritical is found through a distribution of F table for given α value, while the
Ftest is calculated through a statistics program such as SPSS software [93]. Fcritical is
defined in Equation 7.3.
Fcritical = Fα/2, dfb, dfw for two-tailed test, α/2 = 0.025
where,
dfb = degree of freedom between temperature periods = K - 1
dfw = degree of freedom within the samples = N - K
K = Number of temperature periods = 3
N = Number of total samples = 804
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(7.3)

dfb
dfw

=3-1=2
= 804 - 3 = 801

Fcritical is determined using Table C.5 [92]. The Table C.5 is only available for α = 0.01 and α =
0.05, so Fcritical for α/2 = 0.025 was interpolated as the following:
5. F value for α = 0.05 and F value for α = 0.01 were obtained using Table C.5.
F0.05, 2, 801 = 3.04
F0.01, 2, 801 = 4.71
6. Fcritical for α/2 = 0.025 was interpolated from F0.05, 2, 801 and F0.01, 2, 801.
Fcritical = F0.025, 2, 801

=

F0.05, 2, 801 + 2.5* ((F0.01, 2, 801 - F0.05, 2, 801)/4)

Fcritical = F0.025, 2, 801 = 3.04 + 2.5* ((4.71 – 3.04)/4) = 3.04 + 1.04
Fcritical = F0.025, 2, 801 = 4.08 for α/2 (0.025)
Decision rule: Reject H0 if the Ftest exceeds the Fcritical (or Ftest > Fcritical).
In SPSS results, calculated α/2 ≤ selected α/2.
Step 4: Compute the Test Statistic, Ftest
The test statistic or Ftest for temperature periods was calculated using SPSS software
[93]. Table 7-8 shows SPSS output for the one-way ANOVA.

Table 73. One-way ANOVA test results from SPSS
Sum of Squares

df

Mean Square

F

Sig.

Result

248.063

2

124.031

3.339

.036

Not significant

Within Groups

29755.892

801

37.148

Total

30003.955

803

Between Groups

Step 5: Interpret the results for temperature periods (SPSS results show Ftest and probability α
value)
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Table 73 shows that Ftest of the temperature periods is 3.339, and significance of probability (p)
value is 0.036.
According to the decision rule, Ftest (3.339) < Fcritical (4.08), or p (0.036) > α/2 (0.025).
Therefore, the null hypothesis test (H0) failed to reject.
Therefore, in the population of monthly average temperature (°C), there is no
statistically significant difference with respect to the Factor of temperature periods. In other
words, the difference is not statistically significant among the mean of the monthly average
temperature (°C) from 1950 to 1970, the mean of the monthly average temperature (°C) from
1971 to 1990, and the mean of the monthly average temperature (°C) from 1991 to 2016.
Results of the one-way ANOVA analysis for monthly average temperature (oC) indicate
that the monthly average temperature (°C) data from 1950 to 2016 can be used for predicting
temperature (°C) in the future using advanced ARIMA model equation.
7.4.4.5 ARIMA Modeling and Prediction for Monthly Average Temperature
The ARIMA modeling equations for monthly average temperature (oC) are described in
detail by Davis [181]. In this study, only summaries of the ARIMA modeling equations for
monthly average temperature (oC) are presented.
Table 74 shows results of correlation analysis between month and other associated
components such as monthly average temperature (oC), lag 1 monthly average temperature, one
differencing, and moving average temperature.
 Month and monthly average temperature correlation is 0.0783 (poorly correlated).
That means a monthly regression model cannot be made. The trend line is not a good
model.
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 Month and Lag 1 monthly average temperature sequential correlation is 0.0748, which
is also poorly correlated. Therefore, the autoregressive process term is not needed for
the ARIMA model equations.
 Month and one differencing correlation is -0.0125, which is a very low correlation.
This means there is no effected trend line. Therefore, the degree of differencing term
is also not needed for the ARIMA model equations.
 Month and 2 months moving average temperature correlation is 0.0809. This
correlation is low.
 Month and 3 months moving average temperature correlation is 0.0851. This
correlation has a slight improvement.
 Month and 4 months moving average temperature correlation is 0.0914. This
correlation has a slight improvement.
 Month and 5 months moving average temperature correlation is 0.1007. This
correlation has a slight improvement.
 Month and 6 months moving average temperature correlation is 0.1147. This
correlation has an improvement. So the 6 months moving average temperature could
be used for the ARIMA model equations.
 Month and 12 months moving average temperature correlation is 0.7060. This
correlation has a significant improvement. Therefore, the 12 months moving average
temperature was recommended to use for the ARIMA model equations.
 Month and 60 months moving average temperature correlation is 1.0000. This
correlation is a perfect correlation. Consequently, the 60 months moving average
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temperature was recommended to use as both nonseasonal and seasonal moving
average terms for the ARIMA model equations.

Table 74. Correlation of monthly average temperature by month with
Different AR, I, and MA terms
A

B

C

D

E

Month vs.
Monthly
Average
Temperature

Month vs. Lag 1
Monthly Average
Temperature
Sequential
Correlation

Month vs.
One Differencing
Correlation

Month vs.
2 Months
Moving
Average
Temperature
Correlation

Month vs.
3 Months
Moving
Average
Temperature
Correlation

0.0783

0.0748

-0.0125

0.0809

0.0851

F

G

H

I

J

Month vs.
4 Months
Moving
Average
Temperature
Correlation

Month vs.
5 Months
Moving Average
Temperature
Correlation

Month vs.
6 Months
Moving Average
Temperature
Correlation

Month vs.
12 Months
Moving
Average
Temperature
Correlation

Month vs.
60 Months
Moving
Average
Temperature
Correlation

0.0914

0.1007

0.1147

0.7060

1.0000

Based on the correlation analysis shown in Table 74, three ARIMA model equations,
including ARIMA (0,0,12), seasonal ARIMA (0,0,12) (0,0,6), and seasonal ARIMA (0,0,12)
(0,0,60) model equations, were recommended for modeling and predicting monthly average
temperature (oC).
The measured data of monthly average temperature (oC) from 1950 to 2015 were used
for analyzing and evaluating the ARIMA model equations, and the measured data of monthly
average temperature (oC) in 2016 was used for validating the ARIMA model equations.
The three ARIMA model equations were implemented using SPSS software [93] for
measured data of monthly average temperature (oC) from 1950 to 2015. Table 75 shows the
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comparison of results from the three ARIMA model equations. The R value is 0.985 for the
ARIMA (0,0,12) model equation, 0.991 for the seasonal ARIMA (0,0,12) (0,0,6) model
equation, and 0.989 for the seasonal ARIMA (0,0,12) (0,0,60) model equation. These high R
values indicate that there is correlation between measured monthly average temperature and
predicted monthly average temperature form these ARIMA model equations. The predicted
mean and SD of the three ARIMA model equations are close to the measured mean and SD of
monthly average temperature in 2016. The MARE values of both seasonal ARIMA (0,0,12)
(0,0,6) and ARIMA (0,0,12) (0,0,60) model equations are 7.88% and 8.10%, which are higher
than that of ARIMA (0,0,12) model equation. The RMSE values of both seasonal ARIMA
(0,0,12) (0,0,6) and ARIMA (0,0,12) (0,0,60) model equations are also higher than that of
ARIMA (0,0,12) model equation.
Table 75. Measured and predicted monthly average temperature (°C), 1950 - 2015
Statistical
Descriptive
Summary
n
Mean
SD
COV
Average %
Difference
MARE
RMSE

Measured
792
12.96 oC
6.1 oC
47.2%

R = 0.985
ARIMA
(0,0,12)
Model Equation
792
12.97 oC
5.4 oC
42.0%

R = 0.991
ARIMA
(0,0,12) (0,0,6)
Model Equation
792
12.96 oC
5.9 oC
45.2%

R = 0.989
ARIMA
(0,0,12) (0,0,60)
Model Equation
792
12.95 oC
6.0 oC
46.4%

5.20%

2.80%

1.74%

11.52%
1.21 oC

7.88%
0.82 oC

8.10%
0.98 oC

The MARE and RMSE values of the seasonal ARIMA (0,0,12) (0,0,60) model equation
are slightly lower than those of of seasonal ARIMA (0,0,12) (0,0,6) model equation. However,
the average % difference between measured and predicted monthly average temperature for the
year 2016 of the seasonal ARIMA (0,0,12) (0,0,60) model equation is much higher than that of
the seasonal ARIMA (0,0,12) (0,0,6) model equation. Therefore, the seasonal ARIMA (0,0,12)
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(0,0,60) model equation seems to be the most accurate ARIMA model equation that can be used
for predicting temperature in future year.
Figure 153 shows a plot of the measured and predicted monthly average temperature
from the seasonal ARIMA (0,0,12) (0,0,60) model equation from 1950 to 2015. The statistical
descriptive summary of both measured and predicted data is also presented on the plot.

Figure 153. Measured and predicted monthly average temperature from the seasonal ARIMA
(0,0,12) (0,0,60) model equation from 1950 to 2015

In order to evaluate the accuracy of the three ARIMA model equations, the measured
data of monthly average temperature (oC) in 2016 was used for validating the ARIMA model
equations. Predicted values of monthly average temperature (oC) in 2016 of the three ARIMA
model equations were achieved from the SPP results of the model equations.
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Table 76 shows the comparison of the verification results among these ARIMA model
equations. The average % difference of the seasonal ARIMA (0,0,12) (0,0,60) model equation
is 2.25%, which is smaller than that of the two other ARIMA model equations. The MARE and
RMSE of the seasonal ARIMA (0,0,12) (0,0,60) model equation using data in 2016 are also
lower than those of the two other ARIMA model equations. Therefore, the seasonal ARIMA
(0,0,12) (0,0,60) model equation was recommended to use for predicting monthly average
temperature until 2050.
Table 76. Verification of ARIMA models equation using measured monthly in 2016
Statistical
Descriptive
Summary
n
Mean
SD
COV
Average %
Difference
MARE
RMSE

Measured
12
14.04 oC
6.4 oC
45.5%

ARIMA
(0,0,12)
Model Equation
12
13.46 oC
3.1 oC
23.0%

ARIMA
(0,0,12) (0,0,6)
Model Equation
12
13.51 oC
5.1 oC
37.5%

ARIMA
(0,0,12) (0,0,60)
Model Equation
12
13.94 oC
6.0 oC
43.3%

12.38%

3.19%

2.25%

30.66%
3.95 oC

16.07%
1.76 oC

10.33%
1.05 oC

Table 77 shows the calculation of the mean, SD, COV, average % difference, MARE,
and RMSE of the measured and predicted monthly average temperature from the ARIMA
(0,0,12) (0,0,60) model equation.
Figure 154 show a plot of the verification of seasonal ARIMA (0,0,12) (0,0,60) model
equation in 2016. The blue dash line of the predicted data from the verification of seasonal
ARIMA (0,0,12) (0,0,60) model equation is close and mostly fits with the red thick line of
measured data, which indicates the seasonal ARIMA (0,0,12) (0,0,60) model equation gave an
accurate prediction for temperature.
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Table 77. Verification of ARIMA (0,0,12) models equation using measured data in 2016
A

B

C

Cumulative
Month

Month

Measured

793
794
795
796
797
798
799
800
801
802
803
804

Jan-16
Feb-16
Mar-16
Apr-16
May-16
Jun-16
Jul-16
Aug-16
Sep-16
Oct-16
Nov-16
Dec-16
Total
Mean
SD
COV
Average
%
Difference

(°C)
4.38
7.53
10.94
14.15
17.07
20.79
22.23
21.89
19.29
14.85
10.05
5.29
168.46
14.04
6.4
45.5%

D
ARIMA
(0,0,12)
(0,0,60)
Predictions
(°C)
5.37
5.66
9.85
13.54
17.35
20.61
21.49
21.19
18.90
14.95
10.79
7.58
167.28
13.94
6.0
43.3%

E

F = |(D-C)/C|

G = (C-D)2

% Difference
Measured vs.
Predicted

MARE
Calculation

RMSE
Calculation

(%)
0.22
0.25
0.10
0.04
0.02
0.01
0.03
0.03
0.02
0.01
0.07
0.43
1.24 (Sum)

(°C)
0.97
3.48
1.20
0.37
0.08
0.03
0.55
0.49
0.15
0.01
0.54
5.26
13.13 (Sum)
1.09 (Mean)

(%)
22.47
-24.79
-10.00
-4.28
1.66
-0.88
-3.32
-3.21
-2.01
0.65
7.31
43.41

2.25
10.33
(MARE)

MARE (%)

1.05
(RMSE)

RMSE (°C)
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Figure 154. Plot of verification of seasonal ARIMA (0,0,12) (0,0,60) models equation in 2016
The following Equation 7.4 shows the general seasonal ARIMA (0,0,12) (0,0,60)model equation.
Yt = C + (1− θ 1B − θ 2B2 − θ 3B3 … − θ 12B12) . (1− Ɵ 1B1s − Ɵ 2B2s … − Ɵ 60B60s) . at

(7.4)

Yt = Discrete time series
C = Constant = 10.757
s = Season length
1− θ 1B − θ 2B2 − θ 3B3 … − θ 12B12 = Regular Moving Average process of order twelve
1− Ɵ 1B1s − Ɵ 2B2s … − Ɵ 60B60s = Seasonal moving average process of order sixty
at = random shock term; normally distributed, independent with zero mean, and variance
equal to σa
The summary of seasonal ARIMA (0,0,12) (0,0,60) model equation parameters is shown in
Table 78.
Table 78. Summary of seasonal ARIMA (0,0,12) (0,0,60) model parameters
ARIMA Model Parameters

-6.866
-.006
-.014

.000
.996
.989

…

…

Numerator

.062
69.861
25.331

…

No
Transformation

-.428
-.390
-.357

…

MONTH,
period 12

…

MA,
Seasonal

Lag 12
Lag 1
Lag 2

Sig.
.000
.000
.009

…

No
Transformation

t
4.381
-4.484
-2.638

…

Temperature

SE
2.456
.037
.034

…

Temperature
-Model

Estimate
10.757
-.167
-.091

…

…

Constant
Lag 1
Lag 2
MA

Lag 60

-.179

17.404

-.010

.992

Lag 0

.330

.346

.956

.340

From the above analysis, the seasonal ARIMA (0,0,12) (0, 0, 60) model equation was
recommended to use for predicting monthly average temperature until 2050. Figure 155 shows
measured and predicted monthly average temperature from 1950 to 2016, and predicted
monthly average temperature from 2017 t0 2050. The annual average global temperature for
2050 is 13.67 oC.
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The mean of predicted monthly average temperature from 2017 to 2050 is 14.06 oC. As
shown in Table 77, the mean of measured monthly average temperature in 2016 is 14.04 oC.
That indicates that monthly average temperature will increase 0.02 oC or 0.14% by 2050. In
other words, monthly average temperature will not increase significantly by 20150.

Figure 155. Measured and predicted monthly average temperature from the seasonal ARIMA
(0,0,12) (0,0,60) model equation
Table 79 shows the comaparison of the predicted global temperature from IPCC and
EPA models, and the seasonal ARIMA (0,0,12) (0,0,60) model equation. The predicted global
temperature by 2050 from both IPCC and EPA models has significant increase up to 3.5oC for
the IPCC model and 4.1oC for the EPA model. However, the predicted global temperature from
the seasonal ARIMA (0,0,12) (0,0,60) model equation by 2050 has no significant difference
compared with global temperature in 2016, with only 0.02 oC increase. The seasonal ARIMA
(0,0,12) (0,0,60) model equation achieves accurate predicted values in comparison with IPCC
and EPA models because the ARIMA model was developed based on actual measured global
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temperature data from 1950 to 2016. In addition, the ARIMA model was also validated using
monthly global temperature data in 2016, and the average percent difference between the
seasonal ARIMA (0,0,12) (0,0,60) model equation and measured data is only 2.25%.
Table 79. Comparision of global temperature from IPCC, EPA, and ARIMA model equations

7.5

Model

IPCC model
Prediction

EPA Model
Prediction

ARIMA (0,0,12) (0,0,60)
Model Equation Prediction

Increase of global
temperature

1.8oC - 3.5oC
(2000 - 2050)

1.0oC - 4.1oC
(2005 - 2050)

0.02 oC
(2017 - 2050)

Enhancing Coastal Disaster Resilience for Port Infrastructure and Supply Chain

7.5.1 Port Inventory and Condition Data for Port Asset Management
Figure 156 shows an asset-management system applying to ports [169].

Figure 156. Asset-management framework applying to ports
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A spatial map of port planimetric features should be developed to visualize port asset
inventory. Port network partitioning should be carried out for homogeneous features, as
recommended by Uddin et al. [169].
Typical port asset inventory and conditional assessment features include [169]:
 Indentification/Location: port and terminal address, reference longitude and latitude,
sections and locations.
 Construction/Geometry/Material/Structure: construction number, type and date, port
components (docks, cranes), water front protection material, navigation facilities, traffic
control; pavement width and length, surface type, material type.
 Cost and Usage History: Traffic mix, annual operations of container/passenger ships;
total/annual contruction and Maintenance, repair and rehabilitation (M,R&R) costs, unit
cost data, operation cost.
Condition data elements for port asset management include the following [169]:
 User Evaluation: Container handing and intermodal efficiency rating, track/pavement
quality rating, user satisfaction ratings.
 Functional Evaluation: Ratings for safety, barge/bridge accidents,
container/intermodal operations, capacity, and security.
 Structure Evaluation: Nondestructive testing (deflection testing, vibration and seismic
testing), load rating, remaining life for each asset type.
 Risk Assessment for Coastal Disasters: Risk mapping of port infrastructure
surrounding areas should be created by computer modeling and simulations of rainfall
flood, tsunami, and possible sea level rise or SLR/land subsidence using the
inundated/submerged land methodologies. There topics are explained in chapter V and
VI of this dissertation.
7.5.2 Linear Regression Equation for Predicting Flood Inundation
The following data (Table 80) was used to develop and implement a linear regression
equation to predict flood inundation (Figure 157).
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Table 80. Calculated and predicted inundated land for rainfall flood
A

B

No

Site

1

Los Angeles, CA

2
3

Gulfport, MS
Miami, FL
Karachi, Pakistan
25% Peak Discharge
Karachi, Pakistan,
50% Peak Discharge
Karachi, Pakistan
Full Peak Discharge
Hai Phong,Vietnam
Average
SD
COV
Average %
Difference
MARE (%)
RMSE (%)

4
5
6
7

C
Calculated
Inundated
Land
(%)
37.23

D
Predicted
Inundated
Land
(%)
37.23

F
% Difference
Calculated vs.
Predicted
(%)
0.00

G = |(D-C)/C|

H= (C-D)2

MARE
Calculation

RMSE
Calculation

0.00

0.00

39.66
56.76

39.66
56.76

0.00
0.00

0.00
0.00

0.00
0.00

57.53

61.74

7.33

0.07

17.76

73.81

67.49

-8.56

0.09

39.96

76.87

78.98

2.74

0.03

4.44

84.31
60.88
18.3
30.1%

84.31
60.88
18.0
29.6%

0.00
0.21

0.00
0.19 (Sum)

0.00
62.16 (Sum)
8.88 (Mean)

0.21
2.66 (MARE)
2.98 (RMSE)

Figure 157. Plot of calculated and predicted inundated land for selected port cities
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Table 81. SPSS coefficient parameters for flood regression equation
Unstandardized
Coefficients
B
Std. Error

Model

1

Standardized
Coefficients
Beta

t

Sig.
0.354
0.586

(Constant)
First_5km_DEM

51.306
-0.949

31.898
1.246

-0.807

1.608
-0.762

Beyond_5km_DEM
Peak_Discharge

-0.006
0.001

1.102
0.001

-0.006
0.705

-0.006
1.574

0.996
0.360

Hydrograph_Duration_hr
Land_Area_sqkm

-0.299
0.018

1.398
0.014

-0.157
0.611

-0.214
1.286

0.866
0.421

a. Dependent Variable: Inundated_Area_Percent

Regression equation for prediction of inundated land (%):
y = 51.306 – (0.949) x1 - (0.06) x2 + (0.001) x3 - (0.299) x4 + (0.018) x5

(7.5)

where,
y
x1
x2
x3
x4
x5

=
=
=
=
=
=

Inundated land (%)
First 5 km average land DEM elevation (m)
Beyond 5 km average land DEM elevation (m)
Peak discharge of hydrograph (m3/s)
Hydrograph duration (hours)
Land area (km2)

Note that this linear regression equation is valid only for climate regions of the port cities shown
in Table 80.
The 95% confidence interval (CI) for the predicted inundated land (ypredicted) was calculated using
Equation (7.6).
CI = ypredicted ± (tc) . SE

(7.6)

Where,
ypredicted
tc
n
SE

= Predicted inundated land (%)
= Critical value of t distribution of degree of freedom (df) of n-1 = 2.447
= Sample size = 7
= Standard error of predicted inundated land (%) = 7.88421

Note that the tc value was estimated from t table [92] and SE was obtained from the SPSS results
[93].
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It should be noted that, since the population standard deviation (σ) was unknown, the CI
(Equation 7.6) was computed using the tc critical value.
Figure 157 shows that the predicted values for inundated land (%) for all sites were
within the 95% confidence interval, which shows the reliability of the model. Therefore, the
developed linear regression equation can be applied for another port city to predict inundated
land (%) due to extreme rainfall flood.
Application for Gwadar, Pakistan:
Data:

First 5 km average land DEM elevation = 18.6 m
Beyond 5 km average land DEM elevation = 15.3 m
Peak discharge of hydrograph = 6,500 m3/s (used data of Karachi)
Hydrograph duration = 6 hours (used data of Karachi)
Land area = 2,006 km2
y = 51.306 – (0.949) 18.6 - (0.06) 15.3 + (0.001) 6,500 - (0.299) 6 + (0.018) 2,006

(7.7)

y = 73.55%
Inundated land by rainfall flood for Gwadar is 73.55% of the study area, which is 1,475
km2. This is reasonable because, like Karachi, Gwadar is also an arid climate region.


Using the above approach, linear regression equations can also be developed to predict
land submerged due to 2 m tsunami and 2 m sea level rise.

7.5.3 Enhancing Coastal Disaster Resilience for Ports
In port cities and coastal areas, flood disasters appear more frequent than any other
places. Floods not only happen due to heavy rainfall but can also be caused by a hurricane, a
tsunami, or future SLR in these areas. Results of the research indicate that an extreme rainfall
flood, which can happen any year, is more disastrous to people and infrastructures compared to
floods caused by tsunami and future SLR. Therefore, a resilience management plan is needed
for each port city to protect both people and infrastructure from these flood disasters.
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Port cities should be evaluated against the possible risk of inundated/submerged land
from rainfall flood, tsunami, and future land subsidence/SLR. Enhanced design and hardening
for flood disaster resilient bridges presented by Durmus [182] can be applied to infrastructures
in port cities for ocean wave surge from SLR and abrupt tsunamis.
In response to SLR and tsunami, the seawalls around port infrastructures should be
improved and raised to 2 m high to protect infrastructures and communities in the port cities.
Innovative materials such as fiber-reinforced plastic could be used for constructing seawalls.
Flood risk maps in port cite created from the rainfall flood, tsunami, and SLR
simulations are used for making flood disaster resilience management for port cities.
Populations of port cities can be moved gradually away from the coast and flood risk areas.
Improving the resilience of the bridge and road structures in the flood risk areas are required in
the port cities in order to minimize disruptions in supply chain in the port areas as well as global
shipping.

7.6

Impacts of Port LOS and Coastal Disasters on Global Supply Chain
A flood disaster resilience management plan, including the improvement of the

resilience of the bridges, roads, docks, and other infrastructures in the coastal risk areas of port
cities, is recommended in order to minimize damages to infrastructure and disruptions in supply
chain in the port areas, as well as global shipping.
7.6.1 Climate Impacts on Global Supply Chain
Global warming and climate impact models from IPCC, EPA, and NASA were reviewed
in this chapter. The IPCC and EPA models show that both predicted global temperature change
(anomaly) and CO2 will increase significantly by 2050 and 2100.
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The measured monthly global temperature and monthly atmospheric CO2 data from
1958 to 2016 were analyzed. The results show that there is very poor crosscorrelation (0.08)
between global temperature and CO2. This result contradicts the results of the IPCC and EPA
models and their claims of increase in CO2 as global temperature increases.
The IPCC, EPA, and other global temperature models use temperature anomaly data,
which is using a subject reference year with no sound basis, for analyzing and predicting global
temperature. According to acceptable scientific analysis, the actual historic measured
temperatures must be used for global temperature models.
The results of the one-way ANOVA hypothesis testing in this study indicate that there is
no significant difference in the means of monthly average temperature at the different
temperature periods since 1950. Therefore, monthly average temperature data, acquired from
the NOAA, can be used for temperature prediction models.
The predicted monthly average global temperature from 2017 to 2050 indicates that
monthly average global temperature will increase 0.02 oC or 0.14% by 2050, in comparison to
monthly average global temperature in 2016. In other word, monthly average global
temperature will not increase significantly by 2050.
The annual average CO2 predictions by 2050 show that the CO2 will increase from
404.21 ppm in 2016 to 456.94 ppm in 2050, a 13.0% increase from 2016.
Figure 158 plots the monthly average CO2 data and monthly average global temperature
data from January 2016 through December 2050. Particularly, there is no correlation between
global temperature and CO2 because the R value is only -0.015. Therefore, this research clearly
shows global warming is not caused by increase in CO2 levels, which is erroneously claimed by
the IPCC. It is shown by Uddin [168] that there is no significant loss of ice mass in the northern
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and southern hemisphere, and the raise of sea level is not significant. Consequently, there is no
likelihood of any impacts on global marine shipping and supply chains.

CO2 in 2050

Figure 158. Monthly average CO2 and global temperature from 2016 to 2050

According to results shown in Figire 158 and dicussed above, anthropogenic CO2 has
practically no correlation with global warming. Therefore, this expectation by IPCC and
associated climate change groups on the impacts of CO2 on global warming and future sea level
rise are invalid. Furthermore, it has been shown by Stafford [164] that the worldwide number of
natural disaster occurences has decreased since the year 2000 at the rate of 45.8% per year.
Therefore, there will be no significant adverse impacts on global shipping and supply chains.
7.6.2 Impacts of Other Coastal Disasters on Ports and Global Supply Chain
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Other coastal disasters include rainfall flood, storms, hurricanes, and tsunamis. Most
ports and port cities have been traditionally prepared to contain the adverse impacts of rainfall
flood and storms, so supply chain disruptions are minimized. On the other hand, many ports
worldwide have not enhanced infrastructure resilience to withstand the onslaught of hurricanes
and tsunamis. These coastal disasters may degrade port LOS, affect normal operations on sea
side and ground side, and cause supply chain disruptions depending on import and export
freight demand and operating capacity of ports. Economic loss will be enormous. Additionally,
a tsunami warning is minutes, making it the most damaging coastal disaster to port
infrastructures, cargo ship lines, and communities.
7.6.3 Assessment for Coastal Disaster Destruction using L-BANS Mapping
The use of BANS classification of surface types for pre- and post- disaster was shown
by Wodajo [85] to estimate the infrastructure damages and resulting economic costs.
Furthermore, a linear regression equation was developed using built-up area to estimate disaster
damage costs related to hurricanes and floods [85]. Therefore, L-BANS methodology,
developed in this research using public Landsat-8 satellite imagery can be implemented to
estimate built-up area and associated economic costs if a coastal disaster strikes.
7.6.4 Port Infrastructure Damage and Economic Costs Due to Coastal Disasters
The LOS of the Port of Miami in 2014 is estimated D (section 3.4). In the year 2025, the
port degrades to LOS E, as described in Chapter III, section 3.4. This represents poor
performance of ship processing. If cargo vessels are delayed and suffer long waiting times, the
shipping company will move to other ports in the East Coast. Furthermore, if a natural coastal
disaster (hurricane, tsunami) strikes the Port of Miami, then there will be seriously economic
consequences.
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The following example shows the impact of coastal disasters on annual operating
revenue for the Port of Miami:
 Operating revenue for Fiscal Year 2014 [183] = U.S. $ 126.1 million (same annual in
2015).
 The estimated operating revenue for Fiscal Year 2025 without disruption is 44% higher
than 2015 revenue. Revenue in 2025 = 1.44 x U.S. $ 126.1 million = U.S.$ 181.6
million.
 Assume a category 3 to 5 hurricane lands in Miami area in year 2025 that will adversely
impact cargo ship processing and supply chain.
 Assume 20% loss in operating revenue from port and intermodal freight operation
associated with supply chain.
 Therefore, the only revenue loss related to ship processing and intermodal freight
operation = 0.2 x U.S. $ 181.6 million = U.S. $ 36.32 million.
 Port infrastructure repair cost after coastal disaster and resilience enhancement costs =
U.S. $ 554.06 million (as discussed later in this section).
 Total infrastructure damage repair cost, economic cost, and lost revenue = U.S. $ 590.38
million.
A linear regression equation was developed by Wodajo [85] for predicting maintenance,
rehabilitation and reconstruction (M,R&R) costs related to infrastructure damage and
community impacts due to the 2005 Hurricane Katrina flood. This equation can also be applied
to an extreme rainfall flood disaster [184], as shown in Equation (7.8).
Ŷ = 84,856X - 496,608
where,
Ŷ
X

= predicted total M,R&R cost, U.S. $ per km2 of sample area
= pre-flood built-up area, %
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(7.8)

Prediction of M,R&R costs due to an extreme rainfall flood disaster for Miami and surrounding
areas is shown as follows:
 Pre-flood built-up area (X) is 59.18% (Table 44). Note that the pre-flood built-up area
was calculated based on planimetric (groundtruth) data of Miami (presented in section
4.3).
 Predicted total M,R&R cost , Ŷ = 84,856 x (59.18) – 496,608 = U.S. $ 4,525,170 per
km2.
 Total M,R&R cost due to an extreme rainfall flood disaster for Miami and surrounding
areas = U.S. $ 4,525,170 per km2 x (study area in km2) = U.S. $ 4,525,170 per km2 x
122.44 km2 = U.S. $ 554,061,815.
The above cost estimate of infrastructure damage and economic loss of U.S. $ 554
million is a reliable estimate. This cost estimate is adequate for overall economic risk
associated with a catastrophic flood disasters and secure funding resilience strategies.
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VIII. SUMMARY, CONCLUSIONS, AND RECOMMENDATIONS
8.1

Summary
Major motivation of this research was the sustainable global supply chain, port

infrastructure, and coastal communities, which are impacted by the extreme weather disasters.
The impacts of rainfall floods and other coastal disasters on seaport traffic and coastal
communities were reviewed. These weather related disasters threaten millions of people, and
cause damages to infrastructure, global supply chain disruptions, and billions of dollars in
economic costs.
Three forecasting models, including ARIMA model equations, ANN models, and
regression equations were developed to predict future containerized cargo volumes for the Port
of New Orleans and the Port of New York and New Jersey. The historical monthly
containerized cargo volumes of the two ports for the ten years since 2005 were used to develop
these models. The twelve month data of the latest year were used for verifying the accuracy of
these models or quality of predictions. Average percent difference between observed and
predicted values, MARE, and RMSE are important parameters used to evaluate the accuracy of
these models. The comparison of these models was also conducted to make recommendations
for short-and long-term prediction for these ports.
Traffic flow demands on ten important international shipping navigation routes were
analyzed using the automatic identification system or AIS data. These navigation routes are
trading connections from Asia to North and West Europe, Asia to North America, and Europe
to the Eastern United States. A spatial map of cargo vessel demands for selected navigation
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routes was also created. Amount and cost of anthropogenic CO2 emission for container cargo
vessels on the selected navigation routes were also calculated. The level of service or LOS
methodology for cargo vessel service at ports was developed using the AIS data for the Port of
Miami. The mathematical function to estimate the LOS level was proposed based on delay time
and waiting time of cargo vessels at the port and number of processed cargo vessels per total
annual cargo vessels. The calculated LOS level was used to evaluate port operational efficiency
for serving and supporting port managers and marine transportation planners for making
strategies to improve port infrastructures and capacities.
This research developed a Landsat-8 built-up area and natural surfaces (L-BANS) autoclassification methodology. The L-BANS methodology produces geospatial maps of surface
types using the spectral reflectance values of Landsat-8 pansharpened multispectral satellite
imageries. The decision criterion was established for each surface class based on the criteria of
high autocorrelation and uniqueness of band and its range of the spectral reflectance values. The
ANOVA hypothesis testing was conducted to observe if the means of surface class area for six
study sites in square meters have statistical significant difference by using planimetric
groundtruth and L-BANS methodologies. The L-BANS methodology was implemented for Hai
Phong, Vietnam. The L-BANS methodology can be applied for auto-classification for areas
where planimetrics are not available. The L-BANS methodology can be used to evaluate the
economic loss and damage cost due to flood disaster caused by an extreme rainfall or a tsunami.
The rainfall flood simulation using 1-D HEC-RAS program was used in this research to
assess the impacts of extreme rainfall flood on people and infrastructures in the five selected
port cities. Before implementing the rainfall flood simulation in the selected port cites, the
rainfall flood simulation was conducted for Sardis, MS. The HEC-GeoRAS and ArcGIS
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software programs were also used to create geometric data for the rainfall flood simulation. The
output results of this simulation were compared with the output results of the 2-D flood
simulation (CCHE2D-FLOOD) developed by NCCHE, the University of Mississippi.
Hydrograph data, DEM data, Landsat-8 satellite imagery, and population data were main inputs
for the rainfall flood simulation.
The two new coastal disaster simulations, developed by CAIT researchers, were used to
evaluate the land submerged from 2 m SLR related to climate impacts by the year 2100 and the
impact of a 2 m, 4 m, and 9 m tsunami wave peak height or WPH on the selected port cities.
DEM data, Landsat-8 satellite imagery, and population data were also used as inputs for both
SLR and tsunami simulations. The two-way ANOVA hypothesis testing was conducted to
analyze whether the means of inundated/submerged land (in percent) was statistically
significantly different by using rainfall flood, tsunami, and SLR simulations. Infrastructure
disaster resilience rating was also reviewed.
Global warming and climate impact models were reviewed. Data of the measured
monthly average global land and ocean temperature and atmospheric CO2 at Mauna Loa
Observatory, Hawaii, United States, were analyzed to understand the correlation between global
temperature and CO2. The ARIMA time series seasonal model equations for temperature and
atmospheric CO2 were developed. The twelve month data of temperature and atmospheric CO2
in 2016 were used for verifying the accuracy of these models. The results of the ARIMA model
equations for temperature and anthropogenic CO2 were compared with other global warming
and climate impact models from IPCC, EPA, and NASA.
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8.2

Conclusions
The major findings and conclusions of this research are listed in the following sections.

8.2.1 Container Freight Shipping Demand Prediction Models
o

The ARIMA (0,1,3) and ARIMA (1,1,3) model equations for total loaded export
container volumes of the Port of New Orleans were developed. The ARIMA (0,1,3)
model equation has better predictions compared to the ARIMA (1,1,3) model equation.
Therefore, the ARIMA (0,1,3) model equation was used and recommended for future
month predictions.

o

The ANN model and the regression equation for total loaded export container volumes of
the Port of New Orleans were also analyzed. The predictions by the ARIMA (0,1,3)
model equation, ANN model, and multiple regression equation indicated that the ANN
model achieves the most accurate predicted values. The average percent differences
between the observed and predicted data, the MARE, and the RMSE values of the ANN
model equation are smaller than those of ARIMA model equations and the regression
equation. However, the ANN approach requires future values of independent variable
inputs to calculate the forecast. Therefore, applying the ANN model was recommended
for short-term prediction for these ports. The ARIMA (0,1,3) model equation was applied
successfully for long-term prediction because it does not require other independent
variables.

o

The predicted annual total loaded export container volumes of the Port of New Orleans
using the ARIMA (0,1,3) model equation have steadily increased from 240,136 TEUs in
2014 to 280,924 TEUs in 2020, or an 8.1% increase from 2014.
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o

The ARIMA (0,1,3) and ARIMA (1,1,3) model equations for total loaded container
volumes of the Port of New York and New Jersey were developed. The ARIMA (0,1,3)
model equation again shows better predictions compared to the ARIMA (1,1,3) model
equation. Therefore, The ARIMA (0,1,3) model equation was used for future month
predictions.

o

The ARIMA (0,1,3) model equation was used to predict annual total loaded export
container volumes of the Port of New York and New Jersey by 2020. The predicted
annual total loaded container volumes have steadily increased from 6,371,720 TEUs in
2015 to 7,744,908 TEUs in 2020, or a 12.5% increase from 2014.

8.2.2 Cargo Ship AIS Data for Selected Global Navigation Routes
o

A spatial map of cargo vessel demands for selected navigation routes was created.

o

The cargo vessels of ten selected international shipping navigation routes were analyzed
using the automatic identification system or AIS data. The results show that the Europe
Atlantic navigation route to the East Coast of the U.S. has the largest cargo vessel
volumes, with 5,865 vessels per day. The Europe Atlantic is known as the busiest ocean
navigation route, serving about 50 of the World's leading ports.

o

The Suez Canal and the Panama Canal have a very high demand for cargo vessel traffic;
however an average of only 33 cargo vessels in the Suez Canal and an average of 50
cargo vessels in the Panama Canal can pass through these canals per day.

o

Although cargo vessels mostly operated by diesel engine emit less CO2 and other harmful
pollutants than transportation by rail, truck, and air craft, larger amounts of CO2 are
emitted on the selected navigation routes due to heavy shipping volumes. More efficient
routes for cargo vessels, cleaner and renewable fuels, and new larger cargo vessels will
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produce less CO2. These should be future goals for reducing emissions of CO2, NO2, and
other particulate matter (PM) pollution.
o

A LOS for cargo vessel service was developed to evaluate the operating conditions of a
seaport, which was designated by the letters A through F. LOS A, which is equal to or
less than 24 hours (1 day) of delay time, represents the unconstrained flow with an
excellence rating. LOS B, which is equal to or less than 48 hours (2 days) of delay time,
shows smooth flow condition with a very good rating. LOS C, which is equal to or less
than 72 hours (3 days) of delay time, represents the saturated flow with a good rating.
LOS D, LOS E, and LOS F are described as constrained flow, undesirable flow, and over
capacity conditions, respectively.

o

A mathematical function was also proposed to estimate a LOS level based on delay time
and waiting time of cargo vessels at the port and number of processed cargo vessels per
total annual cargo vessels.

8.2.3 Imagery-Based Surface and Landuse Classification
o

The L-BANS auto-classification methodology was developed for classification of a
Landsat-8 pansharpened multispectral satellite imagery into asphalt, building, concrete,
grass, tree, soil, and water surface classes. The L-BANS auto-classification methodology
was developed using 36 groundtruth samples of the Landsat-8 pansharpened
multispectral satellite imageries from six selected sites.

o

The L-BANS classification criteria were based on the spectral reflectance values in the
green, NIR, SWIR 1, and SWIR 2 bands.

o

The L-BANS surface classification results using GeoMedia Pro geospatial analysis were
within ±15% of the groundtruth for four sites (Sardis, Oxford, Gulfport, and Gwadar).
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The results for Los Angeles were ±25% of the groundtruth. The results for Miami were
42% for building and ±31% for tree, compared to the groundtruth.
o

The ANOVA hypothesis testing was conducted to assess the accuracy of L-BANS
classification results of the six selected sites. The test results showed that in the
population, there is no statistical significance between the L-BANS results and the
planimetric groundtruth for all surface classes. Therefore, the methodology can be
implemented anywhere in the world where Landsat-8 satellite imagery is available.

o

The L-BANS methodology was implemented for Hai Phong, Vietnam, because no
planimetric data was available. The L-BANS results showed that total built infrastructure,
which includes asphalt, building, and concrete, is 21.47% of the study area. The
remaining 78.53% of the area was covered with natural terrain surfaces with 18.15%
grass, 0.04% soil, 34.74% trees, and 25.60% water.

8.2.4 Floodplain Simulation Studies to Enhance Disaster Resilience
o

The results of the rainfall flood simulation using the 1-D HEC-RAS program match
reasonably well with the results of the CCHE2D-FLOOD flood simulation in Sardis, MS,
for the flood depths as well as floodplain areas. The results generated from these both
simulations are within ± 5% percent differences for flood depth and within ± 0.7% for
floodplain area.

o

The computational time of the simulation in 1-D HEC-RAS is only 5.58 seconds. It is
much smaller in comparison with the computational time of CCHE2D-FLOOD, which
required 100 seconds.

o

The rainfall flood simulation methodology was implemented for five selected port cities.
The output results of this simulation showed that the inundated area (representing in
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percent of land area) in Miami, Gulfport, Los Angeles, Karachi, and Hai Phong is 56.8%,
39.7%, 37.2%, 76.9%, and 84.31%, respectively.
o

Population at risk by the rainfall flood in Miami, Gulfport, Los Angeles, Karachi, and Hai
Phong is 1.42 million people, 13,029 people, 4.78 million people, 11.53 million people,
and 624,757 people, respectively.

o

The percent of inundated land is higher for high peak discharge of these port cities.
Karachi and Hai Phong, located in semi-arid and tropical climate areas, have more heavy
rainfall. So both Karachi and Hai Phong have more damage of infrastructures and
population at risk from rainfall floods in comparison with other port cities in the United
States.

o

The percent of inundated land is also dependent on a terrain or DEM elevation of the port
cities. Miami and Hai Phong are located at low elevation areas; the inundated area of the
two cities is larger than 56% of the land area. However, Los Angeles is located at a
higher elevation; the inundated area of the Los Angeles is 37.2% of the land area.

8.2.5 Impacts of Weather Related Natural Disasters on Port Cities
o

The CAIT methodology for 2 m SLR simulation was implemented for five selected port
cities. The output results of the 2 m SLR simulation showed that the submerged land
(representing in percent of land area) in Miami, Gulfport, Los Angeles, Karachi, and Hai
Phong is 57.08%, 2.09%, 1.68%, 3.84%, and 16.72%, respectively.

o

Population at risk by 2 m SLR in Miami, Gulfport, Los Angeles, Karachi, and Hai Phong
is 1.43 million people, 687 people, 215,857 people, 2 million people, and 69,183 people,
respectively.

328

o

The CAIT methodology for 2 m tsunami WPH simulation was implemented for five
selected port cities. The output results of the 2 m tsunami WPH indicated that the
submerged land (represented in percent of land area) in Miami, Gulfport, Los Angeles,
Karachi, and Hai Phong is 57.08%, 2.09%, 1.30%, 3.65%, and 16.72%, respectively.

o

The population at risk by a 2 m tsunami WPH in Miami, Gulfport, Los Angeles, Karachi,
and Hai Phong is 1.43 million people, 687 people, 167,136 people, 2 million people, and
69,183 people, respectively.

o

Results from 2 m SLR simulation and 2 m tsunami WPH simulation are not significantly
different in terms of the submerged land and population at risk for the selected port cities.

o

The CAIT methodology for 4 m and 9 m tsunami WPH simulations were implemented
for Miami and Hai Phong. Results of these simulations indicate that the submerged land
increases significantly from 2 m to 9 m tsunami WPH (5.0 times in Hai Phong and 1.7
times in Miami). The population at risk due to a 9 m tsunami WPH is 583 thousand in
Hai Phong and 2.4 million in Miami.

o

The comparison among the rainfall flood, 2 m SLR, and 2 m tsunami WPH simulations
shows that rainfall flood inundation is more disastrous to people and infrastructures
compared to future 2 m SLR related to climate impacts or 2 m tsunami WPH.

o

The two-way ANOVA hypothesis testing was conducted to analyze whether the means of
inundated/submerged land (in percent) have statistical significant difference by using
rainfall flood, tsunami, and SLR. The results of the two-way ANOVA hypothesis testing
indicate that in the population, there is statistical significance by using rainfall flood,
tsunami, and SLR simulation methods.
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o

The need of infrastructure disaster resilience rating was discussed to estimate coastal
disaster risks.

o

The linear regression equation to predict inundated land due to rainfall flood has a high R
value of 0.984. This provides a simple method to estimate flood risk for the climate
region associated with the study site.

8.2.6 Evaluation of Global Warming and Climate Impact Models
o

The crosscorrelation between monthly average temperature (oC) and monthly average
atmospheric CO2 is very poor (0.08). This result is contrary to the results that IPCC, EPA,
and NASA have been claiming in their global temperature and CO2 climate models.

o

IPCC and other global temperature models use temperature anomaly data, which is using
a subject reference year with no sound basis. According to acceptable scientific analysis,
the actual historic measured temperatures must be used for global temperature models.

o

The results of the one-way ANOVA hypothesis testing indicate that there is no significant
difference in the means of monthly average temperature (°C) at the different temperature
periods since 1950. Therefore, monthly average temperature (°C) data, acquired from the
NOAA, can be used for temperature prediction models.

o

The predicted monthly average global temperature (°C) from 2017 to 2050 indicates that
monthly average global temperature (°C) will increase 0.02 oC or 0.14% by 2050 in
comparison to monthly average global temperature (°C) in 2016. In other word, monthly
average global temperature will not increase significantly by 2050.

o

The annual average CO2 predictions by 2050 show that the CO2 will increase from 404.21
ppm in 2016 to 456.94 ppm in 2050, or a 13.0% increase from 2016.
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o

There is particularly no correlation between monthly global temperature and monthly
atmospheric CO2. Therefore, this research clearly shows global warming is not caused by
increase in CO2 levels, which is erroneously claimed by the IPCC.

8.3

Innovation and Contribution to the Sustainable Global Supply Chain Infrastructure
 Containerized cargo shipping volume predictions for a port using ARIMA model
equations.
 The developed LOS methodology for evaluating port operational efficiency for
serving and making strategies to improve port infrastructures.
 The developed L-BANS auto-classification methodology using Landsat-8
pansharpened multispectral satellite for classification of built and non-built surfaces
and port infrastructure asset management.
 Flood disaster resilience management by implementing flood risk mapping for
selected port cities based on rainfall flood simulation methodology using Landsat-8
multispectral imagery, flow hydrographs, and topographic terrain data.
 The developed CAIT methodologies for evaluating the land submerged from 2 m
SLR related to climate impacts by the year 2100 and the impact of a 2 m tsunami
WPH on selected port cities.
 ARIMA model equations for predicting global temperature and CO 2 and very poor
correlation between global temperature and CO 2.
 Contrary to the IPCC claims, global warming is not caused by anthropogenic CO 2.
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8.4

Overall Benefit to Global Supply Chain Infrastructure and Society
Natural disaster resilient port infrastructure and maritime ship navigation routes are vital

for sustainable global supply chains. Cargo shipping is used for transporting 90 percent of the
world’s trade globally. The results of this research will help port agencies worldwide to achieve
the goals of disaster resilience for maintaining sustainable global supply chains, which are
imperative for a stable global economy. The research outcomes can be used by government
policy makers, port agencies, coastal cities, and waterway authorities for improving sustainable
port infrastructure asset management and enhancing disaster risk resilience. Disaster resilient
infrastructure can assist these agencies to safeguard the ports and port cities against increased
flooding risks due to extreme weather events, intense hurricanes and cyclones, and coastal
disasters due to tsunamis in earthquake prone regions. Additionally, the research will benefit
maritime cargo shipping enterprises and supply chain stakeholders for minimizing disruptions
in global supply chains and sustaining the world’s economy.

8.5

Recommendations for Future Research
 Implement extreme rainfall 1-D flood simulation, CAIT methodology for 2 m SLR,
and tsunami simulations for other port cities worldwide, such as Rio de Janeiro in
Brazil, Jakarta in Indonesia, Ho Chi Minh in Vietnam, and Osaka in Japan.
 Conduct rainfall 1-D flood simulations for selected sites in other climate regions
and use inundated land results to calibrate the linear regression equation developed
by this research.
 Develop regression equations using submerged land data, associated with 2 m SLR
and 2 m tsunami, for selected port cities to predict the submerged land area in
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percent of total land area as functions of topography. This simplified procedure can
be very useful for developing countries who may not have a trained geospatial
workforce.
 Calculate costs of infrastructure damage for ports and port cities using the
inundated/submerged land area from rainfall flood simulation and 2 m tsunami
simulations using the L-BANS auto-classification of surface types and landuse.
 Conduct climate research to identify other variables (such as solar cycle, etc),
which may have high correlation with global temperature because this research
shows practically no correlation of monthly global temperature with atmospheric
CO2.
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APPENDIX A
Step-By-Step Procedure of Landsat-8 Imagery Acquisition and Geospatial Analysis

A.1 Creating an Area of Interest using Google Earth and Paint Programs
A.2 Downloading Landsat-8 Imagery at Gwadar, Pakistan, from the USGS Using Earth
Explorer
A.3 Creating Landsat-8 Multispectral Imagine using ERDAS IMAGINE 2013
A.4 Creating Landsat-8 Pansharpened Multispectral Imagery for Gwadar, Pakistan, using
ERDAS IMAGINE 2013
A.5 SubSet Landsat-8 Pansharpened Multispectral Imagine using ERDAS IMAGINE 2013
A.6 Exporting Landsat-8 Pansharpened Multispectral Imagine to JPEG file
A.7 Importing JPEG file into GeoMedia Professional 2013
A.8 Creating a Table of Spectral Reflectance Values for Landsat-8 Bands for Gwadar
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This section describes the step-by-step procedure for creating Landsat-8 pansharpened
multispectral imagery using ERDAS IMAGINE 2013 and opening the exported geo-referenced
JPEG imagery on GeoMedia Professional 2013.
A.1 Creating an Area of Interest using Google Earth and Paint Programs
A.1.1 Determining an Area of Interest using Google Earth
a. Start Google Earth by double clicking on the Google Earth icon.
b. Under Search box, type Gwadar, Pakistan, then click Search. The map of Gwadar, Pakistan,
or Area of Interest (AOI) will be displayed on the map window of Google Earth (Figure A1).

Figure A1. Gwadar map searched by Google Earth
c. From main menu, click on the Add Polygon symbol. The New Polygon dialog box appears as
Figure A2.
d. Type Gwadar, Pakistan, as the name of the polygon, select red color and 3 widths for lines,
and select Outlined under area (Figure A2).

Figure A2. Define color and width for AOI polygon
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e. Draw a polygon that covers Gwadar, Pakistan, as shown in Figure A3.
f. Move the cursor to a corner of the polygon, click and hold down on the mouse to move and
change the corner to the desired location. Repeat the same steps to move the three other
corners to desired locations to ensure that the distances from Gwadar Port to the edge of the
polygon in the north are 12 km, to the edge of the polygon in the south are 8 km, to the edges
of the polygon both west and east are 9 km.

Figure A3. Define color and width for AOI polygon
A.1.2. Creating a map of Area of Interest
a. From the menu of Google Earth, click Add Place mark. Move the place mark to a corner of
the AOI, and write the name of the corner and latitude and longitude coordinate of the corner
place mark.

Figure A4. Map of AOI polygon created on paint program
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b. Repeat the same steps for the other corners of AOI.
c. Press Print Screen on Keyboard and paste on the Paint program (run Paint program by
clicking on Start > All programs > Accessories > Paint).
d. Use tools on Paint program to type the name of the map and latitude and longitude
coordinates of each corner (Figure A4). Select Opaque in Text option to get white
background.
e. Go to File > Save as > JPEG picture, and put the name of the JPEG.
A.2 Downloading Landsat-8 Imagery at Gwadar, Pakistan, from the USGS Using Earth
Explorer
A.2.1 Account Registration
a. Open the Earth Explore website http://earthexplorer.usgs.gov/ (Figure A4).

Figure A5. Earth explore website
b. Click on Register on the right left corner of the Earth Explore website.

Figure A6. User registration
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c. Enter Username, New Password, and Confirm New Password. Then click Continue.
d. Continue to complete other parts (Contact Demographic, Contact Information, and Complete
Registration).
e. Open the email that you used for registration. You will receive an email from USGS in the
following format.

Figure A7. User confirmation
f. Click on the link to confirm and activate your account. Note that you are asked to provide
your user name.
A.2.2 Searching and Downloading Landsat-8 Imagery at Gwadar, Pakistan, from the USGS
Using Earth Explorer
a. Login to USGD using your USGS registered username and password.

Figure A8. USGS sign in
b. Enter User name and Password as shown in Figure A8.

Figure A9. Searching criteria interface
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c. Under Search Criteria, type addresses or place names you want to download imagery of. For
this example, type Gwadar, Pakistan. Then click Show.

Figure A10. Search criteria dialog box
d. Click on the place name that was found. The place will be shown on the map.
e. Zoom in on the area of Gwadar, Pakistan (Figure A11).

Figure A11. Location of Gwadar, Pakistan
f. Click Use Map, and the map of Gwadar appears, as in Figure A12.

Figure A12. Location of Gwadar, Pakistan is defined by map
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g. Click Zoom out from Gwadar, Pakistan (Figure A11). You can change the size of the
rectangular box by moving the points of the corners of the box (Figure A13).

Figure A13. Location of Gwadar, Pakistan is defined by map
h. Click on Data Sets, and you will see a list of data sets. Click on Landsat Archive.
i. Check only Landsat-8 as the following (Figure A14).

Figure A14. Select data set(s) window
j. Click Additional Criteria. Under Cloud Cover, select “Less than 10%” (Figure A15).

Figure A15. Additional criteria window
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k. Click on Results, and the list of imageries will appear as in Figure A16.

Figure A16. Search results window
l. Click on Metadata (Figure A17), and the Metadata dialog window appears as in Figure A18.

Figure A17. Metadata

Figure A18. Meta Data information window
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m. Click on Download option (Figure A19). The Download option window appears, as in Figure
A20.

Figure A19. Download option
n. Choose the lowest option Level 1 Geo TIFF Data Product, which allows all bans to be
downloaded.

Figure A20. Options for downloading Landsat-8 imagery
o. Extract the downloaded file to get all bands, as shown in Figure A21.

Figure A21. List of download BANS files
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A.3 Creating Landsat-8 Multispectral Imagine using ERDAS IMAGINE 2013
a. Figure A22 shows that Landsat-8 has 11 bands, and each band has a different range of
wavelength. Band 1 through Band 7 and Band 9 have 30 m resolutions, Band 8
(panchromatic) has 15 m resolutions, and Band 10 and 11 have 100 m resolutions.

Figure A22. Table of BANS and their resolution
b. Click on the symbol of ERDAS IMAGINE 2013 on Desktop or Start > ERDAS IMAGINE
2013. The main interface of ERDAS IMAGINE 2013 appears, as in Figure A23.

Figure A23. Main interface of ERDAS IMAGINE 2013
c. From main menu of ERDAS IMAGINE 2013, select Raster > Spectral > Layer Stack.

Figure A24. Layer selection and stacking window
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d. From Input File (Figure A24), locate the download imagine files. Select TIFF as the Files of
Type (Figure A25).

Figure A25. Input file window
e. Select the first BAND LC81560422015257LGN00_B1.TIFF. Then click OK.
f. Click Add.

Figure A26. Layer Selection and Stacking
g. Repeat the same steps from d to f in part d to add other BANDS (BAND 2, BAND 3, BAND
4, BAND 6, BAND 7, BAND 9 (Shown in Figure A27).

Figure A27. Layer selection and stacking
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h. Click on Output File to save the output as LS8_Multispectral_Imagery_GwadarPark.

Figure A28. Output file name
i. Check Ignore Zero in Stats (Figure A29).

Figure A29. Layer selection and stacking
j. Click OK.
k. When progress reaches 100%, click Close (Figure A30).

Figure A30. Process list window
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l. Right click on 2D View #1 under Contents window. Select Open Raster Layer.
m. Look in the Multispectral_LS8_GawadarPark folder, and then select
LS8_Multispectral_Imagery_GawadarPark.img. (Figure A31).

Figure A31. Select layer to add
n. Click OK.

Figure A32. Process list showing 100% complete
o. The Landsat-8 multispectral imagine appears in Figure A33. Note that if the Landsat-8
multispectral imagine does not appear, right click on 2D View. Then go to Open Raster
Layer, and select the output file.

Figure A33. The Landsat-8 multispectral imagine
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A.4 Creating Landsat-8 Pansharpened Multispectral Imagery for Gwadar, Pakistan, using
ERDAS IMAGINE 2013
a. From the main menu of ERDAS IMAGINE 2013, select Raster > Pan Sharpen > HPF
Resolution Merge. The HPF Resolution Merge dialog box will appear (Figure A36).
b. Under High Resolution Input File. (*.img), select band 8
LC81560422015257LGN00_B8.TIF, which has 15 m resolution. Note that
LC81560422015257LGN00_B8.TIF is a TIFF file, so TIFF should be selected as Files of
type.

Figure A34. High resolution input file
c. Click OK.
d. Under Multispectral Input File: (*.img), select LS8_Multispectral_Imagery_GawadarPark,
which was created in Part 3.
e. Under Output File: (*.img), select location of output file and type
LS8_Pansharpened_Multispectral_Imagery_Gwadarpark as file name.

Figure A35. Output file
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f. Click OK.
g. Check the box of Ignore Zero in Stats.

Figure A36. HPF resolution merge
h. Click OK, and the LS8_pansharpened_multispectral_gwadarpark will be created.
A.5 SubSet Landsat-8 Pansharpened Multispectral Imagine using ERDAS IMAGINE 2013
a.

Open LS8_pansharpened_multispectral_gwadarpark on ERDAS IMAGINE
2013.

Figure A37. Landsat-8 Pansharpened multispectral imagine showing Gwadar
b. From the main menu of ERDAS IMAGINE, select Home > Inquire > Inquire Box.

Figure A38. Inquire box window with map coordinate
373

c. Change Map to Lat/Lon in Type box (Figure A39).

Figure A39. Inquire box window with Lat/Lon coordinate
d. Change coordinates of the upper left and lower right points based on coordinate values gotten
from Figure A40.
e. Click Apply.

Figure A40. Inquire Box defined by up left and low right points (Lat/Lon Coordinate)
f. Change Lat/Lon to Map in Type box.

Figure A41. Inquire Box defined by up left and low right points (Map Coordinate)
g. Choose Raster > Subset & Chip > Create Subset Image. The Subset window appears.
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h. Define file name of output subset imagery (Figure A42).

Figure A42. Name of output file
i. Click on From Inquire Box.
j. Check Ignore Zero in Output Stats (Figure A43).

Figure A43. Input and output of subset
k. Click OK. The Subset Landsat-8 Imagery is created (Figure A44).

Figure A44. Subset imagery of Gwadar
A.6 Exporting Landsat-8 Pansharpened Multispectral Imagine to JPEG file
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a. From main menu, select Manage Data > Export Data. Select JFIF (JPEG) as Format,
ls8_subset_pansharpened_mul_gwadar.img as Input File, and
ls8_subset_pansharpened_mul_gwadar.jpg as Output File (Figure A45).

Figure A45. Export window
b. Export JFJF Data appears (Figure A46).

Figure A46. Export JFJF data window
c. Click OK to export.
A.7 Importing JPEG file into GeoMedia Professional 2013
a. Open ls8_subset_pansharpened_mul_gwadar on ERDAS IMAGINE 2013.

Figure A47. Subset of pansharpened multispectral imagery at Gwadar
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b. Click on Metadata icon on the main menu of ERDAS IMAGINE 2013. Then click on the
map of ls8_subset_pansharpened_mul_gwadar. The medata window will appear (Figure
A48).

Figure A48. Metadata of Landsat-8 imagery at Gwadar
c. Write down Projection information of the imagery file. (Projection: UTM, Zone 41 and
Datum: WGS 84)
d. Open GeoMedia Pro 2013.

Figure A49. Window of GeoMedia Pro
e. From Warehouse > New Warehouse.

Figure A50. New warehouse dialog
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f. Click New.

Figure A51. Save access databases dialog box
g. Type QN_LS8_Gwadarpark, and click Save.
h. Select Warehouse > Feature Class Definition > New > New, and a coordinate system
properties dialog box will appear (Figure A52).

Figure A52. Coordinate system properties
i. Select parameters of the coordinate in GeoMedia Pro as the same parameters showing in
Figure A48. Under coordinate system type, select Projection.
j. Click on Projection Space tab. Under Projection algorithm, select Universal Transverse
Mercator. Click on Projection Parameters, select Zone 41, and click OK.

Figure A53. Selected coordinate system parameters
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k. Click on Geographic Space, and make sure WGS84 is selected for Geodetic datum.

Figure A54. Selected datum
l. Click Save As, and type Coordinate_System_Gwadar as the name of coordinate system file of
landsat-8 imager at Gwadar.

Figure A55. Defined Coordinate System file
m. Click Save. The coordinate system file will be saved.
n. From the main menu of Geomedia Pro 2013, select Insert > Georeferenced Imaged.
o. Under Georeferenced mode, select World file.

Figure A56. Inserted georeferenced images
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p. Under Coordinate system file, select Coordinate_System_Gwadar file.
q. From Folder, select the folder that has ls8_subset_pansharpened_mul_gwadar file.
r. Under Extension, select *.jp,*jp2.
s. Click on the arrow symbol to move ls8_subset_pansharpened_mul_gwadar from Available
files to Selected files.
t. Under Image feature classes with matching coordinate system, type name of file as
QN_LS_Gwadarpark. Click OK.
u. From main menu of GeoMedia Pro 2013, select Legend > Add Legend Entries. Select
QN_LS_Gwadarpark, and click OK.

Figure A57. Add Legend Entries
v. Click OK, and QN_LS_Gwadarpark imagery will appear.

Figure A58. Landsat-8 QN_LS_Gwadarpark imagery on GeoMedia Pro
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w. Figure A55 shows QN_LS_Gwadarpark imagery on GeoMedia Pro, so you can create
planimetric features at Gwadar.
A.8 Creating a Table of Spectral Reflectance Values for Landsat-8 Bands for Gwadar
a. Open ls8_subset_pansharpened_mul_gwadar on ERDAS IMAGINE 2013.

Figure A59. Subset of pansharpened multispectral imagery at Gwadar
b. Select Manage Data > Pixels to ASCII, and a Pixel To Table dialog box will appear.

Figure A60. Pixel To Table dialog box.
c. From Input File (*.img), select ls8_subset_pansharpened_mul_gwadar file.
d. Click Add.
e. From Output File: (.*asc), type ASCII_Gwadar as output file name.
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f. Click OK, and the Converting pixel data to table dialog box will appear.

Figure A61. Converting pixel data to table
g. Click OK.
h. Open Excel program.

Figure A62. Created Excel table
i. From main menu of Excel, select File > Save As > Computer.

Figure A63. Save As dialog box
j. Type Landsat_8_ASCII as file name.
k. Select CSV (Comma delimited) in Save as type.
l. Click Save.
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m. From main menu of Excel, select File > Open > Computer > Browse.
n. Select ascii_gwadar.asc file, note that select All files is selected to view ascii_gwadar.asc
file.

Figure A64. Open dialog box
o. Click Open.

Figure A65. Text Import Wizard dialog box
p. Click on Finish. The spectral reflectance values for Landsat-8 bands will be viewed in the
excel table.

Figure A66. Table of Spectral Reflectance Values
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q. Delete any first rows that are not necessary and add some information for each band.

Figure A67. Revised Table of Spectral Reflectance Values
r. From File > Save, the spectral reflectance values for Landsat-8 bands will be saved in Excel.
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APPENDIX B
Methodology for L-BANS Auto-Classification of Surface Type Infrastructure and Landuse
B.1 Creating Pixel Spectral Database Using ERDAS IMAGINE 2013
B2. Importing Pixel Spectral of Imagery of Area Interest into GeoMedia Pro 2013
B3. Step-By-Step for L-BANS Analysis
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B.1 Creating Pixel Spectral Database Using ERDAS IMAGINE 2013
The procedures described in the following steps are based on the subset Landsat-8
pansharpened multispectral imagery for Gulfport area, MS. The imagery name is
ls8_subset_pansharpened_mul_gulfport.img.
a) Open ls8_subset_pansharpened_mul_gulfport.img in ERDAS IMAGINE 2013.

Figure B1. Subset of pansharpened multispectral imagery at Gulfport, MS
b) Choose Manage Data from the main menu, click Pixels to ASCII, and the Pixel to Table
dialog box appears (Figure B2).

Figure B2. Pixel to Table dialog box
c) From Input File (*.img), select LS8_subset_pansharpened_mul_gulfport file. Click Add.
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d) From Output File: (.*asc), type ASCII_Gulfport as output file name. Click OK, and the
Converting pixel data to table dialog box appears (Figure B3). Click OK when Percent Done
reaches 100%.

Figure B3. Converting pixel data to table
e) Open Excel program. From main menu of Excel, select File > Open > Computer > Browse.
Select ASCII_Gulfport.asc file, and note that All files is selected to view
ASCII_Gulfport.asc file.

Figure B4. Open dialog box
f) Click Open. The Text Import Wizard dialog box appears as shown in Figure B5.

Figure B5. Text import wizard dialog box
g) Click on Finish. The spectral reflectance values for Landsat-8 bands are viewed in Excel
(Figure B6).
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Figure B6. Table of spectral reflectance values
h) Delete top three rows and the first column of the table shown in Figure B6.

Figure B7. Revised table of spectral reflectance values
i) From main menu of Excel, select File > Save As. Type Excel_ASCII_Gulfport as file name.
Note that if a Landsat-8 imagery covers a large area (larger than 100 km2), the Excel file may
not read all pixel spectral databases. The imagery should be divided or diced in to small areas.
j) Open Microsoft Access 2013, and select Blank desktop database.

Figure B8. Blank database dialog box
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k) Right click on Table 1 > Import > Excel, and then browse to the Excel_ASCII_Gulfport
file.

Figure B9. File open dialog box
l) Select Excel_ASCII_Gulfport file, and click Open.

Figure B10. Import Spreadsheet Wizard dialog box
m) Define a name for each column in Import Spreadsheet Wizard dialog box (Figure B10). The
first and second columns are latitude and longitude values for each pixel; their names are
defined as “Lat” and “Lon”. Values from the third through the tenth column are B1 (Coastal
aerosol), B2 (Blue), B3 (Green), B4 (Red), B5 (Near Infrared), B6 (SWIR 1), B7 (SWIR 2),
B8 (Cirrus), B9 (Thermal Infrared 1), and B10 (Thermal Infrared 2). Their names are defined
as “Coastal”, “B”, “G”, “R”, “NIR”, “SWIR1”, “SWIR2”, “Cirrus”, “TIRS1”, and “TIRS2”,
as shown in Figure B11.
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Figure B11. Defined name for each column in Import Spreadsheet Wizard dialog box
n) Click Finish. The pixel spectral database table is showed in Figure B12.

Figure B12. Pixel spectral reflectance database table
o) From main menu of Microsoft Access 2013, select File>Save As> Access 2002-2003
Database> Save As.

Figure B13. Save as dialog box
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p) Type ASCII_MDB_Gulfport. Click Save. The pixel spectral reflectance database is saved as
ASCII_MDB_Gulfport.mdb.
B2. Importing Pixel Spectral of Imagery of Area Interest into GeoMedia Pro 2013
a) Open a blank GeoMedia Professional Workspace.
b) Select Warehouse > New Warehouse > New. Enter file name L_BANS_Gulfport.

Figure B14. New warehouse dialog box
c) Click Save, and the L_BANS_ Gulfport file is created.
d) From the main menu of GeoMedia Pro 2013, select File>Save Geoworkspace. Type
L_BANS_Gulfport. Click Save.

Figure B15. Save geoworkspace as dialog box
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e) Select Warehouse > New Connection. Type Access Connection_ASCII_MDB_Gulfport as
the Connection name.
f) Under Access Database file, browse to the ASCII_MDB_Gulfport.mdb file. Click OK.

Figure B16. New connection dialog box
g) From main menu of GeoMedia Professional 2013, select Analysis > Geocode coordinates.
Under Geocode attribute in, select ASCII_gulfport.

Figure B17. Geocode coordinates dialog box
h) Under Geocode attribute in, Select ascii_gulfport.
i) Click on Coordinate System > Load. Select CoordinateSystem_Gulfport file. Click Open.
Then Click OK.
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Figure B18. Coordinate System Properties dialog box
j) Under Positive east(m), select Lat, under Positive north(m), select Lon.

Figure B19. Selected parameters in geocode coordinates dialog box
k) Click OK. The pixel spectral map is shown in Figure B20.

Figure B20. The pixel spectral map in GeoMedia Pro 2013
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B3. Step-By-Step of L-BANS Analysis
Table B1 shows decision tree criteria and surface class legend color for each step of LBANS analysis.
Table B1. L-BANS multispectral decision tree criteria and workflow to
auto-classify surface classes
L-BANS auto-classification, Created on 11/11/2016
Steps
0

1

2

3

4
5
6
7

8

L-BANS Multispectral decision tree criteria
for surface discrimination
Define geospatial boundary of area of
interest (AOI)
Total pixels = N
Water (NW)
NW < N
4,430 ≤ NIR Band ≤ 8,050
Tree (NT)
NT < (N - NW)
7,474 ≤ SWIR 1 Band ≤ 12,302
Grass (NG)
NG < (N - NW - NT)
6,935 ≤ SWIR 2 Band ≤ 12,798
Soil (NS)
NS < (N - NW - NT-NG)
11,239 ≤ SWIR 1 Band ≤ 26,802

Polygon
map

Surface class
legend color

Spectral
Range

Yes
(if needed)

Blue

± 2SD

No

Dark Green

± 2SD

No

Light Green

± 2SD

No

Yellow

± 2SD

No

Magenta

± 2SD

Yes
(if needed)

Orange

± 2SD

Yes

Natural terrain (NN)
NN = (NW + NT + NG + Ns) < N
Built Infrastructure (NI)
NI ≤ (N - NN)
Building (NB)
NB < NI
7,428 ≤ Green Band ≤ 20,339
Concrete (NC)
NC < (NI - NB)
8,103 ≤ NIR Band ≤ 16,945

9

Asphalt (NA)
NA ≤ (NI – NB – NC)

No

Gray

10

Check unclassified (NU) pixels
NU = N – NN – NB – NC – NA
Total pixels remaining

No

White

The decision tree criteria is based on high autocorrelation R values for the spectral bands
and unique ranges of the spectral reflectance values.
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B.3.1 Step 1: Water Classification
a) Select Analysis > Functional Attributes from the main menu.
b) Select Geocoded Points of ASCII_Gulfport from the Add functional attributes for menu
(Figure B21).

Figure B21. The Functional Attributes dialog box
c) Click New from the Output functional attributes field. The Functional attribute dialog box
appears. Here, the decision criteria can be defined for water classification.
d) Type Water in the Functional attribute name field (Figure B22).
e) Use the IF function to write the decision criteria for water as shown below.
IF (Input.NIR >= 4430 AND Input.NIR <= 8050, 'water', 'non_water').
To write this expression, double-click on IF under the Functions field; then
double-click on InputNIR under the Attributes field. Then select >= and <=
, and type the expression as shown in Figure B22. According to this expression, if the
reflectance value of the NIR band is greater or equal to 4,430 and less or equal to 8,050,
the pixel will be classified as water; otherwise it will be classified as nonwater.
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Figure B22. Decision criteria for water classification
f) Click Add, and then click Close. Under Query name of the Function Attribute dialog box,
type Functional_Attributes_Water.

Figure B23. Decision criteria for water classification
g) Click OK, and the Functional_Attributes_Water map appears. Right-click on
Functional_Attributes_Water layer. Select Legend Entry Properties > Unique Value
Thematic. Under Attribute for classification, select Water. Click Classify, and the pixels for
non_water and water appear (Figure B24).

Figure B24. Legend Entry Properties dialog box
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h) Uncheck non_water. Click symbol of water in Style column. A Select Style dialog box
appears. Select blue color for water with color code = 106 and size = 2.

Figure B25. Select style dialog box for water
i) Click OK to close the dialog box. Then, click OK on Legend Entry Properties dialog box, the
map of water appears (Figure B26).

Figure B26. Thematic map of water classification results
B.3.2 Step 2: Tree Classification
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a) Before working with tree classification, water must be subtracted from the total pixels. Select
Analysis > Spatial Difference from the main menu. The Spatial Difference dialog box
appears.
b) Under Input features field, select Geocode Points of ASCII_Gulfport in the From features
in drop-down menu, and select Geocode Points of ASCII_Gulfport in the Subtract features
in drop-down menu. Click Filter. Write the decision criteria for water in the Filter dialog box
(Figure B27).

Figure B27. The decision criteria for water in the Filter dialog box
c) Click OK to close the Filter dialog box.
d) Under Query name, type Geocoded_Points_GP_Non_Water.

Figure B28. Spatial difference dialog box for water
e) Click OK, and the Geocoded_Points_GP_Non_Water appears.
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f) Select Analysis > Functional Attributes from the main menu.
g) Select Geocoded_Points_GP_Non_Water from the Add functional attributes for menu.

Figure B29. Geocoded_points_GP_non_water map
h) Click New from the Output functional attributes field. The Functional attributes dialog box
appears. Type Tree in the Functional attribute name field (Figure B30). Under Expression,
write decision criteria for tree as shown below.
IF (Input.SWIR1 >= 7474 AND Input. SWIR1 <= 12302, 'tree', 'non_tree')

Figure B30. Decision criteria for tree classification
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i) Click Add, and then click Close. Under Query name of the Function Attribute dialog box,
type Functional_Attributes_Tree.

Figure B31. Functional attributes for tree classification
j) Click OK, and the Functional_Attributes_Tree map appears. Right-click on
Functional_Attributes_Tree layer. Select Legend Entry Properties > Unique Value
Thematic. Under Attribute for classification, select Tree. Click Classify, and the pixels of
non_tree and tree appear (Figure B32).

Figure B32. Legend Entry Properties dialog box
k) Uncheck non_tree. Click symbol of tree in Style column. A Select Style dialog box appears.
Select dark green for tree with color code = 5 and size = 2.
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Figure B33. Select Style dialog box for tree
l) Click OK to close the dialog box. Then, click OK on Legend Entry Properties dialog box, and
the map of tree appears (Figure B34).

Figure B34. Thematic map of tree classification results
C.3.3 Step 3: Grass Classification
a) Tree must be subtracted from the Geocoded_Points_GP_Non_Water before working with
grass classification.
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b) Select Analysis > Spatial Difference from the main menu. The Spatial Difference dialog box
appears.
c) Under Input features field, select Geocoded_Points_GP_Non_Water in the From features in
drop-down menu, and select Geocoded_Points_GP_Non_Water in the Subtract features in
drop-down menu. Click Filter. Write the decision criteria for tree in the Filter dialog box
(Figure B35).

Figure B35. The decision criteria for tree in the filter dialog box
d)

Click OK to close the Filter dialog box.

e) Under Query name, type Geocoded_Points_GP_Non_Water_Non_Tree.

Figure B36. Spatial difference dialog box for tree
f) Click OK, the Geocoded_Points_GP_Non_Water_Non_Tree map appears.
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Figure B37. Geocoded_points_gp_non_water_non_tree map
g) Select Analysis > Functional Attributes from the main menu.
h) Select Geocoded_Points_GP_Non_Water_Non_Tree from the Add functional attributes for
menu.
i) Click New from the Output functional attributes field. The Functional attributes dialog box
appears. Type Grass in the Functional attribute name field (Figure B38). Under Expression,
write decision criteria for grass as shown below.
IF(Input.SWIR2>=6935 AND Input.SWIR2<=12798, 'grass', 'non_grass')

Figure B38. Decision criteria for grass classification
j) Click Add, and then click Close. Under Query name of the Function Attribute dialog box,
type Functional_Attributes_Grass.
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Figure B39. Functional attributes for tree classification
k) Click OK, and the Functional_Attributes_Grass map appears. Right-click on
Functional_Attributes_Grass layer. Select Legend Entry Properties > Unique Value
Thematic. Under Attribute for classification, select Grass. Click Classify, and the pixels of
non_grass and grass appear (Figure B40).

Figure B40. Legend Entry Properties dialog box
l) Uncheck non_grass. Click symbol of grass in Style column. A Select Style dialog box
appears. Select light green color for grass with color code = 37 and size = 2.

Figure B41. Select style dialog box for grass
m) Click OK to close the dialog box. Then, click OK on Legend Entry Properties dialog box,
and the map of grass appears (Figure B42).
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Figure B42. Thematic map of grass classification results
B.3.4 Step 4: Soil Classification
a) Grass must be subtracted from the Geocoded_Points_GP_Non_Water_Non_Tree before
working with building classification.
b) Select Analysis > Spatial Difference from the main menu. Spatial Difference dialog box
appears.
c) Under Input features field, select Geocoded_Points_GP_Non_Water_Non_Tree in the From
features in drop-down menu, and select Geocoded_Points_GP_Non_Water_Non_Tree in
the Subtract features in drop-down menu. Click Filter. Write the decision criteria for grass in
the Filter dialog box (Figure B43).

Figure B43. The decision criteria for grass in the Filter dialog box
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d) Click OK to close the Filter dialog box.
e) Under Query name, type Geocoded_Points_GP_Built_Infras_With_Soil.

Figure B44. Spatial difference dialog box for building
f) Click OK, the Geocoded_Points_GP_Built_Infras_With_Soil map appears.

Figure B45. Geocoded_points_gp_built_infras_with_soil map
g) Select Analysis > Functional Attributes from the main menu.
h) Select Geocoded_Points_GP_Built_Infras_With_Soil from the Add functional attributes for
menu.
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i) Click New from the Output functional attributes field. The Functional attributes dialog box
appears. Type Soil in the Functional attribute name field (Figure B46). Under Expression,
write decision criteria for soil as shown below.
IF(Input.SWIR1>=11239 AND Input.SWIR1<=26802, 'soil', 'non_soil')

Figure B46. Decision criteria for soil classification
j) Click Add, then click Close. Under Query name of the Function Attribute dialog box, type
Functional_Attributes_Soil.
k) Click OK, the Functional_Attributes_Soil map appears. Right-click on
Functional_Attributes_ Soil layer. Select Legend Entry Properties > Unique Value
Thematic. Under Attribute for classification, select Soil. Click Classify, the pixels of
non_soil and soil appear (Figure B47).

Figure B47. Legend entry properties dialog box
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l) Uncheck non_soil. Click symbol of concrete in Style column. A Select Style dialog box
appears. Select dark gold for building with color code = 47 and size = 3.

Figure B48. Select style dialog box for building
m) Click OK to close the dialog box. Then, click OK on Legend Entry Properties dialog box,
the map of soil appears (Figure B49).

Figure B49. Thematic map of soil classification results
B.3.5 Step 5, 6, and 7: Building Classification
n) Soil must be subtracted from the Geocoded_Points_GP_Built_Infras_With_Soil before
working with building classification.
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o) Select Analysis > Spatial Difference from the main menu. The Spatial Difference dialog box
appears.
p) Under Input features field, select Geocoded_Points_GP_Built_Infras_With_Soil in the
From features in drop-down menu, select Geocoded_Points_GP_Built_Infras_With_Soil in
the Subtract features in drop-down menu. Click Filter. Write the decision criteria for grass in
the Filter dialog box (Figure B50).

Figure B50. The decision criteria for grass in the filter dialog box
q) Click OK to close the Filter dialog box.
r) Under Query name, type Geocoded_Points_GP_Built_Infras.

Figure B51. Spatial difference dialog box for building
s) Click OK, and the Geocoded_Points_GP_Built_Infras map appears.
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Figure B52. Geocoded_points_gp_built_infras map
t) Select Analysis > Functional Attributes from the main menu.
u) Select Geocoded_Points_GP_Built_Infras from the Add functional attributes for menu.
v) Click New from the Output functional attributes field. The Functional attributes dialog box
appears. Type Building in the Functional attribute name field (Figure B46). Under
Expression, write decision criteria for building as shown below.
IF(Input.G>=7428 AND Input.G<=20339, 'building', 'non_building')

Figure B53. Decision criteria for building classification
w) Click Add, and then click Close. Under Query name of the Function Attribute dialog box,
type Functional_Attributes_Building.
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x) Click OK, and the Functional_Attributes_Building map appears. Right-click on
Functional_Attributes_Building layer. Select Legend Entry Properties > Unique Value
Thematic. Under Attribute for classification, select Building. Click Classify, and the pixels
of non_building and building appear (Figure B54).

Figure B54. Legend entry properties dialog box
y) Uncheck non_building. Click symbol of concrete in Style column. A Select Style dialog box
appears. Select dark gold for buildings with color code = 34 and size = 2.

Figure B55. Select style dialog box for building
z) Click OK to close the dialog box. Then, click OK on Legend Entry Properties dialog box, and
the map of building appears (Figure B56).
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Figure B56. Thematic map of building classification results
B.3.6 Step 8 and 9: Concrete and Asphalt Classification
Building must be subtracted from the Geocoded_Points_GP_Built_Infras before
working with concrete classification.
a) Select Analysis > Spatial Difference from the main menu. The Spatial Difference dialog box
appears.
b) Under Input features field, select Geocoded_Points_GP_Built_Infras in the From features
in drop-down menu, and select Geocoded_Points_GP_Built_Infras in the Subtract features
in drop-down menu. Click Filter. Write the decision criteria for building in the Filter dialog
box (Figure B57).

Figure B57. The decision criteria for building in the filter dialog box
c) Click OK to close the Filter dialog box.
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d) Under Query name, type Geocoded_Points_GP_Built_Infras_Non_Building.
e) Click OK, and the Geocoded_Points_GP_Built_Infras_Non_Building map appears.

Figure B58. Geocoded_points_gp_built_infras_non_building map
f) Select Analysis > Functional Attributes from the main menu.
g) Select Geocoded_Points_GP_Built_Infras_With_Soil_Non_Building from the Add
functional attributes for menu.
h) Click New from the Output functional attributes field. The Functional attributes dialog box
appears. Type Concrete in the Functional attribute name field (Figure B59). Under
Expression, write decision criteria for concrete as shown below.
IF(Input.NIR>=8103 AND Input.NIR<=16945, 'concrete', 'asphalt')

Figure B59. Decision criteria for concrete classification
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i) Click Add, and then click Close. Under Query name of the Function Attribute dialog box,
type Functional_Attributes_Concrete.
j) Click OK, and the Functional_Attributes_Concrete map appears. Right-click on
Functional_Attributes_Concrete layer. Select Legend Entry Properties > Unique Value
Thematic. Under Attribute for classification, select Concrete. Click Classify, and the pixels
of non_concrete and concrete appear (Figure B60).

Figure B60. Legend entry properties dialog box
k) Click symbol for asphalt in Style column. A Select Style dialog box appears. Select grey for
asphalt with color code = 58 and size = 2.

Figure B61. Select style dialog box for asphalt
l) Click symbol of concrete in Style column. A Select Style dialog box appears. Select yellow
for soil with color code = 47 and size = 2.
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Figure B62. Select Style dialog box for soil
m) Click OK to close the dialog box. Then, click OK on Legend Entry Properties dialog box.
n) Display on all surface classes, and the thematic map of all the surface classes are displayed on
a map window of GeoMedia Pro 2013 as follows:

Figure B63. Thematic map of Gulfport, Mississippi using L-BANS methodology
o) Thematic map of Gulfport, Mississippi using L-BANS methodology are displayed on a layout
window of GeoMedia Pro 2013 as follows:
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Figure B64. Thematic map of Gulfport, Mississippi using L-BANS methodology
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APPENDIX C
Data and Output of L-BANS Auto-Classification Analysis

C.1 Landsat-8 Imageries in Selected Sites
C.2 Imageries and Frequency Plots of the Groundtruth Samples
C.3 Planimetric and Surface Type Maps
C.4 Results of L-BANS Auto-Classification Methodology
C.5 Input and Output of ANOVA Analysis for Methodology Results of Planimetric
Groundtruth and L-BANS using SPSS
C.6 Supervised Surface Classification Results
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C.1 Landsat-8 Imageries in Selected Sites

Acquired on August 25, 2015 (day time).
Figure C1. Landsat-8 Imagery, Sardis, Mississippi

Acquired on May 23, 2015 (day time)
Figure C2. Landsat-8 Imagery, Gulfport, Mississippi
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Acquired on September 8, 2015 (day time)
Figure C3. Landsat-8 Imagery, Port of Los Angeles, California

Acquired on November 22, 2015 (day time)
Figure C4. Landsat-8 Imagery, Oxford, Mississippi

Acquired on September 14, 2015 (day time).
Figure C5. Landsat-8 Imagery, Gwadar, Pakistan
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C.2 Imageries and Frequency Plots of the Groundtruth Samples

(a) Landsat -8 imagery of building groundtruth sample-B1 in Miami, FL

(b) Frequency plot for coastal aerosol band-1

(c) Frequency plot for blue band-2

(d) Frequency plot for green band-3

(e) Frequency plot for red band-4

(f) Frequency plot for near infrared band-5

(g) Frequency plot for SWIR 1 band-6

(h) Frequency plot for SWIR 2 band-7

(i) Frequency plot for cirrus band-9

(j) Frequency plot for TIRS 1 band-10

(k) Frequency plot for TIRS 2 band-11

Figure C6. Landsat-8 imagery, frequency plots, autocorrelation (R) of spectral reflectance
values, building groudtruth sample-B1 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-B2 for building in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C7. Landsat-8 imagery and frequency plot of reflectance values, building groudtruth
sample-B2 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-B3 for building in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C8. Landsat-8 imagery and frequency plot of reflectance values, building groudtruth
sample-B3 in Gulfport, MS
422

(a) Landsat -8 imagery of groundtruth sample-B4 for building in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C9. Landsat-8 imagery and frequency plot of reflectance values, building groudtruth
sample-B4 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-B5 for building in Oxford, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C10. Landsat-8 imagery and frequency plot of reflectance values, building groudtruth
sample-B5 in Oxford, MS
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(a) Landsat -8 imagery of groundtruth sample-C1 for concrete in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(i) Frequency plot for cirrus band

(h) Frequency plot for SWIR 2 band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C11. Landsat-8 imagery and frequency plot of reflectance values, concrete groudtruth
sample-C1 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-C2 for concrete in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(e) Frequency plot for red band

(d) Frequency plot for green band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(i) Frequency plot for cirrus band

(h) Frequency plot for SWIR 2 band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C12. Landsat-8 imagery and frequency plot of reflectance values, concrete groudtruth
sample-C2 in Gulfport, MS
426

(a) Landsat -8 imagery of groundtruth sample-C3 for concrete in Los Angeles, CA

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure 13. Landsat-8 imagery and frequency plot of reflectance values, concrete groudtruth
sample-C3 in Los Angeles, CA
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(a) Landsat -8 imagery of groundtruth sample-C4 for concrete in Oxford, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(e) Frequency plot for red band

(d) Frequency plot for green band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(i) Frequency plot for cirrus band

(h) Frequency plot for SWIR 2 band

(k) Frequency plot for TIRS 2 band

(j) Frequency plot for TIRS 1 band

Figure C14. Landsat-8 imagery and frequency plot of reflectance values, concrete groudtruth
sample-C4 in Oxford, MS
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(a) Landsat -8 imagery of groundtruth sample-A1 for asphalt in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C15. Landsat-8 imagery and frequency plot of reflectance values, Asphalt groudtruth
sample-A1 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-A2 for asphalt in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(i) Frequency plot for cirrus band

(h) Frequency plot for SWIR 2 band

(k) Frequency plot for TIRS 2 band

(j) Frequency plot for TIRS 1 band

Figure C16. Landsat-8 imagery and frequency plot of reflectance values, asphalt groudtruth
sample-A2 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-A3 for asphalt in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C17. Landsat-8 imagery and frequency plot of reflectance values, asphalt groudtruth
sample-A3 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-A4 for asphalt in Oxford, MS

(b) Frequency plot for coastal aerosol band

(d) Frequency plot for green band

(c) Frequency plot for blue band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C18. Landsat-8 imagery and frequency plot of reflectance values, asphalt groudtruth
sample-A4 in Oxford, MS
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(b) Landsat -8 imagery of groundtruth sample-W1 for water in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C19. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W1 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-W2 for water in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(e) Frequency plot f or red band
(d) Frequency plot for green band

(g) Frequency plot for SWIR 1 band

(f) Frequency plot for near infrared band

(i) Frequency plot for cirrus band
(h) Frequency plot for SWIR 2 band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C20. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W2 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-W3 for water in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C21. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W3 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-W4 for water in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C22. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W4 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-W5 for water in Los Angeles, CA

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C23. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W5 in Los Angeles, CA
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(a) Landsat -8 imagery of groundtruth sample-W6 for water in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(e) Frequency plot for red band

(d) Frequency plot for green band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C24. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W6 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-W7 for water in Gwadar, Pakistan

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C25. Landsat-8 imagery and frequency plot of reflectance values, water groudtruth
sample-W7 in Gwadar, Pakistan
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(a) Landsat -8 imagery of groundtruth sample-S1 for soil in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C26. Landsat-8 imagery and frequency plot of reflectance values, soil groudtruth
sample-S1 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-S2 for soil in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C27. Landsat-8 imagery and frequency plot of reflectance values, soil groudtruth
sample-S2 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-S3 for soil in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(i) Frequency plot for cirrus band

(h) Frequency plot for SWIR 2 band

(k) Frequency plot for TIRS 2 band

(j) Frequency plot for TIRS 1 band

Figure C28. Landsat-8 imagery and frequency plot of reflectance values, soil groudtruth
sample-S3 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-S4 for soil in Oxford, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C29. Landsat-8 imagery and frequency plot of reflectance values, soil groudtruth
sample-S4 in Oxford, MS
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(a) Landsat -8 imagery of groundtruth sample-S5 for soil in Gwadar, Pakistan

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C30. Landsat-8 imagery and frequency plot of reflectance values, soil groudtruth
sample-S5 in Gwadar, Pakistan
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(a) Landsat -8 imagery of groundtruth sample-T1 for tree in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C31. Landsat-8 imagery and frequency plot of reflectance values, tree groudtruth
sample-T1 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-T2 for tree in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C32. Landsat-8 imagery and frequency plot of reflectance values, tree groudtruth
sample-T2 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-T3 for tree in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C33. Landsat-8 imagery and frequency plot of reflectance values, tree groudtruth
sample-T3 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-T4 for tree in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(e) Frequency plot for red band

(d) Frequency plot for green band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C34. Landsat-8 imagery and frequency plot of reflectance values, tree groudtruth
sample-T4 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-T5 for tree in Oxford, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C35. Landsat-8 imagery and frequency plot of reflectance values, tree groudtruth
sample-T5 in Oxford, MS
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(a) Landsat -8 imagery of groundtruth sample-T6 for tree in Oxford, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C36. Landsat-8 imagery and frequency plot of reflectance values, tree groudtruth
sample-T6 in Oxford, MS
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(a) Landsat -8 imagery of groundtruth sample-G1 for grass in Miami, FL

(b) Frequency plot for coastal aerosol band

(c) Frequency plot fo r blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C37. Landsat-8 imagery and frequency plot of reflectance values, grass groudtruth
sample-G1 in Miami, FL
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(a) Landsat -8 imagery of groundtruth sample-G2 for grass in Gulfport, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C38. Landsat-8 imagery and frequency plot of reflectance values, grass groudtruth
sample-G2 in Gulfport, MS
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(a) Landsat -8 imagery of groundtruth sample-G3 for grass in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(i) Frequency plot for cirrus band

(h) Frequency plot for SWIR 2 band

(k) Frequency plot for TIRS 2 band

(j) Frequency plot for TIRS 1 band

Figure C39. Landsat-8 imagery and frequency plot of reflectance values, grass groudtruth
sample-G3 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-G4 for grass in Sardis, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(d) Frequency plot for green band

(e) Frequency plot for red band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C40. Landsat-8 imagery and frequency plot of reflectance values, grass groudtruth
sample-G4 in Sardis, MS
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(a) Landsat -8 imagery of groundtruth sample-G5 for grass in Oxford, MS

(b) Frequency plot for coastal aerosol band

(c) Frequency plot for blue band

(e) Frequency plot for red band

(d) Frequency plot for green band

(f) Frequency plot for near infrared band

(g) Frequency plot for SWIR 1 band

(h) Frequency plot for SWIR 2 band

(i) Frequency plot for cirrus band

(j) Frequency plot for TIRS 1 band

(k) Frequency plot for TIRS 2 band

Figure C41. Landsat-8 imagery and frequency plot of reflectance values, grass groudtruth
sample-G5 in Oxford, MS
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C.3 Planimetric and Surface Type Maps

Figure C42. Planimetric map of Sardis, Mississippi

Figure C43. Surface type map of Sardis, Mississippi
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Figure C44. Planimetric map of Gulfport, Mississippi

Figure C45. Surface type map of Gulfport, Mississippi
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Figure C46. Planimetric map of Los Angeles, California

Figure C47. Surface type map of Los Angeles, California
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Figure C48. Planimetric map of Oxford, Mississippi

Figure C49. Surface type map of Oxford, Mississippi
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Figure C50. Planimetric map of Gwadar, Pakistan

Figure C51. Surface type map of Gwadar, Pakistan
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C.4 Results of L-BANS Auto-Classification Methodology
Table C1. Comparison of L-BANS with ground truth for Sardis, Mississippi

Surface Class

Planimetrics
(Groundtruth)
Area

Percent
Area

L-BANS
Area

Percent
Area

Difference
Planimetrics
&
L-BANS

m2

%

m2

%

%

Class

A1

A2

B1

B2

A2-B2

A Asphalt

912,833

0.98

10,800

0.01

0.97

A

B Building

1,058,831

1.14

266,400

0.29

0.85

B

C Concrete

361,078

0.39

45,900

0.05

0.34

C

BC
Building/Concrete

1,419,909

1.53

312,300

0.34

1.19

BC

G

Grass

30,203,739

32.52

33,643,350

36.22

-3.70

G

S

Soil

205,259

0.22

1,475,550

1.59

-1.37

S

T

Tree

59,555,206

64.12

57,088,800

61.47

2.66

T

577,204

0.62

343,350

0.37

0.25

W

0

0.00

0

0.00

92,874,150

100.00

92,874,150

2,332,742

2.51

323,100

W Water
U Unclassified
SUM
Total Built
Infrastructure
(Building,Concrete,
Asphalt)
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)
SUM

(2.33 km2)
90,541,408

0.00

0.35

2.16

99.65

-2.16

100.00

0.00

(0.32 km2)
97.49

92,551,050

(90.54 km2)
92,874,150

100.00

U

(92.55 km2)
100.00

92,874,150

(92.87 km2)

(92.87 km2)
MARE = 1.3369 %
RMSE = 1,737,130.68 m2

Concrete surface class includes:
 Taxiway Exitway
 Bridge Edges
 Apron
 Concrete Parking Area
 Interstate Pavement
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Table C2. Comparison of L-BANS with groundtruth or the Gulfport, Mississippi
Planimetrics
(Groundtruth)
Area

Percent
Area

L-BANS
Area

Percent
Area

Difference
Planimetrics
&
L-BANS

m2

%

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

3,576,023

3.34

323,550

0.30

3.04

A

B Building

16,451,752

15.37

1,637,550

1.53

13.84

B

C Concrete

5,593,989

5.22

405,900

0.38

4.85

C

BC
Building/Concrete

22,045,741

20.59

2,043,450

1.91

18.68

BC

G

Grass

22,214,354

20.75

23,203,800

21.67

-0.92

G

S

Soil

1,778,912

1.66

7,955,100

7.43

-5.77

S

T

Tree

30,786,489

28.76

46,061,775

43.02

-14.27

T

26,662,258

24.90

27,476,100

25.66

-0.76

W

0

0.00

0

0.00

0.00

U

107,063,775

100.00

107,063,775

100.00

0.00

25,621,763

23.93

2,367,000

2.21

21.72

97.79

-21.72

100.00

0.00

Surface Class

W Water
U Unclassified
SUM
Total Built
Infrastructure
(Building,
Concrete, Asphalt)
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)
SUM

(25.62 km2)
81,442,012

(2.37 km2)
76.07

(81.44 km2)
107,063,775
2

(107.06 km )

104,696,775
(104.70 km2)

100.00

107,063,775
2

(107.06 km )
MARE = 0.9687 %
RMSE = 8,702,022.93 m2

Concrete surface class includes:






Taxiway Exitway
Bridge Edges
Apron
Concrete Parking Area
Port Dock
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Class

Table C3. Comparison of L-BANS with groundtruth the Port of Los Angeles, California
Planimetrics
(Groundtruth)
Area

Percent
Area

L-BANS
Area

Percent
Area

Difference
Planimetrics
&
L-BANS

m2

%

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

4,013,889

2.18

646,200

0.35

1.83

A

B Building

28,662,574

15.55

862,200

0.47

15.08

B

C Concrete

28,890,630

15.67

21,825

0.01

15.66

C

BC
Building/Concrete

57,553,204

31.22

884,025

0.48

30.74

BC

G

Grass

2,738,157

1.49

26,817,750

14.55

-13.06

G

S

Soil

2,443,109

1.33

14,022,000

7.61

-6.28

S

T

Tree

5,249,240

2.85

46,624,500

25.29

-22.44

T

112,351,426

60.94

95,354,550

51.73

9.22

W

0

0.00

0

0.00

0.00

U

184,349,025

100.00

184,349,025

100.00

0.00

61,567,093

33.40

1,530,225

0.83

32.57

99.17

-32.57

100.00

0.00

Surface Class

W Water
U Unclassified
SUM
Total Built
Infrastructure
(Building, Concrete,
Asphalt)
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)
SUM

(61.57 km2)
122,781,932

(1.53 km2)
66.60

(122.78 km2)
184,349,025
2

(184.35 km )

182,818,800
(182.82 km2)

100.00

184,349,025
2

(184.35 km )
MARE = 3.4822 %
RMSE = 24,877,739.49 m2

Concrete surface class includes:







Bridge Edges
Concrete Parking Area
Port Dock
Port Property
Seawall
Interstate Pavement
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Class

Table C4. Comparison of L-BANS with groundtruth for the Oxford, MS
Planimetrics
(Groundtruth)
Area

Percent
Area

L-BANS
Area

Percent
Area

Difference
Planimetrics
&
L-BANS

m2

%

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

56,816

0.71

6,075

0.08

0.63

A

B Building

214,751

2.68

1,350

0.02

2.66

B

C Concrete

179,122

2.23

226,350

2.82

-0.59

C

BC
Building/Concrete

393,872

4.91

227,700

2.84

2.07

BC

2,077,581

25.91

684,900

8.54

17.37

G

Surface Class

G

Grass

S

Soil

7,542

0.09

55,125

0.69

-0.59

S

T

Tree

5,401,116

67.36

6,934,500

86.49

-19.12

T

81,173

1.01

109,800

1.37

-0.36

W

0

0.00

0

0.00

0.00

U

8,018,100

100.00

8,018,100

100.00

0.00

450,688

5.62

233,775

2.92

2.71

97.08

-2.71

100.00

0.00

W Water
U Unclassified
SUM
Total Built
Infrastructure
(Building,
Concrete, Asphalt)
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)
SUM

(0.41 km2)
7,567,412

(0.23 km2)
94.38

7,784,325

(7.57 km2)
8,018,100

(7.78km2)
100.00

8,018,100

2

2

(8.02 km )

(8.02 km )
MARE = 1.3953 %
RMSE = 787,786.73 m2

Concrete surface class includes:





Class

Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
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Table C5. Comparison of L-BANS with groundtruth for the Gwadar, Pakistan

LBANS Area

Percent
Area

Difference
Planimetrics
&
LBANS

%

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

542,900

0.05

20,635,200

1.72

-1.67

A

B Building

16,325,380

1.36

1,903,050

0.16

1.20

B

C Concrete

10,550,192

0.88

114,975

0.01

0.87

C

BC
Building/Concrete

26,875,572

2.24

449,227,575

37.41

-35.18

BC

0

0.00

15,701,625

1.31

-1.31

G

Surface Class

Planimetrics
(Groundtruth)

Percent
Area

m2

G

Grass

S

Soil

447,076,897

37.24

428,973,975

35.73

1.51

S

T

Tree

0

0.00

7,341,750

0.61

-0.62

T

726,172,366

60.48

725,997,160

60.47

0.01

W

0

0.00

0

0.00

0.00

U

1,200,667,735

100.00

1,200,667,735

100.00

0.00

27,418,472

2.28

22,653,225

1.89

0.40

98.11

-0.40

100.00

0.00

W Water
U Unclassified
SUM
Total Built
Infrastructure
(Asphalt, Building,
Concrete, )
Total Natural
Terrain
(Water, Soil, Trees,
and Grass)

(22.65 km2)

(27.42 km2)
1,173,249,263

97.72

(1,173.25
km2)
1,200,667,735

1,178,014,510
(1,178.01 km2)

100.00

1,200,667,735

SUM
(1,200.67 km2)

(1,200.67 km2)
MARE = 5.5604%
RMSE = 13,881,059.34
m2

Concrete surface class includes:



Class

Concrete Parking Area
Port Property
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Figure C52. Spatial map of Sardis, Mississippi using L-BANS classification
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Figure C53. Spatial map of Gulfport, Mississippi using L-BANS classification

Figure C54. Spatial map of Los Angeles, California using L-BANS classification

Figure C55. Spatial map of Oxford, Mississippi using L-BANS classification
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Figure C56. Spatial map of Gwadar, Pakistan using L-BANS classification
C.5 Input and Output of ANOVA Analysis for Methodology Results of Planimetric
Groundtruth and L-BANS using SPSS
Table C6. Input data for ANOVA analysis in SPSS

468

469

Figure C57. Sections of dependent and fixed factors for ANOVA analysis

Figure C58. Interaction of factors in ANOVA analysis
Table C7. The ANOVA test results with interactions using Planimetric groundtruth and LBANS methodologies
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C.6 Supervised Surface Classification Results
Table C8. Comparison of Minimum Distance Method with groundtruth for the Miami,
Florida

Surface Class

Planimetrics
(Groundtruth)
Area

Percent
Area

Minimum
Distance
Area

Percent
Area

Difference
Planimetrics &
Minimum
Distance

m2

%

m2

%

%

Class

A1

A2

B1

B2

A2-B2

A Asphalt

8,525,524

6.96

8,931,449

7.29

-0.33

A

B Building

52,773,228

43.10

18,756

0.02

43.09

B

C Concrete

11,157,386

9.11

31,635,276

25.84

-16.72

C

BC
Building/Concrete

63,930,613

52.21

31,654,032

25.85

26.36

BC

G

Grass

9,122,647

7.45

24,511,193

20.02

-12.57

G

S

Soil

2,251,749

1.84

2,460,532

2.01

-0.17

S

T

Tree

10,926,615

8.92

23,828,848

19.46

-10.54

T

27,684,028

22.61

31,055,121

25.36

-2.75

W

0

0.00

0

0.00

0.00

U

SUM

122,441,175

100.00

122,441,175

100.00

0.00

Total Built
Infrastructure
(Building,
Concrete,
Asphalt)

72,456,137

59.18

40,585,481

33.15

26.03

66.85

-26.03

100.00

0.00

W Water
U Unclassified

Total Natural
Terrain
(Water, Soil,
Trees,
and Grass)
SUM

(72.46 km2)
49,985,038

(40.58 km2)
40.82

(49.98 km2)
122,441,175
(122.44 km2)

81,855,694
(81.85 km2)

100.00

122,441,175
(122.44 km2)
MARE = 0.8521%

RMSE = 22,732,059.97 m2

Concrete surface class includes:





Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
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Table C9. Comparison of Mahalanobis Distance Method with groundtruth for the Miami,
Florida
Planimetrics
(Groundtruth)
Area

Percent
Area

Mahalanobis
Distance
Area

Percent
Area

Difference
Planimetrics &
Mahalanobis
Distance

m2

%

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

8,525,524

6.96

156,603

0.13

6.84

A

B Building

52,773,228

43.10

25,326

0.02

43.08

B

C Concrete

11,157,386

9.11

1,047,324

0.86

8.26

C

BC
Building/Concrete

63,930,613

52.21

1,072,650

0.88

51.34

BC

G

Grass

9,122,647

7.45

74,738,239

61.04

-53.59

G

S

Soil

2,251,749

1.84

11,521,643

9.41

-7.57

S

T

Tree

10,926,615

8.92

26,867,577

21.94

-13.02

T

27,684,028

22.61

8,084,463

6.60

16.01

W

0

0.00

0

0.00

0.00

U

SUM

122,441,175

100.00

122,441,175

100.00

0.00

Total Built
Infrastructure
(Building,
Concrete,
Asphalt)

72,456,137

59.18

1,229,253

1.00

58.17

99.00

-58.17

100.00

0.00

Surface Class

W Water
U Unclassified

Total Natural
Terrain
(Water, Soil,
Trees,
and Grass)
SUM

(72.46 km2)
49,985,038

(1.23 km2)
40.82

(49.98 km2)
122,441,175
2

(122.44 km )

121,211,922
(121.21 km2)

100.00

122,441,175
2

(122.44 km )
MARE = 2.3376%
RMSE = 33,772,743.25 m2

Concrete surface class includes:





Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
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Class

Table C10. Comparison of Maximum Likelihood Method with groundtruth for the
Miami, Florida
Planimetrics
(Groundtruth)
Area

Percent
Area

Maximum
Likelihood
Area

Percent
Area

Difference
Planimetrics &
Maximum
Likelihood

m2

%

m2

%

%

A1

A2

B1

B2

A2-B2

A Asphalt

8,525,524

6.96

208,527

0.17

6.79

A

B Building

52,773,228

43.10

28,083

0.02

43.08

B

C Concrete

11,157,386

9.11

1,422,713

1.16

7.95

C

BC
Building/Concrete

63,930,613

52.21

1,450,796

1.18

51.03

BC

G

Grass

9,122,647

7.45

70,036,011

57.20

-49.75

G

S

Soil

2,251,749

1.84

10,770,000

8.80

-6.96

S

T

Tree

10,926,615

8.92

29,525,881

24.11

-15.19

T

27,684,028

22.61

10,449,960

8.53

14.08

W

0

0.00

0

0.00

0.00

U

SUM

122,441,175

100.00

122,441,175

100.00

0.00

Total Built
Infrastructure
(Building,
Concrete,
Asphalt)

72,456,137

59.18

1,659,323

1.36

57.82

98.64

-57.82

100.00

0.00

Surface Class

W Water
U Unclassified

Total Natural
Terrain
(Water, Soil,
Trees,
and Grass)
SUM

(72.46 km2)
49,985,038

(1.66 km2)
40.82

(49.98 km2)
122,441,175
2

(122.44 km )

120,781,852
(120.78 km2)

100.00

122,441,175
2

(122.44 km )
MARE = 2.2332%
RMSE = 23,647,766.80 m2

Concrete surface class includes:





Concrete Parking Area
Port Property
Interstate Pavement
Bridge Edges
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Class

Figure C59. Spatial map of Miami, Florida using minimum distance method

Figure C60. Spatial map of Miami, Florida using mahalanobis distance method
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Figure C61. Spatial map of Miami, Florida using maximum likelihood method
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APPENDIX D
Step-By-Step Procedure of 1-D HEC-RAS Flood Simulation

D.1 Creating TIN Map from the 2 ft DEM Contour Data
D.2 Creating Geometric Data using HEC-GeoRas Program
D.3 Attributing the Created Geometric Layers
D.4 Completing the Data and Boundary Conditions
D.5 Running Rainfall Flood Simulation
D.6 Creating Floodplain Simulation Maps
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D.1 Creating TIN Map from the 2 ft DEM Contour Data
In this study the 2 ft DEM contour data is used for creating a TIN map as well as
presenting results of flood simulation at Miami, Florida. The 2 ft DEM contour data were
collected from the Florida Geographic Data Library [5L]. The 2 ft DEM contour data were
generated from LIDAR data. The RMSE of the 2 ft DEM data is 0.3 ft (9 cm) [5K, 5L]. Landsat8 pansharpened multispectral imagery, collected from USGS [5F] with resolution of 15x15
meters, is also used for this study.
Adding 2 ft DEM contour data and Lansat-8 pansharpened multispectral imagery of Miami in to
ArcMap
a) Click on the ArcMap icon on the computer desktop, the ArcMap - Getting Started dialog box
appears as shown in Figure D1. Click My Templates > Bank Map > OK.

Figure D1. The ArcMap - Getting Started dialog box
b) Right click on Layers under the Table of Contents, select Add Data, select 2ftDEM.tif from
the selected folder. The 2ftDEM.tif is the 2 ft DEM contour data in Miami, Florida. Then
click Add. The 2 ft DEM contour data at Miami, Florida appears on the ArcMap as shown in
Figure D2.
Figure D2 shows the 2 ft DEM contour data at Miami, Florida. The dark and back color
shows low elevation. The light and white color shows high elevation. The legend of the 2 ft
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DEM contour under the Table of Contents indicates that the lowest elevation point is -2.80533
meters and the highest elevation point is 50.4025 meters.

Figure D2. The 2ft DEM contour data at Miami, Florida opened on ArcMap
c) Right click on Layers under the Table of Contents, select Add Data, and select
Pansharpened_LS8.img. Click Add. The Lansat-8 pansharpened multispectral imagery of
Miami appears on Data View window of ArcMap (Figure D3). This Lansat-8 pansharpened
multispectral imagery covers both ocean and land area of the study area.

Figure D3. The Lansat-8 pansharpened multispectral imagery of Miami on ArcMap
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d) Double click on Pansharpened_LS8.img. The Layer Properties dialog box appears. Click on
Symbology, under Band, changed Layer_4 for Red, Layer_3 for Green and Layer_2 for Blue
(Figure D4). Click Apply, and then click OK. The Lansat-8 pansharpened multispectral
imagery of Miami is shown as natural colors on ArcMap (Figure D5).

Figure D4. Selection of natural colors for the Lansat-8 pansharpened multispectral imagery of
Miami

Figure D5. Natural colors for the Lansat-8 pansharpened multispectral imagery of Miami on
ArcMap
e) Choose File from the main menu. Click Save As, and the Save As dialog box appears (Figure
D6).
f) From File name, type Miami_TIN_Map. Click Save. The 2ft DEM contour data map was
saved as an ArcMap document.
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Figure D6. Defining file name for the TIN map
Creating TIN Map from the 2 ft DEM Contour Data
g) From the main menu of the ArcMap, then select Geoprocessing, select ArcToolbox. The
ArcToolbox dialog box appears (Figure D7).

Figure D7. ArcToolbox dialog box
h) From the ArcToolbox dialog box, select 3D Analysis Tools > Conversion > From Raster >
Raster to TIN (Figure D8). Raster to TIN dialog box appears (Figure D9).

Figure D8. Raster to TIN function in ArcToolbox
i) Under Input raster, select 2ftDEM.tif. Under Output TIN define Maiami_TIN as the file
name of the output TIN. Type 6500000 in the Maximum Number of Points (optional). Keep
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default values for both Z Tolerance (optional) and Z Factor (optional). Click OK; a TIN map
appears (Figure D10).

Figure D9. Converting raster to TIN map
j) The TIN map in Figure D10 shows 9 ranges of elevation in Miami. In order to see clearly the
terrain of the study area, 13 ranges of elevation in the TIN map is created. Double click on the
Miami_TIN layer; the Layer Properties dialog box appears (Figure D11). Click on
Symbology; under Show, uncheck Edge types. Click Elevation then select 13 in Classes, click
OK, a TIN map with 13 ranges of elevation is created and showed in Figure D12.

Figure D10. Created TIN map with 9 ranges of elevation
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Figure D11. Selection of 13 ranges of elevation in TIN Map

Figure D12. Created TIN map with 13 ranges of elevation
D.2 Creating Geometric Data using HEC-GeoRas Program
HEC-GeoRAS, developed by U.S. Army Corps of Engineers, is a set of tools for processing
geospatial data in ArcGIS using a graphical user interface. The interface allows the preparation
of geometric data for import into HEC-RAS. In this study, the HEC-GeoRAS is used to create
geometric data in Miami for import into 1-D HEC-RAS flood simulation.
Creating River Centerlines Layer
a) From the main menu of ArcGIS, select Customize > Toolbars > HEC-GeoRAS; then the
HEC-GeoRAS interface appears (Figure D13).
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Figure D13. The interface of HEC-GeoRAS
b) From main menu of HEC-GeoRAS, select RAS Geometry > Create RAS Layers, and select
Stream Centerline (Figure D14). A Create Stream Centerline Layer dialog box appears
(Figure D15).

Figure D14. Selection of Stream Centerline function

Figure D15. River centerline creation
c) In Figure D15, keep River as the name of the created stream centerline layer. Click OK; a
message appears as shown in Figure D16. Click OK. A River layer is created and showed in
the Table of Content.

Figure D16. A message confirming status of river layer
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d) Double click on River layer in the Table of Contents, a Symbol Selector dialog box appear
(Figure D17). Select 2 as size of the symbol and blue color with RGB (0, 92, 230). Click OK.

Figure D17. Defining color and width of the river layer
e) There are five main rivers and canals in the study area. The planimetrics of centerlines of
these rivers and canals are created based on Lansat-8 pansharpened multispectral imagery. In
the Table of Contents window, left click on Pansharpened_LS8.img and keep the mouse
then drag the Pansharpened_LS8.img to the second layer on the Table of Contents window
(Figure D18).

Figure D18. The lansat-8 pansharpened multispectral imagery for creating river centerlines
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f) From Editor in the Editor toolbar, select Start Editing. From the Editor menu, select Editing
Windows > Create Features, and a Create Features dialog box for the River layer appears
(Figure D19).

Figure D19. Create features dialog box for river layer
g) Under Construction Tools in Figure D19, select Line, and then draw centerlines for the five
rivers and canals that are identified based on the Lansat-8 pansharpened multispectral
imagery. The created planimetrics of centerlines of these rivers and canals are shown in
Figure D20.

Figure D20. Planimetrics of river layers, Miami, FL
h) From HEC-GeoRAS, click on the symbol of Assign RiverCode and ReachCode to River

,

then click on a created river centerline on map. An Assign River and Reach Name dialog box
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appears (Figure D21). In the River Name box, enter Little River as the name of the selected
river centerline. In the Reach Name, enter R1. Click OK.

Figure D21. Defining river name and reach name for the selected river
i) Repeat step h in section D2 for four other rivers and canals in the study area to define river
name as well as reach name for these rivers and canals.
Creating Bank Lines Layer
j) Select RAS Geometry from the main menu of HEC-GeoRAS. Select Create RAS Layers, then
select Bank Lines. A Create Bank Lines dialog box appears (Figure D22). Keep Banks as the
name of the Bank Lines layer in the Bank Lines box. Click OK; A message appears as shown
in Figure D23. Click OK. A Banks feature class is created and showed in the Table of
Content of ArcGIS.

Figure D22. Defining name for a Bank Lines layer

Figure D23. A message confirming status of the Create Bank Lines layer
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k) Double click on the Banks layer in the Table Of Contents, a Symbol Selector dialog box for
Banks layer appears (Figure D24). Select 1 as the width of the bank lines and red color with
RGB (255, 127, 127). Click OK.

Figure D24. Defining color code and width for banks layer
l) Select Start Editing from Editor. In the Create Features dialog box (Figure D25), select
Banks layer. Under Construction Tools select Line. Note that if the Create Features dialog
box is not shown, this dialog box can be activated by selecting Create Features from Editing
Windows in the Editor menu.

Figure D25. Section of a construction tool for creating planimetrics of the Banks layer
m) Draw bank lines for each river and canal based on the Lansat-8 pansharpened multispectral
imagery. Figure D25 shows created bank lines of the Miami River. After creating bank lines
for these rivers and canals, select Stop Editing from Editor.
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Figure D25. Created bank lines for Miami River
Creating Flow Path Centerlines Layer
The Flow Path Centerlines layer is used to identify the hydraulic flow path in the left overbank,
main channel, and right overbank by identifying the center-of-mass of flow in each region.
n) Select RAS Geometry from the main menu of HEC-GeoRAS > Create RAS Layers. Select
Flow Path Centerlines. A message appears as shown in Figure D26.

Figure D26. Copying existing river centerline shapes into the flowpath layer
o) Click Yes in Figure D26 to copy the existing river centerline shapes into the flowpath layer.
A Create Flow Paths dialog box appears (Figure D27). Keep River in the Stream
Centerlines. In the Flowpaths box, type Flowpaths as the name of the Flow Path Centerlines
layer. Click OK. A message appears (Figure D28) and indicates that the Flowpaths layer is
created successfully.
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Figure D27. Defining name for flow paths layer

Figure D28. Message confirming status of the Create Flow Paths layer
p) Double click on the Flowpaths layer in the Table Of Contents; A Symbol Selector dialog
box for the Flowpaths layer appears (Figure D29). Select 1 as the width of the flowpaths and
lepidolite lilac color with RGB (232, 190, 255). Click OK.

Figure D29. Defining color code and width for the Flowpaths layer
q) Select Start Editing from Editor. In the Create Features dialog box (Figure D30), select the

Flowpaths layer. Select Line under Construction Tools.
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Figure D30. Construction tool for creating planimetrics of the Flowpaths layer
r) Draw both left and right flow paths for each river and canal based on the Lansat-8
pansharpened multispectral imagery. The flow path centerline for each river and canal was
already created by copying the existing river centerline shapes into the flowpath layer. Note
that these flow paths are created in the direction of flow from upstream to downstream. The
created flow paths are shown in the Figure D31.

Figure D31. Created flowpaths for the rivers and canals
s) From HEC-GeoRAS, click on the symbol of Select Flowpath and Assign LineType
Attributes

, then click on the left flowpath of the Miami River on the map. An Assign

Flowpath Type dialog box appears. Select Left in the Line Type box for the left flowpath
(Figure D32). Click OK.
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Figure D32. Selection of flowpath type
t) Repeat step s in this section for the right and center flowpaths of the Miami River. Note that
Channel is selected for the center flowpath.
u) Step s and t are repeated for other rivers and canals to select line types for flowpaths.
Creating Cross Sections Layer
The cross sections feature class presents the location of the cross sections in HEC-RAS
and attribute the cross sections with water surface elevations for each profile.
v) Select RAS Geometry from the main menu of HEC-GeoRAS > Create RAS Layers; select XS
Cut Lines. A Create XS Cut Lines dialog box appears as shown in Figure D33. Type
CrossSections in the Cross-sectional Cut Lines box. Click Ok. A message appears (Figure
D34) indicates that the Crosssection layer is created successfully.

Figure D33. Defining name for the cross sections feature class

Figure D34. Message confirming successfully created cross section layer
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w) Keep default color and width for the cross sections (width = 2, green color with RGB (0, 255,
0)). Cross sections must be created in Edit model. To begin editing, select Start Editing from
the Editor toolbar.
x) Draw cross sections for each river and canal in the study area. Note that the cross sections
must the entire extent of the floodplain to be modeled. Some rules for creating cross sections
including (1) cross sections must be oriented from the left overbank to the right overbank
when looking downstream, (2) cross sections should not intersect, (3) cross sections must
cross the river exactly once, and (4) cross sections may not extend beyond the extents of the
DEM.

Figure D35. Created cross sections in Maimai
y) Select Stop Editing from the Editor toolbar. The created cross sections are shown in Figure
D35.
D.3 Attributing the Created Geometric Layers
Attributing the River Centerline Layer
a) Select RAS Geometry from the Editor toolbar. Select Stream Centerline Attributes >
Topology. A Create River Topology dialog box appears (Figure D36). Topology is used to
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verify the connectivity of the river network. Select River in Stream Centerlines box, select
Miami_TIN in Terrain TIN box.

Figure D36. Selection for topology for river layer
b) Click OK. A message appears (Figure D37) indicates that the river topology successfully
created.

Figure D37. Message confirming successfully created topology
c) Select RAS Geometry from the Editor toolbar. Select Stream Centerline Attributes >
Lengths/Stations. A message appears (Figure D38) indicates that the river length and station
distance successfully calculated. Click OK.

Figure D38. Message confirming the river length and station distance
successfully calculated
Attributing the Cross Sections
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d) Select RAS Geometry from the Editor toolbar. Select XS Cut Line Attributes > River/Reach
Names. A message appears (Figure D39) indicates that the river and reach attributes have
been successfully assigned (each cross section is attributed with a River and Reach name
based on the names in the River layer). Click OK.

Figure D39. Message confirming river and reach attributes
have been successfully assigned
e) From XS Cut Line Attributes menu under RAS Geometry, Stationing is selected. A Station
for XS CutLines dialog box appears (Figure D40) shows that stations for XS cutlines
determined successfully (calculated station is used to order the cross sections). Click OK.

Figure D40. Message confirming stations for XS cutlines determined successfully
f) Bank Stations menu is selected. A Bank Stations dialog box appears (Figure D41). Select
CrossSections in the XS Cutlines box, select Bank Lines under Option, and select Banks in
the Bank Lines box. Click OK. A message appears (Figure D42) shows that the Bank stations
for XSCutlines determined successfully.
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Figure D41. Selection of bank lines for the Cross Sections

Figure D42. Message confirming Bank stations for XSCutlines determined successfully
g) From XS Cut Line Attributes menu, select Downstream Reach Lengths, A Downstream
Reach Lengths dialog box appears (Figure D43) shows that downstream reach lengths
determined successfully. Click OK.

Figure D43. Message confirming downstream reach lengths determined successfully
h) Elevations is selected from XS Cut Line Attributes menu, a XS Cutline Profiles dialog box
appears (Figure D44). Select CrossSections in XS Cutlines box, select Miami_TIN in
Terrain box, and type CrossSections3D in XS Cutlines Profile. Click OK. A message
appears (Figure D45) shows that the Bank stations for XSCutlines determined successfully.
Click OK.
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Figure D44. Profile selections for elevation

Figure D45. Message confirming cross section converted to 3D layer successfully
Generating the RAS GIS Import File
i) From main menu of HEC-GeoRAS, select Export RAS Data, the dialog shown in Figure D46
is displayed and allow to pick a file location and file name. Click OK. A message appears
(Figure D47) shows that GIS data for RAS exported successfully. Click OK to close the
message.

Figure D46. Export RAS Data dialog box

Figure D47. Message confirming GIS data for RAS exported successfully
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D.4 Completing the Data and Boundary Conditions
Importing GIS Data to HEC-RAS
a) Click on HEC-RAS icon on the computer desktop, the interface of the HEC-RAS appears
(Figure D48).

Figure D48. Interface of the HEC-RAS
b) Select the File from main menu of the HEC-RAS, then select Save Project As, the dialog
shown in Figure D49 is displayed and allows to pick a file location and file name. Click OK.

Figure D49. Defining a file location and file name for a project
c) Select the Edit from main menu of the HEC-RAS, then select Geometric Data, the dialog
shown in Figure D50 is displayed and allow to import the GIS data into the HEC-RAS.

Figure D50. Geometric Data dialog box
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d) Select File in Figure D50, Select Import Geometry Data > GIS Format, the dialog shown in
Figure D51 appears. Select Miami_RAS_Data file, click OK.

Figure D51. Selection of the imported file
e) Select SI (metric) units for the project unit (Figure D52). Click Next and Next, the attributes
and status of the exported GIS data are shown in Figure D53. Click Finished-Import Data.
The map of the imported GIS data is shown in Figure D54.

Figure D52. Selection of SI (metric) units for the project unit

Figure D53. The attributes and status of the exported GIS data
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Figure D54. Map of imported GIS data
f) From File in Figure D54, select Save Geometry Data As. The dialog shown in Figure D55
appears and allows to pick a file location and file name. Click OK.

Figure D55. Importingh GIS Data to HEC-RAS
Completing the Geometric Data
Entering Manning's n Values
g) From Tables menu in Figure D54, Select Manning's n or k values (Horizontally veried), The
dialog shown in Figure D56 appears.

Figure D56. Edit Manning's n or k values dialog box
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h) In the River box, select All River. Press and keep Shift and click on n#1, n#2, and n#3 in the
Figure D56 to select these columns. Then click on Set Values and enter 0.035 in the appeared
dialog box, click OK. The entered Manning's n values are shown in Figure D57.

Figure D57. Entered Manning's n values
Cross Section Points Filter
Cross sections in HEC-RAS can only have 500 station-elevation points. If having more than 500
points the HEC-RAS interface will stop. The following steps are used to filer cross section
points.
i) Select Tools from the Geometric Data interface, select Cross Section Points Filter. A Cross
Section Points Filter dialog box appears (Figure D58). Tick the check box “Only filter cross
sections with more than 500 points”. Then, click OK. The cross sections with more than 500
points are filtered.

Figure D58. Cross section points filter dialog box
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Completing the Flow Data and Boundary Conditions
Flow data are not imported from the RAS GIS import file so that hydrographs, boundary
conditions, and initial conditions are required to enter through the Unsteady Flow editor. The
hydrographs for Miami were developed using 25 days USGS rainfall and river gage data
collected from the USGS. The graph the developed hydrographs is shown in Figure D59.

Figure D59. Miami simulation hydrograph developed using 25 days USGS rainfall and river
gage data
j) From main menu of HEC-RAS, select Edit > Unsteady Flow Data, a Unsteady Flow Data
dialog box appears (Figure D60). Each river or canal shows the start and the end river
stations.

Figure D60. Unsteady flow data dialog box
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k) Click on File menu (Figure D60), select Save Unsteady Flow Data, a dialog box appears
(Figure D61). Define the name as well as location folder for the unsteady flow data. Click
OK.

Figure D61. Defining name and location for the unsteady flow data
l) The start station at the upstream of the river is assigned for flow hydrograph and the end
station at the downstream of the river is assigned for normal depth. Click on the row under
Boundary Condition of the start station of the Canal, then select Flow Hydrograph, a Flow
Hydrograph dialog appears (Figure D62).

Figure D62. Defining name and location for the unsteady flow data
m) Enter hydrograph data of Miami under Flow column, select 1 day as data time interval, and
starting time reference as shown in Figure D63. Click OK to close the dialog box.
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Figure D63. Entering hydrograph data for the unsteady flow
n) Click on the row under Boundary Condition of the end station of the Canal, then select
Normal Depth, a Normal Depth dialog appears (Figure D64). Enter 0.00084 as friction slope
of the normal depth downstream boundary. Click OK to close the dialog box.

Figure D64. Entering friction slope as a normal depth downstream boundary
o) Repeat step m and n in this section to enter the hydrograph data as well as friction slope for
other remaining rivers and canals.

Figure D65. Boundary conditions for unsteady flow data
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p) Click on Initial Conditions in Figure D65. Then, enter the initial flow for each river and
canal. In this study, “481.4 cfs” is used for the initial flow (Figure D66). Click Apply Data.
From File, select Save Unsteady Flow Data, then from File select Exit.

Figure D66. Entering initial flow data for rivers and canals
D.5 Running Rainfall Flood Simulation
Running Unsteady Flow Analysis
a) Select Run from main menu of the HEC-RAS, select Unsteady Flow Analysis, and an
Unsteady Flow Analysis dialog box appears. From File, select Save Plan Data As, a dialog
box appears (Figure D67). Select location under Selected Folder and type Result under Title.
Click OK to close the dialog box.

Figure D67. Entering initial flow data for rivers and canals
b) Check on the three programs to run: Geometry Preprocessor, Unsteady Flow Simulation, and
Post Processor. Establish a Simulation Time Window and select the Computation Setting as
shown in Figure D68.
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Figure D68. Entering initial flow data for rivers and canals
c) Press the Compute to perform the unsteady flow simulation. When an appearing dialog shows
that the simulation analysis is finished. Click on Close to close the dialog box.
Creating Floodplain Mapping
d) From the main menu of the HEC-RAS, select GIS Tools > RAS Mapper. A RAS Mapper
dialog appears as shown in Figure D68. River network and cross sections in the study area are
shown in the RAS Mapper.

Figure D68. Entering initial flow data for rivers and canals
e) Select Tools, Select Floodplain Mapping, a Floodplain mapping dialog box appears (Figure
D69).
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Figure D69. Floodplain mapping dialog box
f) Click on New Terrain, a dialog box appears as shown in Figure D70. Select 2ftDEM file,
make sure that this is in .flt extension (it was converted from TIN data). Click Open, then
defile Terrain_Miami as the file name. Click OK.

Figure D70. Selecting 2ftDEM data for floodplain mapping
g) From Floodplain Mapping dialog, select All under Profiles and select Water Surface
Elevation under Variables. Click Generate Layers.

Figure D70. Setting profiles and variabless for generating floodplain map
h) The floodplain of the study area is generated for at different times (Figure D71). Under
Results in Figure D71 right click on Max WS Floodplain (this is maximum floodplain area),
select Save Layer As. Then save the maximum floodplain as a shapefile.
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Figure D71. Exported maximum floodplain as a shapefile
D.6 Creating Floodplain Simulation Maps
Above sections, the floodplain shapefile feature class was created and Landsat-8 was
added into Data window of ArcMap. Following the steps in Appendix D and E for creating a
spatial map on Layout View in ArcGIS. The spatial map of the floodplain is created as shown as
followings (Figure D72).

Figure D72. Spatial map of floodplain simulation overlay on Landsat-8 Imagery in Miami and
Surrounding Area, FL
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APPENDIX E
Step-By-Step Procedure of CAIT Methodologies for Geospatial Modeling and Visualization of
Sea Level Rise Simulation

E.1 Adding 2 ft DEM Contour Data and Landsat-8 Pansharpened Multispectral Imagery of
Miami into ArcMap
E.2 Creating Elevation Ranges and Ocean Shapefile Feature Class
E.3 Creating 2 m Sea Level Rise Submerged Land
E.4 Creating Sea Level Rise Simulation Overlay on Landsat-8 Imagery and Affected Population
Maps
E.5 Creating Sea Level Rise Simulation Overlay on DEM/ASL Map
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E.1 Adding 2 ft DEM Contour Data and Landsat-8 Pansharpened Multispectral Imagery of
Miami into ArcMap
The 2 ft DEM contour data and Landsat-8 pansharpened multispectral imagery were used
for a sea level rise simulation at Miami, Florida. The 2 ft DEM contour data used for Miami,
Florida were collected from the Florida Geographic Data Library [5L]. The 2 ft DEM contour
data were generated from LIDAR data. The RMSE of the 2 ft DEM data is 0.3 ft (9 cm) [5K,
5L]. The Landsat-8 pansharpened multispectral imagery, collected from USGS [5F], has
resolution of 15 x 15 meters.
Adding 2 ft DEM Contour Data into ArcMap
a) Click on ArcMap icon on the computer desktop, the ArcMap - Getting Started dialog box
appears (Figure E1). Click My Templates > Bank Map > OK.

Figure E1. The ArcMap - Getting Started dialog box
b) Right click on Layers under Table Of Contents, select Add Data, select 2ftDEM.tif from the
selected folder. The 2ftDEM.tif is the 2 ft DEM contour data at Miami, Florida, then click
Add. The 2 ft DEM contour data appears on ArcMap as shown in Figure E2.
Figure E2 shows the 2 ft DEM contour data at Miami, Florida. The dark and back color
shows low elevation. The light and white color shows high elevation. The legend of the 2 ft
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DEM contour under the Table Of Contents indicates that the lowest elevation point is -2.80533
meters and the highest elevation point is 50.4025 meters.

Figure E2. The 2 ft DEM contour data at Miami, Florida opened on ArcMap
c) Choose File from the main menu, click Save As, the Save As dialog box appears (Figure E3).
d) From File name, type Miami_2m_Sea_Level_Rise. Click Save. The 2 ft DEM contour data
map was saved as an ArcMap document.

Figure E3. Defining a name for the sea level rise simulation
Adding the Landsat-8 Pansharpened Multispectral Imagery into ArcMap
e) Right click on Layers under the Table Of Contents, select Add Data, and select
Pansharpened_LS8.img. Click Add, the Landsat-8 pansharpened multispectral imagery of
Miami appears on the Data View window of ArcMap (Figure E4). This Landsat-8
pansharpened multispectral imagery covers both ocean and land area of the study area.
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Figure E4. The Landsat-8 pansharpened multispectral imagery of Miami on ArcMap
f) Double click on Pansharpened_LS8.img; a Layer Properties dialog box appears. Click on
Symbology, under Band, changed Layer_4 for Red, Layer_3 for Green and Layer_2 for Blue
(Figure E5). Click Apply, and then click OK. The Landsat-8 pansharpened multispectral
imagery of Miami is shown as natural colors on ArcMap.

Figure E5. Selection of natural colors for the Landsat-8 pansharpened multispectral imagery
of Miami on ArcMap
g) In the Table Of Contents, left click on 2ftDEM.tif and keep the mouse then drag the
2ftDEM.tif to the top on the Table Of Contents. Figure E6 shows that the 2 ft DEM contour
data map only cover land areas and some parts of water body from the shoreline to mainland.
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Figure E6. The 2 ft DEM contour data and Landsat-8 pansharpened multispectral imagery of
Miami on ArcMap
E.2 Creating Elevation Ranges and Ocean Shapefile Feature Class
Making Desired Intervals of Elevation using the Reclassify Function
a) From main menu of the ArcMap, select Geoprocessing, select ArcToolbox. The ArcToolbox
dialog box appears (Figure E7).

Figure E7. ArcToolbox dialog box
b) From ArcToolbox dialog box, select 3D Analysis Tools > Raster Reclass > Reclassify
(Figure E8). The Reclassify dialog box appears (Figure E9).

Figure E8. Reclassify function in the ArcToolbox
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c) Under Input raster, select 2ftDEM.tif. Under Reclass field, select Value. Under
Reclassification, the elevation values are reclassified into 9 intervals in Old Values column.
Each interval was assigned with an integer value from 1 to 9 in the New values column
(Figure E9).

Figure E9. Reclassify function dialog box
d) Click Classify in Figure E9; the Classification dialog box appears (Figure E10).

Figure E10. Classification dialog box with 9 classes
e) In the Classes box, select 13. In the Break Values column, type 0, 1, 2, 4, 6, 9, 12, 15, 20, 30,
40, 50, and 70 from top to the bottom (Figure E11).

Figure E11. Classification dialog box with 13 classes
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f) Click OK. The reclassification with 13 ranges is shown in Figure E12. Note that the number
of ranges of elevation depends on the minimum and maximum values of elevation. In this
case, 13 ranges were applied for the elevation range from -2.80533 meters to 50.4025 meters.
If a terrain area that the maximum of the highest point is larger than 50.4025 meters, the
number of elevation ranges could be larger than 13. However the elevation values entered in
the Break Values column must be the same from range 1 to range 13.

Figure E12. Reclassify function dialog box with 13 classes
g) Under Output raster, type Range as output raster file. Tick the check box of Change missing
values to NoData (optional). Click OK. The 13 ranges of elevation appear (Figure E13).

Figure E13. The 13 ranges of elevation in Miami on ArcMap

514

h) From the ArcToolbox dialog box, select Conversion Tools > From Raster > Raster to
Polygon (Figure E14). A Raster to Polygon dialog box appears (Figure E15).

Figure E14. Raster to Polygon Function in ArcToolbox

Figure E15. Raster to Polygon dialog box
i) Under Input raster, select Range. Under Field (optional), select VALUE. Under Output
polygon features, type Ele_Polygon as the name of the elevation ranges polygon shapefile.
j) Click OK, the Ele_Polygon shapefile feature class appears on the Table Of Contents as well
as Data View (Figure E16).

Figure E16. Elevation polygon map on ArcMap
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k) The Ele_Polygon shapefile feature class includes both land and some parts of ocean areas. In
order to calculate area of submerged land by 2 m sea level rise from the Ele_polygon
shapefile feature class, the ocean areas are separated from the Ele_polygon shapefile.
Creating Ocean Shapefile Feature Class
l) Open the Catalog window by clicking on Catalog icon or select Catalog from the Windows
menu. The Catalog window appears as shown in Figure E17.

Figure E17. The catalog window for creating ocean shapefile feature class
m) Right click on Ocean folder (Figure E17), select New > Shapefile. A Create New Shapefile
dialog box appears (Figure E18).

Figure E18. Ocean shapefile feature class creation
n) Type Ocean as the name of the shapefile feature class, selects Polygon as the Feature Type,
and select WGS_1984_UTM_zone_17N as the coordinate system of Ocean shapefile feature
class. Click OK. The Ocean shapefile is created.
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o) Double click on symbol of Ocean shapefile feature class in the Table Of Contents. The
Symbol Selector dialog box of the Ocean feature class appears (Figure E19).

Figure E19. Symbol Selector dialog box for ocean feature class
p) Click Edit Symbol, a Symbol Property Editor dialog box appears (Figure E20). From Type,
select Line Fill Symbol. Under Line Fill, type 135 for Angle, keep 0 for Offset, and type 2
for Separation. Select blue color with RGB (0, 197, 255). Click OK.

Figure E20. Symbol Property Editor dialog box
q) Click on Outline (Figure E20), a Symbol Selector dialog box appears (Figure E21). Select
blue color with RGB (0, 197, 255) - the same color selected for Line Fill (Figure E20). Type
1 as the width of the outline. Click OK to close the Symbol Selector dialog box.
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Figure E21. Symbol Selector dialog box for Outline
r) Double click Ele_Polygon layer in the Table Of Contents, the Layer Properties of the
Ele_Polygon shapefile feature class appears (Figure E22). Click on Display and enter 50 in
the Transparent box. Click OK. The Ele_Polygon shapefile feature class is displayed on
Landsat-8 pansharpened multispectral imagery with 50% transparent (Figure E23). Note that
uncheck Range and all other layers in the Table Of Contents.

Figure E22. Layer Properties of elevation polygon

Figure E23. The elevation polygons displays on Landsat-8 pansharpened
multispectral imagery with 50% transparent
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s) From the Editor toolbar, select Start Editing; select Ele_Polygon in the Start Editing dialog
box. Click OK. Then click on ocean areas on the Ele_Polygon map on Data View; the
elevation polygons in ocean areas were selected.
t) Click on Cut Polygons Tool symbol on the Editor toolbar, then draw a close polygon
surrounding ocean areas (Figure E24). Right click and select Finish Sketch. The ocean
polygons are cut or separated from other polygons in the Ele_Polygon layer. Note that if the
ocean polygons were already separated from land area polygons, the Cut Polygons Tool is not
used.

Figure E24. Ocean polygons are cut from the Ele_Polygon shapefile feature class
u) Click on these ocean polygons on the Ele_Polygon shapefile feature class to select. From
main menu, select Edit > Cut. Select Stop Editing from Editor.
v) From the Editor, select Start Editing; select Ocean in the Starting Editing dialog box. Click
OK. Select Edit from main menu of ArcGIS, click Paste. Select Ocean as the Target layer,
click OK. The selected ocean polygons in the Ele_Polygon shapefile feature class were
moved to the Ocean shapefile feature class. Click Save Edits in the Editor.
w) As mentioned in section D2, the areas on right side of the shoreline or elevation polygons are
ocean area, so that an ocean polygon is created for the ocean area. From Editor, select Editing
Windows > Create Features. A Create Features dialog box appears (Figure E25).
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Figure E25. Create Features dialog box for ocean feature class
x) Select Polygon under Construction Tools. Draw a polygon for ocean area on right side of the
shoreline. Double click to finish the drawing. A polygon for the ocean area was created as
shown in Figure E26.

Figure E26. Ocean feature class on ArcMap
E.3 Creating 2 m Sea Level Rise Submerged Land
Figure E26 shows 13 ranges of elevation in the study area. Note that the 13 ranges of
elevation in the Ele_Polygon shapefile feature class now only present for land areas, the ocean
polygons were already moved to the Ocean shapefile feature class. For 2 m sea level rise
simulation, all polygons in the areas in the second and third ranges are selected as the submerged
land by 2 m sea level rise in Miami. The second range (new values = 2) is from 0 to 1 meter
elevation. The third range (new values = 3) is from 1 to 2 meter elevation.
Creating a 2 m Sea Level Rise Submerged Land Shapefile Feature Class
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a) Right click on Ele_Polygon layer in the Table Of Contents, select Open Attribute Table, the
attribute table of the Ele_Polygon shapefile feature class appears (Figure E27).

Figure E27. The attribute table of the Ele_Polygon shapefile feature class
b) Click on icon on the left corner of the attribute table (Figure E27). Choose Select By
Attributes. The Select By Attributes dialog box appears. Select GRIDCODE = 2 and
GRIDCODE = 3 as shown in Figure E28.
c) Click Apply, the polygons, which GRIDCODE = 2 and GRIDCODE = 3, are selected.

Figure E28. Selection of ranges of elevation for estimating area of submerged land
d) Right click on Ele_Polygon layer in the Table Of Contents. Select Data > Export Data. The
Export Data dialog box appears (Figure E29). Choose Selected features in Export. Under
Output feature class, type 2m_SLR_Submerged. Click OK. A message “Do you want to
add the exported data to the map as a layer?” appears as shown in Figure E30. Click Yes, the
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exported 2m_SLR_Submerged feature class is added as a layer in the Table Of Contents
window and displayed on the Data View.

Figure E29. The 2 m sea level rise submerged land shapefile feature class exported from the
Ele_Polygon shapefile feature class

Figure E30. Option for adding the exported data to the map as a layer
Calculating Area of the Submerged Land
e) Right click on the 2m_SLR_Submerged shapefile feature class in the Table Of Contents.
Choose Open Attribute Table (Figure E31). The attribute table of the 2m_SLR_Submerged
shapefile feature class appears.

Figure E31. Selection for opening attribute table of the 2m_SLR_Submerged feature class
f) Click on icon on the left corner of the attribute table. Choose Add Field. An Add Field
dialog box appears (Figure E32). Enter Area_Km2 as the name of the field. Select Double as
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type of field. Click OK. The Area_Km2 field is added into the attribute table of the
2m_SLR_Submerged shapefile feature class (Figure E33).

Figure E32. Created Area_km2 field for the 2m_SLR_Submerged shapefile feature class
g) Right click on Area_Km2 field (Figure E33), select Calculate Geometry. A Calculate
Geometry dialog box appears as shown in Figure E34. Select Square Kilometers [sq km] as
the units of area calculation. Click OK, the area of the submerged features are calculated in
square kilometers.

Figure E33. Calculate geometry function selection

Figure E34. Options of calculate geometry function
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h) Right click on Area_Km2 field; select Statistics (Figure E35). A Statistics of
2m_SLR_Submerged dialog box appears as shown in Figure E36. The Sum row under
Statistics in Figure E36 indicates that area of submerged features by 2 m sea level rise is
411.96 km2, which is 57.08% of land area.

Figure E35. Selection of depth submerged features from 0 to 1 meter

Figure E36. Selected depth submerged features
E.4 Creating Sea Level Rise Simulation Overlay on Landsat-8 Imagery and Affected Population
Maps
a) Right click on the Layers in Table Of Contents, select Add Data, select City shapefile feature
class that contain cities in the study area.
b) Double click on symbol of the City layer, the Symbol Selector dialog box appears (Figure
E37). Select 8 as size of the symbol and red color with RGB (255, 0, 0). Click OK.

Figure E37. Selection of color and symbol style for city feature class
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c) Double click on symbol of 2m_SLR_Submerged shapefile feature class in the Table Of
Contents. The Symbol Selector of the 2m_SLR_Submerged feature class appears (Figure
E38).

Figure E38. Symbol Selector dialog box for the 2m_SLR_Submerged feature class
d) Click on Edit Symbol, a Symbol Property Editor dialog box appears (Figure E39). From
Type, select Line Fill Symbol. Under Line Fill, type 135 for Angle, keep 0 for Offset, and
type 2 for Separation. Select blue color with RGB (0, 197, 255). Click OK.

Figure E39. Symbol Property Editor dialog box for the 2m_SLR_Submerged feature class
e) Click on Outline (Figure E39), a Symbol Selector dialog box appears. Select blue color with
RGB (0, 197, 255)- the same color selected for Line Fill. Type 1 as the width of the outline.
Click OK to close the Symbol Selector dialog box.
f) From main menu, select View > Layout View. The layout view window, shown in Figure
E40, allows creating a spatial map by adding legend and other map properties.
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Figure E40. The layout view window for creating a spatial map of 2 m sea level rise simulation
g) Double click on 2m_SLR_Submerged layer in the Table of Contents, the Layer Properties
dialog box appears. Under General, type 2.0 m SLR Submerged Land in the Layer Name
box. Click OK.
h) Right click on Layers in the Table Of Contents, select Properties, the Data Frame Properties
dialog box appears (Figure E41). Click on Frame, select None under Border. Click OK. The
frame of the map in Figure E41 disappears.

Figure E41. The Data Frame Properties dialog box for the spatial map
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i)

From main menu, select Insert, the list of tools such as Text, Legend, North Arrow, and
Scale Bar that allows adding title, texts, legend, north arrow, and scale bar for the map
(Figure E42). The spatial map in Figure E43 shows the results of 2 m sea level rise
simulation overlay on Landsat-8 imagery and affected population in Miami and surrounding
areas. Note that the affected population is 57.08% of total population, which is also the same
rate with submerged land. The population data for Miami was collected from U.S. 2010
Census of Population and Housing, Florida. Department of Commerce.

Figure E42. Inserted properties of the spatial map

Figure E43. Spatial map of the 2 m sea level rise simulation overlay on Landsat-8 Imagery
and affected Population in Miami and surrounding areas, Florida
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j) From main menu of the ArcGIS, select File > Export Map, the Export Map dialog box
appears (Figure E44). Type Miami_2m_Sea_Level_Rise as the file name and select JPEG as
the extension of the exported map. Click Save, the spatial map of 2 m sea level rise is
exported to a JPEG file.

Figure E44. Exported spatial map of 2 m sea level rise
E.5 Creating Sea Level Rise Simulation Overlay on DEM/ASL Map
Creating Height Above Sea Level (ASL) Map
a) From the main menu of the Miami_2m_Sea_Level_Rise ArcMap Documents, select File >
Save As. The Save As dialog box appears as shown Figure E45. Type
Miami_2m_Sea_Level_Rise_ASL in the File name box, click Save.

Figure E45. Defining file name of the ASL map of the 2 m sea level rise
b) Tick the check box of the Ele_Polygon layer in the Table of Contents. Then, right click on
the Ele_Polygon layer, select Properties. A Layer Properties dialog box appears.
c) Click General tab, replace Ele_Polygon by ASL (m) in Layer Name (Figure E46). Click
Display tab, replace 50 % by 0 % in Transparent box.
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Figure E46. Defining a name for the DEM/ASL Map
d) Click Symbology. Select Unique values under Categories. Under Value Field, select
GRIDCODE. Select Add All Values. The 13 ranges of elevation from 1 to 13 are displayed
and arranged from top to bottom in the Layer Properties dialog box (Figure E47).

Figure E47. Selection for displaying 13 ranges of elevation of the ASL (m) layer
e) In the Layer Properties dialog box, right click then select Reverse Sorting. The order of the
13 ranges of elevation was reversed. The range 13 was moved to the top and the range 1 was
moved to the bottom (Figure E48).

Figure E48. Reversed ranges of elevation of the ASL (m) layer
f) In the Value column in the Layer Properties dialog box in Figure E48. Click on the symbol of
value 13 (the value 13 is the last range of elevation from 50 meters to 70 meter), a Symbol
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Selector dialog box appears (Figure E49). Change color of both Fill Color and Outline Color
to lepidolite litac color with RGB (232, 190, 255). Type 1 as the Outline width. Click OK to
close the Symbol Selector dialog box.

Figure E49. Selection of color and outline width for the range 13 of elevation
g) In the Label column in the Layer Properties dialog box in Figure E49. Click on 13 then type
50 - 70 as the label of this elevation range.
h) Repeat step f and g for other 12 elevation ranges using elevation range and color code in
column 2 and column 3 in Table E1. Note that click on GRIDCODE under Lable and delete
this text to keep empty in this box. Figure E50 shows selected color and range of the 13
elevation ranges.
Table E1. Elevation range and color code
Range code
13
12
11
10
9
8
7
6
5
4
3
2
1

Elevation Range (m)
50 - 70
40 - 50
30 - 40
20 - 30
15 - 20
12 - 15
9 - 12
6-9
4-6
2-4
1-2
0-1
Sea Level
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Color code RGB
RGB (232, 190, 255)
RGB (190, 210, 255)
RGB (199, 199, 199)
RGB (156, 130, 115)
RGB (112, 57, 2)
RGB (168, 56, 0)
RGB (230, 139, 2)
RGB (123, 139, 2)
RGB (147, 161, 43)
RGB (10, 138, 54)
RGB (176, 219, 112)
RGB (200, 247, 118)
RGB (190, 210, 255)

Figure E50. Selected color and range for 13 elevation ranges
i)

Click OK on the Layer Properties dialog box. The ASL Map (m) with selected
color and elevation ranges are displayed in the Table Of Contents as well as
Layout View (Figure E51).

Figure E51. Selected color and ranges for elevation of the ASL (m) layer
j)

Click on the title of the map on the Layout View, the Properties dialog box
appears (Figure E52) that allows to edit the title of the map. Under Text, type
“Results of Sea Level Rise Simulation Overlay on DEM/ASL Map, Miami and
Surrounding Areas, FL”, keep the same Times New Roman with size 20 for the
title. Click OK.

Figure E52. Defining title for the DEM/ASL map
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k) Double click on the Legend, a Legend Properties dialog box appears (Figure E53). Click on
General tab. Select ASL (m) layer under Map Layers box, click arrow symbol on the top to
move the selected map layer to the Legend Items box. Use the arrow symbol on the right side
to change the order of the map layers (City, ASL (m), and 2.0 m SLR Submerged Land) from
top to bottom (Figure E53).

Figure E53. Selection of map layers for showing their legends on the ASL map
l) Click on Items tab, click Select All to select all 3 map layers. Under Font, select Apply to all
lables. Select Times New Roman with size 20 for legends of the selected map layers (Figure
E54). Click OK. The legends of the selected layers are displayed in Figure E55.

Figure E54. Selection of font and font size for selected layers in the Legend
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Figure E55. Legend of selected map layers on the ASL (m) map
m) The DEM/ASL map does not show population data so that the population information used
for the spatial map of 2 m sea level rise simulation overlay on Landsat-8 Imagery and affected
Population (Figure E43) is not used for this DEM/ASL map.
n) Use Select Elements tool, Delete, and other edit functions in Edit menu to delete population
and arrange the map elements (Legend, North Arrow, Scale Bar) in the Layout View
window. Right click on the Legend, select Convert To Graphics, then move up both Ocean
and 2.0 m SLR Submerged Land layer over ASL (m) layer in the Table Of Contents. The
results of the DEM/ASL map is showed in Figure E56.

Figure E56. Sea Level Rise Simulation Overlay on DEM/ASL Map, Miami and Surrounding
Areas, FL
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o) From main menu of the ArcGIS, select File > Export Map, the Export Map dialog box
appears (Figure E57). Type Miami_2m_Sea_Level_Rise_ASL as the file name and select
JPEG as the extension of the exported map. Click Save, the spatial map of 2 m sea level rise
simulation overlay on DEM/ASL is exported to a JPEG file.

Figure E57. Exported spatial map of 2 m sea level rise overlay on DEM/ASL map
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APPENDIX F
Step-By-Step Procedure of CAIT Methodologies for Geospatial Modeling and Visualization of
Tsunami WPH Simulation

F.1 Adding 2 ft DEM Contour Data and Lansat-8 Pansharpened Multispectral Imagery of Miami
on ArcMap
F.2 Creating a Shoreline Based on 2ft DEM Contour Data and Landsat-8 Pansharpened
Multispectral Imagery
F.3 Creating Depth Submerged by 2 m Tsunami Wave Peak Height
F.4 Calculating Area of Submerged Land Due to 2 m Tsunami Wave Peak Height
F.5 Creating Tsunami Simulation Overlay on Landsat-8 Imagery, Depth Submerged, and
Affected Population Maps

535

F.1 Adding 2 ft DEM Contour Data and Lansat-8 Pansharpened Multispectral Imagery of Miami
on ArcMap
In this study, the 2 ft DEM contour data and Landsat-8 pansharpened multispectral
imagery were used for a tsunami simulation in Miami, Florida. The 2 ft DEM contour data used
for Miami, Florida were collected from the Florida Geographic Data Library (FGDL) [5L]. The
2 ft DEM contour data were generated from LIDAR data. The RMSE of the 2 ft DEM data is 0.3
ft (9 cm) [5K, 5L]. The Landsat-8 pansharpened multispectral imagery, collected from USGS
[5F], has a resolution of 15x15 meters.
Adding 2 ft DEM Contour Data on ArcMap
a) Click on ArcMap icon on the computer desktop. The ArcMap - Getting Started dialog box
appears as shown in Figure F1. Click on My Templates> Bank Map> OK.

Figure F1. The ArcMap – Getting Started dialog box
b) Right click on Layers under Table of Contents, select Add Data, select 2ftDEM.tif , then
click Add. The 2 ft DEM contour data at Miami, Florida, appears on ArcMap, as shown in
Figure F2.
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Figure F2. The 2ft DEM contour data in Miami, Florida opened on ArcMap
Figure F2 shows the 2ft DEM contour data in Miami, Florida. The dark and back color
shows low elevation. The light and white color shows high elevation. The legend of the 2ft
DEM contour under Table of Contents indicates that the lowest elevation point is -2.80533
meters, and the highest elevation point is 50.4025 meters.
c) Choose File from the main menu, click Save As, and the Save As dialog box appears (Figure
F3).

Figure F3. Pixel to Table dialog box
d) From File name, type Miami_2m_Tsunami. Click Save. The 2ft DEM contour data map was
saved as an ArcMap document.
Adding the Lansat-8 Pansharpened Multispectral Imagery on ArcMap
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e) Right click on Layers under Table of Contents, select Add Data, and select
Pansharpened_LS8.img. Click Add, and the Lansat-8 pansharpened multispectral imagery of
Miami appears on ArcMap (Figure F4). This Lansat-8 pansharpened multispectral imagery
covers both ocean and land area of the study area.

Figure F4. The Lansat-8 pansharpened multispectral imagery of Miami on ArcMap
f) Double click on Pansharpened_LS8.img, and the Layer Properties dialog box appears. Click
on Symbology, under Band, change Layer_4 for Red, Layer_3 for Green and Layer_2 for
Blue. Click Apply, and then click OK. The Lansat-8 pansharpened multispectral imagery of
Miami is shown as natural colors on ArcMap.

Figure F5. The Lansat-8 Pansharpened multispectral imagery of Miami on ArcMap
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g) In Table of Contents window, left click on 2ftDEM.tif , and hold the mouse then drag the
2ftDEM.tif to the top on Table of Contents window. Figure F6 shows that the 2ft DEM
contour data map only cover land areas and some parts of water body from the shoreline to
mainland.

Figure F6. The 2ft DEM contour data and Lansat-8 pansharpened multispectral imagery of
Miami on ArcMap
F.2 Creating a Shoreline Based on 2ft DEM Contour Data and Landsat-8 Pansharpened
Multispectral Imagery
For tsunami simulation, a shoreline is created in order to determine cumulative distance of
tsunami from the shoreline. The result of this analysis is based on the maximum distance (29.8
km) from the shoreline that the tsunami moves into the land areas. At 29.8 km from the
shoreline, all land areas in the study area are considered as affection by tsunami. Cumulative
time for this simulation is 53 minutes.
a) From main menu of the ArcMap, select Windows, select Catalog, and the Catalog dialog box
appears (Figure F7). The Catalog allows creating a new feature class as well as defining its
properties.
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Figure F7. The Catalog window
b) Right click on Shoreline folder (Figure F7), select New>Shapefile. A Create New Shapefile
dialog box appears (Figure F8).
c) Type Shoreline as the name of the feature class; select Polyline as the Feature type.
d) Click Edit, select WGS_1984_UTM_zone_17N as the coordinate system of shoreline. Note
that the WGS_1984_UTM_zone_17N was also the coordinate system of the 2ft DEM contour
data as well as the Lansat-8 pansharpened multispectral imagery of Miami.

Figure F8. Create new shapefile dialog box
e) Click Ok, and the shoreline feature class is created and appears on the Table of Contents.
f) Double click on symbol of the Shoreline feature class, and the symbol Selector dialog box
appears (Figure F9).
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Figure F9. Create New Shapefile dialog box
g) Select Dashed 4:4 as line style, width = 2, and red color with RGB (255, 0, 0) for the
shoreline feature class. Click OK.
h) From main menu of the ArcMap, select Editor, select Start Editing. Select Line for Shoreline
feature class in the Create Feature dialog box (Figure F10). If the Create Feature dialog box
does not appeare, from Editor select Editing Windows>Create Features.

Figure F10. Create Feature dialog box
i) Draw a shoreline from the north to the south. Double click to finish the drawing. The created
shoreline is shown in Figure F11.
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Figure F11. Shoreline map
It can be seen from Figure F11 that there is no DEM data on the right side of the shoreline. The
Lansat-8 pansharpened multispectral imagery shows that the areas on the right side of the
shoreline are ocean areas. For this research, elevation of ocean areas was assumed equal to or
less than elevation of sea level.
F.3 Creating Depth Submerged by 2 m Tsunami Wave Peak Height
Creating Depth Map using Minus Function
a) From main menu of the ArcMap, select Geoprocessing, select ArcToolbox. The ArcToolbox
dialog box appears (Figure F12).
b) From ArcToolbox dialog box, select 3D Analysis Tools> Raster Math>Minus. The Minus
function dialog box appears as shown in Figure F13.

Figure F12. Minus function in ArcToolbox
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c) In the Minus Function dialog box, under Input raster or constant value 1, select 2ftDEM.tif.
Under Input raster or constant value 2, enter 2. Under Output raster, type Depth as the
name of the result file from minus function.

Figure F13. Minus function dialog box
d) Then click OK. The Depth raster file is created and appears on the Data View and Table of
Contents (Figure F14).

Figure F14. Depth raster on ArcMap
Making Desired Intervals of Depth using the Reclassify function
e) From ArcToolbox dialog box, select 3D Analysis Tools>Raster Reclass >Reclassify (Figure
F15). The Reclassify dialog box appears (Figure F16).
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Figure F15. Reclassify function in ArcToolbox

Figure F16. Reclassify function dialog box
f) Under Input raster, select Depth. Under Reclass field, select Value. Under Reclassification,
the depth values are reclassified into 9 intervals in Old Values column. Each interval is
assigned an integer value from 1 to 9 in the New values column (Figure F16).
g) Click Classify, and the Classification dialog box appears (Figure F17).

Figure F17. Classification dialog box with 9 classes
h) In the Classes box, select 4. In the Break Values column, type -2, -1, and 0. Keep the
maximum value (48.193883) at the bottom (Figure F18).
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Figure F18. Classification dialog box with 4 classes
i) Click OK. The reclassification with 4 ranges is shown in Figure F19.

Figure F19. Reclassify function dialog box with 4 classes
j) Under Output raster, type Range as output raster file, click OK. The four ranges of depth
appear (Figure F20).

Figure F20. The four ranges of depth on ArcMap
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Create a Polygon Shapefile for the Depth of the 2 mTsunami
k) From ArcToolbox dialog box, select Conversion Tools > From Raster > Raster to Polygon
(Figure F21). A Raster to Polygon dialog box appears (Figure F22).

Figure F21. Raster to Polygon Function in ArcToolbox

Figure F22. Raster to Polygon dialog box
l) Under Input raster, select Range. Under Field (optional), select VALUE. Under Output
polygon features, type Depth_Polygon as the name of the depth polygon shapefile.
m) Click OK, and the Depth_Polygon shapefile appears on Table of Contents as well as Data
View (Figure F23).
n) The Depth_Polygon shapefile includes both land and some parts of ocean areas. In order to
calculate area of submerged land from the Depth_polygon shapefile, the ocean areas are
separated from the Depth_polygon shapefile.
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Figure F23. Depth polygon map on ArcMap
Creating Ocean Shapefile Feature Class
(If an ocean shapefile feature class was created from CAIT 2 m sea level rise simulation
methodology, the ocean shapefile feature class can be used for this tsunami simulation.)
o) Open Catalog window by clicking on Catalog icon or selecting Catalog from Windows
menu. The Catalog window appears as shown in Figure F24.

Figure F24. The Catalog window
p) Right click on Ocean folder (Figure F24), select New>Shapefile. A Create New Shapefile
dialog box appears (Figure F25).
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Figure F25. Ocean shapefile feature class creation
q) Type Ocean as the name of the shapefile feature class, select Polygon as the Feature type,
and select WGS_1984_UTM_zone_17N as the coordinate system of Ocean shapefile feature
class. Click OK. The Ocean shapefile is created.
r) Double click on symbol of Ocean shapefile feature class in Table of Contents. The Symbol
Selector of the Ocean feature class appears (Figure F26). Change both fill color and outline
color to blue with RGB (0, 43, 235), and select 2 as outline width. Click OK.

Figure F26. Symbol selector for Ocean feature class
s) Double click on the Ocean shapefile feature class in Table of Contents, and the Layer
Properties dialog box of the Ocean feature class appears (Figure F27). Click on Display, and
enter 50 in the Transparent box. Click OK. The Ocean shapefile feature class is displayed on
Data View with 50% transparent.
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Figure F27. Setting 50% transparent for Ocean shapefile feature class
t) Double click Depth_Polygon shapefile feature class, and the Layer Properties of the
Depth_Polygon shapefile feature class appears (Figure F28). Click on Display, and enter 50
in the Transparent box. Click OK. The Depth_Polygon shapefile is displayed on Lansat-8
pansharpened multispectral imagery with 50% transparent (Figure F29). Note that all other
feature classes in Table of Contents should be unchecked.

Figure F28. Layer Properties of Depth Polygon

Figure F29. The depth polygons displays on Landsat-8 pansharpened multispectral imagery with
50% transparent
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u) From Editor, select Start Editing, select depth_polygon in the Start Editing dialog box. Click
OK. Then click on ocean areas on depth_polygon on Data View, and the depth polygons in
ocean areas are selected.
v) From toolbar of Editor, click on Cut Polygons Tool symbol; then draw a close polygon
surrounding ocean areas, right click, and select Finish Sketch. The ocean polygons are cut.
Note that if the ocean polygons are separated from land area polygons, the Cut Polygons Tool
is not used.

Figure F30. Cutting ocean polygons from depth polygon shapefile feature class
w) Click on these ocean polygons in Depth_polygon shapefile feature class to select. From main
menu, select Edit>Cut. Than select Stop Editing from Editor.
x) From Editor, select Start Editing; select Ocean in Starting Editing dialog box. Click OK.
Select Edit from main menu, click Paste. Select Ocean as the Target layer, and click OK. The
selected ocean polygons in Depth_polygon shapefile feature class are moved to the Ocean
shapefile feature class. Click Save Edits in the Editor.
y) As mentioned in the F2 section, the areas on the right side of the shoreline are ocean area, so
that an ocean polygon is created for the ocean area. From Editor, select Editing Windows >
Create Features. A Create Features dialog box appears (Figure F31).
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Figure F31. Create features dialog box for Ocean
z) Select Polygon under Construction Tools. Draw a polygon for ocean area on the right side of
the shoreline. Double click to finish the drawing. A polygon for the ocean area is created as
shown in Figure F32.

Figure F32. Ocean feature class on ArcMap
F.4 Calculating Area of Submerged Land Due to 2 m Tsunami Wave Peak Height
Figure F19 shows four ranges of depth due to 2 m tsunami wave peak height. The first range
(new values = 1) is equal to or less than 0 meter elevation. The second range (new values = 2) is
from a 1 to 2 meter depth. The third range (new values = 3) is from a 0 to 1 meter depth. The
fourth range (new values = 4) is non submerged land because the elevation of the land areas is
higher than 2 meters. In this study area, all areas in the first range are located in the ocean area,
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so the first range is not considered for submerged land. Polygons in the second and third ranges
are selected for estimating area of submerged lands in Miami.
Creating Depth Submerged Polygon Shapefile Feature Class
a) Right click on depth_polygon shapefile feature class in Table of Contents, select Open
Attribute Table, and the attribute table of depth_polygon shapefile feature class appears
(Figure F33).

Figure F33. The attribute table of depth polygon shapefile feature class
b) Click on icon on the left corner of the attribute table. Choose Select By Attributes. The
Select by Attributes dialog box appears (Figure F33). Select GRIDCODE = 2 and
GRIDCODE = 3 as shown in Figure F34.

Figure F34. Selection of ranges of depth for estimating area of submerged land
c) Click Apply, and the polygons, GRIDCODE = 2 and GRIDCODE = 3, are selected.
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d) Right click on depth_polygon shapefile feature class in Table of Contents. Select
Data>Export Data. The Export Data dialog box appears (Figure F35). Choose Selected
features in Export. Under Output feature class, type Depth_Submerged. Click OK. The
Depth_Submerged shapefile feature class is created and displayed on Data View.

Figure F35. Depth submerged shapefile feature class exported from depth polygon shapefile
feature class
Calculating Area of Submerged Land
e) Right click on Depth_Submerged shapefile feature class in Table of Contents. Choose Open
Attribute Table. The attribute table of Depth_Submerged shapefile feature class appears.

Figure F36. Created depth submerged shapefile feature class
f) Click on the icon on the left corner of the attribute table. Choose Add Field. An Add Field
dialog box appears (Figure F37). Enter Area_Km2 as the name of the field. Select Double as
type of field. Click OK. The Area_Km2 field is added into Table of Contents.
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Figure F37. Created Area_km2 field
g) Right click on Area_Km2 field, and select Calculate Geometry. A Calculate Geometry dialog
box appears as shown in Figure F39. Select Square Kilometers [sq km] as the units of area
calculation. Click OK, and the area of depth submerged features are calculated in square
kilometers.

Figure F38. Calculate geometry function

Figure F39. Options of calculate geometry function
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h) Click on the icon on the left corner of the attribute table. Choose Select By Attributes. The
Select By Attributes appears (Figure F40). Select GRIDCODE = 2 for selecting depth
submerged features from 1 to 2 meters. Click Apply; the selected depth submerged features
are selected as shown in Figure F41.

Figure F40. Selection of depth submerged features from 0 to 1 meter

Figure F41. Selected depth submerged features
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i) Right click on Area_km2 field, select Statistics (Figure F42); the statistics of the selected
depth submerged features are shown in Figure F43. The area of depth submerged features
from 1 to 2 meters is 72.01 km2, which is 9.98% of land area.

Figure F42. Options of calculate geometry function

Figure F43. The statistics of the selected depth submerged features from 1 to 2 meters
j) Repeat steps h to i in this section. Select GRIDCODE = 3 for selecting depth submerged
features from 0 to 1 meter. The statistics of these selected depth submerged features in Figure
F44 indicates that the area of depth submerged features from 0 to 1 meter is 339.94 km2,
which is 47.10% of land area.

Figure F44. The statistics of the selected depth submerged features from 0 to 1 meter
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F.5 Creating Tsunami Simulation Overlay on Landsat-8 Imagery, Depth Submerged, and
Affected Population Maps
a) Right click on the Layers in Table of Contents, select Add Data, and select City shapefile
feature class that contain cities in study area in Miami.
b) Double click on symbol of the city, and the Symbol Selector dialog box appears (Figure F45).
Select 8 as size of the symbol and red color with RGB (255, 0, 0). Click OK.

Figure F45. Selection of color and symbol style for city feature class
c) Double click on the Depth_Submerged in Table of Contents, and the Layer Properties
appears. Click Symbology. Under Categories click Unique values. Under Value Field, select
GRIDCODE. Click Add All Values (Figure F46).

Figure F46. Layer Properties dialog box
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d) Click on the symbol with GRIDCODE = 2, and change both fill and outline color in to dark
blue with RGB (0, 43, 235).

Figure F47. Color code selection for depth submerged features from 1 to 2 meters
e) Click on the symbol with GRIDCODE = 3, and hange both fill and outline color in to light
blue with RGB (0, 197, 255).

Figure F48. Color code selection for depth submerged features from 0 to 1 meters
f) Under Label, type 1 -2 m for GRIDCODE = 2, and 0 -1 m for GRIDCODE = 3 as shown in
Figure F49.

Figure F49. Defined colors for depth submerged features
558

g) From main menu, select View > Layout View. The layout view window, shown in Figure
F50, allows a spatial map by adding legend and other map properties to be created.

Figure F50. The layout view window for creating a spatial map of 2 m tsunami wave peak height
h) From main menu, select Insert, and the list of tools that allows adding title, texts, legend,
north arrow, and scale bar for the map appears (Figure F51). The spatial map in Figure F52
shows the results of tsunami simulation overlay on Landsat-8 imagery, depth submerged, and
affected population in Miami and surrounding areas. Note that the affected population is
57.08% of total population, which is also the same rate with submerged land.

Figure F51. Inserted properties of the spatial map
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Figure F52. Spatial map of 2 m tsunami wave peak height simulation overlay on Landsat-8
Imagery, depth submerged, and affected Population
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